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Abstract 

ORA is a network analysis tool that detects risks or vulnerabilities of an organization’s design structure. 

The design structure of an organization is the relationship among its personnel, knowledge, resources, and 

tasks entities. These entities and relationships are represented by the Meta-Matrix. Measures that take as 

input a Meta-Matrix are used to analyze the structural properties of an organization for potential risk. 

ORA contains over 100 measures which are categorized by which type of risk they detect. Measures are 

also organized by input requirements and by output. ORA generates formatted reports viewable on screen 

or in log files, and reads and writes networks in multiple data formats to be interoperable with existing 

network analysis packages. In addition, it has tools for graphically visualizing Meta-Matrix data and for 

optimizing a network’s design structure. ORA uses a Java interface for ease of use, and a C++ 

computational backend. The current version ORA1.2 software is available on the CASOS website: 

http://www.casos.ece.cmu.edu/projects/ORA/index.html.  
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Running ORA in Batch Mode 

January, 2010 
ORA Batch Mode XML 

Version 2.0.0 

I. Command Line Arguments 

The program ora.exe (henceforth called ORA) takes one or more of the following 
command line arguments as input: (1) Measures File to be used, (2) the Script File 

to use, and (3) the Log File to use.  

If you installed the front-end of ORA, then the executable can be found as:  
[ORA installation directory] \include\OraFiles\bin\ora.exe 

Likewise, the Measures file can be found as: 

[ORA installation directory] \include\OraFiles\xml\ora_xml_measures.xml 

Measures File 

The Measures File is distributed with ORA and contains an XML encoded description 
of all the measures available to ORA. This is distributed with ORA and is usually 

called ora_xml_measures.xml. The following command line parameter specifies the 
filename: 

-measures <filename> 

Script File 

The Script File is an XML file created by the user and tells ORA where to load the 

input network data and which reports to generate. Section II - ORA Script XML 
Specification - describes in detail the format of this XML script. The following 
command line argument specifies the filename: 

-script <filename> 

Log File 

The Log File is generated by ORA to record the progress and problems of ORA in 
processing the Script File. The log file is a text file, and the following command line 
argument specifies its filename: 

-log <filename> 

Help 
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A listing of the above parameters is available by using the following command line 
parameter: 

-help 

Version 

The ORA version can be obtained by the following command line parameter: 

-version 

II. XML Script 

The batch mode script is a user supplied XML document that is input to ORA (see 
the -script command line parameter above). It tells ORA what network data to load 

and what reports to generate. 

Please note the following general guidelines for the script: 

1. camel case capitalization is used for element names: therefore element names 
begin lower case and the first letter of each word is capitalized. For example, Meta-

Network is metaNetwork. 

2. default values are used: therefore a short, simple script can initially be used to 
run ORA. Advanced users can change the default values. 

The root node is <ora>, which has two child elements <input> and <output>. The 

input element describes the network data to load, and the output section describes 
the reports to generate.  

Example: an empty script 
<ora> 

<input/> 
<output/> 

</ora> 

A. Input Section 

The main unit of input to ORA is the Meta-Network, and therefore the input section 
of the XML script tells ORA how to load one or more Meta-Networks. A Meta-

Network is simply an organization modeled as a collection of matrices. The entire 
Meta-Network can be loaded from a single data file, or each matrix can be loaded 
from separate data files with possibly different data formats.  

1. Meta-Network Specification 
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A Meta-Network is specified by the <Meta-Network> element. It accepts a single 
attribute called id which must be unique across all the Meta-Network elements.  

The child elements describe the location and format of its matrix data. There are 

two cases: (1) all data for the Meta-Network is stored in a single file, (2) the data 
for matrices of the Meta-Network are located in separate files. 

1.1 Meta-Network data in a single file 

The first case is only possible for a data file in the DyNetML format. In this case, the 

<filename> and <format> children are required, and the <properties> child is 
optional. The child elements are described below:  

filename : location of the data 

format : must by dynetml 
properties : [optional] Describes how ORA should interpret the data read from the 

file, but does not cause ORA to modify the input data in any way. Each graph in the 
Meta-Network is given the property.  

Properties are specified with the attributes below, each of which takes values: yes 
or no 

1. sparse: indicates whether the data is sparse 

2. binary: indicates whether the data should be treated as binary (i.e. ignore 
edge weights) 

3. symmetric: indicates whether the unimodal graphs should be considered 
symmetric 

4. diagonal: indicates whether the diagonal values of unimodal graphs should 
be used 

Example: 

<Meta-Network id="Organization"> 
<filename>data/organization.xml</filename> 

<format>dynetml</format> 
<properties binary="yes"/> 

</Meta-Network> 

1.2 Meta-Network data in multiple matrix files 

The second case has the Meta-Network data located in multiple files. In this case, 
the script must describe how to assemble the Meta-Network from different data 
files.  

Matrix data describes a relationship between two sets of nodes, called the source 
and target node sets. Therefore, in specifying a matrix, these nodesets must be 
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specified. A unique id for the matrix is also specified. This id must be unique across 
all matrices in the Meta-Network. 

The <matrix> element defines a matrix and has the following case-insensitive 

attributes: 

sourceType : type of the source node set  
source : [optional] unique identifier of the source node set  

targetType : type of the target node set 
target : [optional] unique identifier of the target node set  

id : [optional] id of the matrix 

The above attributes can be any string.  

The sourceType and targetType attributes specify the class or general category of 
the node sets. By convention, these are taken from Agent, Knowledge, Resource, 

Task, Location, or Organization, but any string can be used. 

The source and target attributes uniquely identify the source and target node sets, 
and if they are not specified the sourceType and targetType are used. To have more 
than one node set of a given type (e.g. "blue" agents and "red" agents), the source 

attribute must be used. 

The id uniquely identifies the matrix within the collection of matrices that is the 
Meta-Network. By default, the id is constructed from the source and target types. 

Examples: 

<matrix sourceType="agent" targetType="agent" id="reports to"/> 
<matrix sourceType="agent" source="employee" targetType="agent" 

target="employee" id="works with"/> 
 
As in the first case, the <matrix> element must have the child elements 

<filename> and <format> that describe the location and format of the matrix data. 
The <properties> element is optional, and pertains only to the matrix. 

The <format> element takes one of the following values: 

dynetml : DyNetML specified data 

ucinet : UCINET binary format (refer to UCINET documentation) 
dl : UCINET text format (refer to UCINET DL documentation) 

csv : CSV (Comma Separated Values) allows row and/or column labels 
raw : space, comma, or semi-colon separated data (no labels allowed) 

Example: 
<Meta-Network id="SampleOrganization"> 

<matrix sourceType="agent" targetType="agent" id="communication"> 
<filename>data/organization_agent_agent.dl</filename> 
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<format>dl</format> 
</matrix> 

</Meta-Network> 

Multiple <matrix> elements are used to define the constituent matrices of the 
Meta-Network. Note that <Meta-Network> has no immediate <filename> and 

<format> children since the data is described under the <matrix> child elements. 
 

Example: 
<ora> 
<input> 

<Meta-Network id="SampleOrganization"> 
<matrix sourceType="agent" targetType="agent" id="social"> 

<filename>data/organization_agent_agent.dl</filename> 
<format>dl</format> 
</matrix> 

<matrix sourceType="agent" targetType="knowledge"> 
<filename>data/organization_agent_knowledge.dl</filename> 

<format>dl</format> 
</matrix> 
</Meta-Network> 

</input> 
</ora> 

In the example, the Meta-Network contains two matrices: the first of type Agent x 

Agent and named social, and it is populated with data from the specified file of the 
specified format. The second has type Agent x Knowledge, and no name is 
specified. 

1.3 Multiple Meta-Networks 

Multiple Meta-Networks can be specified in the <input> section using unique id 
attributes. 

Example: multiple Meta-Networks differentiated by id attribute 
<ora> 

<input> 
<Meta-Network id="SampleOrganization1"> 

<matrix sourceType="agent" targetType="agent" id="social"> 
<filename>data/organization_agent_agent.dl</filename> 

<format>dl</format> 
</matrix> 
<matrix sourceType="agent" targetType="agent" id="friendship"> 

<filename>data/organization_agent_agent_friend.csv</filename> 
<format>csv</format> 

</matrix> 
<matrix sourceType="agent" targetType="knowledge"> 
<filename>data/organization_agent_knowledge</filename> 
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<format>ucinet</format> 
</matrix> 

</Meta-Network> 
<Meta-Network id="SampleOrganization2"> 

<filename>data/organization2.xml</filename> 
<format>dynetml</format> 
</Meta-Network> 

</input> 
</ora> 

1.3 Meta-Network Directories 

If there are multiple DyNetML files in a single directory, then one can specify the 

directory and ORA will create a Meta-Network from each file. The <Meta-
NetworkDirectory> element is used, whose only attribute is name that specifies the 

path of the directory. Each file must have .xml extension. A <transform> element 
can be used within the element to apply to each Meta-Network. The id for each 
Meta-Network is its filename. 

Example: load all Meta-Networks from a directory 

<ora> 
<input> 

<Meta-NetworkDirectory name="data/sample/"> 
<transform> 

<conform method="union"/> 
</transform> 
</Meta-NetworkDirectory> 

</input> 
</ora> 

B. Output Section 

The second section of the script file is the <output> element, and it describes which 

reports to generate. The reports available in ORA and how to specify them in the 
ora-script is documented in the file ORA-batch-mode-parameters.xml, which is an 
XML specification in Relax-NG. 

Ora-Script Report Generation 
To tell ORA to create a report, the <reports> child element is used in the ora-script. 
The <reports> child element contains a collection of <report> elements. Each 

report element specifies any input parameters, the output filename, and the output 
file type/format. Each <report> is uniquely identified by its id attribute. 

The <filename> child specifies the name of the output file to create. The filename 

should NOT have an extension. The <formats> child contains one or more 
<format> children which specify the format of the report output. 

For each report, the possible formats are: text, html, csv, dynetml 
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Example: generating a report in multiple output formats 
<report id="intelligence"> 

<filename>reports/intelligence</filename> 
<formats> 

<format>text</format> 
<format>csv</csv> 
</formats> 

</report> 

Any report specific parameters are designated within the <parameters> child. The 
parameters for each report are documented in the file: ora_xml_measures.xml 

Example: specifying report parameters 

<report id="intelligence"> 
<parameters> 

<numberOfKeyEntities>10</numberOfKeyEntities > 
</parameters> 
<filename>reports/intelligence</filename> 

<formats> 
<format>html</format> 

<format>csv</format> 
</formats> 
</report> 

Example: shorter script if only one output format is specified 
<report id="intelligence" filename="reports/intelligence" format="text"> 
<parameters> 

<numberOfKeyEntities>10</numberOfKeyEntities > 
</parameters> 

</report> 

3. Saving Meta-Networks 

The input Meta-Networks can themselves be saved to files. This allows for 
converting between matrix formats and for saving transformed or conformed input 
data. 

Example: saving a specific Meta-Network 
<ora> 
<output> 

<Meta-Networks> 
<Meta-Network id="sample"> 

<filename>data/output/sample.xml</filename> 
<format>dynetml</format> 
</Meta-Network> 

</Meta-Networks> 
</output> 

</ora> 
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Only the specified Meta-Networks will be saved. Individual matrices can be saved 
using the syntax identical to that of the <matrix> element in the input section. The 

following, for example, saves the agent x agent matrix: 

Example: saving a specific matrix from a Meta-Network 
<ora> 

<output> 
<Meta-Networks> 

<Meta-Network id="sample"> 
<matrix sourceType="agent" targetType="agent"> 
<filename>data/output/sample_agent_agent.dl</filename> 

<format>dl</format> 
</matrix> 

</Meta-Network> 
</Meta-Networks> 
</output> 

</ora> 

In addition, network set operations (union, intersection, difference) can be 
performed on the input networks and then saved. The sample below assumes that 

there were two Meta-Networks specified in the <input> section, namely, A and B, 
and the set operations all pertain to them. Union and Intersect operate on one or 
more input Meta-Networks, and the parameter method indicates how to handle 

common edges. The method attribute takes on one of the following values: binary, 
sum, maximum, or minimum. The difference between two Meta-Networks is taken 

with respect to edges only, and thus no nodes are removed. 

Example: saving union of multiple input Meta-Networks 
<output> 

<Meta-Networks> 
<!--Union--> 
<Meta-Network id="A Union B"> 

<filename>data/output/A-union-B.xml</filename> 
<format>dynetml</format> 

<union method="sum"> 
<Meta-Network id="A"/> 
<Meta-Network id="B"/> 

</union> 
</Meta-Network> 

<!--Intersect--> 
<Meta-Network id="A Intersect B"> 
<filename>data/output/A-intersect-B.xml</filename> 

<format>dynetml</format> 
<intersect method="minimum"> 

<Meta-Network id="A"/> 
<Meta-Network id="B"/> 
</intersect> 

</Meta-Network> 
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<!--Difference (edges only)--> 
<Meta-Network id="A Minus B"> 

<filename>data/output/A-minus-B.xml</filename> 
<format>dynetml</format> 

<difference> 
<Meta-Network id="A"/> 
<Meta-Network id="B"/> 

</difference> 
</Meta-Network> 

</Meta-Networks> 
</output> 
</ora> 

4. Transform Element 

The transform element is used to pre-process a Meta-Network or an individual 
matrix of a Meta-Network before generating reports. It transforms its parent 
element. For example, if the <transform> element is a child of a <matrix> then it 

applies to that matrix. If it is a child of <Meta-Network>, then it transforms the 
entire Meta-Network: for node set modifications (removeNodes, subsetNodes, 

conform), these apply to the Meta-Network as a whole, but transformations of 
edges (symmetrizing, dichotomizing) are applied to each matrix independently. 
 

The <transform> element has the following child elements that define the 
transformation: 

<transpose> : transpose the graph 

<removeIsolates> : remove isolate nodes  

 
<removePendants> : remove pendant nodes  

<symmetrize method=‖‖> : symmetrize using one of two methods 

―union‖ : symmetrize using the union/maximum method 
―intersect‖ : symmetrize using the intersect/minimum method 
Default is ―union‖. 

<subsetNodes> : defines a subset of nodes to create a subgraph 
contains one or more of the following child elements: 
<nodeSet type=‖‖/> : adds all nodes in the specified node set to the subset.  

 
The type attribute can have values: agent, knowledge, resource, task, organization 

<node type=‖‖ id=‖‖ radius=‖‖/> : adds the specified node to the subset 

The type attribute is identical to that of the <nodeSet> element.  
 
The id attribute is the node’s unique id within the node set. 
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The radius attribute is optional (by default it is zero), and includes all nodes within 
a distance <= radius of the node. This is useful for defining ego node sets. 

<removeNodes> : defines a subset of nodes to remove 

contains the same <nodeSet> and <node> child elements as subsetNodes 

<conform method=""/> : creates an identical set of nodes across Meta-Networks. 
This is useful for time-series data to give each Meta-Network the same node sets. 

The union method adds isolates to achieve identical sets, and the intersect method 
removes nodes. 

The method attribute can have one of two values: 

union: create union of node sets  
intersect: create intersection of node sets 
Default is "union". 

By default the agent, knowledge, resource, task, and organization node sets are 
conformed. This can be customized by adding <nodeSet> child elements to specify 
specific node sets, as in subsetNodes above. 

<dichotomize criteria="" cutoff=""/> : creates a binary graph according to the 

criteria and cutoff. Any edges whose value does not satisfy the criteria and cutoff 
are given a value of 0, otherwise a value of 1. 

 
The criteria attribute takes one of the following values: 
lessThan, lessThanEquals, equals, greaterThanEquals, greaterThan 

 
The cutoff attribute can be any numerical value. 

Precedence 

The order (i.e. precedence) in which the transformations occur is as follows: (1) 
individual matrices, (2) Meta-Networks, (3) across Meta-Networks. Each of these 

usages is in the examples below. 

The precedence of operations within a transform (for example, is the graph 
symmetrized before dichotomizing, etc.) is defined to be the same as they are 
specified in the <transform> element. Thus, if the <symmetrize> child is before 

the <dichotomize> child, then the transformation first symmetrizes and then 
dichotomizes. 

Example: remove all agent nodes and the specified knowledge nodes from the 

Meta-Network 
<Meta-Network id="test"> 

<transform> 
<removeNodes> 
<nodeset id="agent"/> 

<node nodesetId="knowledge" id="physics"/> 
<node nodesetId="knowledge" id="mathematics "/> 
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</removeNodes> 
</transform> 

<filename>data/sample.xml</filename> 
<format>dynetml</format> 

</Meta-Network> 

Example: symmetrize a single matrix of the Meta-Network 
<Meta-Network id="test"> 

<matrix sourceType="agent" targetType="agent"> 
<filename>data/aa.csv</filename> 
<format>csv</format> 

<transform> 
<symmetrize method="union"/> 

</transform> 
</matrix> 
<matrix sourceType="agent" targetType="knowledge"> 

<filename>data/ak.csv</filename> 
<format>csv</format> 

</matrix> 
</Meta-Network> 

This example creates a sub-Meta-Network as follows: a set of nodes is defined, and 
then the Meta-Network induced by the nodes (that is, all the edges incident upon 

those nodes). The set of nodes consists of all nodes within distance 2 of agent Andy 
and within distance one of Sam. Because the transform is part of the Meta-

Network, knowledge, task, or organization nodes can be connected to these agents, 
and would therefore be part of the set. 

Example: define a subset of nodes 

<Meta-Network id="test"> 
<transform> 
<subsetNodes> 

<node nodesetId="agent" id="Andy" radius="2"/> 
<node nodesetId="agent" id="Sam" radius="1"/> 

</subsetNodes> 
</transform> 
<filename>/data/myorg.xml</filename> 

<format>dynetml</format> 
</Meta-Network> 

 

This example makes the agent nodes in the Meta-Networks conformable by creating 
the union of all the agent node sets across the Meta-Networks. Currently, only 
agent nodes can be made conformable. 

Example: conform nodesets across Meta-Networks 
<input> 
<transform> 
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<conform method="union"/> 
</transform> 

<Meta-Network id="org1"> 
<filename>data/org1.xml</filename> 

<format>dynetml</format> 
</Meta-Network> 
<Meta-Network id="org2"> 

<filename>data/org2.xml</filename> 
<format>dynetml</format> 

</Meta-Network> 
<Meta-Network id="org3"> 
<filename>data/org3.xml</filename> 

<format>dynetml</format> 
</Meta-Network> 

</input> 

 

Glossary 

A | B | C | D | E | F | G | H | I | J | K | L | M | N | O | P | Q | R | S | T | U | V | 
W | X | Y | Z  

A | Top 

Action : driving to the mall, eating lunch. Used as a verb. 

Adjacency Matrix : A Matrix that is a square actor-by-actor (i=j) matrix where 
the presence of pair wise links are recorded as elements. The main diagonal, or 
self-tie of an adjacency matrix is often ignored in network analysis. 

Aggregation : Combining statistics from different nodes to higher nodes. 

Algorithm : A finite list of well-defined instructions for accomplishing some task 

that, given an initial state, will terminate in a defined end-state. 

Agent : An agent, is an information processing entity that can take agent. The 
most common agents are people. For some research questions, however, it may be 

useful to make these agents decision entities characterized by role, e.g., registered 
nurse and doctor. For other research questions, it make make sense to treat the 

agents as decision making units, like alpha=unit. For other research, the agents 
might be specific animals, or robots, or other types of actors. Researchers disagree 
as to whether all agents in the same entity class should be at the same level, e.g., 

all people, or whether different levels can be mixed such as people and decision 
units. The key is that an agent is an actor that can act in isolation and is not, for 

the purpose of the resesrch, subdividable into parts nor has members. 
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Agent-Generic : Agent-generic are general classes of agents. These can represent 
the role or an attribute by which an agent is characterized. Examples include 

american, girl, child, nurse, president. 

Agent-Specific : Agent-specific are specific agents. They are generally names 
entities representing a unique actor. Examples include George_Washington, 

Red_Deer_0001012. 

Asymmetric Networks : Asymmetric, also called Directed Networks, can have any 
number of links in and out of a node. 

Attribute : Indicates the presence, absence, or strength of a particular 

connection between nodes in a Matrix. It can also be information about the 
specifics of the agents. These are usually traits that agents have in common, each 
can be slightly different (e.g. visible traits like hair colour or intangible traits like 

religious beliefs). 

B | Top 

Betweenness : Degree an individual lies between other individuals in the network; 
the extent to which an node is directly connected only to those other nodes that are 

not directly connected to each other; an intermediary; liaisons; bridges. Therefore, 
it's the number of nodes who an node is connected to indirectly through their direct 

links. 

Betweenness Centrality : High in betweenness but not degree centrality. This 
node connects disconnected groups, like a Go-between. 

Bimodal Ntwork : A network most commonly arising as a mixture of two different 

unimodal networks*. 

Binarize : Divides your data into two sets; zero or one. 

Binary Network : A binary network is constructed by binary values (either 1 or 0) 
in its network matrix and contains only the information whether a link between two 

entities in the network exists or not. 

Bipartite Graph : Also called a bigraph. It's a set of nodes decomposed into two 
disjoint sets such that no two nodes within the same set are adjacent. 

C | Top 

Caesar III : An application for the design of information processing and decision 

making organizations. An application for the design of decision making 
organizations at the operational and tactical levels; it takes into consideration 
cultural differences in coalitions and of adversaries. This tool is under development 

by George Mason University.  
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Categorical : An Attribute Type used primarily used for grouping nodes. 

Centrality : The nearness of an node to all other nodes in a network. It displays 
the ability to access information through links connecting other nodes. The 

closeness is the inverse of the sum of the shortest distances between each node 
and every other node in the network. 

Centralization : Indicates the distribution of connections in the employee 

communication network as the degree to which communication and/or information 
flow is centralized around a single agent or small group. 

Characteristic Path Length : The median of the average shortest distances 

(number of links) connecting each employee to all other employees.  

Interpretation : Characteristic path length gives a insight into how information 
spreads. It reflects the communication performance of the entire network and is 

important for diffusing information and routing information to the right people. A 
small average path length results in fewer "hops" where individuals or groups 
don't get information. 

Classic SNA density : The number of links divided by the number of possible links 

not including self-reference. For a square matrix, this algorithm* first converts the 
diagonal to 0, thereby ignoring self-reference (an node connecting to itself) and 

then calculates the density. When there are N nodes, the denominator is 
(N*(N-1)). To consider the self-referential information use general density. 

Clique : A sub-structure that is defined as a set of nodes where every node is 

connected to every other node. 

Clique Count : The number of distinct cliques to which each node belongs. 

Closeness : node that is closest to all other nodes and has rapid access to all 
information. 

Clustering coefficient : Used to determine whether or not a graph is a small-

world network. 

Cognitive Demand : Measures the total amount of effort expended by each agent 
to do its tasks. 

Column Degree : see Out Degree*. 

Complexity : Complexity reflects cohesiveness in the organization by comparing 

existing links to all possible links in all four networks (employee, task, 
knowledge and resource).  
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Complementarity : The idea that people seek others with characteristics that are 
different from and complement their own, aka the idea that opposites attract. 

Concor Grouping : Concor recursively splits partitions and the user selects n 

splits. (n splits -> 2n groups). At each split it divides the nodes based on 
maximum correlation in outgoing connections. Helps find groups with similar roles 

in networks, even if dispersed. 

Congruence : The match between a particular organizational design and the 
organization's ability to carry out a task. 

Construct : A reduced form of Construct is found in ORA in the Near Term 

Impact Report. 

Continuous : A Attribute Type primarily used for values that are numerical so that 
statistical analysis can be be performed (Average, Minimum, Maximum, and 

Standard Deviation). 

Count : The total of any part of a Meta-Network row, column, node, link, 
isolate, etc. 

CSV : File structure meaning Comma Separated Value. Common output structure 
used in database programs for formatting data. 

D | Top 

Degree : The total number of links to other nodes in the network. 

Degree Centrality : a node with the most connections. (i.e. In the know). 
Identifying the sources for intel helps in reducing information flow. 

Density :  

 Binary Network : The proportion of all possible links actually present in the 

Matrix. 

 Value Network : The sum of the links divided by the number of possible 

links. (i.e. the ratio of the total link strength that is actually present 
to the total number of possible links). 

Disconnected Network : If subsets of nodes are arranged in a way that all nodes 

of group A are unreachable from all nodes from group B and vice versa, the 
network is disconnected. Therefore, there is no link connecting any pair of nodes 
between the subsets of nodes. 

Dyad : Two nodes and the connection between them. 
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Dyadic Analysis : Statistical analysis where the data is in the form of ordered 
pairs or dyads. The dyads in such an analysis may or may not be for a network. 

Dynamic Network Analysis : Dynamic Network Analysis (DNA) is an emergent 

scientific field that brings together traditional Social Network Analysis* (SNA), 
Link Analysis* (LA) and multi-agent systems (MAS). 

DyNetML : DyNetML is an xml based interchange language for relational data 

including nodes, ties, and the attributes of nodes and ties. DyNetML is a universal 
data interchange format to enable exchange of rich social network data and 

improve compatibility of analysis and visualization tools. 

E | Top 

Edge : See Link. 

Eigenvector Centrality : Node most connected to other highly connected nodes. 
Assists in identifying those who can mobilize others 

Entity Class (same as Ontology class) : The group of nodes that exist in the 

same domain and are connected to one another. It's a simplified wat of viewing the 
information. 

Event : Something that happens, especially something of importance. Events are 

usually thought of as a public occasions but they can also be clandestine meetings. 
The number of agents can range in the thousands or as few as two agents (e.g. 
Christmas in Times Square or dinner with friends). 

Event-Generic : Something that occurs periodically [i.e. Summer ] 

Event-Specific : One particular instance which may, or may not, be re-occuring. [ 
i.e. Christmas 2011 or the 9/11 attacks ]. 

F | Top 

FOG : (F)uzzy (O)verlapping (G)roups. Gives a better understanding of individuals 
spanning groups. Fuzzy groups are a more natural and compelling way of thinking 

of human social groups. 

G | Top 

General density : The number of links divided by the number of possible links 
including self-reference. For a square matrix, this algorithm* includes self-

reference (an node connecting to itself) when it calculates the density. When 
there are N nodes, the denominator is (N*N). To ignore self-referential information 

use classic SNA* density. 
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Geodesic Distance : A generalization of the notion of a straight line to curved 
spaces. In presence of a metric, geodesics are defined to be (locally) the shortest 

path between points on the space. 

Gini coefficient : The measure of inequality of a distribution of income. Uses a 
ratio with values between 0 and 1: the numerator is the area between the Lorenz 

curve of the distribution and the uniform (perfect) distribution line; the 
denominator is the area under the uniform distribution line. 

Graph Level Metric : A metric defined for, and gives a value for, the network as a 

whole. The metric is calculated once for the network. Examples are 
Centralization, Graph Hierarchy, and the maximum or average 
Betweenness. 

GraphML : GraphML is a comprehensive and easy-to-use file format for graphs. It 

consists of a language core to describe the structural properties of a graph and a 
flexible extension mechanism to add application-specific data. 

Group : a collection of things (entities, nodes, ties, networks).   A group might at 

times be represented as a meta-node.   Nodes may be classified in to groups on the 
basis of a shared attribute, type, id-range, label, user selection, etc.   For example, 

if you have a set of people and know their gender, then their might be two groups - 
men and women.   In addition the nodes representing those people could be 
displayed as a meta-node for men and a meta-node for women.   Nodes may be 

classified in to groups on the basis of a grouping algorithm.   For example, if you 
have a network showing connections among members of an organization and you 

run a grouping algorithm it will return clusters of nodes that fit together on some 
mathematical criteria.   This cluster is a group and can be represented as a meta-
node. 

H | Top 

Hamming Distance : Number minimum number of substitutions required to 
change one string into another string of equal length. (i.e. "toned" and "roses" is 
3.) 

Heidarian Balance : A motivational theory of attitude change proposed by Fritz 

Heider, which conceptualizes the consistency motive as a drive toward 
psychological balance. (Also known as Balance Theory) 

Heuristics : Problem-solving by trial and error: a method of solving a problem for 

which no formula exists, based on informal methods or experience, and employing 
a form of trial and error iteration. 

Homophily : (i.e., love of the same) is the tendency of individuals to associate and 

bond with similar others. 
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 Status homophily means that individuals with similar social status 
characteristics are more likely to associate with each other than by chance. 

 Value homophily refers to a tendency to associate with others who think in 
similar ways, regardless of differences in status. 

HTML : HyperText Makup Language. 

I | Top 

In-Degree : The sum of the connections leading to an node from other nodes. 
Sometimes referred to row degree. 

Influence network : A network of hypotheses regarding task performance, event 
happening and related efforts. 

Interstitial : An interstitial (something "in between") is a node situated within but 
not restricted to or characteristic of a particular group. It provides extra information 
to the analysis. 

Isolate : any node which has no connections to any other node 

K | Top 

Knowledge : Information learned such as a school lecture or knowledge learned 
from experience (e.g. Excellent knowledge of the periodic table or "I know what you 
did last summer"). 

L | Top 

Latent Semantic Analysis : Latent semantic analysis (LSA) is a technique in 
natural language processing, in particular in vectorial semantics, of analyzing 
relationships between a set of documents and the terms they contain by producing 

a set of concepts related to the documents and terms. 

Lattice Network : A graph in which the links are placed at the integer coordinate 
points of the n-dimensional Euclidean space and each node connects to nodes 

which are exactly one unit away from it. 

Link : The representation of the tie, connection, relation, link between two nodes. 

Link Analysis : A scientific area focused on the study of patterns emerging from 
dyadic observations. The relationships are typically a form of co-presence between 

two nodes. Also multiple dyads that may or may not form a network. 

Link Class : A set of Links of one type. A set of links of one type can be 
represented as a meta-link. 
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Location : An actual physical place. This could be a room in a building, a city, or a 
country (e.g. Pittsburgh, PA or my living room). 

Location-Specific : A Named Entity which is a location [ i.e. The Empire State 

Building ]. 

Location-Generic : A location without a specific reference [ i.e. a beach ]. 

Lossy Intersection : Full intersection means that a node/link needs to be in 100% 
of the networks to be in the resulting network. Lossy intersection at X% percent 

means that a node/link needs to be in at least X% of the networks to be in the 
resulting network. Thus, Lossy intersection is a generalization of full intersection. 

M | Top 

Main Diagonal : in a square matrix this is the conjunction of the rows and cells for 

the same node. 

Math Terms 

These mathematical terms and symbols are used: Let S be any set: 

 card(S) = |S| = the cardinality of S (the cardinality of the node-sets is 
represented as |A|, |K|, |R|, |T|) 

 ℜ denotes a real number 

 Z denotes an integer 

Matrix Algebra : The part of algebra that deals with the theory of matrices. 

Measure : A measure is a function that maps one or more networks to Rn. 
Measures are often scalar (n=1) or vector valued with n=|V| or n=|U|. 

Member Node : A node with a link to a meta-node. 

Meta-Link : The representation of a Group of Links. 

MetaMatrix : See Meta-Network 

Meta-Network : The representation of a Group of Networks. 

Meta-Node : A meta-node is a node composed of a set of member nodes. The 
member nodes may themselves be meta-nodes. 

Monte Carlo : A random optimization of your organization 
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MRQAP - This describes a report in ORA. See Reports for more information. For 
multivariate cases, if your dependent variable is continous or count data (like in a 

negative binomial case), you should use MRQAP. If your dependent variable is 
binary, you should use ERGM (P*) which is forthcoming in ORA. One can perform 

MRQAP on data that have a dichotomous dependent variable (basically, this is 
equivalent to using a linear probability model). You do need to interpret your 
results accordingly. 

Multi-Agent System : A loosely coupled network of problem-solver nodes that 
work together to find answers to problems that are beyond the individual 
capabilities or knowledge of each node 

Multi-node : More than one type of node (people, events, locations, etc.). 

Multi-plex : Network where the links are from two or more relation classes. 

Multimode Network : Where the nodes are in two or more node classes. 

N | Top 

Neighbors : nodes that share an immediate link to the node selected. 

Network : The representation of a set of nodes (including meta-nodes) of one type 
and the links (including meta-links) of one type between them. 

A network N is a triple consisting of two sets of nodes, called U and V, and a set of 

links E⊂UxV. Thus, we write N=(U,V,E). An element e = (i,j) in E indicates a 

relationship or tie between nodes i∈U and j∈V. A network where U=V and therefore 

E⊂VxV is called unimodal*; otherwise the network is bimodal*. We write G=(V,E) 
for unimodal* networks. For our purposes, unimodal networks will not contain self 

loops, which means that (i,i)∉E for i∈V. 

Network Class : A set of Networks on one type. This can also be represented as a 
Meta-Network. 

Network data format : usually comes in the form of NodeSet 1 listed vertically in 

column A starting in row 2 and NodeSet 2 listed horizontally in row 1 starting with 
column B. All the intersecting cells are the links between each of the nodes. 

Newman Grouping : Finds unusually dense clusters, even in large networks. 

Node : A representation of a real-world node (a who, what, where, how, why item. 

people, agents, organizations, beliefs, expertise, resource, tasks, events, or 

locations. Node the representation of a single node (a who, what, where, how why 
item). 
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Node Class : A set of nodes of one type. Note a set of nodes of one type can be 
represented as a meta-node. 

Node-Generic : Generic entities are ones for which there are multiple 

instantiations; i.e., they represent a class. 

Node Level Metric : is one that is defined for, and gives a value for, each node in 
a network. If there are x nodes in a network, then the metric is calculated x times, 

once each for each node. Examples are Degree Centrality*, Betweenness*, and 
Cognitive Demand*. 

Node Set : See Meta-Node. 

Node-Specific : Specific entities are ones for which, within the bounds of the 

research project, there is exactly one entity that can be associated with that name. 

Normalized Sum : Otherwise known as the Average. 

Notation: 

The following matrix notation is used throughout the document for an arbitrary 
matrix X: 

 X(i,j) = the entry in the ith row and jth column of X 

 X(i,:) = ith row vector of X 

 X(:,j) = jth column vector of X 

 sum(X) = sum of the elements in X (also, X can be a row or column vector of 

a matrix) 

 dich(X) = dichotomize (make binary) X, so that dich(X)(i,j) = 1 iff X(i,j) > 0 

 X' = the transpose of X 

 ~X = for binary X, ~X(i,j) = 1 iff X(i,j) = 0 

 X@X = element-wise multiplication of two matrices (e.g. Z=X@Y => Z(i,j) = 
X(i,j)*Y(i,j)) 

O | Top 

ODBC : (O)pen (D)ata (B)ase (C)onnectivity is an access method developed by the 

SQL Access group in 1992 whose goal was to make it possible to access any data 
from any application, regardless of which database management system (DBMS) is 

handling the data. 
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Ontology : "The Specifics of a Concept". The group of nodes, resources, 
knowledge, and tasks that exist in the same domain and are connected to one 

another. It's a simplified way of viewing the information. 

Ontology Class (same as entity class) : The group of nodes that exist in the 
same domain and are connected to one another. It's a simplified wat of viewing the 

information. 

Organization : A group of agents working together for a common cause (e.g. The 
Red Cross or the local chess club). 

Organization-Specific : A Named Entity which is an organization [ i.e. The Red 

Cross ]. 

Organization-Generic : An organization without a specific reference [ ]. 

Out-Degree : The sum of the connections leading out from an node to other 
nodes. This is a measure of how influential the node may be. Sometimes referred to 

as column degree. 

P | Top 

Pajek : A visual tool for analyzing large networks (networks having thousands of 
vertices). 

Path : A set of nodes and links that form a single unbroken chain, such that no 

node or link is repeated. i.e. A ⇒ B ⇒ C ⇒ D ⇒ E 

Pendant : Any node which is only connected by one link. They appear to dangle 
off the main group. 

Percolation Theory : The behavior of connected clusters in a random network. 

Pythia : Program used to create Influence Nets. Pythia is a timed influence net 

application. This tool can downloaded at the following URL: 
http://sysarch.gmu.edu/main/software/. 

Q | Top 

QAP Correlation : Calculates measures of nominal, ordinal, and interval 

association between the relations in two matrices, and uses quadratic assignment 
procedures to develop standard errors to test for the significance of association. 

QAP is designed as a bivariate test (only two variables). Generally, QAP is 

perfectly fine for almost any bivariate network problem. 

R | Top 
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Random Graph : One tries to prove the existence of graphs with certain properties 
by assigning random links to various nodes. The existence of a property on a 

random graph can be translated to the existence of the property on almost all 
graphs using the famous Szemerédi regularity lemma*. 

Reciprocity : The percentage of nodes in a graph that are bi-directional. 

Redundancy : Number of nodes that access to the same resources, are assigned 

the same task, or know the same knowledge. Redundancy occurs only when more 
than one agent fits the condition. 

Regression Analysis : This is used to understand which among the independent 

variables are related to the dependent variable, and to explore the forms of these 
relationships. In restricted circumstances, regression analysis can be used to infer 
causal relationships between the independent and dependent variables. The depend 

and the independent variables can be either network measure or numerical 
attributes of nodes. Used in Visualization/Measure Charts 

Relation : The way in which nodes in one class relate to nodes in another class. 

Resource : Can be either a physical or intangible object. Anything that can be used 

for the completion of a job. (e.g. Use a car to drive from point A to point B or use 
money from a bank account to fund something). 

Robustness : Two different definitions:  

 Networks : Concerned with the reliability (Kim & MÃ©dard, 2004) and 

continued functioning of a network following an intervention. The robustness 
of a network is particularly relevant in communication-type and flow-oriented 

networks. The purpose for understanding robustness of a network has more 
of a management of the network connotation. 

 Measures : This meaning has more of a statistical connotation. Studying the 
robustness of a measure of a network can also be referred to as conducting a 
sensitivity analysis on the measure. In keeping with the terminology of the 

most-recently published research in this area, in lieu of using the term 
sensitivity, we too will use the robustness term, although the terms can be 

used interchangeably. 
A measure is robust if a slight perturbation in its input produces a 
slight change in its output. 

Role : An agents role can be defined as their job for their employer or the part they 

serve during an event. 

Row Degree : see In Degree*. 

S | Top 
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Scale-Free Network : Some nodes act as highly connected hubs (high 
degree), although most nodes are of low degree. Scale-free networks' structure 

and dynamics are independent of the system's size N, the number of nodes the 
system has. A network that is scale-free will have the same properties no matter 

what the number of its nodes is. 

Self-Loop : An node with a connection to itself. 

Self-Looped Network : A self-looped network has non-zero diagonal elements in 
the network matrix. 

Shapefile : The GIS Visualizer can view overlay a Meta-Network over a map. The 

map is a shapefile: a digital vector storage format for storing geometric location 
and associated attribute information. A "shapefile" commonly refers to a collection 
of files with ".shp", ".shx", ".dbf", and other extensions on a common prefix name 

(e.g., "lakes.*"). For example, Shapefiles could represent water wells, rivers, and 
lakes, respectively. Each item may also have attributes that describe the items, 

such as the name or temperature. 

Simmelian Ties : Two nodes are Simmelian Tied to one another if they are 
reciprocally and strongly tied to each other and strongly tied to at least one third 

party in common. It's a tie embedded in closed triples. 

Simulated Annealing : A method of finding optimal values numerically. It's a 
search method as opposed to a gradient based algorithm. It chooses a new point, 
and (for optimization) all uphill points are accepted while some downhill points are 

accepted depending on a probabilistic criteria. 

The term Simulated Annealing draws its inspiration from metallurgy, where 
atoms within a metal are heated thereby dislodging them from a metal's internal 

structure transforming the metal into another atomic state. In this way, your 
organization is heated changing its components in the attempt to arrive at an 

optimized state. 

Slow Measures : As the name implies these measures generally take longer to 
run. 

Small-World Network : Small-World Networks will have sub-networks that are 
characterized by the presence of connections between almost any two nodes within 

them. 

Social Network Analysis : The term Social Network Analysis (or SNA) is used to 
refer to the analysis of any network such that all the nodes are of one type (e.g., 

all people, or all roles, or all organizations), or at most two types (e.g., 
people and the groups they belong to). 
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Sphere of Influence : One node's direct relationship with one of it's neighbors as 
a function of specified path length. 

Standard Deviation : The square root of the variance where variance is the 

average of the squared differences between data points. 

.stl file format : This file format is native to the stereolithography CAD software 
created by 3D Systems. STL files describe only the surface geometry of a three 

dimensional object without any representation of color, texture or other common 
CAD model attributes and can us both ASCII and binary representations 

Symmetric Networks : Any link in a network will have a reciprocal link If there's 

a link from A to B then there will also be a link from B to A. Symmetric 
Network have symmetric values about its diagonal. 

Szemerédi's Regularity Lemma : A fundamental structural result in extremal 

graph theory due to Szemerédi (1978). The regularity lemma essentially says that 
every graph can be well-approximated by the union of a constant number of 
random-like bipartite graphs, called regular pairs. 

T | Top 

Table data format : Table data usually contains a column with referencing IDs and 

headers denoting column names. 

Task : A task is part of a set of actions which accomplish a job, problem or 
assignment. Task is a synonym for activity although the latter carries a connotation 

of being possibly longer duration (e.g.) 

Tie : see Link 

Time : Referring to time or circumstances. Can be as broad as a year or as pinpoint 
as the exact time of a particular day (e.g. Last year or 2:33 PM on March 1st, 

2009). 

Topology : The study of the arrangement or mapping of the elements (links, 
nodes, etc.) of a network, especially the physical (real) and logical (virtual) 

interconnections between nodes. 

Total Degree Centrality : The normalized sum of an node's row and column 
degrees. 

Trail : A set of nodes and links that form a single unbroken chain that can revisit 

nodes but not links. i.e. A ⇒ B ⇒ C ⇒ A ⇒ D 

Transpose : In linear algebra, the transpose of a matrix A is another matrix AT 
(also written Atr, tA, or A') created by any one of the following equivalent actions: 



 

27 
 

 write the rows of A as the columns of AT 

 write the columns of A as the rows of AT 

 reflect A by its main diagonal (which starts from the top left) to obtain AT 

See The Transpose Wikipedia Entry for formulas, examples and more 

information. 

Tuple : An ordered list of elements. Therefore n-tuple is an ordered list of n 
elements. There is also a 0-tuple which is an empty sequence. 

U | Top 

Unimodal networks : These are also called square networks because their 

adjacency matrix* is square; the diagonal is zero diagonal because there are no 
self-loops*. 

W | Top 

Walk : A set of nodes and links that form a single unbroken chain that can revisit 

both nodes and links. i.e. A ⇒ B ⇒ C ⇒ B ⇒ D. 

Weighted Network : If the weights of the links are different we use the term 
weighted network. Every link will be represented by a real number running 

continuously from -∞ to +∞. 

 

Getting Started 

Welcome to ORA's Help File system! The ORA Help and examples contained herein 
are written with a specific data set in mind, mostly designed specifically for a 
particular section. 

How to use ORA help 

If you are not familiar with Social Network Analysis we encourage you to read 

through the beginning sections of the help set. The ORA help set is broken up into 
seven primary parts, which are designed for varying levels of user expertise. 

Getting Started : Provides an overview of Social Networks and how they pertain to 

ORA. 

General Content : Information that applies to many parts of ORA in many 
different ways. 
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The Main Interface : Details working with the data within the Networks. This 
includes loading, saving, merging, performing various math functions on the 

Networks, generating a variety of networks, and running reports. 

The Visualizer : Takes these Meta-Networks and turns them into graphical 
representations. There are tools for creating / deleting nodes and links, displaying 

information in different formats, and helping to analyze the data. 

GeoSpatial/Loom : Describes the parts of ORA specically designed with location 
functions. 

Measures : Explains the various measures used in ORA. They contain a short 

explanation. It also describes the type, input, and output. 

Reports : Contains a description of what each report is and what it will tell you 
about your data. 

Lessons : Designed to teach specific functions and how to carry out many types of 

useful network analytical tasks that can be accomplished by using ORA. 

 

What is ORA? 

An Overview 

The Organizational Risk Analyzer (ORA) is a statistical analysis package for 
analyzing complex systems as Dynamic Social Networks.  

Many complex systems such as organizations, intra-state alliances, food webs, etc. 
can be represented as an ecology of interlinked networks. Within ORA any complex 

system is represented as a Network. What follows is a general description of ORA's 
primary capabilities. Specific instruction is provided under the correlating folders in 

this help system. 

See Basic Terms for additional definitions relating to Social Networks. 

The ORA Visualizer 

The ORA Visualizer renders conceptual images of social networks. Nodes such as 
Agents, Task, Knowledge and Organizations represent real-world Entities like 

the president of a company, driving to the airport, or how to wash your clothes. 
Nodes which share the same attributes can be further grouped together creating 

Meta-Node. Links connect nodes that share a direct relationship. Such relationships 
are derived from the Network. ORA's single unit of data input, and are referred to 
as graphs. The ORA visualizer is interactive. You can zoom, rotate, isolate, add 

and remove Meta-Nodes, and much more. 
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Reports 

ORA can run many reports: Risk, Intelligence, and Sphere of Influence to 
name a few. Multiple organizations can be compared against each other, network 

structure can be optimized, subgroups within a network can be identified, and 
scenarios involving the removal of nodes or links can be examined. Reporting 

capabilities are constantly being refined and updated. 

Charts 

Four chart types are available: Bar Chart, Scatter Plot, Histogram, and Heat 
Map. Each one in turn presents a different statistical profile of a selected nodeset. 

Examples of these reports and how to access them can be found under Basic 
Usages. 

 

Overview 

Contact Information 

Kathleen M. Carley 
CASOS, Carnegie Mellon University 

kathleen.carley@cs.cmu.edu 
tel: 412 268 6016 
ORA 

ORA is an analysis tool designed to help the user evaluate one or more networks. It 
can be used to assess the nature of, features of, change in, and determinants of 

complex networks. A large variety of networks can be assessed including, but not 
limited to, social networks, activity networks, task networks, knowledge networks, 
supply chains, and communication networks. Using ORA questions such as the 

following can be addressed: what is critical, are there groups of interest, are there 
patterns of interest, how might interventions impact the network, who is critical, 

are there emerging groups, how is the network changing. 

What is a network? In any data there are relations among things such as two 
people are cousins, or a set of people are all members of the same club. These 
networks might be psychological or cultural as when two people share the same 

belief. They might be physical as in two resources being in the same location or two 
computers being connected by a line, or they might be social as in people being 

related. There are many reasons why networks exist. Networks are ubiquitous. 
Everyone and everything is constrained and enabled by the networks in which they 
are embedded. Everyone and everything is embedded in multiple networks; e.g. 

you are connected to some people due to work, others due to school, others due to 
your kids, and so on. ORA lets you visualize, assess, and reason about these 

networks. 
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What kinds of networks? 

ORA can assess any type of network. Anything that can be represented as a set of 
nodes and relations can be assessed. Typical networks are: social networks (who 

interacts with whom), financial networks (who lends money to whom); gant charts 
(what task needs to be done before what), supply chains (what resources are 

needed to build what other resources)., semantic networks (what ideas are linked 
to what ideas), proximity networks (what states border on what states), and so on. 

ORA can assess any data that can be represented as nodes and relations regardless 
of what the nodes are or what the relations are. 

What if there are many networks? 

ORA can be used to assess the interlocks among networks. For examples, imagine 
that the following networks exist: who works with whom; who has what skills, what 

skills are needed for what tasks, who is doing what tasks then ORA can assess 
whether in fact the right people have been assigned to those tasks or where there 

are problems because there is insufficient skills available for the task. ORA can 
assess "multi-mode multi-link" data. 

What if the networks change? 

ORA can be used to assess change in networks over time. Over time, the shape or 

topology of a network might change; e.g., start up companies move from a 
collaborative to a hierarchical structure, terrorists change what weapons they use 
to attack sites, scholars cite different papers, and so on. Consequently, over time, 

who or what is critical in a network might change. ORA can assess change in 
networks, and forecast possible ways in which the network might change in the 

future. 

What if information is incomplete? 

ORA can assess networks even when information is incomplete. ORA has been built 
to gracefully degrade so that it calculates all and only those metrics for which there 

is information. 

Illustrative applications 

ORA has been applied in numerous settings. Examples include the following. 
Assessment of team-x leadership structure at NASA. Comparison of terror 

networks. Identification of vulnerabilities in insurgency and terror networks. 
Assessing change in political elite structures in Korea and early identification of 
emergent leaders. Designing teams for wargames. Assessing the impact of turnover 

and retirement on public health organizations in Duchess County, NY. Identifying 
reports with AIS data. Organizations where ORA has been used include: AFIT, 

SOCOM, USMA, CIA, many universities. 
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Tool Evolution 

There are still many challenges in the area of dynamic network analysis. Key 
challenges include handling streaming data, locating confidence intervals for 

metrics, uncertainty assessment, and so on. As these challenges are met, new 
algorithms are implemented, tested and added to ORA thus further meeting the 

user's needs. 

 

Social Network Analysis (SNA) 

Social Network Analysis is a scientific area focused on the study of relations, 
often defined as social networks.  

In its basic form, a social network is a network where the people entities and the 
relations links are a form of connection such as friendship. Social Network Analysis 

takes graph theoretic ideas and applies them to the social world.  

The term social network was first coined in 1954 by J. A. Barnes (see: Class and 
Committees in a Norwegian Island Parish). Social network analysis is also 

called network analysis, structural analysis, and the study of human relations. SNA 
is often referred to as the science of connecting the dots. 

Today, the term Social Network Analysis (or SNA) is used to refer to the 

analysis of any network such that all the entities are of one type (e.g., all 
people, or all roles, or all organizations), or at most two types (e.g., 
people and the groups they belong to). The metrics and tools in this area, 

since they are based on the mathematics of graph theory, are applicable 
regardless of the type of nodes in the network or the reason for the connections. 

For most researchers, the entities are actors. As such, a network can be a cell of 

terrorists, employees of global company or simply a group of friends. However, 
entities are not limited to actors. A series of computers that interact with each 

other or a group of interconnected libraries can comprise a network also. 

Where to find out more on SNA 

 Scott, John, 2000, Social Networks, Sage (2nd edition) 

 Wasserman, S. & K. Faust, 1994, Social Network Analysis: Methods and 

Applications 
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Dynamic Network Analysis 

Dynamic Network Analysis (DNA)* is an emergent scientific field that brings 
together traditional social network analysis (SNA), link analysis (LA) and 

multi-agent systems (MAS)*. There are two aspects of this field. The first is the 
statistical analysis of DNA data. The second is the utilization of simulation to 
address issues of network dynamics. DNA networks vary from traditional social 

networks in that are larger dynamic multi-mode, multi-plex networks, and may 
contain varying levels of uncertainty. 

DNA statistical tools are generally optimized for large-scale networks and admit the 

analysis of multiple networks simultaneously in which, there are multiple types of 
nodes (multi-nodes)* and multiple types of links (multi-plex)*. In contrast, SNA 

statistical tools focus on single or at most two mode data and facilitate the analysis 
of only one type of link at a time. 

DNA statistical tools tend to provide more measures to the user, because they have 
measures that use data drawn from multiple networks simultaneously. From a 

computer simulation perspective, nodes in DNA are like atoms in quantum theory, 
nodes can be, though need not be, treated as probabilistic.  

Whereas nodes in a traditional SNA model are static, nodes in a DNA model have 

the ability to learn. Properties change over time; entities can adapt: A company's 
employees can learn new skills and increase their value to the network; Or, kill one 

terrorist and three more are forced to improvise. Change propagates from one 
entity to the next and so on. DNA adds the critical element of a network's evolution 
and considers the circumstances under which change is likely to occur. 

Adequate Survey Response Rate 

Often people try to get 100% response when the full network is collected - 

however, anything above 85%-90% is considered good. For ego network data - 
standard response rate guidelines are followed. 

Where to learn to more: 

Kathleen M. Carley, 2003, Dynamic Network Analysis‖ in Dynamic Social Network 

Modeling and Analysis: Workshop Summary and Papers, Ronald Breiger, 
Kathleen Carley, and Philippa Pattison, (Eds.) Committee on Human Factors, 

National Research Council, National Research Council. Pp. 133-145, 
Washington, DC. 

Kathleen M. Carley, 2002, Smart Agents and Organizations of the Future‖ The 

Handbook of New Media. Edited by Leah Lievrouw and Sonia Livingstone, Ch. 
12, pp. 206-220, Thousand Oaks, CA, Sage. 
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Kathleen M. Carley, Jana Diesner, Jeffrey Reminga, Maksim Tsvetovat, 2005-
forthcoming, Toward an Interoperable Dynamic Network Analysis Toolkit, 

DSS Special Issue on Cyberinfrastructure for Homeland Security: Advances in 
Information Sharing, Data Mining, and Collaboration Systems. 

 

ORA and DNA 

In general, you may want to use ORA in conjunction with other computational tools 

to advance DNA theory. The CMU CASOS tools that work with ORA to form tool 
chains are AutoMap (extracts networks from texts) and various DNA simulators 
including both Construct and DyNet. These tools are often used in a number of 

real world applications, including the following areas: 

 Designing adaptive teams for Command and Control Networks 

 Estimating the impact of organizational downsizing 

 Estimating the effectiveness of new structures 

 Evaluating risk in organizational designs 

 Examine impact of IT effectiveness 

 Impact analysis of actions in asymmetric warfare simulation 

 Impact analysis of weaponized biological attacks on cities 

ORA is interoperable with a number of other SNA and link-analysis tools: UCINET, 

KeyPlayer, and Analyst Notebook. Additional information is listed under data 
import and export. 

Where to learn more about CASOS tools and this tool chain: 

Kathleen M. Carley, Jana Diesner, Jeffrey Reminga, Maksim Tsvetovat, 2004, An 

Integrated Approach to the Collection and Analysis of Network Data, In Proceedings 
of the NAACSOS 2004 Conference, Pittsburgh, PA 

Kathleen M.Carley, 2004, Estimating Vulnerabilities in Large Covert Networks Using 

Multi-Level Data, In Proceedings of the NAACSOS 2004 Conference, Pittsburgh, PA 

Kathleen M. Carley, 2003, Dynamic Network Analysis in Dynamic Social Network 
Modeling and Analysis: Workshop Summary and Papers, Ronald Breiger, Kathleen 
Carley, and Philippa Pattison, (Eds.) Committee on Human Factors, National 

Research Council, National Research Council. Pp. 133-145, Washington, DC. 

Kathleen M. Carley, Jana Diesner, Jeffrey Reminga, Maksim Tsvetovat, 2005-
forthcoming, Toward an Interoperable Dynamic Network Analysis Toolkit, DSS 
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Special Issue on Cyberinfrastructure for Homeland Security: Advances in 
Information Sharing, Data Mining, and Collaboration Systems. 

CASOS: Center for Computational Analysis of Social and Organizational Systems 

(http://www.casos.cs.cmu.edu/index.html) 

 

System Requirements 

ORA performs best on machines that meet or exceed the following specifications: 

Spec Windows Mac (running XP) 

System XP OSX 10.4.x 

RAM 256 MB 1GB 

Processor Pentium 4 Intel Core 2 Duo 

Speed 1.0 GHz 2.0 GHz 

Java 6.0 6.0 

Extra   Parallels for Dual Booting 

NOTE : When working with extremely large data sets, increasing processing speed 
and RAM is highly recommended. 

 

Files Formats 

ORA can read in a multitude of file formats. Below is a list, with examples of the 

code, of those formats. 

DyNetML – .dl – UCINET – comma delimited (.csv) – text files (.txt) – Pajek 
(.net) – GraphML – GMU model (.stl) – Pathfinder (.lo). 

DyNetML (the native ORA xml format): DyNetML is an xml based interchange 

language for relational data including nodes, ties, and the attributes of nodes and 
ties. DyNetML is a universal data interchange format to enable exchange of rich 
social network data and improve compatibility of analysis and visualization tools. 

<node id="col_jack_o'neill"> 
  <properties> 
    <property name="ally" type="string" value="yes"/> 
    <property name="gender" type="string" value="male"/> 
  </properties> 
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</node> 

<graph sourceType="Agent" source="Agent" targetType="Agent" 
target="Agent" id="agent x agent" isDirected="true"> 
  <edge source="A01" target="A11" type="double" value="1"/> 
  <edge source="A02" target="A01" type="double" value="1"/> 
</graph> 

 

.dl: DL (for "data language") is a very powerful and (fairly) simple language that 
allows the creation of quite complex and large UCINET data sets with minimal data 

entry. DL language files are plain ASCII text files that can be created with any 
editor (be sure to store the results as plain text). 

dl n=9, format=edgelist1 
labels: 

    A,B,C,D,E,F,G,H,I 
data: 
    1    1    1 
    1    2    1 
    1    6    1 
          . 
          . 
          . 
    8    7    1 
    9    9    1 

 

.##h and ##d (UCINet): UCINET datasets are stored in a special (Pascal) 
format, but can be created and manipulated using both UCINET's and other 
software tools (text editors and spreadsheets). Each UCINET dataset consists of two 

separate files that contain header information (e.g. myfile.##h) and the data lines 
(e.g. myfile.##d). Because of this somewhat unusual way of storing data, it is best 
to create data sets with the internal spreadsheet editor or DL language tools, or to 

import text or spreadsheet files and save the results as UCINET files. 

 

.CSV (comma separated values): The CSV ("Comma Separated Value") file 
format is often used to exchange data between disparate applications. The file 

format, as it is used in Microsoft Excel, has become a pseudo standard throughout 
the industry, even among non-Microsoft platforms. File most commonly created 

from an Excel spreadsheet using the Save As… option 

 Each record is one line… but — A record separator may consist of a line feed 
(ASCII/LF=0x0A), or a carriage return and line feed pair (ASCII/CRLF=0x0D 

0x0A)… but — fields may contain embedded line-breaks (see below) so a 
record may span more than one line. 

 Fields are separated with commas. 



 

36 
 

 Leading and trailing space-characters adjacent to comma field separators are 
ignored. 

 Fields with embedded commas must be delimited with double-quote 
characters. 

 Fields that contain double quote characters must be surrounded by double-
quotes, and the embedded double-quotes must each be represented by a 

pair of consecutive double quotes. 

 A field that contains embedded line-breaks must be surrounded by double-

quotes 

 Fields with leading or trailing spaces must be delimited with double-quote 

characters. 

 Fields may always be delimited with double quotes. 

 The first record in a CSV file may be a header record containing column 
(field) names 

,A01,A02,A03,A04 
A01,0,0,0,0 
A02,1,0,0,0 
A03,1,0,0,0 
A04,1,0,0,0 

 

.txt (text files): Otherwise referred to ASCII files which contain no 
extemporaneous formating. 

 

.raw:  

 

.net (Pajek): The file format accepted by Pajek provides information on the 
vertices, arcs (directed edges), and undirected edges. A short example showing the 

file format is given below: 

*Vertices 3 
1 "Doc1" 0.0 0.0 0.0 ic Green bc Brown 

2 "Doc2" 0.0 0.0 0.0 ic Green bc Brown 
3 "Doc3" 0.0 0.0 0.0 ic Green bc Brown  
*Arcs 
1 2 3 c Green 
2 3 5 c Black 
*Edges 
1 3 4 c Green 
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.graphml: GraphML is a comprehensive and easy-to-use file format for graphs. It 
consists of a language core to describe the structural properties of a graph and a 

flexible extension mechanism to add application-specific data. Unlike many other 
file formats for graphs, GraphML does not use a custom syntax. Instead, it is based 

on XML and hence ideally suited as a common denominator for all kinds of services 
generating, archiving, or processing graphs. 

<xs:annotation> 
  <xs:documentation 
    source="http://graphml.graphdrawing.org/" 
    xml:lang="en"> 
    Simple type definitions for the new graph attributes. 
  </xs:documentation> 
</xs:annotation> 

 

.stl (GMU model): This file format is native to the stereolithography CAD software 
created by 3D Systems. STL files describe only the surface geometry of a three 

dimensional object without any representation of color, texture or other common 
CAD model attributes and can us both ASCII and binary representations 

An ASCII STL file begins with the line: 
solid {name} 
where name is an optional string. The file continues with any number 
of triangles, each represented as follows: 
facet normal n1 n2 n3 
  outer loop 
    vertex v11 v12 v13 
    vertex v21 v22 v23 
    vertex v31 v32 v33 

  endloop 
endfacet 
where n1-n3 and v11-v33 are floating point numbers in sign-
mantissa'e'-sign-exponent format and concludes with: 
endsolid {name} 

 

.lo (pathfinder):  

 

Network Drives 

If you are running on a network drive then the help system needs a drive letter in 
order to work correctly. There are 2 possible solutions to this: 

1. Copy the ORA folder to each local machine. 

2. If at all possible Map a Network Drive. Right click on the shared folder and 

select Map Network drive. 
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Mapping a Network Drive 

In an Explorer window select My Network Places. Find the name of the network 
which contains ORA. 

 

Go back to My Document. 

 

From the menu select Tools ⇒ Map Network Drive. This brings up the dialog box 

below. 

 

Select the [Browse] button in order to select the network drive. 
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Select the correct network drive and press [OK]. 

 

Select [Finish]. 
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Your computer now has the Network drive with ORA mapped on the desktop. 

 

DyNetML Networks 

DyNetML 

DyNetML is an xml based interchange language for relational data including nodes, 
ties, and the attributes of nodes and ties. DyNetML is a universal data interchange 

format to enable exchange of rich social network data and improve compatibility of 
analysis and visualization tools 

Uni-Modal Networks 

Uni-modal networks are not changed (e.g. an AA does is NOT symmetrized), but bi-

modal networks are symmetrized in that the links from two or more networks are 
combined using the maximum method. 

Bi-Modal Networks 

Bi-modal networks are combined. e.g., if there is an AK and a KA network, then the 

KA is transposed to AK2 and then AK and AK2 are unioned with the Maximum link 
weight from each (a,k) or (k,a) being used. 

Network names are normalized to have IDs agent x agent, agent x knowledge, etc.. 
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ORA QuickStart 

1.0 GENERAL 

1.1 WHAT IS ORA: 

ORA is a network analysis package that helps the user enter, analyze, visualize, and 

forecast changes in networks using graph based and statistical based techniques. 

ORA consists of two parts: The Editor, which allows you to work on loaded Meta-
Networks and the Visualizer, which allows you to see a graphic depiction of the 

Meta-Network. 

1.2 INSTALLATION: 

This is the procedure to install ORA on your computer: 

Go to http://casos.cs.cmu.edu/projects/ora/software.php 

Click the Download link 

Select the [ Yes ] button to agree to terms and click [ Continue ] 

Insert your Information and click [ Continue ] 

Choose your platform. 

Click the link for your system [ 32-bit or 64-bit ] 

After the program is downloaded double click the ORA icon to install. Follow 

installation instructions. 

 

QuickStart Editor 

2.0 EDITOR 

2.1 EDITOR GUI 

The ORA interface is organized into three sections which are placed in resizable and 

dockable panes. Each pane will have one or more individual parts. On each tab are 
two buttons: undock and close. In the upper right corner of each pane are three 
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buttons: undock, maximize, and close. This will allow you to arrange the 
interface to suit your needs. 

 

fig - The ORA Editor Interface 

1) Menu – Source for performing the majority of tasks. The Menu Items are 
separated into categories each with their own functions. 

2) Toolbar – Buttons for main functions to work with Meta-Networks, NodeClasses 

and Networks. 

3) Toolbar Button Adder – Allows you to add menu functions to the toolbar. 

4) Meta-Network Manager – This pane displays all currently open Meta-
Networks. 

5) Editor – This pane displays in multiple tabs information on Node Classes and 

Networks. 

6) Reports – This pane display reports run on Meta-Networks. 

2.2 WHAT’S IN A META-NETWORK: 
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Meta-Network – A representation of a Group of Networks.  

Node – A representation of a real-world item (a who, what, where, how, why 
item). 

Node Class – A set of nodes of one type. 

Link – A representation of a tie, edge, connection, or relation link between any two 
nodes.  

Network – A representation of a set of nodes (including meta-nodes) of one type 

and the links (including meta-links) of one type between them. 

Attribute – Additional information about a node. The most common agent 
attributes are age & gender although it can be anything you choose. 

2.3 META-NETWOKS, NODECLASSES, AND NETWORKS BUTTONS 

ORA contains tools to Add or Remove Meta-Networks, NodeClasses, or 

Networks. The Plus sign denotes adding and the Minus sign denotes removing. 

 

To add a Meta-Network, NodeClass, or Network click the appropriate button. 

The new item will appear in the Meta-Network Manager. 

To remove a Meta-Network, NodeClass, or Network highlight the item and click 
the appropriate button. 

NOTE : When in the actual program only the applicable buttons will be active e.g. if 

a network is highlighted then only the Network buttons are active. All others would 
be greyed out. 

2.4 CREATING A NETWORK AND NODECLASS FILE 

A NodeClass or Network can be created either in ORA or in an external program 

such as a text editor [NotePad or NotePad++] or a spreadsheet program [Excel]. 

Using a Text Editor 

To create a Network in a Text Editor all information will be separated by commas. 
The lefthand column consists of the FROM nodes and the top row consists of the 
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TO nodes. A ―"0"‖ at an intersection means there is no link while a non-zero 
number means there is a connection. 

,A01,A02,A03,A04,A05 

A01,0,0,0,0,1 

A02,1,0,0,0,0 

A03,1,0,0,0,1 

A04,1,0,0,0,1 

A05,0,0,0,0,0 

In the text file above notice the empty value in the top row just to the left of the 

top comma. This corresponds to the empty cell in the Excel spreadsheet Column 
A–-Row 1.  

To create csv files save them as a text file (.txt) but change the extension name to 
.csv. 

Using Excel 

In an Excel Spreadsheet you would place each set of nodes in a separate row or 
columns with each piece of information in a separate intersecting cell. To create a 

csv file select File > Save As…... and save it as a comma-delimited file. 

 

Excel with the SG-1 Network data 
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Links will run from the node in Column A to the node in Row 1. For example there 
is a link from A02 > A01 [cell B3] but there is no link from A01 > A02 [cell C2]. 

Again note that the cell [A1] is blank. This is common in all network files created in 

this manner. 

2.5 IMPORT CSV FILES INTO ORA TO CREATE NODECLASS AND NETWOR: 

 With NodeClasse and Network created it is time to import them into ORA. For 
this we use the Data Import Wizard.  

Select Import existing data? > Table Data from Excel of delimited formats > 

Rectangle of link weights (a Matrix). Click [ Next > ]. 

Click Create a new neta-network with ID: 

Replace Meta Network with the name for your new MetaNetwork then click [ Next 
> ] 

The Import Data Interface 

Click [ Browse ] and locate the csv file of the agents. 

Set Source type and Target type to agent. 

NOTE : For this Network both are set to agent. Depending on the data you are 
importing these may be set to different nodeclasses. 

NOTE : Clicking on the Click to import from another file allows you to import 
additional networks. 

Click [ Finish ] 

To import additional files into the Meta-Network choose Add to the existing 
meta-network instead of Create a new Meta-Network with ID:. Then select 
the Meta-Network to add. 

 

The ORA Editor with the SG-1 network loaded 
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2.6 CREATING A NODE TITLE/ATTRIBUTE FILE 

CSV files are used to create NodeClass and Network files. These can be created in 
either a text editor or a spreadsheet program. 

In a Text Editor you would place each node on a separate line with all information 
separated by commas. To create csv files same them as a text file (.txt) but change 
the extension name to .csv. For this example the file will create Node Titles. This 

could be used to import any attribute. The top row contains the names of the fields 
that will be imported. 

id,title 

A01,col_jack_o’neill 

A02,maj_samantha_carter 

A03,daniel_jackson 

A04,teal’c 

A05,gen_hammond 

In an Excel Spreadsheet place each node name or attribute into a separate row 

with each piece of information in a separate cell. The juxtaposition of the various 
cells on a row code the relations of interest To create csv files Save As…... a 

comma-delimited file. 

In a Text Editor place each node on a separate line. Save as a text file with the 
.csv externsion. 

NOTE : Only rows with ids which match up to existing nodes will be imported 

unless the Create new nodes option is checked. 

2.7 IMPORT ATTRIBUTES INTO ORA:  

Select Import existing data? > Table Data from Excel of delimited formats > 
Simple Table > Node Attributes. Click [ Next > ]. 

Select the Meta-Network to add information. Click [ Next >]. 

Click Browse and navigate to your attribute file. 

Select from the drop down which column to use to identify your node IDs. 

For each column a box will appear allowing you to chose which attributes to import. 

Place a check mark next to each attribute you want and give it a Type: Text 
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Category, Text, URI, Number Category, Number, or Date. An attribute without a 
check mark will not be imported.  

Select the NodeClass to add the attributes. This drop down will contain multiple 

entries if your Meta-Network contains more than one NodeClass.  

Click [ Finish ]. 

The A01, A02, etc will be replaced with the titles in the attribute file. 

NOTE : Only the attributes you check mark will be imported. All others will be 

ignored. 

2.8 ADD/REMOVE NODES IN THE EDITOR: 

Nodes can be added or removed to any NodeClass through the Editor. Highlight the 
NodeClass then use the buttons on the right side of the Editor to manipulate the 
nodes. Some of the functions require that you place a check mark next to the node 

you are working with [i.e. deleting a node]. 

Create: Insert new nodes into meta-network 

Move : Move node(s) from one node set to another. 

Delete : Remove node from NodeClass 

Merge : Combine two or more nodes into one 

Clean : Condense all references of one person into a single node. 

2.9 CHANGE DISPLAY TO BINARY OR NUMERICAL 

The grids in the Editor can display link data as numeric or check marks. Binary data 

is usually done with check marks as it is simply on or off. Numerical data [for 
weighted links] can show a ink as 0 of a positive/negative number. 

Click Display Options near the bottom right of the Editor interface. 

Select Binary link values to display data as check marks. 

Select Numeric link values to display data as numbers. 

2.10 ADD/REMOVE LINKS IN THE EDITOR TAB [BINARY] 

Click the [ Options… ] button in the lower right of the Editor. 

Highlight a Network in the Meta-Network panel 
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Select the Editor Tab. 

In the grid find the intersection of the column node and row node. 

To create a link place a check mark in the cell. This can be done by clicking the 

box of pressing the spacebar while the cell is active. 

To remove a link deselect a cell by removing the check mark. 

2.11 ADD/REMOVE LINKS IN THE EDITOR TAB [NUMERICAL] 

Highlight a Network 

Select the Editor Tab. 

In the grid find the intersection of the column node and row node. 

To create a link place a non-zero number in the cell. 

To remove a link place a [ 0 ] in the cell. 

2.12 SAVE A META-NETWORK 

It is important to save your work from time to time. If something happens to your 

computer or ORA then all work done since your last save will be lost. You have two 
options. 

File > Save Meta-Network : Saves your work to the file that was originally open. 

File > Save Meta-Network As…... : Saves your work to a new file. Give the file a 

new file name when ORA asks. This can be useful if you are experimenting with 
different ideas and do not want to affect your original data. 

2.13 PREFERENCES 

Every user will have their own way they want ORA to perform. The preferences 

allow for tweaking those functions. There are many parameters that can be set but 
the important ones to a new user are listed for the individual tabs. 

General : Preferences for the look and feel of ORA such as whether tooltips are 
shown when hovering over items and the size of the toolbar icons. 

Data Sets : As a new user concentrate on the three radio buttons near the bottom. 

These allow you to specify what files you want to load whenever you restart ORA. 
To start make sure it is set to Restore previously loaded workspace files at 

startup. This can be changed as you learn more about the workings of ORA. 
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NOTE : Reports and Custom Reports are for advanced users. 

 

QuickStart Visualizer 

3.0 VISUALIZER 

3.1 VISUALIZER GUI: 

Contains the visual representation of your Meta-Network. 

 

The ORA Visualizer Interface 

1) Menu :Source for performing the majority of tasks. 
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2) Toolbars : Main functions for working with displayed Meta-Network. 

3) Zoom/Hyperbolic selector : Select the radio button for the either the sizing or 
fish-eye view 

4) Zoom/Hyperbolic controller : Controls degree of function. 

5) Toolbar Button Adder –:Allows you to add menu functions to the toolbar. 

3.2 DISPLAYING META-NETWORK IN EDITOR: 

Meta-Networks can be visualized in many ways. 

Highlight a Meta-Network. Note we are back in the main ORA interface, not the 
Visualizer. 

Click the Visualizer button. 

Or from the Editor Menu select Visualizations > View Networks > 2D 

Visualization. 

NOTE : The Visualizations menu also contains other display functions for your 
Meta-Networks. Many of which are advanced functions. 

3.3 ADD/REMOVE NODES WITH THE VISUALIZER MENUS: 

Actions > Add Node(s) : Allows you to add nodes to existing or new NodeClasses. 

Tools > Node Status : Displays all the information about the selected node. 

Tools > Node Locator : Selecting a node from the dialog box will reveal the 
location of the node in Visualizer. 

Display > Node Shaper : Use this tool to change the size and shape of the 
selected node. 

3.4 ADD NODE IN VISUALIZER WITH NODE CREATOR 

 The Node Creator button is in the left toolbar. NOTE : [2] on The ORA 

Visualizer interface. 

In the drop down menu select a NodeClass. 

Place a check mark in the box. ORA will ask for a name for each new node 

Click in the Visualizer to create a new node. 
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3.5 ADD LINKS IN VISUALIZER WITH LINK CREATOR 

 The Link Creator button in the left toolbar. NOTE : [2] on The ORA Visualizer 

interface. 

Select the Network from the dropdown menu to add a link. 

Select the weight for new links created. 

Click and hold on the source node. 

Drag the mouse to the target node 

Release the mouse to create a new link. 

3.6 REMOVE NODES OR LINKS IN VISUALZER WITH LINK ERASER 

 Click Node/Link Eraser is in the left toolbar. NOTE : [2] on The ORA 

Visualizer interface. 

Removes node(s) and link(s) from the Visualizer display. Click on a node or a link 
to remove it from the display and Meta-Network. 

If the Permanently Delete check box is empty ORA will remove the node(s) ro 

link(s) from the display only. The node(s) or links(s) will be retained in the Meta-
Network. 

If the Permanently Delete check box contains a check mark the node(s) or 
links(s) will be permanently deleted from the Meta-Network as well. 

3.7 SHOW/HIDE VISUALIZER LABELS, LINKS, & ARROWS: 

In the display various items can be shown or hidden. NOTE : [2] on The ORA 
Visualizer interface. 

 Toggles the display to show/hide the node titles. 

 Toggles the display to show/hide the links. 

 Toggles the display to show/hide the node arrows. 

3.8 CHANGE NODECLASS COLOR: 

You can change the color of an entire NodeClass in the Visualizer. 
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If the Legend is not visible, open it by selecting Tools > Legend. 

Click on the color node for a NodelClass. 

In the color selector dialog box select a new color. 

Click [ OK ]. 

3.9 DATA REDUCTION STRATEGIES 

At times the Visualizer display can be difficult to read. There are multiple ways to 

reduce unneeded information temporarily from the display. 

3.9.1 HIDE ISOLATES 

You can remove Isolates from the display without permanently removing them from 
the Meta-Network. 

From the Visualizer menu select Actions > Isolates > Hide Isolate Nodes. 

3.9.2 REMOVE ISOLATES 

You can permantly remove Isolates from a Meta-Network in two ways: 

From the Visualizer menu select Actions > Delete Isolates > Delete Currently 
Visible Isolates. This will remove from the Meta-Network only those nodes that 
are visible. 

From the Visualizer menu select Actions > Delete Isolates > Delete Underlying 

Isolates. This will remove all Isolates from the Meta-Network. 

3.9.3 HIDE PENDANTS 

You can remove Pendants from the display without permanently removing them 
from the Meta-Network. 

From the Visualizer menu select Actions > Hide Pendant Nodes. 

3.10 ADD ICONS OR PICTURES 

Nodes can be replaced by icons or pictures [50 x 50 pixel max] for easier 
identification. 

Icons 

Right-Click a node and select Appearance Submenu > Set Picture. 
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From the drop down menu select a category then click and highlight your icon. 

Click [ OK ] when finished, The node will then display the icon 

3.11 CHANGE SIZE/COLOR NODES BY METRIC 

Display > Node Appearance > Size Node by Attribute or Measure. 

This will scale the size of all nodes by using the attribute or measure selected. 

Numbers for each node value are user adjustable. 

Display > Node Appearance > Node Color > Color Node by Attribute or 

Measure 

This will color all nodes by using the attribute or measure selected. 

Colors for each node value is adjustable. 

To reset color and size select Display > Node Appearance > Reset Color and 
Size. 

 

QuickStart Reports 

4.0 REPORTS 

Reports give you information about your Meta-Networks. These are the four most 
important reports. The other reports are more specialized. 

Key Entity : Identifies key entities and groups who, by virtue of their position in 

the network, are critical to its operation. 

Networks : agent x agent, agent x knowledge, agent x resource, agent x task, 
agent x event, agent x location, all knowledge networks, any resource networks, 

task x event, task x task. 

Standard Social Network Analysis : Calculates the standard network analysis 
measures. 

Networks : Any square Network [i.e. agent x agent]. 

Sphere of Influence : For each individual, identifies the set of actors, groups, 

knowledge, resources, etc. that influence, and are influenced, by that actor. 



 

54 
 

Networks : agent x agent, agent x knowledge, agent x resource, agent x task, 
agent x location. 

Locate Sub-Groups : Identifies the subgroups present in the network using 

various grouping algorithms. Most algorithms only work on a single network at a 
time. 

Networks : Networks selected by the user. 

These reports are run from the Editor menu. 

From the menu select Analysis > Generate Report > [ type in name of 
specific report]. 

In the searchbox at top type in the name of the report. 

You can type in the entire name or select the report from the drop down menu. 

Place a check mark next to the Meta-Networks to process and click [ Next > ]. 

Place a check mark next to the NodeClasses and Networks to process. Click the box 

to remove unwanted check marks. 

Select the number of nodes to display and click [ Next > ]. 

Select the location to save the files and the filename for the report and click [ 
Finish ]. 

The reports will open in the Report tab of the editor in a text format. They will also 

open your browser and display with animated graphics. 

4.1 FOCUS ON ACTOR 

One item you need to discover is who is important in a Meta-Network. To obtain 
this information you can run the Key Entity report. Go to Analysis > Generate 

Reports > Locate Key Entities > Key Entity. 
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The report will ask you for the number of nodes to display and if you want to use a 
particular attribute in the calculation. But the most important selection is the Who, 

How, What, and Where. When focusing on actors place a check mark in the Who 
only. By default the report lists the top 10. This can be changed when running the 

report. 

To find out how a particular person is connected run the Analysis > Generate 
Reports > Locate Key Entities > Sphere of Influence report. 
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Begin with placing a check mark next to one or more a Meta-Networks from the list. 

Then click [ Next > ]. 

In the second window place a check mark next to the NodeClass(es) to analyze. 
In this case choose Agent. 

All networks which contain any of the NodeClasses selected appear in the bottom 

pane. Having only choosen Agent only the Agent x Agent Network appears. Place 
a check mark next to Agent x Agent. Then click [ Next > ]. 



 

57 
 

 

Next place a check mark next to the agent(s) to track. Then click [ Next > ]. 

Finally place a check mark next to all the nodes to visualize. Then click [ Next > ]. 
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The final screen allows you to choose where to sent the results. The two most 
common choices are: Text will display it in the Report Tab in ORA. HTML will 

open a file in your browser. The browser version is usually best for presentations as 
it contains more visual elements. 

4.2 FOCUS ON REGION 

In addition to finding out who the important agents are in a Meta-Network the Key 

Entity report can also show you the important locations. 

As with Focus on Actor above the check mark should be placed in the Where box 
only. 

Once the key locations are discovered agents connected to that location can be 

analyzed. In time marked data it will also show When those agents were in those 
locations. 

4.3 FOCUS ON TIME 

In the Editor the Measures Over Time allows you to see how a network measures 

changes over multiple time periods. 

This requires your data to have time data. Highlight a Meta-Network and in the 
Editor pane to Date:. If the area is blank your Meta-Network does not have time 

data and the function will not run. You can click the [ Click to create… ] button to 
assign a data to each time slice. 

Below is an example of the type of display viewing two meaures over nine time 
periods. 
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Any Networks included in a Meta-Network can be displayed in the fashion. 

In the Visualizer the View Networks Over Time allow you to see how Networks 
change over the specified time periods. 

Each Meta-Network included should contain nodes and networks named the same. 
This is necessary in order for ORA to assess how individual items have changed for 
each time period. If a node has a slightly different name then ORA will assume they 

are not the same node. 

The animated sequence will display the selected networks for each Meta-Network. 

This display is the normal Visualizer display. 

Refer to the User’s Guide for more information. 

 

QuickStart Other 

5.0 MEASURES 

A measure is a function that takes as input a Meta-Network and outputs a single 

value or a vector of values. For more information on the measures see the User’s 
Guide. 

6.0 GEOSPATIAL, LOOM & TRAILS 

These are advanced topics and you should refer to the ORA Users Guide for more 
information 

 

QuickStart Information 

7.0 ORA INFORMATION 

7.1 CONTACT INFORMATION 

Carnegie Mellon University 
School of Computer Science 

Institute for Software Research (ISR) 
Center for Computational Analysis of Social and Organizational Systems (CASOS) 
5000 Forbes Avenue 
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4212 Wean Hall 
Pittsburgh, PA, 15213 

7.2 QUESTIONS, BUGS, AND COMMENTS  

Please contact :Dr. Kathleen M. Carley (kathleen.carley@cmu.edu) 

7.3 COPYRIGHT NOTIFICATION  

COPYRIGHT (c) 2001-2011 Kathleen M. Carley  
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General Content 

These are pages for information on ORA which is general in nature and does not 

pertain to any particular ORA section. 

1, 2, or n Mode Data 

Actions vs Tasks vs Event 

Beliefs 

Change Format 

Delimited Files 

Dynamic Network 

Large Meta-Networks 

Monte Carlo 

Multiple Links in Imported Data 

Ontology 

Parts of Speech 
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Reduced Form Network 

Regression 

Simulated Annealing 

Synchronization 

 

Multi-Mode Data 

Ora can handle 1,2 or n mode data. A mode is a class of nodes. Iypical social 

network analysis handles one mode data (e.g. a people to people network). In this 
case, the metrics identify which node in the network are critical. The grouping 
algorithms cluster the nodes, (e.g., the people, into groups). Sometimes you have 

two mode data such as people by events, (e.g. the classic Southern Women Study 
[1]). In this case, you can ask questions like who was at the most events or what 

events were attended by most people to create two different one mode networks 
people to people and events to events. With these one mode networks you can 
again calculate all the standard metrics. 

In ORA, however, there are additional special metrics such as redundancy, that can 

be calculated on two mode data. 

With N mode data, you can do all the above, and in ORA there are additional special 
metrics such as cognitive demand that calculate a nodes position based on multiple 

matrices. 

In ORA, the types of nodes can be cross indexed as being related to agents, 
organizations, locations, tasks, events, resources, knowledge, beliefs, roles. If you 

do this there are some additional metrics that rely on knowing what type of nodes 
you have that you can take advantage of (e.g., with locations you can run the 
locations reports). 

In general, all metrics that run on agents also run on organizations and roles. For 

tasks and events - there are other special temporal metrics. All metrics that run on 
resources also run on knowledge and beliefs. The standard social network measures 

run on any square one mode network - however in ORA - some guidance is 
provided on how to interpret this based on the type of nodes. 

 

References 

[1] Davis, A et al. (1941). Deep South. Chicago: University of Chicago Press. 
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[1] Breiger R. (1974). The duality of persons and groups. Social Forces, 53, 181-
190. 

 

Actions, Tasks, and Event 

There are three nodeclasses in ORA where you can depict what a particular node 
might be doing. They might seem a little confusing at first. Below are basic 
explanations of the three. But depending on your situation you may find it 

necessary to alter the definitions to suit your needs. 

Action : Small activities, e.g. the employee makes coffee. 

Task : Designed activities, e.g. it is part of the job description of the employee to 
make coffee. 

Event : One time happening, e.g. the employer made coffee on December 12th, 

2011. 

These definitions are not set in stone but they can be used as a good starting point 
for your Meta-Network. 

 

Beliefs 

Belief Diffusion is the change in beliefs of actors in a social group over time. 
Beliefs cannot be evaluated for truth. Knowledge can contribute to or deny a belief. 

Example 1 

Belief : Cats are better house-pets for a family than dogs. 

Supporting Evidence : Cats tend to live longer than most breeds of dog. 

Contrary Evidence : Most cats must have explicit socialization training early if 
they are going to be as affectionate as most breeds of dogs. 

Example 2 

Fact 1 : Cats damage furniture. 

Fact 2 : Cats are passive aggressive. 

Fact 3 : Cats leave trophies. 
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         => I don't want a cat! 

 

Change Format 

Description 

The Change Format is used when you want to: 

Merge nodes : Take the information from two separate nodes and combine it 
into one node. 

Move nodes : move a node from one entity class to another 

Delete nodes : Remove a node entirely from the entity class. 

The Columns 

frequency : Number of occurrances of a concept. 

current_concept : Contains the text as it appears in the original file/node. 

new_concept : Contains the text to want to use as a replacement for the text 
in the ConceptFrom column. 

current_metaOntology : Blank when the file is created. Filled in by the user 

with terminology of their choosing. 

new_metaOntology : Contains the class of the node [ Agent, Location, 
Resource, etc. ]. To denote when a concept is to be deleted place the [ # ] in 

this column. 

current_metaType : Blank when the file is created. 

new_metaType : Used to denote whether the concept is specific item [  i.e. 
President Obama ] or a generic item [  i.e. American ]. 

Where To Use This File 

This file is used in the Data Management > Meta-Network Clean... function. 

New Change List Support 

Integration of ORA and Automap formats are improved by use of the Change 

Format. Deleting, Merging, and Moving nodes is greatly simplified. ORA and 
Automap both use this format. 
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How is it used? 

When nodes are deleted, merged, and moved within the Node Editor in ORA, these 
operations are recorded internally in a Change List that can then be exported. Also, 

existing change lists can be loaded and applied to the node class within the editor. 

There is one change list per meta-ontology. For example, editing the Agent : 
Friends node class will modify the change list for the meta-ontology Agent. If you 

move to another meta-network and edit its Agent : Enemy node class, then it will 
also modify the Agent change list. You need to manually clear the change list, as 

otherwise the changes are just accumulated. 

Here is the support in the GUI:  

1. Navigate to one of the Afghanistan meta-networks and edit the Agent node 
class, and click on the Clean drop arrow: 

 

These are the different options: 

Deduplication : Opens a dialog that has existed for a while and that lets one 

find nodes that are duplicates based on the similarity of their IDs or Titles. The 
nodes can then be easily merged. 

Apply change list : Prompts for a change list file and applies it to the node 

class. 
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View changes : View the record of the node Merge, Move, Delete operations 
performed to the current meta-ontology. From within this dialog, one can clear 

the list. 

Save changes : Exports the current changes to the Change List format, and 
this can then be used in Automap or applied later in ORA. 

NOTE : The Delete, Merge, and Move buttons have been made simple buttons. 

These otherwise have not been changed. 

You can think of the Change List as simply a log of the operations performed on the 
node class during the ORA session. 

 

Delimited Files 

Excel when reading in a flat file (i.e. txt or .csv) is sensitive to the kind of delimiter 

used. In the American version of excel, it assumes that a comma or tab is used to 
separate columns. In other versions, it often assumes that a semicolon or tab is 
used to separate columns. This is because in many other languages the comma is 

used as a period in showing the price of items. 

AutoMap and ORA export data as comma separated and can import comma 
separated. This means if you are reading into or reading from a non-American 

version of excel you may have problems. 

Reading in the.csv file into Excel that uses something other than commas will cause 
the data to appear as a set of text in column A. There are two ways to fix this. 

First read the file into a text editor and globally change all the delimiting characters 

to commas. 

Second read the file into excel and use the Text to Columns function and use a 
different delimiter. 

Excel Example 

Let's start with a simple three line file using semicolons as delimiters. 

NOTE : Remember, data can be separated with a variety of characters. This 

procedure allows you to import data with any of them. 

100;apple;red 
101;lime;green 
102;lemon;yellow 
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Opening this file in Excel will place each line of text into a single cell. You need to 
separate this into individual columns. 

 

Select the cells you want to convert then click the Data tab. Click the Text to 

Columns function. 

 

This brings up the Convert Text to Columns Wizard. Make sure the Delimited 
radio button is selected. Then click [ Next > ]. 
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Under the Delimiters header make sure the Semicolon box contains a check 

mark. In the Data previewarea it will show you what your data will look like after 
the conversion. Click [ Next > ]. 
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Lastly you can do some final tweaks to how your data will be converted if you want 

such as your data format or a different destination. In this example we want the 
data to be inserted back into the original starting cell. Click [ Finish > ]. 
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Each piece of data now resides in a separate cell. 

 

The new file can now be imported into ORA through the Data Import Wizard. 
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What Is A Dynamic Network 

Networks are ways of connecting the who, what, where, why, how and when. Each 
type of who, what, where, why, how and when is called an entity class. The items 

within them are called nodes or entities. The set of networks for three or more of 
these entity classes is called the meta-network. The entire field of Dynamic Network 
Analysis is based on the concept of the MetaNetwork. 

Node 

A Node can literally be anything you can think of; on an abstract level, an Entity 
may be merely a dot in a visual network model. It is what we are networking and 
connecting our ties to and thus looking at in detail visually. 

NodeClass 

A NodeClass is a group of similar nodes [i.e. people, places, knowledge] 

Network 

A Network shows how the nodes connect to each other. 

Meta-Network 

A Meta-Network incorporates different NodeClasses and allow you to perform an 
analysis on the model that way. Such a model is called a MetaNetwork. 

A Meta-Network is network composed of multiple networks. A MetaNetwork is the 

sum of all networks we are considering. The Meta-Network is the foundation for 
Dynamic Network Analysis; 

Dynamic Networks 
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 S1 : 2 agents share 1 location 

 S2 : They move apart to separate 
locations 

 S3 : A 3rd connected agent is 
detected at its own location 

 S4 : 2 of the agents meet 

 S5 : The 3rd joins at same locale 

 S6 : One agent disappears 

 

The Operational Statistics indicate the number of additions, modifications, and 

removals to the Network. 

Manipulating Keyframes/Deltas 

You can Convert Keyframes to Deltas, Deltas to Keyframes, or Aggregate by 
Day/Week/Month/Year. 

Over-Time Visualizations 
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Visual Comparisons, Animating over time, and Plotting changing centrality. 

 

Deltas and Keyframes 

`  

The difference between Deltas and KeyFrames 

The Keyframe acts as a starting point, or a snapshot of what the meta-network 

looks like at any given time. It doesn't care what came before or will occur after. 

The Delta is a set of instructions on how to change the meta-network. It reviews 
what came before it, applies a set of changes, and displays the revised meta-

network. 

Initial State : Nothing    Initial State : Nothing  

KeyFrame : 3 nodes, 3 
links  

 

Delta : +3 nodes, +3 
links  

KeyFrame : 6 nodes, 9 
links  

 

Delta : +3 nodes, +6 
links  

KeyFrame : 6 nodes, 6 
links  

 

Delta : -3 links  
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KeyFrame : 8 nodes, 12 
links  

 

Delta : +2 nodes, +6 
links  

The biggest advantage of Deltas is it requires less information than KeyFrames. 
KeyFrames are a screenshot of every node and like in every time slice. Deltas, on 
the other hand, require only the information about individual changes. 

NOTE : Change in the first KeyFrame do not affect proceeding KeyFrames. But with 

Deltas changes in the initial KeyFrame are taken into account by each Delta. 

Importing Deltakey Frame Data 

The easiest way to create a dynamic meta-network is to first create a number of 
regular meta-networks. Next, import all these neta-networks into ORA. Select all 

the meta-networks in the meta-network pane you want to merge and right-click. 
From the contextual menu select Create a Dynamic Meta-Network. This brings 
up a Dynamic Meta-Network importer dialog with all your selected meta-networks. 

Next you need to select which meta-networks you want to act as keyframes. This 
can be as few as the first meta-network or as many as all. Then click the [Import] 
button. You have now created a Dynamic Meta-Network. 

Delta KeyFrame and Loom 

The question arise as to whether you need a Delta KeyFrame to run this in Loom. 

No, a Delta KeyFrame Meta-Newwork in not a necessity for Loom as long as the 
locations/nodeclass/node id's match in every Meta-Network. 

How can you show only some time periods or some locations 

In Loom, only the locations that have entities currently moving through them are 

displayed. Locations with entities moving through them cannot be hidden. 

Similarly, there's no way to currently turn off individual time periods. The work-
around would be to just not include that time-periods meta-network whenever you 

load up loom. 

 

Create Dynamic Network 
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A Dynamic Meta-Network is made up of multiple Meta-Networks. 

28 Raiders of the Lost Ark Meta-Networks 

 

I split up The Raiders of the Lost Ark into 28 
parts and created a Meta-Network for each. 
These contain nodeclasses for agent, locations, 

resources, knowledge, and tasks. The nodes 
names contained in each Meta-Network are 
identical but only appear in Meta-Networks 

where they have active links. 
 

Example : Belloq, the evil archaeologist, 
appears in Raiders, peru but is absent until 

eight Meta-Networks later in Raiders, cario-
bar. 
 

To create a Dynamic Meta-Network highlight all 
the Meta-Networks you want to include. Right-

Click on any of them and select Create 
Dynamic Meta-Network. 
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In the Dynamic 
Meta-Network 
Importer it lists 
each Meta-

Network, the date, 
and whether you 

want it to be a 
Meta-Network 
[check mark] or a 

Delta [no check 
mark]. 

 
An important item 

about the date is 
there can not be 
any duplicate 

dates. Also the 
Dynamic Meta-

Network will look 
at each in 
chronological 

order. 
 

The far right 
column is used if 
you find the need 

to remove a Meta-
Network before 

you move on to 
the creation 
process. Click the 

[ X ] to delete a 
Meta-Network 

before importing. 
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When finished you will see an new Meta-
Network in the Manager pane. This icon has 
the clock overlay signifying it is a Dynamic 

Meta-Network. 
 

The Keyframe Meta-Networks carry the 
standard Meta-Network icon [the items check 

marked in the Importer window]. In the main 
editor page the statistics will be displayed: 
SOurce count, Node class count, Node count, 

Link count, Network count, and Total density. 
 

The Deltas carry the green and orange circle 
icons. In the main editor page the Operation 
Statistics will be displayed This consists of 

additions, modifications, and deletions of 
NodeClasses, Nodes, Links, and Networks. 

The Info Tab 

When you highlight Meta-Network or Delta you will see different information in the 
Info Tab. A Meta-Network will display the exact count of nodes, links, and other 

network information. 
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The Delta, on the other hand, will display only the changes that occurred between 
itself and the previous Meta-Network/Delta. Displayed are the number of items 
Added, Modified, and removed. 

 

 

Large Meta-Networks 

Description 
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There's always a question as to the maximum size for a Meta-Network in ORA. That 
depends on a number of items. 

First it depends on your machine. Extremely large networks [ networks containing 

10^6 nodes ] have been run successfully on 64-bit multi-core machines. 

It is also about the amount of memory in the machine. The more you have the 
better it is. It helps make very big networks are doable. 

Also, if it is taking forever even when running Standard Network Analysis, you may 

want to go to Analysis > Measures Manager... and opt out some of the slow 
metrics, such as information centrality, if you are not particularly interested in 

those. 

 

Monte Carlo Network Optimization 

Description 

Monte Carlo methods (or Monte Carlo experiments) are a class of computational 
algorithms that rely on repeated random sampling to compute their results. Monte 
Carlo methods are often used in computer simulations of physical and mathematical 

systems. These methods are most suited to calculation by a computer and tend to 
be used when it is infeasible to compute an exact result with a deterministic 

algorithm. This method is also used to complement the theoretical derivations. 

In general, Monte Carlo methods are used in mathematics to solve various 
problems by generating suitable random numbers and observing that fraction of the 

numbers which obeys some property or properties. The method is useful for 
obtaining numerical solutions to problems which are too complicated to solve 
analytically. The most common application of the Monte Carlo method is Monte 

Carlo integration. 

 

Multiple Links in Imported Data 

The Problem 

There has been a question of what to do when there is the possibility of multiple 
links between the same nodes in a file to be imported using the Data-Import 

Wizard > txt Data > Simple Table > Networks, Nodes and Node Attributes. 



 

79 
 

Normally the weight of the links in the final network which contains multiple links 
will be summed. [&nbsap;node1 > node2 is 0.4 and node1 > node2, 0.5 ]. The 

expected result would be 4.5 but is in fact summed and becomes 0.9. 

The Solution 

If you don't know in advance which nodes have multiple links you need to use the 
Data Import Wizard to create one Network per link type. 

 

Ontology 

What Is Ontology? 

Ontology has to do with making clear and explicit statement about entities in a 

paricular domain. What kinds of things can exist in this world we're trying to 
explain. What types of relationships do they have with each other. It is concerned 

with what is that with what is possible. 

Categorization or Classification : Organizing a set of entities into groups based 
on their essences and possible relations. This assumes that for any new items 
added to the group a place will already exist. 

Below is the Best Classification chart and I'm sure you recognize it. 

 

The Periodic Table has the most value, both descriptive and predictive, of any 

classification chart. The pink column on the right contains the noble gases. It is an 
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odd category, because helium is no more a gas than mercury is a liquid. Helium is 
just a gas at most temperatures. 

Even in a nearly perfect categorization scheme, there are these kinds of context 

errors, where people are placing something that is merely true at room 
temperature, and is absolutely unrelated to essence, right in the center of the 

categorization. And the category 'Noble Gas' has stayed there from the day they 
added it, because we've all just gotten used to that anomaly as a frozen accident. 

If it's impossible to create a completely coherent categorization, even when you're 

doing something as physically related to essence as chemistry, imagine the 
problems faced by anyone who's dealing with a domain where essence is even less 
obvious. 

What Makes For A Good List? 

Here are the ideal situations you would like to cleanly classify your domain. 

Small corpus 
Formal categories 
Stable entities 

Restricted entities 
Clear edges 

What Makes For Good Participants? 

The other important issue is in regards to who is doing the classifying. Here are a 

few things that help to job go smoother. 

Expert catalogers 
Authoritative source of judgment 

Coordinated users 
Expert users 

 

Parts of Speech 

Parts of Speech assigns a single best Part of Speech, such as noun, verb, or 
preposition, to every word in a text. While many words can be unambiguously 

associated with one tag, (e.g. computer with noun), other words match multiple 
tags, depending on the context that they appear in. 

CC 
Coordinating 

conjunction 
PRP$ Possessive pronoun 
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aCD Cardinal number RB Adverb 

DT Determiner RBR Adverb, comparative 

EX Existential there RBS Adverb, superlative 

FW Foreign word RP Particle 

IN 
Preposition or 

subordinating 
conjunction 

SYM Symbol 

JJ Adjective TO to 

JJR Adjective, comparative UH Interjection 

JJS Adjective, superlative VB Verb, base form 

LS List item marker VBD Verb, past tense 

MD Modal VBG 
Verb, gerund or 
present participle 

NN Noun, singular or mass VBN Verb, past participle 

NNS Noun, plural VBP 
Verb, non-3rd person 

singular present 

NNP Proper noun, singular VBZ 
Verb, 3rd person 

singular present 

NNPS Proper noun, plural WDT Wh-determiner 

PDT Predeterminer WP Wh-pronoun 

POS Possessive ending WP$ 
Possessive wh-

pronoun 

PRP Personal pronoun WRB Wh-adverb 

 

 

Reduced Form Network 

This is what Reduced Form does and does not do: 

1. Uni-modal networks are not changed (e.g. an AA does is NOT 

symmetrized), but bi-modal networks are symmetrized in that the links 
from two or more networks are combined using the maximum method. 

2. Bi-modal networks are combined: For example, if there is an AK and a KA 
network, then the KA is transposed to AK2 and then AK and AK2 are unioned 
with the Maximum link weight from each (a,k) or (k,a) being used. 
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3. Network names are normalized to have IDs agent x agent, agent x 
knowledge, etc. 

 

Regression Technique 

Regression analysis is also used to understand which among the independent 
variables are related to the dependent variable, and to explore the forms of these 

relationships. In restricted circumstances, regression analysis can be used to infer 
causal relationships between the independent and dependent variables.[ 1 ] The 
dependent and independent variables can be either network measure or numerical 

attributes of nodes. 

To test the shape of the distribution or normality of the variables use ... 

Procedure 

From the main menu select Analysis > Generate Reports... > Statistical 
Procedures and Diagnostics > QAP/MRQAP Analysis. Place a check mark next 

to the Meta-Network(s) to analyze. Click [ Next > ]. 
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In the top section select the node classes to analyze. In the bottom section select 
the Networks to analyze. Place a check mark in the box next to Create a Meta-

Network from select nodes and networks to create a new Meta-Network. Click 
[ Next > ]. 

 

Under Dependent network: select the Meta-Network and Network to use. 

Under Independent network(s): select the networks to keep independent. 

Under Select the algorithms to run: select what to use for analysis. 

Under Set the algorithm parameters: set the set and permutations. 
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QAP/MRQAP ANALYSIS REPORT 

Input data: Raiders, Tanis - all 

Start time: Mon Dec 12 13:59:48 2011 

Data Description 

Parameters 

The random seed is 0 

The number of permutations is 100 

The dependent network is characters x characters-12 from the meta-network 
Raiders, Tanis - all 
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The independent network(s) used from each meta-network:  

characters x characters-12 

characters x characters-14 

characters x characters-15 

characters x characters-16 

The total number of independent networks is 3 

Correlation Results 

Network Correlation Significance 
Hamming 
Distance 

Euclidean 
Distance 

Raiders, Tanis - all : 
characters x characters-

14 
0.69 0.01 4 2.00 

Raiders, Tanis - all : 
characters x characters-

15 
0.30 0.21 8 2.83 

Raiders, Tanis - all : 
characters x characters-

16 
0.39 0.04 16 4.00 

Regression Results 

R-Squared: 0.470588 

Variable Coef Std.Coef 
Sig.Y-

Perm 
Sig.Dekker 

Constant 0.00 
 

0.04 
 

Raiders, Tanis - all : characters x 
characters-14 

0.50 0.69 0.00 0.00 

Raiders, Tanis - all : characters x 

characters-15 
0.00 0.00 0.24 0.45 

Raiders, Tanis - all : characters x 
characters-16 

0.00 0.00 0.40 0.39 
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Hanneman & Riddle (2005) argue that predicting and testing hypotheses about a 
node's non-relational attributes can be done using a mixture of relational 

(network) measures and non-network measures. This tool allows such tests. 
An example would be to use the entity class agents - such as specific people, 

and then regress their performance on a combination of node metrics e.g., 
degree centrality and non-relational attributes e.g. age and gender. This 
process computes basic linear multiple regression statistics by ordinary least 

squares (OLS), and estimate standard errors and significance using the 
random permutations method for constructing sampling distributions of R-

squared and slope coefficients. 

[ 1 ] Wikipedia  

 

Simulated Annealing 

Decription 

Simulated annealing is an optimization heuristic (an algorirthm designed to solve a 
really difficult problem for which the best answers are computationally difficult to 

assess). This provides very good answers, but not always the best. You may have 
heard of other such algorithms, like the genetic algorithm (GA) or hill-climbing or A-
star. 

The method was independently described by Scott Kirkpatrick, C. Daniel Gelatt and 

Mario P. Vecchi in 1983,[ 1 ] and by Vlado Cerný in 1985.[ 2 ] The method is an 
adaptation of the Metropolis-Hastings algorithm, a Monte Carlo method to generate 

sample states of a thermodynamic system, invented by M.N. Rosenbluth in a paper 
by N. Metropolis et al. in 1953.[ 3 ] 

Source 

The name and inspiration come from annealing in metallurgy, a technique involving 

heating and controlled cooling of a material to increase the size of its crystals and 
reduce their defects. The heat causes the atoms to become unstuck from their 
initial positions (a local minimum of the internal energy) and wander randomly 

through states of higher energy; the slow cooling gives them more chances of 
finding configurations with lower internal energy than the initial one. 

 

[1] Kirkpatrick, S.; Gelatt, C. D.; Vecchi, M. P. (1983). "Optimization by Simulated 
Annealing". Science 220 (4598): 671-680. 
doi:10.1126/science.220.4598.671. JSTOR 1690046. PMID 17813860. 
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[2] Černý, V. (1985). "Thermodynamical approach to the traveling salesman 
problem: An efficient simulation algorithm". Journal of Optimization Theory 

and Applications 45: 41-51. doi:10.1007/BF00940812. 

[3] Metropolis, Nicholas; Rosenbluth, Arianna W.; Rosenbluth, Marshall N.; Teller, 
Augusta H.; Teller, Edward (1953). "Equation of State Calculations by Fast 

Computing Machines". The Journal of Chemical Physics 21 (6): 1087. 
doi:10.1063/1.1699114. 

 

Synchronization 

NOTE : This feature available in version 1.9.5.4.5. and above 

In ORA you can now work in synchronization between ORA's Main Interface and 
ORA's Visualizer.  If you position a network visualization window in a manner where 

you can see the ORA main interface and or any of its visualization windows (e.g., 
Legend), you can then make changes directly into the Main Interface (e.g, such as 

changing links in the Editor) and that change will be immediately affect the 
visualization without any further action from the user. 

 

ORA's Main Interface 

The ORA interface is organized into five sections. The menu, the main icons, and 
three re-sizable panes which are dockable. On each tab are two buttons: undock 

and close. In the upper right corner of each pane are three buttons: undock, 
maximize, and close. This will allow you to arrange the interface to suit your 

needs. 
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1 - The Menu 

The main source for accomplishing your tasks within the editor. It contains all the 

functions for managing the Meta-Networks, generating reports and doing analysis. 

2 - The Icons 

Contains the main functions for adding or deleting Meta-Networks, NodeClasses, 
and Networks and importing existing Meta-Networks. Clicking the down-facing 

triangle brings up a window which allows you to add buttons to the GUI for the 
functions you use the most. 

3 - Meta-Network Manager Pane 

This pane contains a tree directory of the current Meta-Network(s) loaded into ORA. 

This contains the Meta-Networks currently active plus all their Meta-Nodes and 
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Networks. Clicking on the plus icon will expand the Meta-Network showing all the 
Meta-Nodes and Networks and clicking on the minus icon condenses the Meta-

Network. Hovering the pointer over a graph it will display information about that 
Network. 

 

 

4 - Editor Pane 

Contains the basic information about the highlighted Meta-Network such as how 
many nodes are represented. This panel also allows quick access to ORA's 

Visualizer, Reports and Chart tools. By selecting the Visualize button, the currently 
loaded Network will render in the ORA Visualizer, which will load in a separate 

window. 

With the Meta-Network selected panel 2 displays the information regarding the 
Meta-Network itself. The Meta-Network name and pathway at the top. In the 
bottom, under statistics, are information regarding the actual Meta-Network 

including source, node, link, and network counts. 

When a Meta-Network is expanded it reveals nodeclasses and networks. 
Highlighting any of these will reveal information these items. 

The Info Tab : Display relevant information whether a nodeclass or network is 

highlighted. 

The Editor Tab : Displays the information in a matrix which can be edited in 
either binary or numeric mode. The data can be directly manipulated in the grid. 

Nodes, links, and attributes can be added, removed, or edited. 

With the Nodes and Attributes buttons you create, delete, or merge nodes and 
attributes. The Find box assists you in locating particular nodes and attributes. 

5 - Reports Pane 
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This pane is initially empty when ORA is first started up. As reports are run they will 
be contained within this panel. 

NOTE : All three panes can be resized to your preference. 

 

Main Interface Tasks 

There are a number of tasks that are performed from within the Main Interface to 
assist in controlling your Meta-Networks, NodeSets, and Networks. These are 
mostly functions not associated with any of the Menu Items. 

Attributes : Adding or Deleting an Attribute and the uses of Attributes. 

Attributes Buttons : Controls in the Editor for Attributes. 

Clean Button : Helps combine into a single node names with slight variances. 

Contextual Menus : Right-Clicking of several items brings up a contextual 

menu of additional functions for various items. 

Contextual Menus/Multi-Files : Selecting multiple Meta-Networks and Right-
Clicking. 

Contextual Menus/Network : Selecting Networks and Right-Clicking. 

Contextual Menus/Dynamic Meta-Networks : Selecting a Dynamic 
Meta0Netowkr and Right-Clicking. 

Creating New Meta-Networks : A brief overview of creating a Meta-Network. 

Create From Excel : Create a Meta-Network using Excel 

Dating Meta-Neworks : Attaching a date to your Meta-Network 

Document/URI Attributes : Using Links as Attributes. 

Duplicate Items : How to duplicate a Meta-Network, NodeClass, or Network. 

Editor Tab-Networks : Description of items and functions in the Editor Tab 

Editor Toolbar : Description of the Editor Toolbar functions.. 

Filters : Setting Filter parameters for searching nodesets. 
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Fold Network : How and Why to Fold a Network 

Hovering ToolTips : A brief overview of the information given in the tooltips. 

ID Names : Description of ID Names and why they are important. 

Info Tab-Nodeset : Editor Tabs for NodeSet. 

Info Tab-Networks : Editor Tabs for Networks. 

Info Tab-Networks-Statistics : Description of the statistics pane. 

Network Editor : Working with the Editor tab with a Network. 

Node Buttons : Description of the buttons in the Editor GUI to work with 
nodes. 

Search : Finding information within the Editor. 

Visualize Buttons : The difference between Visualize this Network and 
Visualize Only this Network button. 

 

Attributes 

Attributes are extra containers that can be attached to an Node. You can add a 
value to this container. To add an attribute to an Node right-click on the Node 
name. This will bring up the contextual menu below. 

Add Attribute 

 

Hightlight a Meta-Network the right-
click to bring up the menu. Then select 
Add Attribute... 
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Type in the name for your new 
attribute and select the Type form the 
drop down menu. Your choices are 

Text, Text Category, URI, Number 
Category, Number, or Date. 

Then click [OK]. Let's say we want to 

add other languages spoken by the 
nodes. 

 

The attribute you added will be 
inserted alphabetically in the editor. 

 

You can now assign any text to this 
attribute for any of the rows in the 
Network which can be used later to 

help define your Network.</td 

Edit Attribute 

Click the downward triangle to bring up the filter/edit functions. Click the Edit 
Attribute tab. From here you can edit the Attribute name and Attribute type. 

Delete Attribute 
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And attributes can be removed just as 
easily by pressing the Delete button. 

The dialog box will present you with a 
list of attributes. Any attribute with a 

check mark next to it will be deleted 
from Meta-Network. 

Import Attribute 

The [Import] button allows for the quick importing or an attribute(s) through the 

Editor panel. Use a .csv file with rows as nodes and columns as attributes. This can 
be done with, or without, an ID column. 
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1. Use the Textbox and Browse button to navigate to the csv file with the new 
attribute(s). 

2. Select the radio button to use either 1) an ID column, or 2) a file in the 
same order as NodeSet. 

3. This section contains all the attributes in the file. If one was chosen to 
identify the NodeSet then it will be greyed out. For attributes NOT greyed out 

you can chose to make then Categorical* or Continuous*. 

4. Select All / Clear All buttons places a checkmark in all columns or removes 

same. 

5. Placing a checkmark in the Create new nodes for unrecognized nodes 

creates new nodes into the select NodeSet if no node for an attribute 
currently exists. 

6. Import / Cancel tells ORA to begin the import or cancel the operation. 

Note: Whenever you set a Node Display Attribute for a Nodeset, the info is 

also set as an attribute of the nodeset.  In other words, Node Display 

Attributes are now encoded in the data, allowing it to be retained from 
session to session. 

 

Attribute Buttons 

Attribute Buttons 

Used within the Editor to manipulate the attributes of a NodeClass. 

 

Create : You will be asked for the name of the new attribute as well as the Type: 

Text, Text Category, URI, Number Category, Number, Date. 

Import : Import attributes from a file in the following format: columns contain 
values for a single attribute, and rows contain values for a single node. The first 
row must be attribute names. 
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Export :  

To a file : Click the [ Browse ] button and select a place to save the file. Place 
a check mark for the parameters Only export nodes missing an attribute 

value or Only export visible nodes. The attributes whcih have a check mark 
next to them will be exported to the file. 
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To a network : This allows you to create a new network. Select a property. 

Next you can either 1] select an exisint nodeclass; or 2] select a new nodeclass. 
Lastly give this network a new name. 
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Delete : Ora will list the attributes. Place a check mark next to the attributes you 

want to delete and remove the check mark from attributes you want to keep. 

Measures : Select the measure and input network to comput and the name of the 
new attribute to create. 

 

 

Clean Button 
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When large datasets are created people's names are after written differently 
through many different documents. For example you could see someone referred to 

as John in one documents, John Smith in another doucments, and John W. 
Smith in yet another document. All three of the these names refer to the same 

person but in ORA they would be considered different individuals. 

The [Clean] function is used to condense all the different referenes of one person 
into a single node. In the example below there are three instances for Colonel Jack 

O'Neill (Colonel Jack O'Neil, Jack O'Neil, and Jack), three instances for Major 
Samantha Carter (Major Samantha Cater, Samantha Carter, and Sam), Two 
instance for Doctor Daniel Jackson (Doctor Daniel Jackson and Daniel Jackson) and 

finally two instance for General George Hammond (General George Hammond and 
Hammond). 
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Visualizing this network makes it appear there are quite a few more people there 
actually are in the network (12 as opposed to 5). 

 

The Clean Button 

The clean button has multiple functions. Clicking the downward triangle will reveal 
the menu. 

Deduplication 

Find and merge nodes with similar IDs or Titles. Similarity is based on edit distance 

which is the number of characters that would need to be changed to convert one 
string to another. 
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From observing in the Editor 
there are three instances of the 
agent Jack : Colonel Jack 

O'Neill, Jack O'Neil, & Jack. 
With the distance set to 0 the 

only agent visible is Colonel 
Jack O'Neill 

 

Increasing the Min-Edit to 9 
makes visible a second agent, 
Jack O'Neil. The difference 

between the two agents in the 
spelling of the surname (one (l) 

as opposed to two (l)s) and the 
rank. Clicking the [ Merge ] 

button will combine these two 
together into a single node. 

Merge 

When merging nodes you will be asked how to handle the links. There are four 

options for combining the links of merged nodes. 

 Sum : Add the weights of all nodes. 

 Minimum : Examines the link weights and uses the smaller number found. 
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 Average : Examines the link weights and uses the average of all the link 
weights. 

 Maximum : Examines the link weights and uses the largest number found. 

 Binary : If any link is a non-zero then the link becomes a [1]. Else it uses 
[0]. 

Apply Change List 

Apply a previously created Change List to the selected Meta-Network. 

View Changes 

View the current Change List. Click the [ Clear ] button to clear all changes. 

 

NOTE : The Change File can be edited in either Excel or a text editing program. 

Save Changes 

Allows you to save any modifications that have been done to the current Change 
List. 

The Merge Button 

After running the deduplication and merging any duplicates possible the final stage 

is to use the merge to combine any that may not, for various reasons, be caught by 
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the deduplication process. Place a check mark in the tickybox next to each node to 
merge then click [ Merge ]. 

After The Clean And Merge 

When you are finished with the Clean & Merge your editor grid will reflect the 
changes. Plus you will see a new columns, alias. This will contain all the node 
Titles/IDs that were eliminated during the process. 

 

Final 

After going through the entire Meta-Network and merging all the same people into 

single nodes I have ended up with a total of five nodes instead of 12 nodes. 

 

 

Contextual Menus-Meta-Networks  

Right-clicking on any Meta-Network, NodeSet, or Network brings up a contextual 

menu with the functions available such as add or delete. And within each contextual 
menu are specialty functions for Meta-Networks, NodeSets, and Networks. 
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The first four are self-explanatory. 
Transform… opens up the Meta-
Network Transform… dialog box. 

 

The first two are self-explanatory. 
The Add Attribute … item opens 
up the attribute function in order 

to add attributes to a nodeset. 
 

Adding and Removing a Network 
are fairly self-explanatory. Below is 

a description of the other 
functions. 

 

 Set Diagonal… : Used on a square network to set cells 1,1 through x,x to 

the same value. In binary view the choice are 1: True (+1) 2: True (-1) 3: 
False (0). In Numeric view you can put any value into the diagonal. 

 Transpose : Rotates axis X 90 degrees clockwise and mirrors the image 
horizontally. 

1 2 
  <- becomes ->   

1 3 

3 4 2 4 

1 2 

  <- becomes ->   

1 3 5 

3 4 2 4 6 

5 6 empty 
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 Fold Network… : This function creates a new network using matrix algebra. 

Below are four variations of a four x four network and the results when each 

is folded. 

 

 Save Network… : (also called Exporting a Network) Any Network can 
be saved individually to a file in one of the following formats: CSV*, 

DL, DyNetML*, or UNCINET (.##h). Also check File Formats for more 
information 

 Binarize Network : Turns all non-zero numbers to [1] and leaving all [0] 
untouched. 

 Remove Links… : Removes links in accordance to the selection in the 
dropdown menu (as seen in the images below). 

 

 Symmetrize… :  

 

 Contextual Menus-Multi Files 

Includes: Union Meta-Networks, Intersect Meta-Networks, Conform Meta-Networks 
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There's also a separate contextual menu when you've got two or more Meta-
Networks selected. Open up multiple Meta-Networks in the Main Interface. Load 

two or more files into Panel 1. We'll demonstrate this on two Meta-Networks 
containing Bob, Carol Ted, & Alice. The agents are identical but the tasks in each 

are different, except for driving which appears in both and has slightly different 
values. Inbetween the time of cookingIn and eatingOut Alice's feelings for Ted have 
grown. 

CookingIn and 

 

EatingOut 
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Highlight both of them by holding down the [Control] while clicking on each file. 
Then Right-click on one of the files. This brings up the contextual menu. 

 

The Add New Meta-Network & Remove Selected Meta-Network are self-
explanatory. 

The Union Meta-Network will create a new Meta-Network using one of five 

actions: sum, binary, average, minimum, or maximum. 

 

 Sum : In any identical network all values from all networks are added 
together. (i.e. bob's score of 4.0 in both meta-networks are added together 

for a total of 8.0). 

 

 Binary : Then in the binary option it doesn't matter what numbers appeared 
in either meta-network as it uses only 1 or 0 as a result. If any cell has a 
non-zero it will contain a 1 as a result. 
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 Average : This option takes the sum of all identical cell values and 
divides them by the number of cells used. In cookingInted x alice 

contained a 2 while in eatingOut the value for ted x alice was a 1. This was 
averaged out to 1.5. 

 

 minimum : This function finds the smallest value in any identical cells and 

uses that in the final result. (i.e. for ted x carol and ted x alice both cells 
use the smaller value of "1" even though they are from different meta-
networks. 

 

 Maximum : This function finds the largest value in any identical cells and 

uses that in the final result. (i.e. for ted x carol and ted x alice both cells 
use the larger value of "2" and "3" respectively, each taken from a different 

meta-network. 

 

Intersect Meta-Network works similar to the Union function and has the same 
five options. But in creating the new Meta-Network only nodes that appear in all 
Meta-Networks are carried over to the new Meta-Network. 

For example: All four agents appear in both Meta-Networks and are brought over 

into the new Meta-Network. But though there were six tasks in the cookingIn and 
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three tasks in eatingOut there is only one task (driver) in the new Meta-Network 
created from the intersect function. Only nodes found in all Meta-Networks are 

brought over. 

 

And even though bob has a value for driver in cookingIn only carol has a value for 
driver in both Meta-Networks. 

 

Conform Meta-Network alters the selected Meta-Networks and makes them 

equal. union adds nodes that are found in one Meta-Network but not the other. 
intersect removes nodes that are not common to both. 

 

Contextual Menus-Networks  

Right-clicking on any network brings up the contextual menu 
with a set of functions for working with Networks. 

 

Hide selected 

Select one or more rows or columns. Then right-click to bring up the contextual 

menu. Selecting Hide Selected will remove the selected rows or columns from the 
display. 

NOTE : They are hidden for as long as you have the current network viewed. 

Clicking anywhere else in the Editor then returning back to the previous Network 
will reveal all rows or columns which were hidden. 

Sort 
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The order which nodes are displayed is the default 
order they were entered. ORA gives you four 
different ways to display these same nodes.  

 Ascending by Title A↓Z : Arranges nodes in 

alpha order lowest to highest. 

 Ascending by Link Count : Arranges nodes in 

order of number of links from lowest to 
highest. 

 Descending by Title Z↓A : Arranges nodes in 

alpha order highest to lowest. 

 Descending by Link Count : Arranges nodes 
in order of number of links from highest to 

lowest. 

 

NOTE : Nodes will retain their sort order for the duration they are displayed on the 
screen. Changing this view and returning to a network will place the nodes back in 
their original order. 

Hightlight 

Highlights or clears selected nodes.  

 Clear all : Clears the highlight from all nodes. 

 Clear selected : Clears the highlight from only the 

selected nodes. 

 Hightlight selected : Highlights all nodes currently 

selected. 

 

Example 

First I sorted the agents by [Right-Clicking] on any agent and selecting Sort > 
Descending by link count so the nodes with the highest numbers of links would 
rise to the top. I clicked on paul_atreides, counted down ten agents, and [Shift-

Clicked] on thufor_hawat. This selected the ten agents with the most links. 
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Hovering over any of the selected agents I [Right-Clicked] bringing up the 

contextual menu. I select Hightlight > Highlight selected. This placed a yellow 
highlight over the top ten agents. 

 

I wanted the list sorted by name again so I [Right-Clicked] and selected Sort > 

Ascending by title.  
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NOTE : Highlighting works in the same manner with regards to columns. 

 

Contextual Menus - Dynamic  
Meta-Networks 

The Meta-Network with a Clock signifies a special type of Meta-Network. 

In the Meta-Network Panel click the [+] button to the left of the icon to expand the 

contents. Clicking on any of the just revealed icons will display te contents of the 
individual components. The first one (with the regular Meta-Network icon) contains 
the general data. Each of the other components are the individual timeslices within 

the dataset which also contain the same number of NodeClasses and Networks. 

Right-clicking on any Meta-Network with the clock icon brings up the contextual 
menu to work with these types of files. 
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Contextual Menu for Dynamic Meta-Network 

Remove Selected : Remove selected Meta-Networks from ORA. 

Import Keyframes... : Merges the new Keyframe into the Selected Meta-

Network based on the new date. If the new Keyframe has no date it will be 
placed at the beginning of the Dynamic Meta-Network. 

Import Keyframes as deltas... :  

Create a new delta... : Add new delta either at the end of the all time periods 

or inserted after a specific date. 

Aggregate... : Combine data from individual parts of Meta-Network determined 
by parameters. 

MetaNetwork Transform... : Use to transform each keyframe in the Dynamic 
Meta-Networlk according to the parameters selected. 

Contextual Menu for Keyframe 

Add New Meta-Network : Create Blank Meta-Network 

Remove Selected Meta-Network : Remove Selected Meta-Networks from 
ORA. 

Add New Node Class... : Create Blank Node Class in Selected Meta-Network 

Add Blank Network... : Add blank Network to Selected Meta-Network 

View Status :  

Meta-Network Transform... : Use to transform each keyframe in the Dynamic 

Meta-Networlk according to the parameters selected. 

MetaNetwork Anonymize... :  

Contextual Menu for Other Deltas 

Insert Keyframe : Inserts new KeyFrame after Selecte Delta. This Keyframe 
will containall the information from the previous Delta which can then be 

modified by additions, Deletions, and modifications. 

Convert to Keyframe : Converts a Delta into a Keyframe. 

NOTE : You can not convert a Keyframe into a Delta. 
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Create New Delta : Create a new Delta. You can choose to add one to the end 
of the time by various increments or use the Custom date function to insert it 

into the list. The new Delta will contain all the information from the previous 
Delta or Keyframe. 

 

Create a New Meta-Network 

What follows are procedures for creating a new Meta-Network. 

There are times you need to run measures on or visualize only part of an existing 

Meta-Network. This section will show you the easy way to create sub-sets of an 
existing Meta-Network. 

First duplicate the Meta-Network. Highlight the Meta-Network then from the 

main menu select Edit ⇒ Copy Meta-Network. Then from the main menu select 

Edit ⇒ Paste Meta-Networks. It would be a good idea to rename this new Meta-

Network immediately so as to not get it confused with the original. You can do this 
in the Editor tab, see Renaming. 

Next, expand the Meta-Network you want by clicking the [+] if it isn't expanded 
already. Highlight the nodeset with the nodes you want to remove. 

 

In panel 2 select the Editor tab which brings up the matrix with nodes on the 

vertical and attributes on the horizontal. Below each attribute is a <set filter>. 
Below left is the stargate_summit meta-network along with the ally attribute. I 
wish to make a new meta-network of the good guys only. In the dropdown menu 

under ally I select no. These are the nodes I want to remove. 
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Place a checkmark in the box of each node. Below the matrix in the section called 
Nodes are three buttons. Click the [Delete] button. The nodeset now contains 

only the nodes that had yes in the attribute ally. 

 

With this same procedure I created a Meta-Network of only the allies. 

 

Create Meta-Network from Excel File 

If you don't have a Network, you can create one from scratch. Below is step-by-
step instruction on how to do this in ORA. 

We will create an square, agent-by-agent Network. We say it is square because all 
row headings correspond directly to column headings. This is important as it relates 

to specific measures ORA can run on a graph. If the graph is not square, some 
measures will not work. 

Open a blank Microsoft Excel work book. In column A we will enter the name of all 

the nodes that make up our social network or organization. 
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NOTE : When creating your spreadsheet, do not add any additional titles, notes, or 
other headings, which will interfere with the "square" properties of the Network. 

 

Next, create column headings using the correlating names as they appear in row 
headings. Again, this will ensure that our Network will be square. 

 

Next we will create links between each agent. We do this by entering a 1 if a direct 

connection or relationship exists and a 0 if it does not. Please note that headings 
that cross-reference themselves are considered redundant and thus are left blank 

or 0. 

In the example below, Redundant cells are filled in with red strips to illustrate the 
self-loops. This redundancy should continue as a smooth diagonal line from the top 
left corner of your Network to the bottom right. 

 

NOTE : If you don't end up with a diagonal line then your graph is not square. 

Using 1s and 0s to establish link, complete your spreadsheet. 

In the Network example, we have assigned links randomly. Within your 
organization or network, however, you can describe any direct connections or 

relationships you are interested in analyzing. For instance, you may determine that 
a direct connection exists if agents within your network consult with each other at 
least once a month; literally, it can be anything you decide. 



 

117 
 

Below is our completed Network (The red fill illustrates cells that do not require 
input due to their redundancy*). 

 

Now that we have essentially built a Network from scratch using Excel, the next 
step is to save it in a compatible file format ORA can interpret. For Excel 
spreadsheets this will be the CSV* file format. 

From the main menu select File ⇒ Save As 

Make sure you save this file as a CSV (comma delimited) 

You have now created a Network from scratch which can be loaded into ORA. 

Now return to ORA and load up your new Network. Below is a our new Network 
rendered in the ORA Visualizer. Notice the arrows only point from one node to 

another if there is a 1 in the column for a particular node. i.e. There is a "1" in 
the bob column for ted but a "0" in the ted column for bob. So an arrow 
points from ted to bob but NOT from bob to ted. 

 

For a more in-depth explanation for creating Meta-Networks see the lessons 
section under Meta-Network. 

 

Create New Node 
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With the [Create] button in the editor you can create any number of nodes at one 
time. But there are times you only need to insert a sigle node into a nodeset. Such 

as while building a dataset you forgot to include it in the original construction. ORA 
gives you a quick method of adding a single node. 

 

Below is the small Star Wars set containing 11 agents. And for some reason you 

needed to include a 12th agent, say Jabba the Hutt. 

 

I typed jabba_the_hutt into the Search box and since he's not in this set ORA 
display no nodes. But notice to the right of the Search box a [Create a new node] 

button has appeared. If the node you want does not exist this allows you to 
instantly add it to the nodeset. 
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Upon click the [Create a new node] button the Jabb_the_hutt node is added to 

the bottom of the list. 

 

12 JAN 11 

 

Dating Meta-Networks 

Certain functions require a Meta-Network to have a date attached to it. These 
include: Measures Over Time, Networks Over Time, and Loom. To add a date first 
highlight the Meta-Network. In the Editor pane find Meta-Network Date. Click on 
the [Click to create...]. 
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Now you can set the parameters for the date which include year, month, day, and 
time. 

Remove Meta-Network date 

 

If, at any time, you need to remove the date from a Meta-Network click on the [X] 
to the right of the date. 

 

Delimited Files 

Excel when reading in a flat file (i.e. txt or .csv) is sensitive to the kind of delimiter 
used. In the American version of excel, it assumes that a comma or tab is used to 
separate columns. In other versions, it often assumes that a semicolon or tab is 
used to separate columns. This is because in many other languages the comma is 

used as a period in showing the price of items. 

AutoMap and ORA export data as comma separated and can import comma 
separated. This means if you are reading into or reading from a non-American 

version of excel you may have problems. 

Reading in the.csv file into Excel that uses something other than commas will cause 
the data to appear as a set of text in column A. There are two ways to fix this. 

First read the file into a text editor and globally change all the delimiting characters 

to commas. 
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Second read the file into excel and use the Text to Columns function and use a 
different delimiter. 

Excel Example 

Let's start with a simple three line file using semicolons as delimiters. 

NOTE : Remember, data can be separated with a variety of characters. This 
procedure allows you to import data with any of them. 

100;apple;red 
101;lime;green 
102;lemon;yellow 

Opening this file in Excel will place each line of text into a single cell. You need to 
separate this into individual columns. 

 

Select the cells you want to convert then click the Data tab. Click the Text to 
Columns function. 

 

This brings up the Convert Text to Columns Wizard. Make sure the Delimited 
radio button is selected. Then click [ Next > ]. 
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Under the Delimiters header make sure the Semicolon box contains a check 

mark. In the Data previewarea it will show you what your data will look like after 
the conversion. Click [ Next > ]. 
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Lastly you can do some final tweaks to how your data will be converted if you want 

such as your data format or a different destination. In this example we want the 
data to be inserted back into the original starting cell. Click [ Finish > ]. 
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Each piece of data now resides in a separate cell. 

 

The new file can now be imported into ORA through the Data Import Wizard. 

 



 

125 
 

 

Document/URI Attributes 

The following instruction demonstrates how to add a document attribute or a URI 
to a Node. 

Adding a document links in the Editor 

Load a Meta-Network into ORA. Then expand the Meta-Network using the [+] icon 

to display all the NodeClasses and Networks in the Meta-Network. Then right-click 
on a NodeClass and this will access the contextual menu. From here, select Add 

Attribute. Give the new attribute a name. 

In Pane 2 click the Editor tab to display the matrix and find the new attribute just 
created. All cells will be empty. A new pathway can be inserted in the cell at this 
time. 

Once the node title has been changed, you can now enter a URI directly inside the 
corresponding blank field. This can either be an absolute pathway to a document on 
the user's hard drive or a web URL. 

Adding a URI in the Visualizer 

Visualize a Meta-Network, select a node, and right-click to access it's contextual 
menu. From the contextual menu select, choose URI submenu > Attach URI. 
This brings up the Add URI box where the new URI can be entered. 

When viewing the Meta-Network in the Editor a new column appears with the title 

you inserted in the field Name:. 

NOTE : When using a absolute path to a document the link will not work if the 
Meta-Network is opened on another computer. It's much safer to use URIs from the 

internet to connect documents. 

The same document pathway can be used for multiple nodes. 

When the Meta-Network is displayed in the Visualizer the document URI will appear 
in the Node Status tooltip. You can go to this URI by right-clicking a node and use 

the URI submenu to Go To URI. A new explorer window will be launched showing 
the location of the document file. It can then be opened with the appropriate 
program. 

Multiple URIs/URLs 
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A node can have multiple URIs and you can still launch from the URI SubMenu. The 
preferred method for launching URIs is through the Node Status dialog where you 

can choose an individual URI to launch. 

There's a new URI tab that allows you to view URI's, launch them, and add new 
ones. When adding new ones, the current convention is to create a new Attribute 

with name URI-X, where X is the earliest number that doesn't already exist. So, 
adding a URI to nodes will create results such as URI-1, URI-2, etc. Currently, when 

finding URI's to \launch, only those that follow the above convention are included, 
but it will be expanded to include any attribute with URI or URL in it anywhere. 

 

Duplicate Items 

ORA allows for the quick duplication of Meta-Networks, Nodesets, and Networks. It 
uses the Copy and Paste commands but some aspects work in a different manner 

than most users are familiar with. 

Meta-Network 

Duplicating a Meta-Network can be done with the menu, Edit > Copy Ctrl+C then 
Edit > Paste Ctrl+V. This will create a duplicate of the highlighted Meta-Network. 

And as the menu items show you can also use the keyboard shortcuts, Crtl+C and 
Ctrl+V 

There is also a method for duplicating two or more Meta-Networks simultaneously. 
Hightlight all the Meta-Networks you need to duplicate. Press and hold the [Alt] 

key. Place the mouse cursor over one of the highlighted Meta-Networks then Click 
and hold. Drag the cursor into an unused area of the Meta-Network Manager pane 

and release the mouse button. All highlighted Meta-Networks will be duplicated. 

NodeSets and Networks 

Using the Menu items Edit > Copy Ctrl+C and Edit > Paste Ctrl+V work 
differently with NodeClasses and Networks. This can be used to either create new 

Meta-Networks or duplicate ModeClasses and Networks in existing Meta-Networks. 

This leads to an interesting side benefit. You can highlight NodeClasses and 
Networks from different Meta-Networks, Copy, and Paste. This will create a new 

Meta-Network with all the highlighted items. 

Create new Meta-Network : As with Meta-Networks click, hold and drag a 
NodeClass(es) or Network(s) to an unused space in Meta-Netowrk Manager pane. 
Upon releasing the mouse button ORA will create new Meta-Networks containing 

those NodeClasses and Networks. 
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NOTE : If you highlight two NodeClasses or Networks with the same name ORA will 
ask you to give the second one a different name. 

Add to existing Meta-Network : Dragging a NodeClass or Network to an existing 

Meta-Network will add that NodeClass or Network to the new Meta-Network. If that 
NodeClass name is currently in use ORA will as you to rename the NodeCLass or 

Network you want to append. 

 

Editor Tab-Network 

 

Search nodes... drop down:  

Search nodes... : Using the AND/OR drop down you can search for ALL or ANY 

of the terms in the box. 

Search nodes... : This doubles the capacity for searching and gives you two search 
boxes and AND/OR options. It allows you to make a finer tuned search. 

Find a link... : Select a node from each drop down box and ORA will locate the cell 

corresponding to that link. 

Results drop down :  
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Highlight Results : Highlights in yellow the results of your search 

Show Results : Shows only the results of the search. All other nodes will be 
hidden. 

Hide Results : Hides the results of a search showing only nodes and links that do 
not match. 

Add/Remove Link :  

You can remove specific links (links with a line value lower or higher than a given 

value or self-loops). You can also set the self-loops (diagonals) of a network to a 
designated value. Lastly you can symmetrize your networks using different 
methods (maximum, minimum, sum, average). 

Convert Links :  

This allows you to manipulate the line weights of your network. 

Binarize link weights : (x ≠ 0 ⇒ x = 1) 

Collapse link weights : (a ≤ x ≤ b ⇒ x = 1) 

Negate link weights : (-x) 

Invert link weights : (1/x) 

Logorithm of the link weights : (log10(x)) 

Absolute value of the link weights : (|x|) 

Scale the link weights : (c * x) 

Row-Normalize the link weights : (x/ROutDegree) 

Increment the link weightsSubtract the link weights : (c + x) 

Subtract link weights : (c - x) 

Highlight :  

Clear all : Clears all highlights from editor. 

Hightlight Isolates : Highlights on yellow any nodes not connected to any 
other nodes in the Network. 

Hide Display Oprions :  
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Show all : Displays all hidden nodes and links 

Hide highlighted rows : Any rows that are highlighted yellow will be hidden. 

Hide highlighted columns : Any columns that are highlighted yellow will be 

hidden. 

Display Options 

Binary link values : Changes the grid to display check boxes. If a link exists, 
regardless of the weight, a check mark will appear in that cell. 

Numeric link values : Changes the grid to display cells. The weight of the link 

will be display as a negative value, 0, or a positive value. 

Display row sums : Creates a column to the right of the row names and 
displays the sum of all links in that row. 

Display column sums : Creates a row below the columns names and displays 

the sum of all links in that column. 

 

Editor Toolbar 

 
 

To help facilitate your workflow ORA 
allows you to mount/unmount tool 

buttons in the Editor's toolbar (and 
also in the Visualizer toolbar). Click 

the down-triangle to open the 
dialog box. 
 

The Configure Toolbar dialog box 
will appear. You will notice that 

some items are already checked. 
These correspond to the buttons 
already present. Placing a check 

mark next to any tool instantly 
mounts it on the toolbar. Removing 

the check mark from a button 
instantly removes the button. 
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When you are finished click [Close]. 
 
If at any point you can select the [Restore Default] button which will remove all 

the changes you made and restore the toolbar to the buttons found in the image 
at the top. 

NOTE : The buttons appear from left to right in the order you select them. You can 
not re-arrange buttons once they are placed on the toolbar. 

 

Filters 

Use of this function allows you to reduce the number of nodes that appear in the 
Editor. By clicking the double up-pointing arrows in the top right of the Editor pane 
you will reveal the filtering tabs. Using the [+] you can add additional filtering 

parameters. Likewise you can remove filters by using the [X] 

General Filter 
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The General Filter works across all columns. Think of it as a blunt force filter. The 
terms you are searching for are either In or are not in the dataset. 

Attribute Filter 

 

With the Attribute Filter you can do finely tuned searches specifying whether a term 
is foun, or not, within a specific attribute. 

NOTE : At any point you need to backtrack or start over select the General Filter 

tab and click the [Reset] button. 

General Filtering 

Here is the character nodeset from part 7 of the Foundation dataset. 
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Using the General Filter on the Foundation dataset we'll use it to find the military 
officers on the world Kalgan. Note that Kalgan is in the attribute HomeWorld and 
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police is in the attribute profession. After typing kalgan into the search box ORA 
filters out all entries which do not contain the world kalgan. 

 

Next military is typed into the search box. Remember to leave a space in-between 
each word. And since Match all is selected ORA filters out all entries with do not 

include BOTH kalgan and military. Only one entry corresponds to both. 

 

Now let's change the conditions from Match all to Match at least one. Now every 
entry which has either kalgan -OR- military shows up. 
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Attribute Filtering 

Single Attribute Filter : Click the leftmost drop down and select profession. Click 

the middle drop down and select is one of. Type politician or spy into the 
textbox. Four characters fit this filter and are displayed in the Editor. 
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Multiple Filters using AND : The search can be further refined by adding 
additional parameters. Click the [New filter] button to create a second filter 

parameter. It will appear directly beneath your first filter. Click the leftmost drop 
down and select home world. Click the middle drop down and select is one of. 

Type terminus into the textbox. This eliminates the character portirat_hart from 
the search as there is no home world specified for that character. 

 

Multiple Filters using OR :  

Leaving the filter parameters the same we'll now change the condition from AND to 
OR. This means that a character will be displayed in the Editor if either the 
profession or home world match. 

 

 

Fold Network 

Folding a Network can answer questions about a Network such as which agents 
have the most common knowledge. Folding a Network multiples the network by 
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its transpose. The result is an agent x knowledge network whose links are the 
number of knowledges in common for the agents. 

 

Fold a network select the Network in the Meta-Network Manage pane and right-
click. From the contextual network select Fold Network. From the dialog box 
select the Fold Method and Compare options. In the Network ID give the new 

Network a unique name. 

 

The new Network is agent x knowledge - Shared Knowledge. This will appear in 

the Meta-Network Manager pane. 
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Examining the Network in the Editor will show the diagonal gives the number of 

knowledges each agent has. The off-diagonal contains the knowledge agents have 
in common. 

Creating a transpose and then doing the multiplcation could also be done manually 

in the Matrix Alegbra tool under Data Management. 

 

Hovering - Tooltips 

Hovering the pointer over various parts of the panels will reveal 
information about the Meta-Network. 
 
Hovering over the parts in Panel 1 will reveal different information about 

the Meta-Networks, Meta-Nodes, and Networks. 
 

Hovering over the Meta-Network reveals the name. 
 
Hovering over a NodeClass reveals the nodeclass anme and size. 

 
Hovering over a network reveals the network type, it's ID, and the link 

count. 

 

 

 

ID Names 

Working with ID Names 
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Each Meta-Network, NodeClass, and Network can be given a distinct ID Name. At 
times this can be very helpful when working with multiple Meta-Networks it can also 

cause problems with certain functions. 

 

Here I renamed one of the Meta-Nodes to those guys. It is also reflected 
throughout all of Meta-Network Panel. You can rename any Meta-Network, 
NodeClass, or Network for better readability. 

Areas where it's important to maintain Name ID integrity 

View Measures Over Time : This function allows an analyst to see how a network 
measures change over multiple time periods. So in order to track measures over 
time it is necessary that the ID Names of the Networks are the same in all 

instances. 

View Networks Over Time : This function allows you to set up multiple Networks 
that encompass various time frames and view them in succession. Since you want 

to see what happens over the same Network Over Time it becomes virtually 
important to make sure the ID Names of these Networks are all the same. Else ORA 
will not be able to analyze them correctly. 

Comparing Networks : When ORA runs measures on Networks it's sometimes 

necessary to do have identical Network names. This will be listed in the Measures 
section. 

 

Info Tab - Nodeset 

Panel 2 contains two tabs, Info and Editor. The Info tab is mainly designed to 
display information regarding the Meta-Networks, NodeSets, and Networks. But this 
is the area where you can rename the Node Class ID and the Node Class Type. 
Place the cursor in the box, make sure the entire name is highlighted, and type in 

your new name. 

This area also gives you the Node Count of the selected Node Set as well as the 
Attribute Names contained within the NodeSet. 
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The Editor tab contains most of the editing functions. 

 

The Search box for finding particular node(s) in a set. 

The <set filter> for displaying only a particular sub-set of node(s). 

The Check boxes to designate which nodes to Delete or Merge. 

The Nodes buttons: Create, Delete, Merge, and Clean. 
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The Delete button has these options. 

Deleted selected nodes : Deletes any nodes which have been check-marked. 

Clear delete list : Clears all deletion data from memory. 

Load and apply delete list : Will apply all deletiong found in the selected file. 

Save delete list : Writes a file with the deletions performed on the selected 
Meta-Network. 

The Merge button has these options. 

Merge selected nodes : Merge into a single node all selected nodes. will be 

prompted for the final name. 

Clear merge list : Clears all merge data from memory 

 

Info Tab - Network 

When a Network is selected there are also two tabs, Info and Editor. 

The Info tab contains a textbox, Network ID in which you can change the name of 
any network, The Source and Target Nodesets, and whether this network is 

directed or not, the Link Count, and the Density. 

The two buttons underneath allow the choice of Visualize this Network which will 
send the entire Meta-Network to the visualizer or Visualize Only this Network 
which display only the currently selected Network. 

Below is an image of InfoTabs and Editor Tabs in ORA.  
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Network ID : Allows you to rename the network. 

Source class : Displays the source node or the leftmost column in the graph. 

Target class : Displays the target node or the topmost row in the graph. 

Network Properties: Symmetric, No Self-loops, and Binary link weights 

Place a check mark in the box(es) which you want to include. 

Network Statistics 

Gives information regarding the selected network. 

When computing measures: 
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The purpose of this is to let the user tell ORA what links should be used and how 
they should be interpreted when computing measures, as this affects the results. 

The areas are: Symmetric/Or Not, Self-loops/Or Not, and Binary/Weighted. 

If you want ORA to treat the data as symmetric if it is symmetric, then use Auto-
Detect. This option will test if the network is symmetric, record the result, and use 

that result when computing measures. The same goes for binary and self-loops. If 
all the links in the network are of weight one, then the network assumed to be 

binary (but if there is a link with a weight other than one, then it is assumed 
weighted). Lastly, if the network has no self-loops, then it is assumed it cannot 
have any. 

If, for example, there just happens to be no self-loops, but there could be, and the 

user wants the measure to take that into account, then the user would select TRUE. 
On the other hand, if are self-loops and they should always be ignored, then the 

user can choose FALSE. Note that FALSE does not change the network data in any 
way, but the measures just ignore the loops. 

The Editor tab has two views: Binary and Numeric.  

Binary view is used when you only need to establish a connection between two 

nodes with no weights. It's a simple Yes or No arrangement. 

 

The Numeric view allows you to treat links between various nodes with more or less 
importance. Notice that all the row nodes have a check marked connection to the 
column containing [yu] in the binary mode. This denotes they know one another. 

But in the numeric mode this value is a 0.5 which is used to denote previous 
acknowledgement but is an adversary. 
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The Convert Links button contains options for converting links in a Network. 

Binarize link weights ( x 0 -> x = 1) 

Collapse link weights (a=x=b -> x = 1 

Negate link weights (-x) 

Invert the link weights (1/x) 

Logorithm of the link weights (log10(x)) 

Absolute value of the link weights ((|x|) 

Row-Normalize the link weights (x/OutDegree) 

Increment the link weights (c + x) 

The Remove Links buttons deletes all links for the selected condition and the 
value of the links you wanted removed. 

 

Less than 
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Less than of equal to 

Equal to 

Not equal to 

Greater than or equal to 

Greater than 

Load and apply merge list : Will apply all merge combinations found in the 

selected file. If a node in the list is missing from the Meta-Network ORA will 
ignore that line. 

Save merge list : Writes a csv file with all combinations of merged nodes. If 
you performed multiple merges it will list them all. 

The Attributes buttons: Create, Delete, and Import. 

Use the Select All/Clear All buttons to place, or remove, all check marks from 

section 3.  

 

Info Tab-Network-Statistics 

The Info Tab : Display relevant information whether a nodeclass or network is 

highlighted. 
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Network Properties 

Symmetric (undirected links) : Create additional links to maintain symmetry of 
the Network. [e.g. you create a link A > B and ORA would automatically create the 

link B > A of the same weight. 

No self-loops : Disallows a link to be set back to node to itself. 

Binary Link Weights : This will set all link weights that are not [0] to [1] 

NOTE : Changing these options for existing networks can have huge impact to your 

data. Changing a network from weighted to unweighted will set all link weights 
wuv to 1.0. These options also have implications for the editor. If the option is set 
to directed network then changing the value wuv in the matrix will automatically 

change the value wvu. 

Statistics 

Select how to treat links when computing measures: 

You can use this to control how Links and Properties are handled for each individual 
Network. 

Under Select how to treat the links when computing measures: you can 

select between True, False, and Auto-detect. 

Treat as symmetric : Symmetrizes the network for the calculation, e.g., if the 
line weight wuv is larger than wvu then wvu -> wuv. 

Ignore self-loops : All diagonal elements are set to 0. 

Treat as binary : The link weights for all wuv with wuv ? 0 are set to 1. 

The default setting for these is Auto-detect. If the network is symmetric, then 
when computing measures the network is considered as symmetric. Similarly, if the 
network has only binary link weights, then when computing measures the network 

is considered binary. The user can also explicitly set to True or False whether the 
network should be treated as symmetric, without self-loops, or binary. 

To change the settings, select the network and change one or more of the three 

controls in the info window of a network in the section Select how to treat the 
links when computing measures.  

Whenever ORA calculates a measure (independent from which measure calculation 
you select) a network will be pre-prepared based on the settings of these primary 

measure parameters. These setting do not change the original data but the way 
ORA handles the data when calculating measures. To actually convert the data you 
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can change the network parameters (see section 2) or use other procedures to 
have more detailed options (e.g. symmetrize by minimum value). You can find an 

introduction into these procedures in section 2.7. 

 

Network Editor  

With a network highlight and the Editor tab displayed ORA has many functions for 
working with nodes and links in a network. 

 

Search Nodes... 

 
 

Search type 1 

Using the Search box and the [AND/OR] selector you can refine a search on a 
Network. 
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With the [AND/OR] selector set to AND I type lady into the Search box. This 
results in two rows/columns being highlighted, lady_jessica and lady_fenring. 

 

To refine the search I type jessica into the Search box (making sure to place a 
space between the words). This eliminates lady_fenring leaving only 

lady_jessica highlighted. 

 

Without changing anything in the Search box I change the AND to OR in the 

[AND/OR] selector and it now reveals any node with either lady OR jessica. 
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NOTE : Idential search results were achieved with different parameters. 

Search type 2 

This search is similar as the primary search but with two Search boxes for added 
refinement. 

 

Find a link... 

Chosing two nodes in the two dropdown menus will locate the link in the matrix. 

 

NOTE : The box to the right of the node dropdowns is for setting the weight of the 
link. 

 

 
 
Remove All Links : Removes all 
links from Network. 

 
Remove links by value : Allows you 

to set parameters for the values of 
links which you want to remove. 
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Remove self-loops (diagonel) : 
Removes links connecting a node to 

itself/ 
 

Symmetrize by method : Gives for 
options : Maximum, Minimum, Sum, 
and Average. 

 

 
 
Convert Links : Gives options for 

changing the value of links in a 
Network. 

 

 
 
Clear all : Clears all highlighting 

from rows and columns. 
 
Highlight isolates : Highlights rows 

and columns of any node with has no 
connections to any other nodes in the 

network. 
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Show all :  
 

Hide highlighted rows :  
 
Hide highlighted columns :  

 

 

17 JAN 11 
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Node Buttons 

Node Buttons 

Used within the Editor you can manipulate nodes in a NodeClass. 

NOTE : Any changes done to a NodeClass are permanent. There is no Undo. 

 

Create : inserts a new node(s) into the NodeClass. You will be asked for the 

number of new nodes to create and a node ID. If multiple nodes are to created then 
a number will be appended to each new node. 

Move : Move all check marked node(s) to another designated NodeClass. ORA will 

prompt you for the movement of links associated with these node(s). 

Delete : Removes node(s) and all associated link(s) from the Meta-Network. There 
are four sub-options viewable by clicking the downward triangle. The nodes deleted 
are kept in a log which is used for creating a delete list. 

Delete selected nodes : Instantly deletes all nodes which have a check mark 

placed to the left of their name. 

Clear delete list : Clears from the log any information about nodes that were 
deleted. 

Load and apply delete list : You can load a previously saved delete list and ORA 

will then apply it to the currently selected Meta-Network. 

Save delete list : Saves the log of deleted nodes to a file which you can give a 
distinctive name. Nodes from any NodeClass which were deleted are saved to this 

list. 

Merge : removes all selected nodes and replaces them with a single node with all 
previous links and attributes. This is used primarily when data needs to be 
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consolidated. Example : A NodeClass contains two nodes, jack and col_o'neill. 
These are actually the same person. Merge could combine their information into 

one node which could be named col_jack_o'neill. 

Merge selected nodes : Merge all check marked nodes into a single node. 

Clear merge list : Clears from the log any information about nodes that were 
merged. 

Load and apply merge list : You can load a previously saved merge list and ORA 

will then apply it to the currently selected Meta-Network. 

Save merge list : Saves the log of merged nodes to a file which you can give a 
distinctive name. Nodes from any NodeClass which were merged are saved to this 

list. 

NOTE : Information on both deleted nodes and merged nodes is kept in a log file 
which ORA used to create delete and merge lists. 

Clean : finds all nodes whose IDs are within the edit distance of the selected node. 

An edit is a change of a single character. 

 

Search 

Sub-set of a NodeSet 

With the Search feature you can quickly locate specific nodes. Typing a term into 
the Search box will display all nodes with that term in their name or attributes. 

To the right of the Search box is the AND/OR selector. This is a boolean search 

tool. AND requires all terms in the Search box to be present in every node. OR will 
display all nodes with any of the Search terms present. 

NOTE : Be aware of how sub-strings work in searches. A search for male will find 
all values of male as well as female because male is a sub-string of male. 

Example 

When you start, all nodes will be visible in the Editor. Using the wildcards you can 
reduce and control what is displayed. 
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The [*] wildcard 

The use of the [ * ] tells ORA to find all nodes with the string enclosed by the 
astericks. That string can occur anywhere in the name. 

NOTE : Search requires the use of the wildcard character [ * ] both before and 

after the search term. 

 

NOTE : Highlights done to emphasize the search. ORA does not highlight these in 
the actual program. 

 
NOTE : The Search functions works on the nodeset as a whole meaning there's no 



 

154 
 

selecting one single attribute to search. A term found anywhere marks that node to 
be displayed. 

The [?] wildcard 

Unlike the asterick the question mark substitutes for only a single character. In the 
example the first node is 3rd Officer Jane Blythe. Typing ?rd* tells ORA to 
search for the string rd which contains any one preceeding character and any 

amount of trailing characters. It locates three nodes which match 

 

Adding a second ? tells ORA to search for the string rd which contains any two 
preceeding character and any amount of trailing characters. 3rd Officer Jane 
Blythe is no longer found as there is only one character preceeding the rd string. 
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Adding a third ? to the search produces a third set of results. 

 

Filters 
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Filtering allows you to select specific nodes 
to display in the Editor. A check mark tells 
ORA to display a node with an equal value. 
 

The [ Clear all filters ] button removes the 
filter parameters from that particular column 

only. It does not affect any other filters you 
have set elsewhere. 
 

Deselecting all except (blanks) will display 
any node which has a null value. This is 

useful when you need to fill in attributes for 
blank nodes. 

 
With Define a custom filter you can 
specific a filter in greater detail. If there were 

three nodes with attributes of city-1, city-2, 
and city-3 defining *city* as the filter 

would display all three. This also contains the 
Matching [shows only what matches the 
filter] and Not matching [which shows only 

what does not match the filter]. 
 

When finished click the [ Apply ] button 
activate the filter. 

 

You can also set filtering to multiple columns to better define your search. This 
search required the home world to equal trantor and also sector to equal dahl. 
Only nodes with both attributes are displayed. 

 

 

Visualize Buttons 

There are two Visualize buttons and they work slightly different.  
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Visualize this Network 

The Visualize this Network visualizes the chosen Network. In the Legend dialog 
box all NodeSets and LinkSets are available. 

 

Visualize Only this Network 

The Visualize Only this Network visualizes the chosen Network. But in the 

Legend only the NodeSet and LinkSet chosen are displayed. This is a much quicker 
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means to display a Network. ORA only makes computations for the chosen 
Network. 

 

Clicking on the downward triangle brings up the dropdown menu with additional 

options for visualizations: Network Drill Down, Visualizer 3D, Visualize 2D, 
Node Cloud, Path Finder, Sphere of Influence, and Node Selector 

 

File Menu 

Below is an image of the File Menu accessible from ORA's main title bar menu. 
Further below are descriptions of the various tools accessible through the File Menu.  

 

Open Meta-Network : opens a single Network with the following 
formats: DyNetML* (the native ORA xml format), .dl, .##h (UCINet), 
.csv* (comma separated values, Excel spreadsheet out), .txt (text files), 

.raw, .net (Pajek), .graphml*, .stl* (GMU model), and .lo (pathfinder). 

 

Data Import Wizard : Contains additional options for importing 
Networks such as multiple file importing. See Lessons for more 
comprehensive information regarding this function. 

 

Data Export... : Allows you to export a Meta-Network into a different 
format: CSV, UCINET-Binary, UCINET-DL, Netdraw VNA, Text, 
Pajek, DyNetML, or C3Trace. 
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Import CASOS Database… 

 

Open Workspace…Allows you to open an entire workspace that you 
were previously using. A workspace consists of a set of Meta-Networks 

that were all open at the same time, and saved as a workspace. 

 

CEMAP...Opens up the CEMAP Parser. 

 

AutoMap...Opens up the program AutoMap. 

 

Pile Sort... allows a user to load a series of entities such as concepts 
which can then be organized into a piles. The output will be a network in 
DyNetML format. 

 

Save Meta-Network : This item is initially greyed out. It only becomes 
active when you've made a change to a Network. You can use it as an 
indicator whether you've made a change to the active Meta-Network. 

Notice as you highlight each Meta-Network the icon in the toolbar will be 
greyed out (no changes) or colored (changes made to that Meta-
Network). 

 

Save Meta-Network As... : Allows you to save the changes in a Meta-
Network under a new filename. 

 

Save Workspace : Saves the active Meta-Networks into a Workspace 
which can be opened up at a later date. 

 

Exit : Closes the program and gives you two options for the next time 
you open up ORA.  
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 Meta-Networks have been modified : If you have any Meta-
Networks with unsaved changes you can save them by clicking 

[ Save ] 

 Change lists have been modified : If you have any Change Lists 

with unsaved changes you can save them by clicking [ Save ] 

 Restore workspace : If checked, the next time ORA is started it 

will load any Meta-Networks currently open when it was last 
closed. 

 Restore preferences : If checked, all preferences from Edit > 
Other... will remain in effect. If not then ORA will resort back to 

it's defaults.. 

 

Open Files in ORA 

ORA is designed to work with DyNetML files. However, data in a format other than 
DyNetML can be imported and converted. 

 Open Meta-Network 

From the Main Menu select File > Open Meta-Network. to bring up the initial 

open dialog box. Navigate to the folder with your DyNetML file and click [OK]. 

The selected file will then appear in Panel 1 of the main interface. 
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 Data Import Wizard 

The Data Import Wizard imports files in a variety of File Formats. The idea behind 
the data import wizard is that users come to ORA with a variety of file formats from 

various different network analytical tools. Very rare is it that an analyst has a Meta-
Network ready to load. Moreover, network data may exist in a separate file or in a 
variety of file formats, which then need to be merged together. 

The Data Import Wizard is used to convert the user data from their native format 
and separate files and convert it into Meta-Networks and then into a DyNetML file. 

The files can be in any of the following formats: CSV, UCINET, GraphML, or 
Pajek. ORA uses the file extension to determine the native file format to assign to 

your network. Therefore, if you change a file extension from its native extension 
(e.g., GraphML file such as "example.gml" to "example.dot" ORA will not 

recognize the data format). 

This section will review the basics of the Data Import Wizard. See the lesson 
Creating a Meta-Network for more comprehensive information on importing. 

Data Import Wizard is accessed either File > Data Import Wizard or the icon in 

the toolbar. You are presented with a dialog box showing all the file format options 
to import. Each contains a description on the right-side of the box. 



 

162 
 

 

Other Functions Besides Importing 

 Create a meta-network from separate network files: Use this option to 
select multiple networks in one of the several native file formats indicated 

above and pull them into ORA. The file formats don't have to match. ORA will 
then combine all the network files into one Meta-Network, which will then be 
saved as a DyNetML* file (ORA's native file format). 

 Create a meta-network from table data: Text files in the form of rows of 
Nodes and columns of Attributes will be used to populate existing 

NodeSets.  

 Import node attributes from table data: Text files used to import 

Attributes to a Node. 
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Data Import 

The Data Import function contains many methods for creating new Meta-Networks 
or importing data into pre-existing Meta-Networks. 

This section instructs you how to: 

Creating a new blank Meta-Network. 

Importing Network matrix data to create a new Meta-Network. 

Importing Attributes into an existing Meta-Network. 

 

Create Blank Meta-Network 

ORA allows you to create a blank Meta-Network from the Data Import Wizard. 
This Meta-Network will contain NodeClasses and Network which can be populated 
with information either manually or by importing csv file data. 

Select the Import Wizard with File > Data Import Wizard  

 

In the left box select Create a blank meta-network? Then click [Next >]. 

This brings up the dialog box for creating a blank Meta-Network. 
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Following the three steps you can create a blank Meta-Network with any number of 

NodeClasses and Networks.  

Step 1: Specify the name for your new Meta-Network. 

Step 2: Click the [New] button to insert a new NodeClass. 

1. Select a Type from the drop down menu. 

2. Give it a unique ID name. 

3. Specify the size you want your new NodeClass to be. 

NOTE : In the above image two NodeClasses were created, Agent and 
Knowledge. 

NOTE : The [Remove] button will remove that particular NodeClass from the 

screen. It will not affect any other NodeClasses. 

Continue creating all necessary NodeClasses. 

Step 3:  

As with NodeClasses this step is for creating all necessary Networks. Click the 

[New] button to insert a new Network. 
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1. Select a Source ID and a Target ID from the drop down menus. 

2. Give it a unique Network ID name. 

NOTE : The employee x employee network was called works with while the 

employee x skill was called employee x skill. 

NOTE : The [ X ] button will remove that particular NodeClass from the screen. It 
will not affect any other NodeClasses. 

Continue creating all necessary Networks. When you are done click the [Finish] 

button. You will see you newly created Meta-Network in the Meta-Network 
Manager Pane 

 

When you are finished you can use the ORA Editor to type in information of use the 

Data Import Wizard to import information from externally created CSV files. 

 

Import Matrix Data 

Creating the Blank Meta-Network 

Data in a Matrix form (In excel or text delimited format) can be imported via 
the Data Import Wizard. Open the wizard by selecting File > Data Import 

Wizard. 
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Select Rectangle of link weights option then click [Next >]. 

 

Select the Create a new meta-network with ID: and give it a new name. Then 

click [Next >]. 
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The data in the example is an agent x agent type so the Source Type and the 
Target type are set to Agent. ORA will automatically fill in the Network ID as 

Agent x Agent. You can change this name if you want. Click [Finish]. 

 

The Meta-Network Manager Pane now contains a new Meta-Network with the 
imported Network and in the process has created a new NodeClass. You can 

examine these in the Editor. For now the Node ID and the Node Title will be 
identical. This can be adjusted when additional attributes are imported. 

NOTE : To import additional matrix files follow the above procedure except use the 
Add to the existing meta-Network option as shown below. 
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Click the [Browse] button to select the file{s) to import. Set the Source type and 
the Target type for each file imported. To add more Networks click the [Click to 

import from another file] button to add another Network. 

 

When you have imported all your Networks click the [Finish] button. You modified 
Meta-Network can be viewed in the Meta-Network Manager Pane. 

 

Import Attribute Data 

After a Meta-Network is created and Networks have been imported it's time to 
import Node Attributes. Select File > Data Import. From the dialog box select 
Import existing data? > Table data from Excel or text delimited formats > 

Simple table > Node attributes. Click [Next >]. 
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On the next screen click the Meta-Network to add attributes to. Then click [Next 

>]. 

This brings up the next screen for adding the attributes. 
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Step 1: Click [Browse] and select the file with the attributes for the Meta-

Network. 

Step 2: Select the Use this column for node IDs. The data file should contain a 
first column of node IDs for Agents. Each row should contain the attributes for 
those agents. 

Step 3: Select the attributes to import by placing a check mark next to the 
attribute's name. Next select the Type for each attribute. 

Step 4: Place a check mark next to the NodeClasses to add attributes to. 

Click [Finish] to import. 

After the import the nodes in the selected NodeClass will contain new attributes. 

 

Import Keyframe Data 

Importing GCC Timeline data into ORA 
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ORA can import data from a CSV file into a Dynamic Meta Network of keyframes. IN 
this example each has an Agent x Resource and an Agent x Agent network. The 

AA = AR * RA network computed using the Matrix Algebra Tool. 

Open the Data Import Wizard using File > Data Import Wizard [ Ctrl + W ]. 
Then select the option below. 

 

Configure the final Data Import Wizard page per the picture below:  
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I import AR and then RA, which contain the same links but transposed so that I 

can then easily multiply to get AA = AR*RA. This is how the Matrix Algebra Tool in 
ORA functions. To multiply by a transpose you must create an intermediate 
transposed matrix. 

Select Data Management > Matrix Algebra menu open the Matrix Algebra Tool. 

Select the options below for each keyframe in the AxA network. 
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Select Visualization > Measures Over Time. Plot the density of the AA network 
to see that the networks are not all empty.  
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Import Simple Table Data 

Select File > Data Import Wizard. Then select Import existing data? > Table 
data from excel of text delimited formats > Simple Table > Networks, 
nodes, and node attributes.  
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Import Arbitrary Database 

ORA can import data from other databases such as MySQL. This is done through 
the Data Import Wizard. You will need to configure your database via an ODBC[1] 

connection, and place the jODBC driver into the requisite ORA JRE installation 
folder. 

If you want to write a dynetml file to a database, such as one in MySQL, then you 

would use File Manage CASOS Database. 

The jODBC installer deploys the following files: 

jodbc.dll jBASE ODBC Driver Library 

libjODBCSetup.dll jBASE ODBC Setup Library 

jODBCManager.exe jBASE ODBC Manager 

ACE.dll ACE (Adaptive Communication Environment) Libraries 

ACE_SSL.dll   

libeay32.dll OPENSSL Libraries 
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ssleay32.dll   

icuuc40.dll ICU (International Components for Unicode) libraries 

icudt40.dll   

NOTE : The ODBC installer copies the ODBC driver and setup libraries under the 

Windows\System32 directory. 

ODBC Setup library is a separate library implementing the ODBC Setup API 
required by the driver manager to display graphical components such as connection 
dialogs. Connection dialogs enables users to configure DSNs inside Windows' ODBC 

Manager (odbcad32.exe) or input connection details when requested by the driver. 

jBASE ODBC Manager is a small console application used to register the ODBC 
libraries with the system, create/remove DSNs or test a connection to a remote 

jBASE instance. Please run jODBCManager -h to obtain more information on how 
to use this utility. 

Installing the driver 

The ODBC installer will automatically register the ODBC driver and ODBC Setup 

libraries. The registration process is required to inform the ODBC Manager about 
the location of the ODBC driver libraries. The ODBC installer will also add the 
installation directory to the global user environment variable PATH. This is 

necessary since the jBASE ODBC driver depends on other shared libraries as e.g. 
ACE, etc. 

When installing on Windows 7 x64, the following extra steps are required: 

Start a command shell as Administrator. 

Navigate to the directory where you installed the driver then run the following 

'jodbcmanager' command. 

C:\Program Files (x86)\jBASE ODBC Connector>jodbcmanager -i -
driver="C:\WINDOWS\system32\jodbc.dll" -
setup="C:\WINDOWS\system32\libjODBCSetup.dll" 

Configuring DSNs 

ODBC applications usually obtain the connection details from DSNs which may be 
configured via Microsoft's ODBC Data Source Administrator (also known as ODBC 

Manager / odbcad32.exe or Control Panel > Administrative Tools > Data Sources 
(ODBC)) 

When installing on a 64 bit client, the version of ODBCAD that should be used is the 
version in c:\windows\syswow64 
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If the installation has been successful, the following driver should appear in the list 
of available ODBC drivers: 

jBASE ODBC Driver 

Adding a DSN for this driver will present the following dialog: 

 

Most of the parameters shown in the previous picture refer to the connection details 
required by the remote jAgent instance. Server specifies the IP/machine name and 

Port specifies the TCP port of the remote jAgent instance. 

Please refer to the jAgent user guide for more information about the available 
options. 
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Pressing the test button will attempt to establish a connection to the server using 
the provided user/account credentials. If the driver is not correctly registered with 

the system or the PATH environment variable does not contain the path to the 
installation directory, the following message box will appear: 

 

Connection strings 

Connection strings, as defined by the ODBC SQL CLI, specify the connection 
parameters supplied to the server when attempting to establish a connection. All 

connection attributes are defined in a single string separated by semicolons. jBASE 
ODBC Connector accepts the following attributes: 

DSN Data Source Name 

DRIVER Name of ODBC Driver. Must be jBASE ODBC Driver 

DESCRIPTION DSN Description 

SERVER Server Address 

PORT jAgent Port Number 

UID User ID 

ACCOUNT 
jBASE Account. User Authentication will be used if this field is 
blank 

PWD User/Account Password 

SCHEMA Schema Name. used. Reserved for future yse 

SSL 
Enable SSL Encryption (1 = Enable SSL, 0 = Disable SSL 
[default]) 

SSL_CERTIFICATE Path to SSL Certificate File 

SSL_KEY Path to SSL Public Key File 

COMPRESSION 
Enable Data Compression (1 = Enable comp., 0 = Disable 
comp. [default]) 

COMP_THRESHOLD Compression Threshold. Default = 1024 byte 
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DSN, DRIVER, UID and PWD are attributes defined by the SQL CLI, all other 
attributes are jBASE ODBC Connector specific attributes. Attributes highlighted in 

bold are mandatory attributes. 

Example: 

DSN=T24;SERVER=127.0.0.1;PORT=20002;UID=test;PWD=test 

 

Import From Other Tool 

UCINET 

UCINET has been supported for many years, both import and export. 

There are different data formats grouped under term UCINET.  

The DL protocol is a flexible language for describing data and itself encompasses a 
number of different formats. Three of these formats - nodelist, edgelist and 

fullmatrix. nodelist is a file with node desccriptions. edgelist is a file with link 
descriptions. fullmatrix is a file which contains both. 

NOTE : The Italicized text is for reference only. 

DL 

FORMAT = FULLMATRIX The type of data 

N = 3 The Number of Nodes 

NM = 1 The Number of Matrices 

LABELS: Node Names 
ALPHA 
BRAVO 
CHARLIE 
 

MATRIX LABELS: Matrix names 
FRIENDS 
 

DATA: The Actual Data 
0 0 1 
1 1 0 
1 0 1 

VNA - NetDraw format 

Note that the values do not need to be numeric. They should all be separated by a 

comma, space or tab. Values that contain spaces should be enclosed in quotes as 
in "Bill Smith"). 
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VNA files are ordinary text files. They consist of sections called star sections. Not 
every file has to have every possible star section, and sections can be in any order. 

At the moment, there are 3 possible star sections (soon to be 6). They are:  

*node data : Describes the actors in a network 
*node properties : Descrubes the display characteristics of the node 

*tie data : Contains dydadic data among pairs of nodes 

*node data 
id gender role age 
Alpha male leader 56 
Bravo female follower 22 
Charlie male follower 34 
  
*Node properties 
ID x y color shape size 
Alpha 1094 415 255 1 10 
Bravi 84 742 255 1 10 
Charlie 1224 996 255 1 10 
  
*tie data 
from to friends advice 
Alpha Bravo 1 3 
Bravo Alpha 0 1 
Alpha Charlie 1 2 
Bravo Charlie 0 6 

These formats can be imported via the Data Import Wizard > Data from 
another network analysis tool, and exported with the Data Export tool. 

 

Import SQL 

To configure the SQL Server database, follow this procedure: 

1. Download the JDBC driver for SQL Server from 
http://msdn.microsoft.com/en-us/sqlserver/aa937724. 

2. Install the JDBC driver (which just unzips the file). 

3. Go to the installation JDBC folder and get these two JAR files:  

sqljdbc.jar and sqljdbc4.jar 

4. Place these two jar files (or the equivalent thereof based on his install) in 
location C:\Program Files\ORA\jre\lib\ext\ 
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Data Export 

ORA can export your Meta-Networks to a variety of formats. 1] Select a Meta-
Network. 2] Select an Output Format. 3] Click the [ Browse ] button to select the 

destination. When finished click the [ Export ] button. 

 

NOTE : Some of these are all proprietary formats and can only be opened with the 
proper program. 

Analyst Notebook : Exports two .CSV files. One for Entities, and one for Links. 

C3Trace : Exports one .xls file. This spreadsheet will contain multiple sheets 

depending on the amount data in your original Meta-Network. 

CMapTools : Exports a single file in the .CXL format 

CSV : Exports one .CSV file for each Nodeclass and Network. 

Pajek : Export one file in the .net format for Pajek. 

UCINET - Binary : Exports files int ##d and ##H format for use in UCINET. 

Creates two files for each Nodeclass and Network. 

UCINET - Text : Exports one .dl file for each Nodeclass and Network. 
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Saving Your Files 

 Save Meta-Network 

This option is initially grayed out when you first load a Meta-Network. This signifies 
that the Meta-Network is currently unchanged. Whenever you make ANY change 

within he Meta-Network the option will become full-color indicating it is time save 
changes.  

After clicking the icon in the toolbar, or selecting the menu item, it will become 
grayed out again till you change your Meta-Network once again. 

No change needs saved in the Meta-Network 

 

Changes made to Meta-Network and need saved 

 

Save Meta-Network As... 

If you need to save a Meta-Network under a different name use select File > Save 
Meta-Network As.... This will leave the original file intact and create a new Meta-
Network with the new file name. 

 Save Workspace 

While working with multiple Meta-Networks you may want to retain the information 

of what files you had open for later use. Saving your workspace creates a file which 
can be opened later and will recreate your workspace as before. 

From the Main Menu select File > Save Ora Project. After selecting [OK] on the 

initial dialog box the Save Ora Project dialog box will appear. Navigate to the 
folder where you want to save your workspace. 

This Workspace can then be called up with the Load Workspace in a future session. 
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CASOS Email Parser 

CEMAP belongs to the family of Extract, Transform, and Load software. It is 
designed to extract data from electronic sources in their native formats and make it 

possible to load into the target software system. 

CEMAP can be used in either Interactive mode or Hands-off Batch mode. In the 
interactive mode, users can design the output datasets in a repetitive fashion with 

minimal effort—the software is designed with the realities of the analytic workflow 
in mind. As a batch process, CEMAP can be set up to execute in an automated 
fashion, for example, to extract one’s email network every night at midnight. 

CEMAP separates much of the technical detail from the analytic detail allowing the 

user to use the individual parts of CEMAP which they understand. 

The inner workings consist of three vital elements: templates, tablesets, and 
template/tableset mapping. Brought together they form a profile. 

A template describes the endprocess, output files that CEMAP is being asked to 

create for later loading into the downstream or host software. 

A tableset describes the technical elements necessary to extract the raw source 
data. 

The tableset-to-template mapping contained with a profile expresses the 

manner in which the output of the tableset is logically connected to the input of 
the template. Critically, the output of the tableset is a set of one or more 

relational data tables (think excel spreadsheet) and the input to the template is 
a set of one or more relational data tables. The mapping simply describes the 
connection between the tableset output and the template input. The profile 

contains all of this information in one logical construct. 

CEMAP is an ORA tool that primarily allows you to pull network data in the form of 
emails into ORA. However, the CEMAP tool could be used to convert any sources of 

data in the world into DyNetML, ORA's native file format, for analysis.  

Setting up CEMAP is similar to setting up a new ISP mail client. What follows are 
procedures to configure this tool and how to use it.  

IMPORTANT NOTE : Before attempting to download emails from Gmail your Gmail 

account needs to be set up for IMAP. Information on that procedure is contained 
on the Google site. 

Email Dates 
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Each email has an identifying number in a long number showing the date, for 
example: [20060308042751s1500bii66e]. The 20060308 is in the 

year/month/day format and says this email was sent on March 8, 2006. 

The CASOS Email Parser (CEMAP) that is launched through AutoMap/ORA 
(http://www.casos.cs.cmu.edu/projects/automap/software.html) enables the 

extraction of different types of network information from emails (e.g. who 
exchanges information, who provides what information, etc.). 

 

CEMAP - Interface 

Starting CEMAP 

From the main menu select File > CEMAP.... The following interface will appear 

 

Profile Mgmt.Menu 

Load Profile : Select a Profile from the built-in list. 
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Save profile to original location : Save the currently loaded Profile back to it's 
original location. 

Save profile to file as... : Save a Profile to a new location. 

Reload Active Profile : Not Currently Implemented 

Clear Current profile : Not Currently Implemented 

Reload user's startup profile : Loads the user's Profile 

Load default startup profile : Loads the default Profile 

Save active profile to file as... : Saves the currently loaded Profile. User can 
select new name for this Profile. 

Options 

Save your user profile :  

Activate CASOS Remote Debugging :  

Activate CASOS Remote Execution :  

Save passwords in Profile saves :  

Help 

 

CEMAP Profile 

What is a Profile 

CEMAP contains many built-in profiles. These are sets of instructions for extracting 
data from web site APIs needing onlu minimum information from the user. 

Profiles 

You will mostly work with the built-in Profiles for extracting emails and other data 

from web site APIs. CEMAP contains many specialized profiles but also many 
general profiles which can be customized to suit you needs. Let's concentrate on 
some of the more useful profiles. 

Select the Profiles tab. Click the [ + ] next to Build-in Profiles then the [ + ] 

next to Email. Here is a list of the most common email types.  
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EML : Email attachments, IMAP  

IMAP : Internet message access protocol one of the two most prevalent 
Internet standard protocols for e-mail retrieval. This allows users to access 

emails from a remote server. 

MBOX : A generic term for a family of related file formats used for holding 
collections of electronic mail messages. 

POP3 : Stands for Post Office Protocol 3 which is used by local e-mail clients 

to retrieve e-mail from a remote server over a TCP/IP connection. 

gmailIMAP : Similar to IMAP except specifically geared toward retrieving emails 
from the Gmail server. 

Microsoft Exchange Server : An e-mail-based collaborative communications 

server for businesses. 

Microsoft Outlook Extract : A personal information manager from Microsoft, 
available both as a separate application as well as a part of the Microsoft Office 

suite. 

 

CEMAP - Email 

Cemap is an email client. If it fails to download emails that means that one or more 
of these parameters is wrong: (a) the server imap.gmail.com, the user id, or the 
password for the user id. --or-- that the host computer (running cemap) simply 

could not connect to the Internet to get to the email server, which doeas happen 
with any email client rather often. Most email clients will automatically retry this 

connection process without the human even knowing it. CEMAP will not do the 
auto-retry. 

Procedure 
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From the main menu select File > 
CEMAP.... This brings up the 
CEMAP dialog box. 
 

Expand Build-In Profiles then 
expand Email then highlight 

gmailIMAP. 
 
Click the [ Select Profile ] button. 

 

Click the Templates tab. Here are 
the optional material which can be 
extracted from gmail. To extract 
this, right-click on any of the red-

colored entries and select Toggle 
Activation Setting. 

 
Click the [ Execute ] button. 

 

Fill in your UserID and your password. CEMAP defaults to your INBOX but you 
can change to any folder. When finished click [ Continue ]. 
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CEMAP will now begin processing. When finished a Parsing Finished alert will 

appear. 

NOTE : Depending on the number of emails it needs to extract the process could 
take a fair amount of time. 

The resulting XML file can be opened up directly in ORA. 

 

CEMAP Profile 

CEMAP can obtain data from Facebook using APIs from the Facebook platform. With 
it it can create an Ego-Network of the subject's friends. CEMAP's purpose is to 

transform real-world data into relational network data. You use the interactive 
interface to create a profile. Then you can tweak that profile for your needs. Finally 

you can save that profile for future use. The use indicates the source of the data 
and that is made available to CEMAP to create a Tableset. 

In Your Browser 

Go to the CEMAP Facebook site: http://cemap4ora.com/facebook/. 

Follow directions to allow permissions: 

http://www.cemap4ora.com/facebook/grantAccess.html. 
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NOTE : This is important for first time CEMAP users. Facebook requires you to 
grant access first. 

NOTE : This does not function in Internet Explorer. You will need to switch to an 

alternate browser to perform this funtion. 

Click the connect button to get your key: 

<<<< Click here to obtain your special key 

If you are not logged into Facebook a login screen will appear. Type in your Email 
and Password. 

A window will appear with a User Session code [This example has the code blurred 

on purpose]. 

 

Copy this code for use in CEMAP. 

In ORA 

Open CEMAP in ORA File > CEMAP... 

In the CEMAP window highlight Built-In Profiles -> General -> facebook. Then 
click the [ Select Profile ] button. To run the function click the [ Execute ] button 

in the lower right of the window. 

Fields Editor -- DIALOG [1] 

NOTE : This dialog will appear only the first time you access this function. 

Click the [ Location to Store Network File ] button. Navigate to the location you 
want to store the file and type in a name in the textbox. 
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NOTE : You need to type in the .XML extension. 

Click [ Continue ]. 

Fields Editor -- DIALOG [2] 

Leave both apiKey/secretKey as default. 

Paste your userSessionId you obtained from the web page into the 

userSessionID field. 

Click [ Continue ]. 

CEMAP will start Parsing the data from Facebook. When it is finished a new Meta-
Network will appear in the Meta-Network Pane titled Facebook Profile. 

The Meta-Network is ready to be used the same as any other Meta-Network. 

Example of a Facebook Network 

NOTE : When you click continue, ensure that 1) You have no tab/window open to 

Facebook; 2) You are logged in; and 3) The window with the session key is open. 

 

 

Pile Sort 

The PileSort module allows a user to load a series of entities such as concepts or 
people's names. These entities are displayed in a deck, which can then be 

organized and grouped into a pile, which will contain entities that are similar to one 
another. The output of the PileSort module will be a network in DyNetML format. 

The user can use either a text editor of a spreadsheet to create a two-column 

comma-separated file (i.e. a .csv file). The first column contains the concept and 
must not be blank. The second column is optional and can contain metadata. 

NOTE : Concepts can not contain embedded commas. 

Pile Sort GUI 
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Pile Sort Interface : consists of two panes: The Side Deck and the Canvas. The 
Side Deck displays cards that have not been organized into piles, such as initially 
when the input file in read. The Canvas contains the piles where the cards are 

placed from the Side Deck. 

Pile Sort Menus 

 

File > Load a File : Navigate to a directory with a new Pile to Sort. 

 

File > Exit : Leave the Pile Sort program. 

 

Edit > Add an Empty Pile : Creates an additional empty pile on the 
canvas. 

 

Generate > Create a Network DyNetML File : Creates a DyNetML file 
from the current state of organization. All cards in a pile are fully 

connected and cards remaining in the deck are isolates. 

 

Help > Show Help Topics : Accesses the ORA Help files 
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Other Functions 

 

Add Card : takes the concept that has been filled into the text field next 
to the [Add] button and creates a card with that name at the end of the 
card deck. 

 

Transfer All Cards to Another Pile : Click and hold the icon of a pile and 
drag it to another pile. All cards in the first pile will be transfered to the 
new pile. 

 

Cycle Through the Cards in the Pile : Rotates the cards in a pile that 
the card currently beneath the currently highlighted card becomes 

highlighted. The newly highlighted card becomes the pile's representative. 

 

Return Cards to the Side Deck : Removes all cards from a pile and 
returns them to the side deck. 

 

Mark a Card as a Pile's Representative : marks the currently 
highlighted card as a pile's representative. 

 

Move Card to Another Pile : Click and hold a card in a pile and drag it to 
another pile. 

 

Click to Add a Title : allows the entire pile to be given a name. Either 
click on the title bar or use the drop down menu item. 

 

Drag and Drop Here : allows the user to drag cards from the side deck 
onto a pile. 

Loading a list of concepts :  

All piles are initially empty. The concepts appear in the side deck to the left. A 
scrollbar will appear if the number of concepts is greater than the screen length. An 

empty pile contains the banner drag and drop here signifying an empty pile. Once 
a concept is placed in a pile it will all concepts will be displayed in it's window. 

NOTE : To have duplicate concepts in more than one pile requires the creation of 

duplicate cards. 

NOTE : You can leave cards in side deck. Any card not so placed will become an 
isolate in the resulting network. 
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Viewing in ORA 

Saving a sorted Pile : Sorted piles are saved to the DyNetML format. Networks 

are formed from the individual piles which include the metadata from each card. 

Viewed in the Editor you can see all the saved information from Pile Sort. The 
column containing_pile is the name you gave the pile into which a card was 

placed. meta-information is the optional second column from the .CSV file 
originally loaded into Pile Sort. If that was empty, then the meta-information cell 

would also be empty. 
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Clicking the [Visualize this Network] button displays your Pile in the ORA 
Visualizer. How networks are formed is based upon the cards placed in each pile. 
The four cards not placed into a pile (cuttlefish, seal, sea horse, and shark) became 

isolates in the Visualizer. 
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Edit Menu 

The Copy/Paste functions are dynamic in nature. ORA understands what you have 
highlighted and will copy it onto the clipboard. Whatever is currently in the 

clipboard can be copied back into ORA any number of times. 

The first two options are to Copy/Paste Editor values. 

 

The copy function will place a copy of whatever is currently highlighted 
into the clipboard. That will remain until another item is copied. 

 

The Paste function will create a copy of whatever is stored in the 
clipboard. This can be repeated as many times as necessary. 

NOTE : ORA's menus change as different items are highlighted.. They also change 
after something has been copied. If a NodeClass had previously been copied the 
menu item will change to Paste NodeClass. If you then copy a Meta-Network the 

menu item will change to Paste Meta-Network. 

 

Preference Menu 

The View Menu shows a log of all activity performed in ORA. 

 

Defaut Layout : Resets the Editor GUI layout to its default panes 
position. 

 

Change Font : Allows you to change the GUI font to any font on your 
system. Be careful with the font chosen as some fonts are built more for 

custom design rather than readability. 

 

Load Font : Add font to use for the ORA display. ORA will ask whether to 
make this the default font. If Yes the the GUI will be displayed with the 

new font. These loaded fonts can be found in C:\Documents and 
Settings\{username}\Ora Fonts. 

NOTE : Some fonts may make reading the GUI difficult. Take note of your previous 
font before making any changes. 
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Event Log : The log maintains a list of all actions performed in ORA. This 
allows you to review steps that were taken during a particular time. 

NOTE : The report pane must be visible in the GUI to view the log. This pane can 

be reinstalled by selecting View > Default Layout. 

 

Measures : Allows you to select the type of measures to run. 

Use only fast measures :  

Do not use slow measures :  

Scale measures as percentages (like UCINET) :  

 

Other : Contains settings for controlling the environment for working 
within ORA. 

General 
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Enable tooltips toggles whether the tooltips are shown when you hover over an 
object. 

Restore docking window layout will restore any changes you've made to the 

GUI layout. Unchecked at time of closing will result in ORA going back to it's default 
layout. 

Look and Feel Classname  

Large toolbar icons  

Datasets 
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Maximum Meta-Networks to fully load  

Load DyNetML sources  

Load DyNetML link properties  

Specify set of files to load at startup gives three options. 1) Do not load any 

files at startup starts ORA with an empty Meta-Network pane. 2) Restore 
previously loaded workspace files at startup loads the files stored in the 
Workspace file. 3) Load specified files below allows you to pick which files you 

want loaded the next time you start ORA. 

Reports 
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Select reports display as list of all reports available. Check marked reports will be 
used in the report generator. Report names can be changed by right-clicking a 

report and typing a new name. There is a Reset report names button which 
changes all names back to their default. 
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You can type in text for the header and footer of your reports. It will appear on 
all pages. The Decimal precision controls the number of decimal places for all 
numbers. 

Custom Reports 
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Allows you to name, describe, and set up the measures to be used. If there are 
variable parameters for a measure they can be set also. If you have created any 
previous Custom Reports they will appear in this window. This is where they can 

be Modified or Deleted. 

 

Preferences Panes 

 Preferences are global variations which control aspects of how ORA works. 
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General 

Enable tooltips Toggles whether tooltips are shown when you hover over an 
object. 

Restore docking window layout Restores the layout to the default settings. Any 

changes you've made to the GUI layout will be removed. If it unchecked at time of 
closing the program ORA startup in the defulat arrangement. 

Look and Feel Classname : Sets the style of the ORA GUI. 

Large toolbar icons : Placing a checkmark toggles between using the 16x16 or 

24x24 icons. 

Data Sets 
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Maximum Data Files to Load : Tells ORA the maximum number of files to load 
upon start-up. The checkboxes let you select what to load from the individual Meta-

Networks. 

Load DyNetML sources :  

Load DyNetML link properties :  

What To Load : You have three options for loading files when ORA is started up. 

Do not load any files at startup : Ignores any files that were loaded during 
the last session. 

Restore previously loaded workspace at startup : Loads the files that were 

current when ORA was last shutdown. 

Load specified files below: Loads the files specified in the box below the 
option. 

Reports 
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Selecting Reports to Display : Any reports with a checkmark will appear in the 
report generator window. Check marked reports will be used in the report 

generator. Report names can be changed by right-clicking a report and typing a 
new name.  

Reset report names : Resets the names of all reports back to their default names. 

Import/Export Settings : These two buttons are used if multiple people work on 

the same computer. Each individual can use the Export Settings button to export 
the settings they are using at the end of a session then use the Import Settings 
when they return to the computer. 
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You can type in text for the header and footer of your reports. It will appear on 
all pages. The Decimal precision controls the number of decimal places for all 
numbers. 

Decimal Precision : Sets the precision to which results are calculated. 

Enable Flash Charts : Toggles whether Flash charts will be rendered in reports. 

Custom Reports 
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The Create, Modify and Delete buttons. 

Allows you to name, describe, and set up the measures to be used. If there are 
variable parameters for a measure they can be set also. If you have created any 

previous Custom Reports they will appear in this window. This is where they can 
be Modified or Deleted. 

 

Data Management 

These sets of menu items enable you to control the addition or removal of Meta-
Networks, Meta-Nodes, and Networks as well as adding Attributes to a Meta-Node. 

Matrix Algebra, Meta-Network Transform, and Meta-Network Union... also create 

new Meta-Networks, Meta-Nodes, and Networks but do it with Mathematical 
operations. 

 

Matrix Algebra... : Performs mathematical operations on two Meta-
Networks. 

 

Meta-Network Transform... : Cleans up a visualizer display making it 
easier to read. 



 

207 
 

 

Meta-Network Anonymize… – Resets the NodeID (and optionally the 
Node Title) to anonymous values. 

 

Meta-Network Union – Creates a single Meta-Network from two (or 
more) existing Meta-Networks. 

Meta-Network 

 

Add New Meta-NetworkUsed for adding or removing Meta-Networks 
from use. 

 

Remove Selected Meta-Network : Removes any Meta-Network which is 
currently selected. 

NodeClass 

 

Add New Node Class... : Enables you to add, remove Node sets, as well 
as, change the size of the Node set. You can also add an Attribute to an 

existing Node Set. Depending on what you have selected different options 
may be greyed out. 

 

Remove Selected Node Class : Removes all selected NodeClasses from 
the Meta-Network along with any associated Networks. 

 

Add Attribute... : Creates a new attribute in a NodeClass. You need to 

give the attribute a name and also what type of attribute it is: Text, Text 
Category, URI, Number Category, Number, Date. 

Network 

 

Add Blank Network... : Similar to Node Class in that you can add or 
remove Networks. This function also enables you to Set the Diagonal of 
a graph to either -1, 0 or +1. Useful for setting consistent values on an 

agent-by-agent Network. 

 

Remove Selected Network : Removes all selected Networks from the 
Meta-Network. 

 

Set Diagonal : Allows user to constant values to the diagonal of a square 
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network. If Binary View is chosen you can pick True (+1), False (0), or 

True (-1). If Numeric View is chosen you can set the diagonal to any 
value. 

 

Attribute Partition Tool : Creates new Meta-Networks from existing 
Meta-Networks using a node attribute. 

Infer Links... 

 

Beliefs :  

 

Randomize Links : A new Meta-Network is created with identical 
NodeClasses, and with networks of the same size and density, but with 
links distributed randomly according to Erdos-Renyi. 

 

 

Network Algebra 

 Network Algebra allows you to perform mathematical operations on two 

Meta-Networks. The options in ORA are addition, subtraction, and 
multiplication. These functions help spot strong and weak connections within a 
Meta-Network. 

NOTE : The term Network Algebra is synonymous with Matrix Algebra in 

computational parlance. Also, the following images display Matrix Algebra in the 
title bar. This may or may not be the case for the most recent version of ORA. 

Matrix Algebra Definitions 

Matrix Multiply : Technically this is the outproduct.  

Inner Product : This is a form of matrix multiplication, sometimes referred to 

as the dot product. Both matrices must be of the same dimensions - e.g, both 
10 x 5. The resulting matrix will be of the same dimensions. For the inner 

product each term is simply multiple by it's corresponding term in the other 
matrix.  

I start with one Network loaded. 



 

209 
 

 

From the menu select Data Management ⇒ Network Algebra… 

The Network Algebra dialog appears. There are six areas which you can manipulate. 

These are each described below the dialog box. 

Note : Both Networks should be the same dimensions. 

1. Select a Meta-Network 

 

This dropdown menu will show all the Networks you currently have active. To 
perform a math function on a Meta-Network, highlight it in the dropdown 

menu. 

2. Select an Operation 
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This option allows you to choose which operation, Add, Subtract, or 

Multiply, you want to perform on the Networks. 

o Add: Adds together corresponding cells of two different Networks. 

o Subtract: Subtracts corresponding cells of two different Networks. 

o Multiply: Multiplication is slightly different than the add or subtract. 
The number of rows in the first Meta-Network must equal the number 

of columns in the second. A Meta-Network can be multiplied by itself 
to help reveal specific strong and weak areas. 

 Add Networks:  

 Subtract Networks:  

 Multiply Networks:  

 Dot Products Networks:  

 Set the Diagonal:  

 Add by a Scalar:  

 Subtract by a Scalar:  

 Multiply by a Scalar:  

 Divide by a Scalar:  

 Transpose:  

3. Select Network 1: 

Next select the first Network you want to work with. 
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4. Select Network 2: 

Then select the second Network to do the algebra on. 

 

5. Add Network: 

If you wish, you can add additional Networks to the equation. Different 

selections in the previous choices will give you different options in each 
dropdown. 

 

6. Enter a name for the new Network: 

When everything is set, type in the name for your new Network. 

Finally, select [OK] to create you new Network. You can then create more 
Networks if desired. When done, select [Cancel] to remove the dialog box 

from the screen. 

Your new Network will now appear in the box with your Meta-Network. Next 
highlight the Network you just created. 

 

Next, select the [Visualize Only this Network] button 
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You will get a warning box asking if you're sure you want to visualize only one 

Network. Select [OK] to run the visualizer or close the box. 

 

This will bring up the visualizer displaying the Network. Your display will depend on 
the Network selected. In this particular example there are only Agents and Links 

connecting Agents displayed in the Visualizer and the Legend. 

 

 

Now we'll create a second Network by using the multiply operation. The second 
Network will put knowledge into the mix. 
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Note : Remember to name your file something different. 

 

Highlight your newly created Network and select the Visualize Only this Network 
once again and select OK in the dialog box. 

 

This time, since a Network with knowledge was selected the Visualizer and Legend 
display both Agents and Knowledge and also the Links connecting them all. 
Also the Matrix Algebra selected was multiplication it creates links which were not in 

the original Network. 
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Meta-Network Transform 

 On some occasions the display in the Visualizer is too cluttered to make much 

sense of your network model. ORA offers a variety of ways to clean up the display 

in order to make it easier to view your data. 

In the main menu select Data Management > Meta-Network Transform…. 
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The Meta-Network Transform dialog box will appear. It consists of three 

sections. The top section display a dropdown menu with all the currently active 
Meta-Networks. Use this menu to select the Meta-Network. The bottom section has 

two tabs. The Entire Meta-Network contains choices on how to transform the 
Meta-Networks. The Individual Networks tab allows you to select to work on 
only individual networks. 

The "Entire Meta-Network" tab 

This tab contains funtions which work on all nodeclasses and networks. 

Remove isolates based on : allows you to remove isolates from the entire Meta-
Network or from an individual Network. 

Remove pendants based on : allows you to remove pendants from the entire 

Meta-Network or from an individual Network. 

Symmetrize by method : turns directed or asymmetric network data into 
undirected or symmetric data. All three methods use a pair of values from the 
upper and lower portions of the table (e.g. cell 1, 3 is compared to cell 3, 1). If 

a network had a link from A to B but not from B to A then symmetrizing the 
network would create a reciprocal link from B to A. 

 Maximum Compares the values and uses the larger of the values. This is 

called using the strongest value. 
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 Minimum Similar to Maximum only it uses the lower, or weaker, value. 

 Average takes the two values and averages them. 

Create a Reduced Form meta-network :This is used to reduce the number of 

Networks in a Meta-Network when Link direction does not matter. 

Remove Links :When using weighted links this functions allows for links to be 

removed from view based on link weight. You can choose from six options for the 
removal of links. 

 

Binarize (set link weights to one) :Takes all links weighted greater than [0] and 
make them all equal to [1]. All links will be either [1 or 0]. 

Create partition Networks by attribute :This partitions the Node Set according 

to the values of the specified entity attribute and then creates a group of new 
graphs based on the partitioned Meta-Node. This kind of grouping is often done in 
network analysis to understand how some Meta-Nodes are embedded in various 

social roles or how they interact within larger Meta-Nodes. The dropdown menu will 
contain all the attributes in the meta-network. 

Example, if you have an Agent Meta-Node that has a gender attribute for each 

node that takes on values male and female, then using this feature four new 
Agent x Agent Networks would be created that contained links from males to males, 
males to females, females to males, and females to females. No new Meta-Node is 

created and no data is changed. 

Create union matrices : Creates new networks that are the union of all networks 
of the same type. If the Meta-Network had two Agent x Agent Networks, then using 

this feature would create a new Agent x Agent Network which would contain all the 
links that were present in the original two Networks. 

Combine into a meta-network with one nodeclass and one network : 

Creates a new Meta-Network with a single NodeClass and a single Network. The 
nodes are prefixed with the name of the NodeClass they were taken from. 

The "Individual Networks" tab 

This tab allows you to Choose one or more networks to transform by placing a 

checkmark in the box. All marked netowrks will be processed. 
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Then select one or more transformations to apply : 

Symmetrize by method : turns directed or asymmetric network data into un-
directed or symmetric data. All three methods (maximum, minimum, 

average) use a pair of values from the upper and lower portions of the table (e.g. 
cell 1, 3 is compared to cell 3, 1) 

Remove links : removes links based on one of six options. 

 

Binarize (set link weights to one) : Take all weighted links greater than [0] and 

make them all equal to [1]. 

Transpose the network : writes the rows of network [A] as the columns of 
network [AT] and writes the columns of network [A] as the rows of network [AT]. It 
literally rotates the network 90° then mirrors the image horizontally. 

 

 

Meta-Network Anonymizer 

 Meta-Network Anonymize tool removes IDs (and optionally Titles) from any 

chosen NodeClass. This is particularly helpful if you are discussing sensitive network 
information about real people and wish to remove their names from the network 

model.  
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The Visualizer 

Visualizer Before Anonymizing : When you load your network model into the 
Visualizer, you will see (by default) the names of your agents or applicable entity 

class nodes. You may, for a number of confidentiality reasons, wish to hide this 
information from your audience yet still show them visually what the network can 

reveal.  

 

Visualizer After Anonymizing : None of the nodes have recognizable names and 
only the link and network information is known. 
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Meta-Network Anonymizer dialog 

From the main menu select Data Management > Meta-Network Anonymize.... 

The Meta-network Anonymizer tool will appear in a pop-up window. Here you can 
select a number of parameters pertinent to the node classes you wish to 

anonymize.  
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1. Select a Meta-Network : All active Meta-Networks appear in the drop-down 
menu. Select the Meta-Network to anonymize. 

2. Friendly names : The user can create a list for each NodeClass of names 
that will not be anonymized. 

3. Anonymizer values :  

4. Options :  

o Remove alias attribute :  

o Remove latitude/longitude attributes : Removes geospatial 

attributes from the Meta-Network. 

o Anonymize only titles :  

o Create anonymized name attribute : If you would like to use 
descriptions other than Titles or IDS, you can generate your own 

terms. This is intended to be used with the friendly anonymizer tool 
but can be used for whatever reasons you deem fit. To do so, be sure 

the create Name Attribute is checked then enter your own term. 
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5. Anonymize button : Click the button when you are ready to crate an 
anonymized file. 

Writing an Anonymized file : When the [Anonymize] button is selected ORA 

writes a .CSV file. The Save box allows the user to navigate to a directory to save 
the file. 

Encoded ID,Original ID 
A-1,A01 
A-2,A02 
A-3,A03 
A-4,A04 

Node Title : If the Anonymize node title is selected then ORA will also write the 
original Title to the file. 

Encoded ID,Original ID,Title 
E-1,E01,revanna_meeting 
E-2,E02,summit_meeting 
E-3,E03,revanna_bombardment 
E-4,E04,sgc_meeting 

 

 

Meta-Network Clean 

When large datasets are created people's names are after written differently 
through many different documents. For example you could see someone referred to 
as John in one documents, John Smith in another doucments, and John W. 

Smith in yet another document. All three of the these names refer to the same 
person but in ORA they would be considered different individuals. 

This function provides additional cleaning for text analysis. The user can select and 

operate on multiple meta-networks at once. The new dialog is under the Data 
Management main menu item. The following functions are available. Select from 
the main menu Data Management > Meta-Network Clean... 

Functions 

Convert LexisNexis meta-network to our standard meta-ontologies. 

Apply Change Lists 

Create Blank Change Lists. 

Workflow 



 

222 
 

Load LexisNexis data called Afghanistan.xml, which is a dynamic meta-network 
in the LexisNexis format typical from Juergen's analyses. Open the Text Analysis 

Cleaner dialog. Select all of the meta-networks in the dynamic meta-network. 
Click [ Next ]. 

 

Select the LexisNexis tab: 
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Click [ Run ]. The following transformations are made: 

1] Node IDs need to be converted to standard node IDs. What happens is: 

Nodes are all converted to Lowercase. 

All punctuation is removed. 

Spaces converted to underscores. 

2] Node class meta-ontologies are changed to those used in Automap. 

3] The meta-networks are made Reduced Form, which means: 

Uni-modal networks are symmetrized. 

Bi-modal networks are combined into a single direction (e.g. AK and KA 

are combined into a single AK, and which node class is first is by convention) 



 

224 
 

Self-loops are removed 

The Results Log of the transformation is available but at this time is not very 
interesting. This becomes more important when a Change List in applied. 

 

Apply A Change List 

Next a Change List is applied to the Agent and Knowledge node classes. These 

meta-ontologies are standard, and the node IDs are standard. You should expect 
the Change Lists to apply well. Click on the Apply Change Lists tab. Click the 

[ Browse ] button and navigate to your change list file. Click the [ Run ] button. 
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As you can see the Results Log is now more useful It shows the number of nodes 
merged, deleted, and moved. 
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Further Change Lists can now be applied ot the Meta-Network. 

Export Change List 

You can now export empty (or blank) change lists that can then be loaded into 
Excel and edited for an iterative cleaning process. Click the Create Change Lists 

tab and place a check mark next to all NodeClasses to export. 
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Results 

This will create a union all of the selected Afghan meta-networks to create 
combined node classes. It will also create a single file per node class by 

appending _agent, _knowledge, _task to the base filename. The 
Frequency column of the newly created (blank) change lists will be populated 
according to this rule: if the node has a frequency attribute, then its value is 

used (it will be summed across meta-networks); otherwise the node's total 
degree is used. 

NOTE : This can easily be misleading, for example, suppose a node exists in all 

the meta-networks, but only in the first one has the "frequency" attribute. This 
frequency value will be used, even though it is based on only one meta-network. 
 

NOTE : Only CSV files are currently used; Excel (.xlsx) will be supported shortly. 
 

NOTE : This dialog could be combined with the Meta-Network Transform dialog 
or perhaps that is not a good idea? Suggestions welcome. 
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Meta-Network Union 

 Meta-Network Union is used to combine two or more Meta-Networks 

together. There are tools to select which Meta-Networks to use or exclude and how 
to combine the link weights. ORA can save out the result as an entirely new Meta-

Network file.  

 

Select a collection of meta-networks : allows the user to define the Meta-

Networks to combine. It has two options. 

1. All meta-networks : will create a new Meta-Network using all the currently 
loaded Meta-Networks. 
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2. Only meta-networks currently selected : will create a new Meta-Network 
using only the selected Meta-Networks. All nodes will be merged into one 

NodeClass and all links will be merged into one Network. 

3. All files in the directory : will create a new Meta-Network from all the files 

in a specified directory. Use the [Browse] button to navigate to the directory 
to use. 

Select filters : narrows the Meta-Networks to use. If the Use only meta-

networks in the date range: is checked you will need to fill in the Begin and the 
End dates. This will filter out Meta-Networks which fall outside those dates. 

Select how to combine edge weights: contains the options for how to reduce 

the amount of edges within a Meta-Network. The options are Minimum, 
Maximum, Average, Binary, and Sum. 

Treat the meta-networks as semantic networks :  

Union link sources and properties :  

The Office-Union 

I have two meta-networks for the office: The Office-staff 
and The Office-temps. Each has the same resource and task 
nodeclasses. 

 
With only these two meta-networks loaded I choose All 

meta-networks and click the [Compute] button. 

 

ORA combines these two meta-networks into one combining 
all the nodeclasses and networks. 
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Potential Problems Using Union 

As great of a tool as this is there are a few things to look out for. First and foremost 
is Node ID conflicts. If the datasets contain radically different information but the 

same Node IDs you could end up with some results that might be confusing. We'll 
use the datasets from Raiders of the Lost Ark and Star Wars. 

On the left are the characters in the raiders of the Lost Ark dataset. To the right are 

the Star Wars Characters. Notice the similarities and differences here. Raiders uses 
characters character_1 through character_9. Star Wars uses Character_1 

through Character_11 Notice the Upper- Lowercase C difference? Winder if that 
will present a problem.. 

Raiders   Star Wars 

 

Characters 

 

Next, the locations. On the left are the locations in the raiders of the Lost Ark 
dataset location_1 through location_19. To the right are the Star Wars 

locations, locations_1 through locations_13. Another difference with Raiders 
using location whereas Star Wars uses locations. That could be a potential 
problem also. 

Raiders   Star Wars 
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Location 

 

So after a Union is run on these two meta-networks the 13 locations from Star 
Wars were combined with the 19 locations of raiders, each with having a separate 
entry. For this situation this is not a problem. But if your datasets contained 
information that needed to match up then you would end up with duplicate entries. 

With the characters we find that the upper- lowercase [C] wasn't taken into 
account. There are still 11 characters. The problem that happened was it combined 
the information from the two datasets. We have Princess Leia Organa has a title 

of indiana_jones. That's definitely a problem. 

Locations   Characters 
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Attribute Partition Tool 

 To create new Meta-Networks which are a subset of nodes use the Attribute 

Partition. Select an Node-Class(es), select the Attribute set, then select the 
individual attribute(s) to form a new Meta-Network. 
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There are four sections to the dialog box: 

Select a Meta-Network: The dropdown menu lists all the currently open Meta-
Networks 

Select Node Class(es): Place a checkmark in the box(es) of the NodeSets you 

want included. 

Select an attribute: This drop-down menu shows all the attribute(s) contained 
within the selected NodeSet(s). If you change the NodeSet(s) the choice of 

attribute(s) will be reflected in this dropdown. 

Attribute Value: Place a checkmark in the box(es) of the attributes you want 
included in the new Meta-Networks. Each attribute check marked will create a 
separate Meta-Network. 
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When you click the [Compute] button ORA will tell you how many new Meta-
Networks were created and you will see them in pane 1 of the GUI. 

Create New Meta-Network Example 

Using the Doctor Who Companion Network I selected the gender attribute. In the 
value section I placed check marks in all three boxes in order to create three new 
meta-networks. When I click the [Compute] button ORA creates three new meta-

networks. 

 

Males 

 

Females 
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Robots 

 

 

Randomize Existing Network 
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 Randomizing Links is commonly done to test a hypothesis about a given 

network. If after conducting experiments, there is no significant difference between 

a hypothesis and a random graph, the evidence supporting the hypothesis could be 
weak. 

A Random Graph : is obtained by starting with a set of n nodes and adding Links 

between them at random. Different random network models produce different 
probability distributions on networks. 

The theory of random networks studies typical properties of random networks, 
those that hold with high probability for networks drawn from a particular 

distribution. For example, we might ask for a given value of n and p what the 
probability is that G(n,p) is connected. In studying such questions, researchers 

often concentrate on the limit behavior of random networks-the values that various 
probabilities converge to as n grows very large. Percolation theory characterizes 
the connectedness of random networks, especially infinitely large ones. 

Random networks are widely used in the probabilistic method, where one tries to 
prove the existence of networks with certain properties. The existence of a property 
on a random network implies, via the famous Szemerédi regularity lemma, the 

existence of that property on almost all networks.  

Creating a Random Graph : is a function which randomizes the Links in a 
Network. From the main menu select Data Management > Randomize Links. 

From the dialog box select from the drop-down menu. A new Meta-Network will 
appear in Pane 1 and it's name will denote it has been randomized. 

 

The original Meta-Network is selected and the Network agent x agent is chosen. 

From the Info Tab in the Editor the button is clicked. This 
displays the Network as it appears in the original Meta-Network. 
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Now select the newly created randomized Network and select the agent x agent 

Network. From the Info Tab in the Editor the button is clicked. 

This displays the Network as it appears in the randomized Meta-Network. 

As shown in the visualizer the links have been randomized. 
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Generate Network 

 

Create New Meta-Network : Creates a new blank Meta-Network. 

 

Influence Network Generator : Creates an Influence Network file for 
use in the external program Pythia. 

 

Command and Control Structure Generator : Creates Network files for 
use in the external program Caesar III. 

 

Create New Meta-Network In Visualizer : Creates a blank Meta-
Network in the Visualizer which can be populated with NodeClasses and 
Networks from scratch. 

 

Create Stylized Network : Generates new Networks using various 
Mathematical formulas including Erdős-Rény, Core-Periphery, Scale-Free, 
Cellular, Lattice, and Small-World Networks 
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Create Expected Interaction Network : Predicts the expected 
interaction of a network given known tasks and other available network 
data. You can create: Expertise Correlation, Similarity Correlation, 
Distinctiveness Correlation, and Resemblance Correlation 

 

 

Influence Network Generator 

Influence Network : is a hypotheses regarding tasks, performance, event 
happening, and related events. This functions covers how to generate an 
influence network from a social network using ORA and examines the probability of 

event happenings based on the state and influence of supporting nodes. 

The Influence Network Generator tool in ORA takes a Meta-Network and 
outputs an influence network that is readable by another software program, 
Pythia. Pythia, a software tool developed by George Mason University, has the 

ability to reason about an influence network's structure extracted by ORA. 
Therefore, ORA and Pythia can work in conjunction to perform an influence network 

analysis. Essentially, ORA generates the network and Pythia tells you something 
about it.  

ORA generates influence nets for Pythia from Meta-Networks. ORA can also read in 

a Pythia influence net and assess its structure. After ORA generates an influence 
network, the user then has to work with Pythia and a SME (subject matter expert) 
to get the probability distributions to make sense. The key advantage is by inferring 

the influence network from the meta-network via ORA you save a lot of the start-up 
time in performing an influence network analysis. 

The ORA file generated by this function is directly loadable in Pythia. It is not a 

complete influence network and the user will need to make adjustments to the 
generated networks. It uses basic ontological interpretations and inferred baseline 
probabilities where the user specifies positive/negative probability. 

We create an influence network based on: Extracting a task network which directs 
the target task to analyze. Then examine the complexity, importance, 
personnel/resource/expertise assignment of the tasks. 

The examinations become influence network nodes containing ontological 

interpretation when: The task is done — the task is complex — the task is 
important — there are sufficient actors associated with the task — resources are 

available — expertise is available. 

Then links are created as in the task network and background hypotheses nodes 
link to a task node. 
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Running the Routine : From the main menu: File > Influence Network 
Generator. This brings up the Influence network step by step creation dialog 

box. There are three options: Task Based, Event Based, and Belief Based.  

 

After selecting the creation type and clicking [Next] you will be presented with a 
number of steps depending on what information needs created. 

 

Information on the thresholds you want and other data will be input in the dialog 
boxes until the final screen is reached. 
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When all the information is input a dialog box with the results will display. This is 

the final check before clicking the [Convert] button and saving the file. 

Il-Chul Moon, Destabilization of Adversarial Organizations with Strategic 
Interventions, PhD Thesis, School of Computer Science, Carnegie Mellon University 

 

Extracting a Task Network for the 
Influence Network Generator 

What follows are procedures to extract a Task Network for the Influence Network 
Generator. 

In a Meta-Network there is an event-to-event network and a task-to-task network. 
Choose one task to analyze. 
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Here we look at bomb preparation. Find the tasks that need completed to 

accomplish the objective. Then trace from provide_money, get_money, 
purchase_oxygen.  

 

The complexity of the task depends on three items. Resources / Expertise 

required and number of person required.  
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 Very Low (default baseline=1.0): 0 resource/expertise required / 1 
person required. 

 Low (default baseline=0.9): 1 resource/expertise required / Less than 3 
persons required. 

 Medium (default baseline=0.8): Less than 4 resource/expertise required / 
Less than 4 persons required. 

 High (default baseline=0.7): Less than 8 resource/expertise required / 
Less than 7 persons required. 

 Very High (default baseline=0.6): More than 7 resource/expertise 
required / More than 6 persons required. 

 

The importance of the task is determined by using standardized degree 
centrality and betweenness (ranging (0~1): 

 Very Low (default baseline=0.4): Not connected to other tasks 

 Low (0.5): Low out-degree density and low betweenness in task network 

 Medium (0.6): Medium out-degree density and low betweenness in task 
network 

 High (0.7): High out-degree density or medium betweenness in task 
network 

 Very High (0.8): High out-degree density in task network 
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The actor assignment of the task is determined by sufficient actors, which are 

associated with the task. 

 No personnel (default baseline=0): No assigned actors 

 Insufficient (0.25): Only 75% of resources/expertise are covered by 

assigned actors. 

 Almost sufficient (0.5): More than 75% of resources/expertise are covered 

by the assigned actors. 

 Sufficient (0.7): At most one person associated with each resource and 

each expertise connected to the task. 

 More than sufficient (0.8): More than one person associated with some 

resources and expertise connected to the task. 

 

Resource / Expertise availability 
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Finds if Expertise and Resource are directly accessible. The availability is 
determined as follows: 

 Redundantly available/accessible baseline probability=0.75): More 

than one person with the expertise associated with the task. 

 Available/accessible (0.6): One person with the expertise/resource is 

associated with the task. 

 Unavailable/unaccessible (0.25): No person with the expertise/resource 

is associated with the task. 

Learn more... 

Il-Chul Moon, Kathleen M. Carley, and Alexander H. Levis, Inferring and Assessing 
Informal Organizational Structures from an Observed Dynamic Network of an 

Organization, Management Science, 2008, Submitted and under review 

Il-Chul Moon, Kathleen M. Carley and Alexander H. Levis, Vulnerability Assessment 
on Adversarial Organization: Unifying Command and Control Structure Analysis and 

Social Network Analysis, SIAM International Conference on Data Mining, Workshop 
on Link Analysis, Counter-terrorism and Security, Atlanta, Georgia, Apr. 26, 2008 

 

Pythia 

Pythia is a timed influence net application. Conversely, data from Pythia can be 
loaded into ORA using the Data Import Wizard.  

In conjunction with the Pythia application from George Mason University, data from 

ORA can be loaded into Pythia to create organizational displays.  

What follows is a brief example of creating an organizational display using ORA with 
Pythia.  

Start from an ORA Task Network (shown below) 
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The data can be loaded into Pythia to create an organizational display. 
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Reference at the George Mason University web site: 
http://sysarch.gmu.edu/main/software/ 

Contact George Mason at the above URL for instructions on downloading Pythia and 

additional instructions on how to use the tool.  

Learn more... 

Il-Chul Moon, Destabilization of Adversarial Organizations with Strategic 
Interventions, PhD Thesis, School of Computer Science, Carnegie Mellon University 

 

Command and Control Structure 
Generator 

C2 Structure and Meta-Network 

A Meta-network is a representation of a complex adaptive system. This system it 
has agents, expertise, resources and tasks. And inherent in this data are Meta-

networks that contain the C2 structure of an organization, which are the links of a 
social network among commanders represented in the following ways: 

 Command chains 

 Information sharing relations 

 Result/response sharing relations 

However, meta-networks may only have one commander-to-commander network 

without classifying the nature of links. An analyst oftentimes needs a method to 
infer the nature of relations among commanders based on a given meta-network. 

That is where this tool can help. ORA uses the task assignment and communication 
directions to infer the nature of a link. 

C2 structure in CAESAR III : Design View and Analysis View can be generated 
from a series of matrices describing the communications among decision makers 

(agents). The goal should be producing the matrices out of a social network. The 
analysis view has cognition aspects The nature of a link is determined by the timing 

of communication during the decision making process. 

Meta-Network : Network among people (, knowledge, resources, tasks, etc). Data 
for statistical analysis, not exactly an analysis tool. Reveal the organizational 

structure, influence propagation, command and control structure, etc. Widely used 
in organizational science, counter-terrorism, structure reformation, etc. 

C2 structure extraction in ORA : ORA provides a function, Command and Control 
Structure Generator. Automatic generation of C2 structure based on a target task 
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and a social network among decision makers. Generated influence network is 
directly loadable in CAESAR III. It is not a complete C2 structure but a reasonable 

inference (or approximation). 

C2 Structure Generation Procedure 

Determine a target task to analyze. Extract the task network of the target task. 
Extract the related (assigned) agents of the task network. The other agents are 

aggregated and represented as the outside world (IN and OUT). Regard the agent-
to-agent network as a information sharing network. Determine the network level 

based on the link directions and network topology. Then, extract a command chain 
from links bridging different network level. Determine the result sharing 
requirement based on the task network (i.e. the link direction between the two 

tasks indicate the result sharing requirement) Then, create a result sharing network 
based on the requirements. 

 

Extracting a Task Network for the 

Command and Control 

What follows are procedures and an overview of extracting a task network for 
command and control analysis using ORA in conjunction with Caesar III, an 
external software tool for task network analysis.  

In a Meta-Network, there are event-to-event networks and task-to-task networks 

contained in most data sets. We select one task to analyze and use ORA's 
command and control tool to discover the steps needed to complete this task from 

beginning to completion.  

In the images below, we are extracting a task network needed for the 
bomb_preparation task node. 

The idea is to find how tasks should be completed to accomplish the objective, 

bomb_preparation (e.g., find the trace to a purchase_oxygen task. Provide_money 
—> get_money —> purchase_oxygen). 
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Assigned Agents 

Identify the task network. Find all the assigned agents. Agents directly linked to a 
task in the task network. 
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Approximated Information Sharing Network 

Just the agent-to-agent network in a meta-network. 

 

Inferred Command Chain 

Determine the network level. Find the inferred hierarchy of the organization. Find 
the command chain from the hierarchy. 

 

Red arrows are command chains. Purple arrows are social network links. 
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Inferred Result Sharing Network 

The task network defines the task prerequisites. Then, the result of a task should 

be informed to the agents doing the next task. Create a result sharing network by 
using the above inference rule. 

 

Ahmed_ghallani should inform the result of purchase_oxygen to the agents doing 

bomb_preparation. Purchase_oxygen is a prerequisite of bomb_preparation. 
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Visualization by CAESAR III 

Generated by ORA. Target task : surveillance. Design view and analysis view in 
CAESAR III. 

 

Learn more... 

Il-Chul Moon, Kathleen M. Carley, and Lee W. Wagenhals, Estimating Task Success 
Likelihood by an Influence Network Generated from an Organizational Structure, 

Organization Science, 2008, Submitted and under review 

Il-Chul Moon, Eunice J. Kim and Kathleen M. Carley, Automated Influence Network 
Generation and the Node Parameter Sensitivity Analysis, International Command 
and Control Research Technology Symposium (ICCRTS’08, DOD CCRP conference), 

Bellevue, WA, Jun 17-19, 2008 

 

Caesar III 

Caesar III is an software application for the design of decision making organizations 
at the operational and tactical levels; it takes into consideration cultural differences 

in coalitions and of adversaries. What follows in overview of how Caesar III and 
ORA can work together.  

ORA can import data from Caesar III. See the Data Import Wizard for detailed 
instructions.  

The Design View and Analysis View can be generated from a series of matrices 
describing the communications among decision makers (agents). The goal should 
be producing the matrices out of a social network. The analysis view has cognition 
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aspects. The nature of a link is determined by the timing of communication during 
the decision making process. 

 

Meta-Networks are generated by ORA. Then through Caesar III's Design and 
Analysis Views their structure is analyzed. 

Reference at the George Mason University web site: 

http://sysarch.gmu.edu/main/software/ 

Contact George Mason University at the above URL for instruction on downloading 
Caesar III data. 

 

New Meta-Network in Visualizer 

From the main menu select Generate Networks > Create New Meta-Network 
in Visualizer. This does two things: 

1) It creates an empty Meta-Network in the Meta-Network Manager Pane. 

2) It brings up an empty Visualizer window to create a Meta-Network. 

NOTE : The Main Interface and the Visualizer are linked. What you do in one is 
reflected in the other. 

The Windows  
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Your work area contains, from left to right, Meta-Network Designer, Visualizer 
window, and Legend. 

The Meta-Network Designer Window 



 

255 
 

 

The Designer box contains four areas. 
 
The Nodes Button : Displays the graphic 
representation of the selected NodeClass 

 
The Links Button : Allows you to change 

the link weight. 
 
The Agents Drop Down menu : Used to 

select a NodeClass for placing a new Node. 
 

The Avatars Drop Down menu :  
 
The Icon Display Area : Shows the current 

group of icons available. 
 

The New NodeClass Button : This menu 
starts out empty until you create u.a 
NodeClass. Once NodeClasses are created 

they will appear in this men 

Creating New Nodes 

To create a new node select a NodeClass, select a link weight, then click, and hold, 

an icon and drag it into the Visualizer window. 
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Creating New Links 

 

In the Designer window click the [Links] 
button. This brings up buttons to set the 

weight of new links. 
 

The drop down at the bottom defaults to 
Auto-Find and Create Networks. 

 
If you place a check mark in the Auto-
Create Bidirectional Links when you 

create a link. (e.g. You create a link from 
Node A to Node B) ORA will automatically 

create a complementary link (e.g. a link 
from Node B to Node A will be added). 
 

To create links, click and hold the left 
mouse button on a node. Then drag the 

cursor to another node and release the 
button.  

Final Network 
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Create Stylized Networks 

Stylized Networks are models built upon common network structures evident in 
many real world environments. 

Create Erdős-Rényi Network : A model for generating random graphs by setting 
an Link between each pair of nodes with equal probability, independently of other 

Links. 

Create Core-Periphery Network : The core-periphery structure of the network 
has a dense central core of key agents and a large periphery of marginal agents. 

The core-periphery structure is an ideal typical pattern that divides both the rows 
and the columns into two classes. One of the blocks on the main diagonal (the 

core) is a high-density block; the other block on the main diagonal (the periphery) 
is a low-density block. The core-periphery model is indifferent to the density of ties 

in the off-diagonal blocks. 

When we apply the core-periphery model to actor-by-actor data (Core/Periphery), 
the model seeks to identify a set of actors who have high density of links among 

themselves (the core) by sharing many events in common, and another set of 
actors who have very low density of ties among themselves (the periphery) by 



 

258 
 

having few events in common. Actors in the core are able to coordinate their 
actions, those in the periphery are not. As a consequence, actors in the core are at 

a structural advantage in exchange relations with actors in the periphery. 

Create Scale-Free Network : Some nodes act as highly connected hubs (high-
degree), although most nodes are of low degree. Scale-free networks' structure 

and dynamics are independent of the system's size N, the number of nodes the 
system has. In other words, a network that is scale-free will have the same 

properties no matter what the number of its entities is. 

Their most distinguishing characteristic is that their degree distribution follows a 
power law relationship, \mathbf{P(k) \sim k^{- \gamma}}, 

 

Where the probability P(k) that a node in the network connects with k other nodes 
was roughly proportional to , and this function gave a roughly good fit to their 

observed data. The coefficient may vary approximately from 2 to 3 for most real 
networks. 

Create Cellular Network :  

Create Lattice Network : A Lattice Network is a large-world network where nodes 
are placed at the integer coordinate points of the n-dimensional Euclidean space 

and each node connects to nodes which are exactly one unit away from it. (i.e. if 
the lattice is two dimensional and the length of the lattice is 2 along the 

first and 2 along the second dimension, then it has 4 nodes and they're 
placed at coordinates (1,1), (1,2), (2,1), (2,2)) The two nodes are connected 

if the difference of one of their coordinates is one or minus one and all their other 
coordinates are exactly the same. 

Create Small-World Network : A type of graph in which most nodes are NOT 
neighbors of one another, but most nodes can be reached from every other node by 

a small number of hops or steps. A small world network, where nodes represent 
people and links connect people that know each other, captures the small world 

phenomenon of strangers being linked by a mutual acquaintance. 

The small-world behavior is characterized by the fact that the distance between any 
two inks is of the order of that for a random network and, at the same time, the 
concept of neighborhood is preserved. 

A Small-World Network is a regular network with a degree of random long range 
connections. It is rarely disrupted by the elimination of one node. 

Fixed Degree-Distribution Network : A random graph is constructed by 
specifying as input: (a) the number of nodes in the network, and (b) the number 

of link for each node. The graph is random according to the input, however it 
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should be noted that not all degree sequences are illogical so this algorithm may 
produce an empty graph as a result. read more… 

 

Fixed Degree-Distribution Network 

Create Fixed Degree Distribution : creates a random graph constructed by 
specifying as input: (a) the number of nodes in the network, and; (b) the number 
of links for each node. The graph is random according to the input, however it 

should be noted that not all degree sequences are illogical so this algorithm may 
produce an empty graph as a result. 

 

Allow self-loops : Checked allows the generation of a node tied to itself. 
Unchecked disallows the generation of a node tied to itself 

Construct directed-tie network : Checked generates directed network. 

Unchecked generates an undirected network 

If directed, then count is inbound, else outbound : Checked the degree list is 
incoming ties. Unchecked the degree list is outgoing ties 

Degree list : Enter the degree listing – in the desired node order. The input for the 

degree sequence is a comma delimited list of the number of edges. 
Correspondingly, the number of nodes is determined by the number of parameters 
entered.  

To facilitate simplified entry, a shortcut can be made by specifying the number of 

nodes at a specific number of edges. Further, the node id in the generated graph 
will correspond with the position in the input string. 

Degree sequences that are illogical will be impossible to generate, e.g., 2@20 (two 

nodes with 20 ties each; impossible because the maximum ties a node can have in 
this network of size two is 1 tie.) Further, some networks can be difficult to produce 
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due to the specific degree distribution and the random process used to construct 
the network, so the algorithm is designed to make up to 10 separate attempts at 

constructing the exact distribution. After 10 attempts, the algorithm will return the 
error meta-network. The user may chose to resubmit the same request for another 

up-to-10 attempts at making the network. 

For example, the following are valid input strings (with self-loops off and 
undirected): 

 1,5,3,0,1 - produces a 5 node network with one isolate and 2 pendants, etc. 

 3@2, 0, 0 - produces a 5 node network with 2 isolates and 3 nodes with 2 
edges. 

 10@5,10@3 - will produce a 20 node network 

The following are valid input strings but illogical: 

 100,0,1 - is illogical and will produce a null meta-network named with an 
error message 

 3@2,1 - is illogical and will produce a null meta-network named with an 
error message 

 10@5,10@3,1 - is illogical will produce a null meta-network named with an 
error message 

 

Create Expected Interaction Networks 

Below is an image of the Expertise Correlation tool in ORA and procedures on using 
the various options it contains: 
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Below are links to the Measures section pertaining to each Correlation. 

  Expertise Correlation… : Measures the complementarity of two agents 
based on their knowledge. 

 

  Similarity Correlation  

Measures the degree of similarity between agents based on the number of 
knowledge bits they both have. 

 

  Distinctiveness Correlation… : Measures how distinct are two agents based 

on the number of knowledge bits they hold oppositely. 
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  Resemblance Correlation… : Measures the degree of resemblance between 
agents based on the number of knowledge bits they both have or both do not have. 

 

 

Analysis Menu 

 

Generate Reports : Top level for all the ORA reports. These are further 
grouped into similar reporting groups to make it easier to find the 
particular report you want. 

 

Measures Manager : The option allows you to choose which measures 
are to be used in generating reports for the selected Meta-Networks. The 

dropdown menu allows you to chose measures lists which divide them 
up into categories such as: Slow Measures, Critical Risk Employees, 
and Resource Allocation Risk. 

 

Batch Mode Console : Opens a console window that lets the user to type 
commands and execute in a non-graphical way. It is an advanced menu 

item. 

 

Topic Analysis : Analysis using the LDA [Latent Dirichlet Allocation] and 
LSA [Latent Semantic Analysis] Clustering functions. 

 

Correspondence Analysis : Runs a correspondence analysis on the 
selected network to find patterns in the row and column entries. 

 

Aggregation Analysis : Analyzes the consistency of the network over 
time comparing multiple levels of temporal aggregation. Several network 
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measures are computed on snapshots of varying sizes which are then 

correlated and compared with the temporal information loss. 

 

Geary-C & Moran-I Analysis... : This function performs Moran's I test 

using phylogenetic and spatial link matrix (binary or general). It uses 
neighbouring weights so Moran's I and Geary's c randomization tests are 
equivalent. 

 

 

Generate Reports 

 Creates reports on the selected Meta-Networks. These reports are detailed in 
the Reports Section. 

You can choose an individual report from the drop-down menu or use the By 
Category drop-down menu which forms them into groups by function. All 
measures are in both drop-downs. 
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After choosing a report from the drop down menu a description and output format 
will appear beneath it. 

The next section allows you to chose which Meta-Networks to run the report on. 

Place a check mark next to all reports to use. 

Clicking on the downward poiting double arrow reveals the Transform section 
which allows you to select the method the Meta-Networks are changed prior to 

running the report. 

 General mathematical transformation :  

 Remove node :  

 Partition nodes into separate Meta-Networks by attribute value :  

Click [Next] 
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This next screen will differ depending on which report was chosen. For some reports 
you will be taken directly to the print screen. For others there will be additional 

information you need to specify. 

The Final Print Screen : allows you to chose whether to write the file to a Text, 
HTML, CSV, or PowerPoint file and tell ORA where to save it. You can also choose 

to use a different filename for all the reports written. 

 

All Measures Report 

There are several different ways to get network measures in ORA. The normal way 
is by using reports. Reports are collections of measures based on different research 
questions. The Standard Network Analysis report includes all measures. 

The All Measures Report defaults to running all measures in the system. But you 

can define this report to only run specific measures using The Measures 
Manaager. From the main menu select Analysis > Measures Manager. 
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From this box you can select or unselect all/some measures. Notice that each 

measure has a First and Last name. This is to assist in finding specific measures. 
There is also a search filter and drop down AND/OR box will also aid in this task. 

NOTE : For faster selection you can use the [Select] or [Un-Select] buttons. 

Example : If you want to find degree and betweenness centrality, we can 

first select centrality in the last name field and then select degree centrality and 
betweenness centrality in the window. When you are finished with selecting the 

measure, close the window to save the options. When next you select the All 
Measures Report only the measures you selected in the Measures Manager will 
be calculated. 
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Measures Manager 

 Before you run any measures on a Meta-Network you can use the Measures 

Manager to set exactly the measures you wish to compute. 

Form the main interface menu select Analysis > Measures Manager. 

 

NOTE : You can sort the measures by clicking on any of the headers. 

The dialog box has multiple sections: 

Filter Commands : 
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This section comprises two radio buttons (Match at least one filter | Match all 
filters) which allow for complex filtering, a [Reset Filters] button, and a Search 

text box used for inputting your search. Whatever searches you input in this 
section are reflected in the Tabbed Window below. It will display only the nodes 

which match the search(es). 

Item(s) Selected | Visible | Total 

When first called up the All Measures tab defaults to showing every measures 
available. When started there were 137 item(s) selected, 137 visible, 137 

total. 

Selecting the Slow Measures tab this changes to 16 item(s) selected, 16 
visible, 16 total. 

Typing Cognitive into the search text box reduces this to 16 item(s) selected, 8 

visible, 16 total showing that only 8 out of the 16 Slow Measures contain the word 
Cognitive. 

Furthermore you can unselect measures by removing the checkmark next to the 
measure's name. With each measure deselected the number of selected items will 

reduce by one. 

With these tools you can select only the measures you want to run reports on. 

Buttons 

 Reorder 

 Select All : Selects (puts a checkmark in the box) all visible measures 

 Clear All : De-Selects (removes check marks) from all visible measures. 

Tabbed Window 

This section contains tabs which sort the measures into various categories. 

Each of the nine tabs sorts out the measures in different categories. This is very 

useful for large Meta-Networks when you'd prefer not run, say the Slow 
Measures* cause it would put too much a drain on your machine. By removing the 

check boxes for the Slow Measures they are taken out of the mix and the reports 
will effectively ignore them. You can turn them back on when you're finished by 
placing a checkmark back in the box. 

In the Tabbed Window there are four columns: 

1. Last Name : Deals the general type of measure (Congruence, Exclusivity, 
Cognitive...). Most entries in this column will display one row as they are 
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singular in what they need to show. Others will display two rows as it's nearly 
the same measure run on both knowledge and resources. Then a few 

(like Centrality) will display quite a few rows the types of measures written 
for that type of measures are somewhat varied. 

2. First Name : Deals with the category of the measure (Betweenness, 
Closeness, Centrality...). This is a secondary factoring. 

3. Graph Level : Graph Level* produces a single number as output. 

4. Entity Level : Entity Level* produces one number per entity. 

Drop-Down Menu 

Gives the user the ability to select which currently active Meta-Network to run the 

measures on, as well as, which individual networks. 

 

Groupings of Reports 

This chart shows the groupings for the reports in ORA 

Groups and Which Reports They Contain 

Groupings  Reports  

Dynamics  Belief Propagation 
Change in Key Entities 

Immediate Impact 
QAP/MRQAP Analysis 

Statistical Change Detection 

Geospatial  Geospatial Assessment 

Key Entity 
Trails 

Groups  Core Network 

Local Patterns 
Locate Subgroups 

Knowledge Networks & Network 
Text Analysis  

Communicative Network 
Assessment 

Communicative Power 
Group Talk 
Hot Topics 

Large Scale 
Part of Speech 

Semantic Network 
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Locate Key Entities  Change in Key Entities 
Communicators 

Critical Sets 
Key Entity 
Management 

Simmelian Ties Analysis 
Sphere of Influence 

Standard Network Analysis 

Locate Key Relations  Shortest Path 

Specialty  Capabilities 
Drill Down 

Influence Net 
Merchant Marine 
Optimizer 

Public Health 
Rules of Engagement 

Tactical Insight 
Trails Analysis 

Statistical Procedures and 
Diagnosics  

Context 
Missing Links 
Potential Errors 

QAP/MRQAP Analysis 
Statistical Change Detection 

Statistical Distribution 

Show Me Everything    

 

 

Reports In Which Group 

ORA contains many reports for data analysis. The table below shows all the reports 
and into which groups they fall. 

Reports and the Groups In Which They Belong 

Report  Group(s)  

Belief Propagation Dynamics 

Capabilities Specialty 

Change in Key Entities Dynamics 
Locate Key Entities 

Communicative Network Knowledge Networks & Network Text 
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Assessment Analysis 

Communicative Power Knowledge Networks & Network Text 

Analysis 

Communicators Locate Key Entities 

Context Statistical Procedures and Diagnosics 

Core Network Groups 

Critical Sets Locate Key Entities 

Drill Down Specialty 

Geospatial Assessment Geospatial 

Group Talk Knowledge Networks & Network Text 
Analysis 

Hot Topics Knowledge Networks & Network Text 
Analysis 

Immediate Impact Dynamics 

Influence Net Specialty 

Key Entity Geospatial 
Locate Key Entities 

Large Scale Knowledge Networks & Network Text 
Analysis 

Local Patterns Groups 

Locate Subgroups Groups 

Management Locate Key Entities 

Merchant Marine Specialty 

Missing Links Statistical Procedures and Diagnosics 

Optimizer Specialty 

Part of Speech Knowledge Networks & Network Text 

Analysis 

Potential Errors Statistical Procedures and Diagnosics 

Public Health Specialty 

QAP/MRQAP Analysis Statistical Procedures and Diagnosics 

Dynamics 

Rules of Engagement Specialty 
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Semantic Network Knowledge Networks & Network Text 
Analysis 

Shortest Path Locate Key Relations 

Simmelian Ties Analysis Locate Key Entities 

Sphere of Influence Locate Key Entities 

Standard Network Analysis Locate Key Entities 

Statistical Change Detection Statistical Procedures and Diagnosics 
Dynamics 

Statistical Distribution Statistical Procedures and Diagnosics 

Tactical Insight Specialty 

Trails Geospatial 

Trails Analysis Specialty 

 

 

Topic Analysis 

LSA and LDA come from alternate schools of thought that attempt to link together 
documents based on shared content, which is construed in aggregate as shared 
―themes‖. To get these themes, both methods use a bag of words approach that, 
unlike the methods described above, does not look at adjacency as the sole definer 

of context. Rather each document is seen as one indiscriminate context. 
Correlations between all the words in documents are considered to determine 

underlying correlations that go beyond immediate context. 

Latent Semantic Analysis : Latent semantic analysis (LSA) is a technique in 
natural language processing, in particular in vectorial semantics, of analyzing 

relationships between a set of documents and the terms they contain by producing 
a set of concepts related to the documents and terms. It finds correlations between 
particular words in documents and, from this, particular correlations between the 

documents by mapping the documents to a vector space of reduced dimensionality, 
the latent semantic space. After running LSA, an analyst will possess a number of 

correlations between terms of particular strengths and a number of correlations 
between documents dependent on the strengths of these term correlations. The 
method has been applied to a variety of different data; notable examples include 

looking at the communications of the ICA for information about relations within the 
discipline, and looking at presidential debates for salient features shared by election 

winners. 

Latent Dirichlet Allocation : Takes a collection of Meta-Networks as input and 
uses a set number of topics to locate. Each Meta-Network models a document and 
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the node classes are combined to create a single list of concepts with frequencies 
determined by an attribute called Frequency. The algorithm assigns a probability 

that a topic belongs to a document and a probability that a concept belongs to a 
topic. For each topic the ten concepts with the highest probability of belonging to 

that topic are report. It is a method for attempting to determine the words that 
make up a set of topics covered by a corpus of documents. LDA assumes that 
documents consist of a mixture of topics, and that the constituent words of the 

document are, individually, each members of particular topics. LSA attempts to find 
the strongest correlations between particular words. LDA, in contrast, uses 

probabilistic methods to identify which words are most closely linked in a topic. 

Regarding Your Input Network 

The input daya needs to be a concept by text matrix if you want to do topic 
analysis. You can import a .csv file also if you want where the rows are concepts 

and columns are texts. You can also generate a concept by text matrix when you 
generate a semantic network from AutoMap. 

Example 

This is the 20040101union_timeInterval Meta-Network before processing. As 

you can see it is not very informative. 
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We will process it with the LSA and LDA functions. 

LSA 
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Number of Topics 
determines the 
number of groups of 
concepts in the final 

Meta-Network. 
 

From the Editor's 
menu select Analysis 
> Topic Analysis. 

This brings up the 
Topic Analysis dialog. 

Select the Use 
Existing Network tab 

and select the Meta-
Network. From the 
Network menu select 

Concept x Text. 
 

In the CHoose an 
algorithm and set 
its parameters: 

make sure the Latent 
Semantic Network 

tab is active. For the 
number of topics 
select 10. 

 
In the Which topic 

members should be 
returned? select the 
Only members with 

values in the top 
(rank): and set this 

to 10. 
 
Click the 

[ Computer ] button.  

A new Meta-Network will be added to the Manager Pane. Expand this by clicking the 

[+]. Select the Topic x Concept network. The click the [ Visualize ] button. 

Network clustered using LSA 

Each of the numbered nodes represent a group. And in this example each of the 
groups contains 10 links as per the parameters set. 
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LDA 
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The Select how to 
input... and Which 
topic members... 
sections are the same 

as in the LSA. 
 

The parameters for 
the LDA are more 
indepth than the LSA. 

You have: 
 

Number of Topics : 
The number of groups 

you want in the final 
display 
Number of 

iterations : The 
number of runs 

performed. 1,000 is 
the minimum. A 
higher number refines 

the results but will 
take longer to 

compute 
Step size : The 
number of iterations 

after which the model 
parameters are 

recomputed. 100 is 
the minimum 
recommened. A higher 

step size will compute 
faster but will reduce 

accuracy. 
Beta : determines 
how heavily the 

empirical predictive 
distribution of a 

multinomial Dirichlet is 
smoothed. Its default 
value is 0.1 and can 

be altered to give the 
desired resolution in 

the resulting 
distribution. 
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Network clustered using LDA 

Each of the numbered nodes represent a group. And in this example each of the 
groups contains 10 links as per the parameters set. 

 

 

Correspondence Analysis 

General Purpose 

Correspondence analysis is a descriptive/exploratory technique designed to analyze 

simple two-way and multi-way tables containing some measure of correspondence 
between the rows and columns. The most common kind of table of this type is the 
two-way frequency crosstabulation table. For a comprehensive description of this 

method, computational details, and its applications (in the English language), refer 
to the classic text by Greenacre (1984). 

Applies to categorical rather than continuous data. It provides a means of 

displaying or summarising a set of data in two-dimensional graphical form. All data 
should be nonnegative and on the same scale for CA to be applicable, and the 
method treats rows and columns equivalently. 
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  Smoking Category   

Staff 
Group 

(1) 
None 

(2) 
Light 

(3) 
Medium 

(4) 
Heavy 

Row 
Totals 

(1) Senior Managers 
(2) Junior Managers 
(3) Senior Employees 

(4) Junior Employees 
(5) Secretaries 

4 
4 
25 

18 
10 

2 
3 
10 

24 
6 

3 
7 
12 

33 
7 

2 
4 
4 

13 
2 

11 
18 
51 

88 
25 

Column Totals 61 45 62 25 193 

Mass : To continue with the simpler example of the two-way table presented 
above, computationally, the program will first compute the relative frequencies for 

the frequency table, so that the sum of all table entries is equal to 1.0 (each 
element will be divided by the total, i.e., 193). You could say that this table now 

shows how one unit of mass is distributed across the cells. In the terminology of 
correspondence analysis, the row and column totals of the matrix of relative 
frequenciesare called the row mass and column mass, respectively.  

Inertia : The term inertia in correspondence analysis is used by analogy with the 

definition in applied mathematics of "moment of inertia," which stands for the 
integral of mass times the squared distance to the centroid (e.g., Greenacre, 1984, 

p. 35). Inertia is defined as the total Pearson Chi-square for the two-way divided by 
the total sum (193 in the present example). 

According to the well-known formula for computing the Chi-square statistic for two-

way tables, the expected frequencies in a table, where the column and rows are 
independent of each other, are equal to the respective column total times the row 
total, divided by the grand total. Any deviations from the expected values 

(expected under the hypothesis of complete independence of the row and column 
variables) will contribute to the overall Chi-square. 

Eigenvalues and Inertia for all Dimensions 

Input Table (Rows x Columns): &nbsp5 x 4 
Total Inertia = .08519 Chi2 = 16.442 

No. of 
Dims 

Singular 
Values 

Eigen- 
Values 

Perc. of 
Inertia 

Cumulatv 
Percent 

Chi 
Squares 

1 
2 

3 

.273421 

.100086 

.020337 

.074759 

.010017 

.000414 

87.75587 
11.75865 

.48547 

87.7559 
99.5145 

100.0000 

14.42851 
1.93332 

.07982 

 

References 
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Correspondence Analysis. Retrieved on Spember 27, 2011, from 
http://www.statsoft.com/textbook/correspondence-analysis/. 

 

Correspondence Analysis Example 

From the Editor Menu select Analysis > Correspondence Analysis. 

 

The Corresondence Analysis box will appear with a list of all currently loaded Meta-
Networks. Place a check mark next to the Meta-Network(s) to analyze. For Select 
an input network: select the network to analyze. When you are finished click 

[Compute]. This brings up the Scatter Plot. 
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The buttons at the bottom are navigation buttons: 

[ |<< ] Go To First Graph 

[ << ] Go To Next Graph 

[ >> ] Go To Previous Graph 

[ >>| ]Go To Last Graph 

The number in the middle of the buttons tells you which graph is currently 
displayed. 

 



 

282 
 

 

Moran-I and Geary-C 

Description 

 Moran's-I : The measure of spatial autocorrelation to study stochastic 
phenomena which are distributed in space in two or more dimensions. The values of 

Moran's I range from +1 meaning strong positive spatial autocorrelation, to 0 
meaning a random pattern to -1 indicating strong negative spatial autocorrelation. 

This particular statistic is designed for the measurement of global spatial 
autocorrelation of ordinal, interval or ratio data. 

 Geary's-C : Based upon a paired comparison of juxtaposed map values and 
ranges between 0 and 2. Positive spatial autocorrelation is found with values 
ranging from 0 to 1 and negative spatial autocorrelation is found between 1 and 2. 

However, values can be found greater than 2 on occasion (Griffith, 1987). As 
similar values are in juxtaposition the numerator which measures the absolute 
difference squared between juxtaposed values will tend toward zero. Whereas, as 

non-similar values become juxtaposed the statistic will tend toward larger values in 
the numerator and thus toward its maximum value of two. 

This particular statistic is designed for the measurement of local spatial 

autocorrelation of ordinal, interval or ratio data. 

Example 

Moran's I Geary's C 
 

A 0.9 .04 

B 0.2 0.9 

C -.8 1.8 

A has positive global spatial autocorrelation and local spatial autocorelation. 

B is random with respect to space. 

C has negative global and local spatial autocorrelation. 
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Select Proximity Network : Select a Meta-network from the first dropdown 
menu. The second dropdown menu will contain all the networks in the selected 
Meta-Network. 

Create Values Vector : There are three ways to select a value 

1. Use the values of attributes : uses an attribute within the Meta-Network. 

2. Load values from file : browses for a file previously constructed. 

3. Use combined degree centrality of the networks : Place a checkmark for 
one (or more) networks within the selected Meta-network to use. Combines 

the centrality to use in the formulas. 

Results : Displays the Moran-I and Geary-C results. 
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Reference 

Geary, R. C. (1954). "The Contiguity Ratio and Statistical Mapping". The 
Incorporated Statistician (The Incorporated Statistician) 5 (3): 115-145. 

Moran, P. A. P. (1950). "Notes on Continuous Stochastic Phenomena". Biometrika 
37 (1): 17-23. 

 

Simulations 

 

Near-Term Analysis : The Near Term Analysis (NTA) is a tool that 
allows for the removal of nodes from a given organizational structure to 
evaluate how the organization will likely perform as a result. 

 

OrgAhead : OrgAhead is an organizational learning model designed to 
test different forms of organizations under a common task representation. 
Each member of the organization receives information from a subordinate 

or from the environment, makes a decision based on the information and 
what he or she has learned so far, and provides superiors with an answer 

to the decision. These decisions are either yes/no or yes/maybe/no; 
again, we're dealing with an intellective model. 

 

Micro Simulations : Micro Simulation allows you to run some basic 
simulations on the curretly loaded visualization. Link weights are 
important as once they are normalized, they correspond to the probablity 

of a transmission. 

 

 

Near Term Analysis 

The Near Term Analysis (NTA) is a tool that allows for the removal of nodes from 
a given organizational structure to evaluate how the organization will likely perform 
as a result. The Near Term Analysis tool uses a multi-agent model as input, Dynet 

ML*. 

The goal is to provide an answer to the question on how an organization will behave 
and change after considering a sequence of strategic interventions or personnel loss 

by way of agent removal. In other words, we want to know what happens when we 
remove nodes from an organization, be they people, places, resources, knowledge 

sets or other common Node Classes*. 
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This example will use the Stargate dataset (SG-1). This dataset is included with 
the version of ORA downloaded and can be found on-line at the following url: 

http://www.casos.cs.cmu.edu/projects/ora/sample.php. 

From the menu bar select File > Open Meta-Network then select SG1.xml. 

In this example, we will remove two agents: daniel_jackson and 
maj_samantha_carter  

1. Open the SG1 Meta-Network into ORA. 

2. Highlight the SG1 Meta-Network before starting NTA in the ORA Meta-
Network Manager panel. 

3. From the main menu select Simulations > Near-Term Analysis. 

NOTE : If your dataset contains an Organization nodeset ORA will display the NTA 
main window. If not, it will ask for you to chose a substitute Organization nodeset. 

 

When a Meta-Network is first loaded into ORA's the Near Term Analysis, a pop-up 
may appear asking for a location node. Select Cancel and proceed with the Near 

Term Analysis. 
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The NTA main window consisted of four sub panels: Input Data, Settings, 
Simulation time line and Cases to simulate. Below is a brief description of each 
panel:  

 

1. Input Data 

In this section is the file name of the Meta-Network loaded. 

2. Settings (Global Parameters) 

In the Setting area are two text boxes. The first, The Number of replications 
informs ORA how many times to run the simulation. The second, The number of 

simulated time-points defines the range in the section Simulation time line.  

In the settings area, there are two critical factors: 1) the number of replications 
and 2) the number of simulated time points. 
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Why is this important? 

The number of replications if set at a higher versus lower value, will result in more 
experiments being conducted on the scenario the tool is presented. Therefore, the 

more replications the more likely the results will mirror those in a real world 
example. 

The number of time points determines the length of the Near Term Analysis 

iterations. If this number is also set to a relatively high value, the simulation will 
take longer.  

NOTE : Be mindful of any memory considerations when running high value 

replications or time points. 

3. Simulation time line 

This are of the Near Term Analysis tool shows a visual representation of the time 
points selected in Settings area above. 

4. Cases to simulate 

After the settings (global parameters) are set, the virtual experiment cells need 

set. 

Initially, there is a pre-defined simulation cell, the Baseline. The Baseline is the 
cell without any entities removed as is the control situation when the organization 

does not experience any interventions. Besides Baseline, any other cells need set 
up. Start by selected Add new simulation instances, the leftmost of the four 
buttons. 

Add new simulation cases 

To run a Near Term Analysis, we will begin by selected the Add new simulations 
cases button from the main Near Term Analysis Tool (see area highlighted in red 
ellipse below).  
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After selecting Add new simulation instances button, a dialog box titled Near 

Term Analysis– Simulation scenario create wizard will appear. This wizard 
supports the creation of virtual experiment cells in three different ways. The First 
allows for the most freedom of choice. The second and the third options will ask 

for a set of criteria for selecting important agents in the network and make 
experiment cells according to the selection. Therefore, the first option gives full 

flexibility to users, and the second and the third option provides a systematic 
analysis setup method. To proceed this demonstration, select the first option and 
select [Next]. 
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There are four options: 

The next section explores all four of the Near Term Analysis Options: 

Run the Step-by-Step Wizard – This process will help walk through setting up a 
near term analysis experiment on the Meta-Network loaded into the Near Term 

Analysis tool. 

Create one simulation case – In this simulation experiment, events and user-
specified time can be applied to agents. 

Create a set of cases by isolating agents – This scenario isolates one agent and 

perform an experiment. Then the experiment can be performed again with the 
agent removed. 

Create a set of cases by isolating a set of agents relating to a specific 

measure. – Based on measures contained in the ORA intel report, a set of agents 
can be isolated and a simulation case can be created. 
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Near Term Analysis Menu 

 

File Menu 

Save the current simulation setting: Brings up a save box where you can 
navigate to a directory and save all the current simulation settings. 

Load a simulation setting from a file: Navigate to a directory to load a 
previously saved simulation setting. 

NOTE : This will remove any settings that are currently active. 

Close: Closes the Near Term Analysis window. 

 

Simulation Menu 

Execute simulation cases: Begins running the simulation. Same function as the 

[Execute] button at the bottom of the window. 
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Show the add simulation wizard: Brings up the creation window. same as the 
[Add new simulation cases] button. 

Add ORA-Intel report based simulation cases: Same as [Add ORA-Intel 

report based simulation cases] button. 

Edit the highlighted case: Brings up the dialog box to edit parameters for 
selected event. 

Remove the selected cases: Removes selected event from simulations. 

Remove all of the cases: Same as the [Remove all the simulations] button. 

 

Output Options 

 

These menu items will display in the Near Term Results menu:  

Generate evolved Interaction Matrix:  

Generate evolved Agent-to-Agent Matrix: Displays how agents interact with 
one another. 

Generate evolved Agent-to-Knowledge Matrix: Displays how knowledge is 

diffused within the agent network 

Generate evolved Agent-to-Task Matrix: Display how tasks are used within a 
network. 

 

Near Term Impact Option 1 

Step-by-Step wizard 

Selecting the first option brings up the step-by-step creation dialog box. 
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Under Options select whether to isolate an agent, knowledge, or resource. 

We'll leave it at agent. Then select the [Next] button. 

 

Under Options select the agent to isolate. Here we select daniel_jackson. The 

select the [Next] button. 
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Under Options select the time-step to isolate the agent. For this simulation we 
select 5. The select the [Next] button. 

 

At this point you are asked if you want to add more events to the simulation or not.  

You can add as many eventsas you wish. But for this example we'll only use only 
one event. Select [No] to continue. 

 

Now repeat the steps above and add a second simulation. But this time let's 
remove daniel_jackson at time-step 25. 
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Now proceed to Analysis Results. 

 

Near Term Impact Option 2 

Apply events to specified agents 

The second option for creating simulation files is to create one simulation case and 
apply events to specified agents, knowledge, or resource nodes. 

Select the [Add new simulation cases] button to bring up the wizard. 

 

1. Type in a search criteria to highlight only the agents to work with (i.e. typing 

in dan brought up only daniel_jackson. 
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2. Place a checkmark on the line. Notice that when you placed a checkmark in 
the box the Event automatically changed to Isolation. 

3. Double-click in the Timing cell to select it and type in a number from 0 to 
the highest number you selected for your simulation. In this case we'll repeat 

with the timing of "5". 

4. Select the [Add events] button. This places the event in the Simulation 

event edit list section. 

5. If there were more events to add you could continue with the same 

procedure. When you are done, select the [Add a simulation] button at the 
bottom. 

The two buttons beneath the Simulation event edit list section to remove events 

from the list. The [Remove all the events] button obviously removes everything 
in the Simulation event edit list but the Remove the selected events from 
the event list only removes the events with a checkmark beside them.  

The [Reset selection] button removes all check marks placed in the bottom table 
and sets the Event to No Event. 

The [Previous] button returns to the main Wizard screen. 

When you have finished you will have created the same two simulations as in 
Option 1. 

 

Now proceed to Analysis Results. 

 

Term Impact Option 3 

Create set of cases using Measures 

Option 3 allows for selecting agents/knowledge/resources based on their ranking 

when certain measures are run on them. 
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Here are three examples run with the same Isolation Time and Cut-offs. Only 
the measures were changed. 

Centrality, Total Degree 

 

Cognitive Demand 

 

Clique Count 
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When you have run the measures proceed to Analysis Results. 

 

Near Term Impact Option 4 

A set of agents by a set of cases by measure(s). 

 

Option 4 allows the addition of adding Time gaps between the isolations and 
whether to isolate them in descending, Ascending, or Random order. 

Now proceed to Analysis Results. 

 

Near Term Impact Results Menu 

Save the Construct launch scripts : Information on Construct can be obtained at 
the following URL: 

http://www.casos.cs.cmu.edu/project/construct/index.html. 

Show text report on the ORA main window : Displays the report in Panel 3 of 
the ORA Main Interface. 
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Save the completely evolved Meta-Networks : Will save as an ORA Meta-
Network any of the simulation cases with a checkmark in the Select column. 

Save the html report : Navigate to a directory to save an html file that can be 

displayed in a browser. 

Save the text report : Navigate to a directory to save an text file. 

Save the Knowledge Diffusion line chart : Saves the chart as a .png file that 
can be used in other documents. 

Save the Task Accuracy line chart : Saves the chart as a .png file that can be 
used in other documents. 

Save the Energy Task line chart : Saves the chart as a .png file that can be 
used in other documents. 

Save the Knowledge Diffusion result CSV file : Saves the results as a .csv file 

that can be used in other programs. 

Save the Task Accuracy result CSV file : Saves the results as a .csv file that 
can be used in other programs. 

Save the Energy Task result CSV file : Saves the results as a .csv file that can 

be used in other programs. 

Close :  

 

Copy the chart in the clipboard : Copies the window to the clipboard that can be 
pasted into other programs. 
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Standard Deviation ranges : Standard Deviations* displays the range of 
values for a particular instance. 

Grid lines in the chart : Displays the grid lines for values. 

Legends in the chart : Displays the legend underneath the chart. 

Event annotations in the chart : Displays the event annotations within the chart. 

 

 

Deviation from the baseline : Using the baseline numbers the chart shows the 
offset for the simulation. 

Show actual values : Uses he actual calculated values in the chart. 

 

Background color : choose the background color of the chart of either white or 
gray. 
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Near Term Impact Results 

Now we're ready to Execute the simulations. But before that you must select the 
type of Output Options you want. From the Near Term Analysis menu select 

Output Options ⇒ {any or all of the four options}.  

 

Now select the [Execute] button in the bottom-right corner. This will bring up two 
dialog boxes asking you to confirm you're selected output options and then an alert 

telling you that, this may take a while with a large Meta-Network and a lot of 
simulation runs. 

 

An alert box will display advising you that the near term calculation may take a long 

time depending on settings of your experiment.  

 

After selected [Execute] the Processing Near Term analysis dialog will show 
you the progress. 



 

301 
 

 

Next will be displayed the Near Term Analysis results window. 

 

The results of the experiment will compare against the baseline data established 

prior to the removal of any isolated agents. In the example above, we can see how 
the network was impacted in the time line when we isolated daniel_jackson and 

removed this node from the data set. 

Further information can be obtained form the following references: 

For knowledge diffusion and energy task 

Schreiber, C. (2006) Human and Organizational Risk Modeling: Critical Personnel 
and Leadership in Network Organizations, PhD Thesis, Carnegie Mellon University, 

CMU-ISRI-06-120 

For binary task accuracy 

Lin, Z., K. Carley. 1997. Organizational response: The cost performance trade-off. 
Management Sci. 43(2) 217-234. 
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Micro Simulations 

The Micro Simulation exists in both the Editor and in the Visualizer. The 
difference is the Visualizer version is mainly used to visualize as it happens. The 

Editor version is used to create simulation data. 

Procedure 

The first thing it requests is a node class. After that it will give you a choice the 
square networks comprised of that node class. This creates a new meta-network 

consisting of a single node class with the same nodes as the input node class, 
and a single network with the same links present in the selected networks. If 
multiple networks are selected and multiple links from node A -> node B are 

present, the resulting link from A -> B has a weight equal to the sum of all A -> B 
links. 

 

Once a new Meta-Network is defined it takes all the links and normalizes them 

between zero and one. The link weight then corresponds to the probability that a 
transmission will occur down that link. This means that both Link Direction and 
Link Weight play an important role. 

The Simulations 

The Simulations are Disease, Money, Information, and Technology and are 
types of flows. At any given timepoint, any node that has one of those things is 
going to try to give it to someone else. And each flow has its own rules. 

Types of Simulation Flows 
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Disease : An entity can not re-get the disease, and an entity can only give out the 
disease while it has the disease. The entity can also give out a disease to multiple 

other entities. After a user-specified number of time periods, the entity loses the 
disease. 

Money : Once an entity gives away the money, he cannot give the money to 

anyone else. There is no limit on re-getting the money. 

Information : Once an entity gets information, they cannot lose it. They also 
never stop giving out the information. 

It's important to understand how these transmissions occur. During the 

transmission phase ORA looks at every node that has a resource. It then iterates 
through all outgoing links, trying to give that resource through that link ( in the 
case of money, since it can only go through one link, we randomize the order links 

are tested ). When looking at a link, if checks to see if the transmission can occur 
based on the link weight. Another check is made to see if the transmission can 

overcome the transmission resistance. 

These checks are continued based on the rules outlined above for the user specified 
number of time periods. Then a dynamic meta-network is generated that shows for 

any given time period what node was associated with a resource. 

Adoption of Technology : is a unique simulation. A node is more likely to adopt a 
piece of tech if it has many neighbors trying to convince it to adopt the tech. A 
node is more likely to un-adopt a piece of tech if the node has fewer neighbors also 

using the tech. 

 

Visualization 

 

Measure Charts : When run this function will plot the three graphs, Bar 
Chart, Scatter Plot, and Histogram on the chosen Network. 

 

View Measures Over Time : Requires multiple Networks. First plots 

points for measure selected on each of the Networks active with the option 
to see a direct line from the earliest to the latest point. 

 

View Network Over Time : Requires multiple Networks. Displays nodes 
and links for each of the active Networks. 

 

Network Drill-Down: Allows for quick, plotting of nodes connected to a 

chosen node. 
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Node Cloud : Create an image with higher used concepts showing up in 
larger font sizes. 

 

Color Grid : Creates a colored grid representing the networks. White cells 
represent no connections. 

 

Network Block :  

 

GeoSpatial Networks : Analyze, forecast, and visualize a wide variety of 
spatial interactions and networks within a global-scale. See 
GeoSpatial/Loom > GeoSpatial for more information 

 

View Trails : Works with nodes moving between places over time. 
Requires the use of a trailset.See Loom for more information 

 

View Trails in GIS :  

View Networks 

 

3D Visualization : Visualizes the selected network in the 3D Visualizer 

 

2D Visualization : Visualizes the selected network in the 2D Visualizer 

 

Path Finder : is used to find, not only, the shortest path between two 
nodes but also paths to other nodes when particular situations occur. 

 

Sphere of Influence : Each node within a network has a unique Sphere 
of Influence or Ego Network. Essentially it's a direct relationship with it's 
neighbors as a function of specified path length. The ORA Visualizer allows 

you to focus on this relationship by creating an Ego Map centered on any 
particular node you choose. 

 

Key Set Selector : uses information input by the user to create a 
simplified visualization. 

 

Blank Visualization : Opens the Visualizer with no active Meta-Network. 
Allows you to create NodeClasses and Networks from scratch. 
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Charts Types 

 Below are examples of each type of ORA charts: Bar Chart, Scatter Plot, and 

Histogram. 

Bar Chart 

A bar chart contains horizontal bars representing the individual nodes in the set. 

These rectangular bars are usually proportional to the magnitudes or frequencies 
of what they represent.  

Bar charts are used for comparing two or more values. The bars can be 

horizontally or vertically oriented. Sometimes a stretched graphic is used instead of 
a solid bar. 
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Scatter Plot 

A scatterplot uses Cartesian coordinates to display values for two variables. 

The data is displayed as a collection of points, each having one coordinate on the 
horizontal axis and one on the vertical axis. 

A scatterplot does not specify dependent or independent variables. Either type of 

variable can be plotted on either axis. Scatterplots represent the association 
(not causation) between two variables. 
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A scatterplot can show various kinds of relationships, including positive (rising), 
negative (falling), and no relationship. If the pattern of dots slopes from lower 

left to upper right, it suggests a positive correlation between the variables being 
studied. If the pattern of dots slopes from upper left to lower right, it suggests a 

negative correlation. A line of best fit can be drawn in order to study the correlation 
between the variables. An equation for the line of best fit can be computed using 
the method of linear regression. 

 

Histogram 
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In statistics, a histogram is a graphical display of tabulated frequencies. A 
histogram is the graphical version of a table which shows what proportion of 

cases fall into each of several or many specified categories. The histogram 
differs from a bar chart in that it is the area of the bar that denotes the value, not 

the height, a crucial distinction when the categories are not of uniform width 
(Lancaster, 1974). The categories are usually specified as non-overlapping intervals 
of some variable. The categories (bars) must be adjacent. 

The word histogram is derived from histos and gramma in Greek, the first meaning 
web or mast and the second meaning drawing, record or writing. A histogram of 
something is thus, etymologically speaking, a drawing of the web of this something. 
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Regression 

Regression analysis is also used to understand which among the independent 
variables are related to the dependent variable, and to explore the forms of these 

relationships. In restricted circumstances, regression analysis can be used to infer 
causal relationships between the independent and dependent variables. 

The dependent and independent variables can be either a network measure or 

numerical attributes of nodes. 

 

R-Squared : The coefficient of determination, R2, is the proportion of variability in 
a data set that is accounted for by a statistical model. There is no consensus about 

the exact definition of R2. Only in the case of linear regression are all definitions 
equivalent. In this case, R2 is simply the square of a correlation coefficient. 

Adjusted R-Squared : Unlike R2, the adjusted R2 increases only if the new term 

improves the model more than would be expected by chance. The adjusted R2 can 
be negative, and will always be less than or equal to R2. 

Standard Error : The Standard Error is an estimate of the standard deviation of 

the coefficient, the amount it varies across cases. It can be a measure of the 
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precision with which the regression coefficient is measured. If a coefficient is large 
compared to its standard error, then it is probably different from 0. 

Num Observations : Number of nodes in the NodeClasess. 

 

Predicted Y Value : In the scatterplot, a point is plotted as (X , Y) The regression 

line will give the predicted Y value. 

Residual : The difference between the Predicted-Y value and the actual value. 
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ANOVA : Information about levels of variability within a regression model and form 

a basis for tests of significance. 

 

 

View Measures Over Time 

 Using the View Measures Over Time on a Network allows an analyst to see 

how a network measures change over multiple time periods. If you use non-dated 

data, ORA will alert you if your Meta-Networks are not dated. 

Below is the Meta-Network Pane showing five time periods for the Tanzania dataset. 
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Highlight all the Meta-Networks and selectr from the main menu Visualizations > 
View Measures Over Time... A dialog box will appear stating it will run on the 

currently loaded Networks. 

NOTE : Measures Over Time will only be run on the selected Metw-Networks. 

NOTE : It is of the utmost importance that the Networks in all Meta-Networks are 
named the same. If not, the Over Time function will not work correctly. 

Computation Parameters 

First, the Computation Parameters dialog window appears. Here you can select the 
measures to use and whether to combine or transform the datasets. When done, 
click the [Compute] button to continue to the analysis. 

 

Measures tab : gives you control over the measures used in the computation. With 
the Custom option you can select as many or few measures to use. 

Aggregate tab : Combines multiple dates into one entry. If you have one meta-
network for each day of the year, aggregating by month would reduce the 365 
meta-networks into 12 meta-networks (the 12 would contain the 30 meta-networks 

for each day of the month unioned together). 

Transform tab : The Conform using method makes the node classes indential 
across Meta-Networks. Union adds isolate nodes, and Intersect remove nodes. 

NOTE : Measure values computed on conformed Meta-Networks may differ from 

those computed on non-comformed data. 

Measures Over Time window 
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This window is divided into three panes. 

The Measure Selector Pane contains tabs for all NodeClasses in addition to a 

Network Level tab. If the Network Level tab is selected you can choose which 
measure(s) to apply to the entire Meta-Network. If a NodeClass tab is chosen you 
can choose which Node(s) to view and in the Select a measure: text box select 

the measure to apply to them. All actions are instantly updated in the Charts 
Pane. 

The Restrictor Pane allows you to set the beginning and ending time periods and 

additionally you can skip any number of intermediary steps. 

The Charts Pane contains three tabs and a legend at the bottom showing the 
colors associated to which nodes. 
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Measures values :  

NOTE : Hovering over any measure will bring up a description of that measure. 

Fast Fourier Transform : Transform measures values to identify cycles in a 

temporal situation. Doesn't plot measure values. It plots strength of cycles. (i.e. 
traffic patterns could have a heavy/light traffic pattern or a weekly pattern, 
heavy on weekdays and light on weekends). Defines cycles of different lengths. 

Change Detection :  

CUSUM : Keeps track of cumulative total of deviation across time. No matter 
how small the change. 

EWMA : Exponentially Weighted Moving Average. Check Wikipedia. 
Incorporates historical data but places more emphasis on recent data. 

Networks in Control : Number of Networks to use as a control group 

NOTE : If your change time is in the "Networks in control" bunch then you'll never 
see the change. 

Risk : Higher risk numbers will possibly give more false alarms.  

Weight : How much to weight newer over older observations. Start and 
Finish is for which network to use. 

Shewhart X-Bar : How different is current observation from the baseline. 
Only takes into account current observation. 

wiki: X bar and R chart 

 

Measure Selector Pane 
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The Network Level tab is a list of all 
the measures used in the current 
operation. Place a check mark next 
to any measure you want to use. 

 
The [AND/OR] drop down allows 

for boolen operations on the 
measures. 
 

The [Select All / Unselect All] 
buttons can be used as a starting 

point to select mostmeasures or 
only a few measures. 

 

All the individual Node Class tabs 
work identically. Like the Network 

Level you place a check mark next 
to the nodes you want to use and it 

also contains the [AND/OR] drop 
down. 
 

The Measure: and Networks: drop 
downs allow you to hone you 

selections. 
 
The [Select All / Unselect All] 

buttons can be used as a starting 
point to select mostmeasures or 

only a few measures. 
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Restrictor Pane 

 

The Restrictor Pan allows you to set the Starting and Ending Meta-Network to use 
and also to skip a number of Metaworks in the middle. 

 

Over Time-Measures Tab 
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Over Time-Fast Fourier Tab 
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Frequencies 

Fast Fourier Transform : Transform measures values to identify cycles in a 

temporal situation. Doesn't plot measure values. It plots strength of cycles. (i.e. 
traffic patterns could have a heavy/light traffic pattern or a weekly pattern, 
heavy on weekdays and light on weekends). Defines cycles of different lengths. 

Dominant Frequencies : Selecting Dominant Frequencies on the radio button 
to the lower right, displays only the statistically significant frequencies. 

Plots 

Original Plot :  

Period Plot :  

Filtered Plot :  

Original and Filtered :  

 

Over Time-Change Detection Tab 
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CUSUM 

Keeps track of cumulative total of deviation across time. No matter how small 

the change. 

Networks in Control : Number of Networks to use as a control group 

NOTE : If your change time is in the "Networks in control" bunch then you'll never 
see the change. 

Standardized Change :  

Set sensitivity to false alarm 

Decision interval :  

Risk : Higher risk numbers will possibly give more false alarms. 

Observations :  

EWMA 

Exponentially Weighted Moving Average. Check Wikipedia. Incorporates 
historical data but places more emphasis on recent data. 
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Networks in Control : Number of Networks to use as a control group 

Risk : Higher risk numbers will possibly give more false alarms. 

Weight : Shows the weight of the newer observations over the older 

observations. Start and Finish is for which network to use. 

Shewhart X-Bar 

Show how different the current observation is from the baseline. This only takes 
into account the current observation. 

Networks in Control : Number of Networks to use as a control group 

Risk : Higher risk numbers will possibly give more false alarms. 

 

View Network Over Time 

 View Network Over Time : Uses all selected Meta-Networks for analysis in 

various time frames. Select all the Meta-Networks to use in the analysis. 

NOTE : It is of the utmost importance that the Networks in all Meta-Networks are 

named the same. If not, the Over Time function will not work correctly. 
 

NOTE : Meta-Networks for use in the Over-Time tool are required to have date 
information. If they do not a warning box will appear telling you of the missing 
information.  

 
NOTE : Menu options and right click context menus apply to what is currently 

selected. If an entire dynamic meta network is selected [ the parent item ] it 
applies to each snapshot/delta, otherwise it only applies to the currently selected 

snapshot/delta. 

 

Now select from the menu Visualizations > View Network Over Time This will 
bring up the visualizer along with the Networks Over Time window. 
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The Animation Tab controls the workings of the animation. It also contains the 

Play/Stop buttons. 

The Timeslices Tab contains check boxes for all active Meta-Networks. Placing a 
check mark in the boxes will use that particular Meta-Network. 

The Clustering Tab allows you to set the time frame for clustering by day, week, 

month, or year. 

Animating the Display 

Pressing the Play button will start the animation. Below are the five agent x agent 
Networks. In different time slices new nodes appear and the connections between 

the agents changes. 
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Change Detection (Over-Time Viewer) 

Description 

The View Measures Over-Time is used to find out how quickly you can identify 

changes in a network to exploit subtle organization change, And also to facilitate 
improved command and control subject to a specifid risk of false alarm. Various 
measures of a network are taken at different points in time. You need to identify a) 

that a change did occur and b) when did that change occur. 

NOTE : It is important to note that this is not predicting change. But rather it is 
detecting that a change has occurred quickly and be able to make some inference 

about the actual time of change. 

Example of Change Detection 

Change Detection may offer you a tool to operate inside the normal decision cycle. 
The following figure represents some measure of interest over time. It could be the 

revenue of a company, the combat power of an enemy, or a measure of interest 
from a social network. When do you conclude from this measure that a change may 
have occurred? Let's assume that by conventional methods you can detect a 

change in organizational behavior as of today, the vertical line. This time point 
might be too late to take preventative or mitigating action. In other words, this 

could be the point of inevitable bankruptcy for the company, or the successful 
culmination of a terrorist attack. Identifying that a change occurred by time period 
E might allow the analyst to respond to the change before it is too late; get inside 

the decision cycle. 
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Change detection is more challenging than it may seem at first. The sudden 
change in the measure between time D and time E, however, may look very 
similar to the peak at time A. Furthermore, if you assert that a change in fact 

occurs at time A, there may exist a large amount of time periods to investigate for 
the cause of any change. If you can identify more likely points in time where 

change may have occurred, you can reduce the costs in terms of time and 
resources to search for the potential causes of change. Identifying the likely time 

that a change may have occurred is called Change Point Identification. 

Another problem you face is detecting the change as quickly as possible after the 
change occurred. Can you improve the ability to get inside the decision cycle by 
detecting the change at time D, or even better at time B? This is called Change 

Detection. 

NOTE : It is important that you use at least 10 time periods for an accurate 
simulation. 

 

The Three Procedures 

The Shewhart X-bar Control Chart 
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This is simple and easy to implement and provides a Proof of Concept. If calculates 
a samle average of observations and measures of a process. The decision interval 

indicates whether the observation is in the tail of the disbtribution. 

 

Cumulative Sum (CUSUM) 

Other statistical schemes increase power (faster detection, given the same 
probability for false alarm). The CUSUM considers previous values of the observed 
process. It can take a long time to detect small changes. Intuitively, we can see 

change earlier. How to detect it? 

 

Cumulative Sum is good at detecting small changes in mean over time and has 
good buildt-in change point detection. 

The Load data and use CUSUM option. CUSUM has an additional parameter. This 
is equivalent to ? in the equation presented earlier. It is an optimality parameter for 
the CUSUM approach that will make this approach the uniformly most powerful for 

a change in the social network measure of ?. As a rule of thumb this is usually set 
to 1. 

There are three ways to set the risk of a False Alarm. 

1. The user can specify the decision interval. 
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2. The user can specify a probability as in the Shewhart approach. 

3. The user can specify the average number of in-control networks expected 
before a false alarm. 

This is due to the nested conditional probability inherent in the CUSUM. 

The CUSUM signals a change, when the statistic exceeds the decision interval. The 

most likely point in time that the change actually occurred is interpreted as the 
point that the CUSUM was last equal to 0. In this case, the time period is 19, which 
is one time point before the actual change. This is where an analyst would begin to 

look for explanations of change in the group. There are two separate charts plotted. 
One is for increases (red) in the social network measure, and the other is for 

decreases (blue) in the measure. 

Exponetially Weighted Moving Average  

This chart requires two items. 

 A definition of what normal behavior is. 

 What is the risk of false alarm. (This is a trade-off between speed and 

mistakes). 

 

Change Detection GUI 

GUI 
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1) Recompute measures button : Runs the calculations. Allows you to change 

the measures used and obtain other results. 

2) Measure Selector pane : In the left pane you can choose the particular 
measures that you want to analyze in either Network or agent level. 
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3) Restrictor pane : Allows you to set the dates which the Over-Time Viewer will 
work and also if you want to set a skip interval. 

4) Chart pane : Area for displaying the final results. This area contains four tabs: 

Measures Values :  
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Fast Fourier : Charts the results of the selected measures after applying the Fast 
Fourier Transform [FFT]. 

 

Change Detection : Used to quickly determine that a changed has occurred. Find 
the change point to detemine the exact date. 

 

Distribution : Display this information in a color grid. The darker boxes signal 
higher values. 
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5) Function Buttons :  

Display Options : Allows you to Rename the X-Axis, Y-Axis, or both, recolor 

the measures lines, change the width of the lines on the graph for better 
visibility. 

Save Chart As... : Navigate to a directory, give the chart a name and click [ 
Save ] 

Date markers... : A one or more dates to the graph which will place a vertical 
line on the chart. 

Close : Close the dialog box. 

 

Over Dependence 

Over Time Dependence 

One major obstacle to the study of network dynamics is periodicity or over-

time dependence in longitudinal network data. For example, if we define a 
social network link as an agent sending an email to another, we have continuous 

time stamped data. Intuitively, we can imagine that individuals are more likely 
to email each other at certain times of the day, days of the week, etc. If the 
individuals in the network are students, then their email traffic might follow the 

school's academic calendar. Seasonal trends in data are common in a variety of 
other applications as well. When these periodic changes occur in the 

relationships that define social network links, social network change detection 
methods are more likely to signal a false positive.  

A False Positive : This occurs when the social network change detection 
method indicates that a change in the network may have occurred, when in fact 

there has been no change. 
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To illustrate, assume that you are monitoring the density of the network for 
change in hourly intervals. The density of the network measured for the interval 

between 3 A.M. and 4 A.M. might be significantly less than the network 
measured from 3 P.M. to 4 P.M. because most of the people in the network are 

asleep and not communicating between 3 A.M. and 4 A.M. This behavior is to be 
expected, however, and it is not desireable for the change detection algorithm to 
signal a potential change at this point. Rather, it would be ideal to control for 

this phenomenon by accounting for the time periodicity in the density measure. 
Only then can real change be identified quickly in a background of noise. 

Periodicity can occur in many kinds of longitudinal data. Organizations may 

experience periodicity as a result of scheduled events, such as a weekly meeting 
or monthly social event. Social networks collected on college students are likely 

to have periodicity driven by both the semester schedule and academic year. 
Even the weather may introduce periodicity in social network data, as people are 
more or less likely to email, or interact face-to-face. 

Spectral Analysis provides a framework to understand periodicity. Spectral 

analysis is mathematical tool used to analyze functions or signals in the 
frequency domain as opposed to the time domain. If we look at some measure 

of a social group over time, we are conducting analysis in the time domain. The 
frequency domain allows us to investigate how much of the given measure lies 
within each frequency band over a range of frequencies. 

For example, the figure below shows a notional measure on some made-up 
group in the time domain. It can be seen that the measure is larger at points B 
and D corresponding to the middle of the week. The measure is smaller at points 

A, C, and E. 
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If that signal is converted to the frequency domain as shown in the figure 

bwlow, you can see how much of the measure lies within certain frequency 
bands. The negative spike corresponds to 7 days, which is the weekly periodicity 

in the notional signal. The actual frequency signal only runs to a value of 8 on 
the x-axis. The frequency domain signal after a value of 8 is a mirror image, or 
harmonic of the actual frequency signal. 
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The frequency domain representation of a signal also includes the phase shift 

that must be applied to a summation of sine functions to reconstruct the original 
over-time signal. In other words, we can combine daily, weekly, monthly, 

semester, and annual periodicity to recover the expected signal over-time due to 
periodicity. For example, the next figures represent monthly, weekly, and sub-
weekly periodicities. If these signals are added together, meaning that the 

observed social network exhibits all three of these periodic behaviors, the 
resulting signal is shown in Sum of the Signals. 
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If the periodicity in the signal is not accounted for, it appears that there may be 
a change in behavior around time period 20, where the signal is negatively 

spiked. In reality, this behavior is caused by periodicity. If you transform the 
signal to the frequency domain you can see the weekly periodicity at point B and 

the sub-weekly periodicity at point A. 
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Spectral Analysis applied to social network measures over time will identify 
periodicity in the network. The next procedure will transform an over time 
network measure from the time domain to the frequency domain using a Fourier 

transform. Then the significant periodicity will be identified in the over-time 
network and present two methods for handling the periodicity. 

The over time dependence analysis is accessed by selecting the Fast Fourier 

Transform tab in the Over Time Viewer. This displays the frequency plot of the 
data. 

You can use the Over Time Viewer to help determine which frequencies are 

significant. 

The [Dominant Frequencies radio button], displays only the statistically 
significant frequencies. 

The [Fourier Transform radio button] uses the normal distribution in order to 

transform data from the time domain to the frequency domain. Therefore, the 
normal distribution is an appropriate distribution to fit to the frequencies plotted 
in the frequency plot. All frequencies that are within two standard deviations of 

the mean are then set equal to zero for the dominant frequency plot, revealing 
only the dominant frequencies. 
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NOTE : A dominant frequency is a potential source of periodicity, as opposed to 
random noise in the over time signal. 

The analyst will often want to transform the statistically significant frequencies 

from the frequency domain back into the time domain so that he/she can make 
better sense of them. To do this, the analyst must select the radio button on the 

lower left called Period Plot. 

The [Period Plot radio button] shows the analyst the expected periodicity in 
the over-time data. In the example, you can see weekly periodicity. The peaks 

and valleys in the period plot occur approximately every 7 days. At this point, 
the analyst may wish to merge the daily data into weekly networks. This would 
average out the effects of weekends and evenings that are likely to affect the 

properties of daily networks. Another approach is to simply look at the networks 
departure from what is expected. 

The [Filtered Plot radio button] will create an over-time plot of how the 

measure deviates from what is expected, based on the periodicity of the 
measure. You can also plot the filtered measure with the original measure to see 
the difference as shown below. 

 

Procedure 

Your Dataset 

 

Load your dataset which you need to run the 
Change Detection on into ORA. This should be a 
dataset with multiple time periods. Measures will 
be run on all the time periods and this will 

determine IF a change has happened. 
 

Highlight the Meta-Network. 

Start Measures Over Time Function 

From the Editor's main menu select Visualizations > View Measures Over 

Time... to start the process. In the dialog box select Centrality measures radio 
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button. The measures for Change Detection you are mostly concerned about are 
the Closeness and Betweenness measures. But this will not always be the case. 

Finally click [Compute]. 

Set Parameters For Trigger 

False Alarm vs. Fast Detection : You need to determine which type detection you 
are looking for. This will help you set the trigger point. Where you set the risk bar 
has an effect on triggering alarms. Set it too low and it will trigger an alarm quite 

frequently possibly giving too many false alarms. Set it too high and you might not 
see the trigger until it's too late. 

Example 

I select Network Centralization, Row Betweenness : A-03 

Next I click the Change Detection tab abd select CUSUM from the drop down 
menu. 

I then set the Risk to 0.17 and click [Compute]. 

 

Setting the Risk to 0.17 sets the trigger line in the chart (1). 

The datapoint at (2) is a major spike but has not set off the alarm yet. 
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After a slight decrease the next jump at datapoint (3) is still under the trigger point 
but very close. and the following datapoint sets off the alarm Sep-2009. Tracing 

backwards the point of change is Jul-2009 when the upward trend began. 

NOTE : There are two separate charts plotted. One is for increases (red) in the 
social network measures, and the other is for decreases (blue) in the measure. 

 
NOTE : When a change signals in both increasing and decreasing directions, it is 

likey a false alarm. 
 
NOTE : Once a signal occurs the CUSUM is no longer plotted over time. 

Early Detection/False Alarm 

 

Setting parameters to different values can make changes in the alarm rate. 
Changes in the parameters (1) are Networks in control increase to 4 and Risk 
increases to 0.193. This lowers the alarm trigger point to 0.7 (2). 

(3) shows that the alarm is triggered in Aug-2009, a month earlier than the 
previous example although the upward trend is also Jul-2009. 

Had the Risk been risen any more the alarm would have been triggered in Jun-
2009 and the changed point would be taken as May-2009, a full two months 

earlier than the previous example. 
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The question would be is May-2009 the true change point or is it merely a false 
alarm given the parameters set to detect it. 

 

Drill Down 

 DrillDown allows for any path to be followed. 

From the drop down textbox select the node you wish to start with. Here we'll begin 

with daniel_jackson. 

 

The dialog box below will appear confirming you want to discontinue your last drill-
down session. 
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Click on the node and a contextual menu will appear with all the links it has to 

other nodes. I select <event> (5 nodes). 

 

This shows the five events the daniel_jackson was at. 



 

342 
 

 

Next I select summit_meeting and from the contextual menu select <resource> 
(4 nodes).  

 

It drills down showing the five links to resource nodes connected to the 
summit_meeting. 
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This can be continued for as long as you need. 

The [+] and the [-] buttons increase and decrease the font size. 

 

Node Cloud 

 In ORA you can opt to visualize your data as a word cloud. A word cloud can 

loosely be described as a visual representation of words that appear within your 
data by displaying words that appear with the most common frequency as the 

largest. Below is a screen image of the SG1 data set as visualzed in ORA's word 
cloud feature. 
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Word Cloud Tools and Settings 

File : By accessing the File Menu you can open a previously saved Meta-Network, 

Save an Image to the clip board, and close your Meta-Network word cloud. 

Options : In options, you can choose the measure you wish to apply to your word 
cloud visualization. 

Horizontal Words : You can use this slider to set the ratio of the horizontal words 

visualized to the vertical word display (e.g, changing this setting to 100% would 
result in all horizontal word visualizations and no vertical words. Conversely, 
changing this setting to zero has the opposite effect.  

Select a layout : Choose either word cloud layout (default) or a square layout. The 

square layout will attempt to visual your word cloud in approximate equal ratio of 
width and height.  

Min. Font Size : Sets the parameter for the smallest font size to display. Note: if 

you change this setting, click "run" to have the new setting applied.  
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Max. Font Size : Sets the parameters for the largest font size to display. Note: if 
you change this setting, click "run" to have the new setting applied.  

Max Words : Sets a limit on the maximum amount of words to visualize (e.g., if 

you set this at 10, the word cloud will only visualize the words that appear in the 
top ten in terms of frequency.  

Run : Click [Run] to apply any changes to the settings. 

 

Color Grid 

The Color Grid is designed to allow you to quickly see what connections are in a 
network. Whereas the Editor either uses numbers in it's numeric view or check 
boxes in it's binary view the colored blocks used in the COlor Grid make it easier to 
discern who has a connection to whom. 

The color ranges from White : no connection; Yellow : few connections; Red : the 
most connections. 

 

Menus 

File > Save Image As... Creates a color image (JPG or PNG) of the currently 

display grid. 
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File > Save Image As... (Greyscale) Creates a greyscale image (JPG or PNG) of 
the currently display grid. 

 

Options > Toggle Headers : Toggles on/off the display for the headers and 

reduces the size of the grid. 

 

 

View Trails 

 Tracks agents as they travel from location to location finding when various 

agents were co-located in the same area. 
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The Person Pane allows you to choose which Trail(s) you want to visualize, as 

well as what color to use. 

The Location Pane acts as more of a legend, showing you the currently active 
targets, while providing a way to change colors. 

The Trail Pane is where the trails are actually visualized. The Y-Axis 

corresponds to time. 

Trails Data 

The data to be used is known as TAVI. It tracks persons as they move around, with 

their position decided by which camera locates that person for any given time. As 
such, at any given point in time, each person is only associated with one location 

TAVI makes use of a relatively new data format known as the Dynamic Meta 
Network. The Dynamic Meta Network allows for creation and usage of multiple time 
slices, while keeping file size complexity to a minimum. In TAVI's case, it works 

with around 2700 different time slices, tracking about 20 agents over the course of 
two years. 
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After a Trails dataset is loaded you can view the individual time slices in the Meta-
Network pane. To view this is Loom select Visualizations > View Trails. 

The Focus of Activity are figuring out where people tend to go and guessing what 

they do there? 

It always involves both subjects and locations. 

Unlike a network, subject may revisit location. 

The time stream is an integral part of the data. 

Subjects exist at one location at a time (but longer relationships may be 

implicit in repeated visits). 

Loom is primarily concerned with how specific entities move or evolve through 
other entities. In the most basic case, this involves Agents as they move through 
Locations, which is what we'll be looking at today. More abstract examples include 

Agents moving through Beliefs or Beliefs moving through Locations. When you first 
start Loom, you are prompted for a Network. The target nodes in the Network 

dictate what they're moving through. The source nodes are who/what is doing the 
moving. Once started, Loom goes through all time slices, and looks at the 
connections in that network only. It sets up a series of way points based on what 

connections are made at that time slice, upon which it constructs a trailset. 
Classically, we restrained Loom such that for any time slice, any source node could 

appear in at most one target, but now we allow for a source node to occupy 
multiple targets at a time (Agents having multiple beliefs, for example). 

Notes on Trails : Everything is scaled according to time. This can lead to some 

interesting behavior. In this example, we see a horizontal line. This doesn't mean 
an entity occupied two targets at that time, but rather, is because of the scale. The 
change may have taken only minutes or hours when the entire thing looks at two 

years. 

Procedure 

The Trails Report : To access the Trails Report use the Report Manager. The 

trails report can be found either through the drop down menu or in the Geospatial 
category 

Input : The report requires an input of at least two meta-networks with similar 

network structure (for the network we're interested in). Since TAVI is dynamic, we 
can get all the meta-networks we need from it. However, 2700 meta-networks will 
take quite a bit of time to work on, so we can aggregate by month to reduce it to a 

much more manageable number. 
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Selecting a Trail(s) : The next window is perhaps the most important. While it 
doesn't ask for a specific Network, is does ask for nodes to track and a node class 

to track through. 

In other words, we're selecting the Subjects (trails) up top, and the targets on the 
bottom. Since we've been looking at Person X Location, that is what has been 

selected. 

Finish : Select the format for output, the directory in which to save it, and an 
optional extension. 

 

Help Menu 

The Help Menu contains information which is beneficial in running ORA. 

 

Help Contents : Calls up this Help File System 

 

System Monitor :  

 

 

About Ora : Contains information regarding this software, the institute of 
origin, permissions and warranties, version and build dates, and Java 

usage. 

 

 

The ORA Visualizer 

The ORA Visualizer produces a graphical model of a Meta-Network comprised of 
Links and Nodes. Moreover, you can interact with your Meta-Network model by 
removing key actors, isolating certain links, focusing on any particular 
relationship between two nodes using tools such as the Path Finder.  
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You can apply a host of grouping algorithms, look at node's Sphere of Influence, 
Locate Nodes, which may be hidden in complex clusters of nodes and links. 

The Visualizer Interface 

Below is a visualized Meta-Network displayed with the current tools available in the 
Visualizer. In this view all nodes and links are visualized. Note the different palette 
areas and options available from the Visualizer.  

 

NOTE : If a Meta-Network contains more than 400 nodes then all node labels will 
be hidden. If a Meta-Network contains more than 1000 links then all links will be 

hidden also. The labels and links still exist and still factor into the layout, but just 
aren't drawn. The user still has the option to toggle them back on using the 
corresponding buttons on the Visualizer. 

Closing the Visualizer 
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When you close the Visualizer you will be asked [Save Visualizer options?]. 
Selecting [Yes] will maintain the current state this Meta-Network is in. i.e. If you 

have hidden any nodes they will not appear the next time this Meta-Network is 
opened. 

Synchronization 

Synchronization allows you to work in the Editor and instantly see those effects in 

the Visualizer (or visa versa). Adding or removing a link in the Editor will place that 
link on the screen in the Visualizer. 

The ORA Layout Algorithm uses a standard spring embedder algorithm. For large 

data sets, this has been enhanced using the Barnes-Hut Simulation for calculating 
the force of repulsion between any two nodes. 
Reference :Nature 324, 446 - 449 (04 December 1986); doi:10.1038/324446a0, A 

hierarchical O(N log N) force-calculation algorithm, Josh Barnes & Piet Hut 

 

Visualizer Basics 

Contained in this section are some basics to the visualizer. Many are small, yet 
important aspects to the visualizer. 

 

Add Deltas 

Importing deltakey frame data 

The easiest way to create a dynamic Meta-Network is to first create a number of 

regular Meta-Networks. Then select all the Meta-Networks you want to merge into a 
dynamic Meta-Network. Right-Click on one of the highlighted Meta-Networks in the 
editor tree. Select Create a Dynamic Meta-Network from the contextual menu. 

This brings up a Dynamic Meta-Network importer dialog containing all Meta-

Networks you had selected. Next you need to select which Meta-Networks you want 
to act as keyframes. This can be as little as just the first Meta-Network or as many 

as all the Meta-Networks. Click the [ Import ] button at the bottom of the screen. 
A Dynamic Meta-Network will be created. 

Does data have to be in deltakeyframe to run Loom 

No. It can be run with multiple Meta-Networks as long as the Node IDs in the 

locations NodeClass match in all Meta-Networks. In the zip file I sent for Star Wars, 



 

352 
 

I included the regular meta-networks. Select all of 'em, and go the "visualizers -> 
view trails" route. It'll prompt for the network, and open up Loom. 

Can you show only some time periods or some locations 

In Loom, only the Locations that have entities currently moving through them gets 
shown. If an entity is currently moving through a location, that location cannot be 
hidden. 

Similarly, there's no way to currently turn off a time period. The work-around would 

be to just not include that time-periods meta-network whenever you load up loom. 
I'm anticipating this being something I'm going to get to implement.  

 

Dotted-Line Links 

You can set this parameter to change certain links from solid lines to dotted lines by 

setting the parameter on the toolbar. 

 

Change the dropdown menu from Hide links with weight: to Change to dotted-
lin links:. Then set the trigger [Less Than, Equal To, Greater Than], and then set 

the value. 

Any link which matches these parameters will be converted to a dotted line. 

 

Link Thresholds 

ORA attempts to find the link underneath the cursor. But as the number of links 
increases it becomes more difficult for to acquire the correct link. 

A threshold limit of 5,000 has been set. ORA will not attempt to locate the link 
under the cursor when viewing a Meta-Network with more than this number. 

10 MAR 11 
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Selecting Nodes 

There are times you need to have a set of nodes selected in order to work on them. 
Instead of clicking on each node individually you can use the Marquee tool. 

Selecting a Set of Nodes 

  With The Marquee Tool you can select a set of nodes to work with. To select 

your nodes, Click and Hold the mouse button, drag the pointer to select the 

nodes, and release the button. 

 

The Visualizer Toolbar 

This section explains the function of each of the toolbar's default buttons. The user 
can add or remove buttons from the toolbars. These are explained in other sections 
of this help. 

When you first load a Meta-Network you will see the pause button depressed in 
the Visualizer tool bar. You can layout the Meta-Network by clicking the play 
button. The visualization will space apart across the screen. This is called laying 

out a Network. The Visualizer is separating nodes and links that, at first, appear on 
top of each other. You can pause this process again when you think the Meta-

Network is satisfactorily spaced apart or you can let ORA lay out the entire Meta-
Network. Your computer speed, as well as the complexity of Meta-Network, will 
determine how long this takes.  

 

Copy / Paste : This feature allows you quickly capture a visualization 
and save it to be pasted into another document later. 

  

Play / Pause : The Play Pause function works very similar to the play 
pause feature on any device. The pause button (two vertical bars) is 
depressed, the Visualizer stops laying out a Meta-Network. When the play 

button is depressed (right pointed triangle) ORA Visualizer begins 
laying out the Meta-Network as described above. The red ellipse 

highlights on the tool bar where this feature is located and accessible. 

 

Magnifying / Maximizing : The Magnifying Glass icon with the plus 
sign inside it, allows you to instantly fill the Visualizer window pane with 

the currently rendered Meta-Network. The red circle in the screen shot 
above highlights where to access this feature on the Visualizer tool bar. 
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If there are any nodes off screen, clicking the button once will bring all the nodes 
into view on the screen. 

NOTE : This function works well when selecting a small part of your overall Meta-

Network and magnifying it to fill the visualizer screen. 

 

Rotating The Visualization : To Rotate your visualization look for 
the word next to the Noon-pointing sundial icon in the tool bar. 
This feature is another way to manipulate your visualization to fill 
the entire visualizer window pane. 

NOTE : Use this feature in conjunction with the magnifying glass function to work 
your visualization into largest size possible. 

 

Show Labels : The Show Labels button allows you to toggle the labels 
on & off in the visualizer. Default is is ON. 

 

Show links : The Show Links button allows you to toggle the links on & 
off in the visualizer. Default is is ON. 

 

Show Arrows : The Show Arrows button allows you to toggle the 
arrows on & off in the visualizer and show directional data. Default is is 

OFF. 

 

Font Size : The Font Size allows for setting the size of the font 
in the visualizer. This allows you to change the size of the font to 

suit you needs for each individual visualizer set. It ranges from 
4, which is almost unreadable, to extremely large numbers, 
which can also be unreadable by virtual of overcrowding. So pick 

the size of font that best suits your screen. 
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Node Size : The Node Size allows for changing the node size, 
larger or smaller by increments of one. Four is the smallest size 
possible and creates a very small, almost indistinguishable dot. 
As the number increases is becomes easier to see the individual 

nodes until the number gets to a point where is can simply 
overpower the screen. But this gives you the ability to 

customize the entity size to suit your needs. 

 

NOTE : This also affects the size of the nodes in the Legend. 

  
Link Width : Allows for changing the general width of the line, larger or 
smaller. And as the options before you can pick the exact size which best 

suits your needs for the display. 

 

 

Meta-Node Size : Use the Meta Node Manager to handle creating and 
removing Meta-Nodes. 

 

Node Sizes : The Toggle Node Size button rotates through three sizes for 
the nodes (as seen below). 
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Hide Links by Weight : Use the Hide Links with Weight to select which links to 
display. As long as there are links with different values you can hide links of smaller 
values leaving only the more important links visible. This can assist in seeing links 

that might normally be too cluttered to view. Below left is a Meta-Network with all 
links in view. Below right is the same Meta-Network with links less than 2.0 hidden. 

 

 

Drag : Used to move the view around the Meta-Network to see different 
parts. Press and hold the left mouse button and move the pointer around 

to view various parts of the Meta-Network. 

 

Marquee : Click and drag the marquee over nodes to select them. 
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After releasing the mouse button the set of selected nodes will remain enlarged 
enclosed in a dashed line. 

 

After selecting a group of nodes they can be moved all together. Press the [Pause] 

button on the toolbar, switch to the [Move] tool, then grab and move the group. 
This is useful in creating displays of small portions of the visualizer. 
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NOTE : Only one set of nodes can be selected at a time. Creating a second 
selection negates the first nodes selected. 

 

The Paint Tool : The Visualization Paint tool allows you to draw on 
the visualization.  You can select a brush size and a brush color via a 
small pop-up menu that appears whenever paint mode is selected.  

Nodes are also selected whenever you stop drawing, using the shape 
drawn (plus a line from the endpoints of the drawing) as a giant polygon, 
which selects nodes based on whether or not they’re inside the polygon.  

There’s also a ―clear‖ button that removes all paint. ―painting‖ works 
similar to using a marker on your computer screen – no matter how 

much you zoom/pan/do whatever to the visualization, the marks will 
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remain in the same place. 

 

Node Creator : You can create new nodes within pre-existing 
NodeClasses or create them in a new NodeClass. 

 

Link Creator : Click on one node then drag the pointer to a second 
node. A link between the two will be created. 

 

Node / Link Eraser : While the Eraser tool is active any node or link 
clicked will be removed from the Meta-Network,/tr>  

 

 

Visualizer Toolbar 

 

 

To help facilitate your workflow ORA allows you to mount/unmount tool 
buttons in the Visualizer's toolbar. The Visualizer contains two toolbars 

for this function. One on the top and another along the left side. Either 
of these toolbars can be placed in the horizontal or vertical position. 

Click the down-triangle to open the dialog box. 
 
The grey-out buttons are the default set. The buttons at 100% are the 

ones I added to my GUI. 
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NOTE : Buttons without graphic images are placed on the toolbar using words. 
When placing a toolbar vertically it will expand to the width of the largest button. 

 

The Configure Toolbar dialog box 
will appear. You will notice that 

some items are already checked. 
These correspond to the buttons 
already present. Placing a check 

mark next to any tool instantly 
mounts it on the toolbar. Removing 

the check mark from a button 
instantly removes the button from 
the toolbar. 

 
When you are finished click 

[Close]. 
 
If at any point you can select the 

[Restore Default] button which 
will remove all the changes you 

made and restore the toolbar to the 
buttons found in the image at the 
top. 

NOTE : The buttons appear in the order you select them. You can not re-arrange 
buttons once they are placed on the toolbar. 

 

Hide Links By Weight 

ORA can visualize your network with only the more weighted links displayed. 
Below are procedures to accomplish this task.  

You can select to hide links either Less Than or Greater Than a certain value. 
Below is an agent x location network. And there are three tooltips displayed for 
jacob_carter for the values of 1.0, 2.0, and 3.0. We'll keep the hiding style as Less 

Than. 
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First we'll increase the value to 1.1 hiding all lower values. The link to the 

hasaraSystem_spaceStation is removed from view. The others, however are still 
on the screen. 

 

Now let's increase the value to 2.1. This removes the link from jacob_carter to 
revanna. 
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If we increases to value to 3.1 then all of the links would be removed. 

In this way you can remove links which are of lesser important to concentrate on a 

smaller set of data. 

 

Hyperbolic View 

The Hyperbolic function creates a bulge within your visualization adding a sense of 
depth. By moving the slider from right to left, you can increase or decrease this 

bulge effect and create different depth-added views. By moving the network around 
the window you can create the view you need. The Hyperbolic radio button and 
slider can be found at the bottom of the window. 

This tool is useful when nodes may be very tight on screen such as the ones in the 

following images. Using the Hyperbolic tool you can help space them out for easier 
viewing. Here is how to do so: 

 

NOTE : The Hyperbolic function, when selected, converts the slider to this feature. 
This is also true of using the zoom and rotate functions. Use all three in conjunction 
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to get your visualization just the way you want it. Scroll down below this screen 
shot for another when viewed with the Hyperbolic feature. 

 

Select the Hyperbolic tool and move the slider to the right. Then click-and-hold on 

some part of the white background and move the entire network to the left. You will 
notice the space between the nodes begins to increase the closer them come to the 
center of the screen. 

 

Now the nodes are able to be read much easier. 
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NOTE : It is useful to use this tool in conjunction with the Rotate and Magnify 
tools to obtain just the view you desire. 

 

Visualizer Paint Tool 

 The Visualization Paint tool allows you to 
draw colored lines on a visualization. You can 

select a brush size and a brush color via a small 
pop-up menu that appears whenever paint mode is 

selected. 
 

Nodes are also selected whenever you stop 
drawing, using the shape drawn (plus a line from 
the endpoints of the drawing) as a giant polygon, 

which selects nodes based on whether or not 
they're inside the polygon. There's also a clear 

button that removes all paint. Painting works 
similar to using a marker on your computer screen 
- no matter how much you zoom/pan/do whatever 

to the visualization, the marks will remain in the 
same place. 

 

From the Paint Palette you can select a brush size by adjusting the slider. Then 
choose a color by clicking a pre-set colour or clicking the [Custom Color] button 

and select any color. Clicking the [Clear] button sets everything back to default. 
Once brush size and color are selected, you can draw on the Visualization. 

To undo your drawing click the [Clear] button. 

NOTE : If you pan the visualization, the paint drawing will remain stationery on the 

screen. It does not move with the visualization.  

 

Rotating A Visualization 

You can rotate a visualization with the slider bar at the bottom of the interface or 
from the tool bar at the top. To do this from the slide bar, click the rotate option 

toward the bottom of the interface. This activates the rotate feature.  
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As you move the slider from the left to right, your visualization will rotate 
correspondingly. From the tool bar, you can click inside the rotate icon, which will 

turn the visualization depending on exactly where you clicked.  

In the screen shot below, the yellow ellipses highlight where to access ORA's rotate 
tool both at the bottom and top of the visualizer interface. 

NOTE : Use the rotate feature in tandem with the magnifying glass to find a 

visualization's maximum screen size. 

 

 

Show/Hide Labels 

 Node labels, which often prove helpful in describing Networks, can sometimes 

clutter a visualization. Thus, it may be necessary to eliminate labels from your 
visualization. To remove labels go to Visualizer tool bar and find the Show Labels 
button. 

This initial screen shot shows the visualizer with all the labels. 
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When you click the Label button on the Visualizer tool bar ORA toggles the labels on 
and off. Note that now a much more clearer conceptual picture of the network is 
produced. You can flip between the two views. 

 

Zooming 

At the bottom of the Visualizer interface is a sliding zoom bar (image below).  

You can drag the scrollbar left (to zoom out) or right (to zoom in).  

 

In the screen shot below the zoom bar has been set to the far left, the absolute 
zoom out possible. At this point very little is distinguishable. 
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In the next shot the zoom bar has been placed almost to the far right, absolute 

zoom in. It allows for extreme closeups of various parts of the Meta-Network. 
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NOTE : Clicking on the Magnifying glass in the Visualizer tool bar will set the view 
to include all visible nodes. 

 

File Menu 

 

Open Meta-Network : This opens an Open File dialog box so you can 
navigate to a directory and open a Meta-Network into the Visualizer. 

 

Open Ora-Image :  

 

Save Image to File : This opens a Save As... dialog box and allows you 
to save an image of the current Visualizer in one of the following formats: 

PNG, JPEG, SVG (scalable vector), or PDF. 

 

Save Meta-Network to File : After you've made changes to the 
information you can save the current status of the Meta-Network into a 

new file in a DyNetML* format. 

Save Special :  

 

Save Meta-Network (Only Selected Nodes) : Saves a new Meta-
Network file which will contain only nodes currently selected, i.e. a subset 
of the currently loaded Meta-Network. 

 

Save Grouping to New Meta-Network :  

 

Save Meta-Network (No Dotted Links) :  

 

Save Meta-Network (Only Dotted Links) :  

 

Copy Image to Clipboard : Similar to the Save Image to File... only 
saves it to the clipboard where you can paste it into an image-editing 
program. 

 

Add Meta-Network to ORA : Save the currently visible network into a 
new Meta-Network titled, New Meta-Network. This new Meta-Network 

can be renamed accordingly. 
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Add Grouping to Current Meta-Network :  

 

Add MetaNodes to Current Meta-Network :  

 

Visualize in 3-D :  

 

GeoSpatial Networks :  

 

Node Cloud :  

 

Close : Close the Visualizer and returns to the Main Interface. 

 

 

Save Image to File 

An image can be captured from the Visualizer and saved in one of four formats: 

 PDF : This format us usable with Adobe's Acrobat and Reader programs. 

 JPEG : A standard compressed format for image editing. 

 PNG (Portable Network Graphics). PNG is a bitmapped image format that 

employs lossless data compression. PNG was created to improve upon and 
replace the GIF format. 

ORA Images are functional in regards to PNGs. Whenever you save a PNG, 

relevant information about the visualization gets stored inside the image. This 

makes saving a little longer, but not so long that you'd notice if you were not 
looking for it. These images Node Colors, Node Location, Screen Center, and 

Zoom Value. 

Loading images into a visualizer will re-create the image inside the visualizer. 
Loading an image is as simple as dragging-dropping it onto the visualizer.  

SVG : Stands for Scalable Vector Graphics. SVG is an XML specification and file 

format for describing two-dimensional vector graphics, both static and 
animated. SVG can be purely declarative or may include scripting. Images can 
contain. 

Selecting Image Resolution on Save 
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After choosing a format form the drop-down menu and specifying a filename press 
[Save]. A dialog box will appear asking for the quality of the image. The 1.0 saves 

the image in the same resolution. A higher number will result in a higher resolution 
image. 

 

Below are examples of an image saved with a scale of 1.0 (on the left) and then 
saved with a scale of 5.0 (on the right). Use a number higher than 1.0 if there is a 

need for a higher resolution image. 

 

NOTE : Values less than 1.0 are ignored when scaling images. 

 

Saving New Meta-Networks 

Occasionally you need to select only a portion of the visible Meta-Network and save 
them to a new Meta-Network. Using the Marquee tool and Control-Clicking 
individual nodes you can select exactly which nodes you need to create a new 

Meta-Network. 
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From the main menu select File > Save Special > Save Meta-Network (only 
Selected Nodes). Navigate to the directory to save the new Meta-Network and 

click [ Save ] 

This new Meta-Network can be loaded into ORA and viewed independent of the 
original Meta-Network. 

Save Selected Sub-Network 

Ability to save selected sub-Meta Network/Network comprised of dotted-

links/network comprised of non-dotted links, ability to launch into GIS (if network 
has locations with appropriate data) 

 

Views 

This section of the help contains a description of the functions of the View Menu: 

 

Change Font : Allows you to change the GUI font to any font on your 
system. Be careful with the font chosen as some fonts are built more for 
custom design rather than readability. 

 

Log Hidden Nodes to Event Log :  

 

Log Hidden Nodes to File :  

 

 

Actions 

This section of the help contains a description of the functions of the Action Menu: 

 

Undo : Undoes a variety of actions performed in the Visualizer. 

 

Add Node(s) : Function for adding Nodes directly into the Visualizer. 
These can be added to existing NodeClasses or within newly created 
NodeClasses. You also have the option of the number of nodes to create. 

 

Add Node (with links or attributes) : Allows you to add a Node directly 
into the Visualizer. In addition you can create links and assign weights to 
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these new links. You can also select attributes and assign values to these 

attributes. 

 

Add Link : Allows you to create new links in a Meta-Network in the 

Visualizer. Then select the source and target nodes and then select the 
network. You have the option of creating a new network for this link. 
Lastly you can select the weight of the new link. 

Notes on Display of Multiple Edges : If your Meta-Network contains graphs with 
multiple edges between two nodes ORA will display the edges as curved 
lines so as to allow visualization of overlapping Edges. This is to say that if 

there is represented two nodes with four edges coming from four different 
graphs. 

Please note that Tool tips are currently handled by math looking at the edge 

as if it were a straight line. Since our line is not straight anymore, it will only be 
highlighted if the cursor's in the middle - nowhere near the edge. But otherwise, 

you should still see tool tips. 

 

Delete Isolates... : Allows you to remove Isolate nodes in two ways. 

 

Delete Pendants : Allows you to remove Pendant nodes in two ways. 

Delete Currently Visible Isolates/Pendants : Currently Visible is 
exactly as it sounds. If it has no visible link on the screen, it's an isolate. 
It does not matter if there's a link that is hidden, it's an isolate/pendant. 

Delete Underlying Isolates/Pendants : Underlying ignores was is 

currently set to visible and hidden. It looks at the data itself. If the Data 
says it's an isolate/pendant, then it's an isolate/pendant and is removed. 

WARNING : These actions DELETE the nodes from the Meta-Network. Saving the 

Meta-Network will permanently remove the nodes. 

 

Pin All Nodes : Set all nodes as unmovable 

 

Unpin All Nodes : Release all nodes and allow them to be moved 
independently. 

Show Motifs 
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Show Isolates : Nodes which have no connection to any other node. 

 

Show Dyads: Nodes which have a connetion to only one other node 

 

Show Triads : Nodes which have a connection to two other nodes 

 

Show All-In-All Cliques : A group in which every node is connected 
to every other node in the group 

 

Show Stars : A central node with connections to all other nodes in the 
group. The pendant nodes are not connected to each other. 

 

Show Long Chains : Seeks out links which are nodes with only two 
neighbors. 

 

Show Cycles : A cycle exists if for any node in the group, there is a 
path back to that same node. 

NOTE : Cycles is the only motif that really looks at link direction. 

Isolates 

 

Hide Isolated Nodes : Remove any node which has zero links 
connecting it to other nodes. 

 

Periphery : Moves Isolates back to their original position. 

 

Combine into MetaNode : Collects all the Isolate nodes into a Meta-
Node. 

 

Move into Column : Moves all isolates to the right side of the screen in a 
column. The isolated nodes can be moved back using the Periphery 

option. 
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Hide Pendant Nodes : Remove any node which has only one edge 
connecting it to another node. 

 

Recursively Hide Pendants : This function will run the both the Hide 
Pendant routine until there are no more Pendants. 

 

Recursively Hide Pendants and Isolates : This function will run both 
the Hide Pendant and Hide Isolate routines until there are no more 
Pendants or Isolates. 

 

Hide Nodes by Degree: You are asked for a degree (visible neighbors) a 
node has and will hide all of these. 

 

Recursively Hide Nodes by Degree: Works similar to Hide Nodes by 
Degree but continues processing until no mode nodes can be hidden. 

 

Show All Nodes: Any nodes that were previously hidden will be revealed. 

 

Show All Nodes Except Isolates : Reveal any nodes that were 
previously hidden with the exception of nodes that have no links 

connecting them to another node. 

 

Compute Standard Measures for Visible Network : Compute Standard 
measures computes the following collection of measures on the visible 

network: Total Degree Centrality, Betweenness Centrality, Eigenvector 
Centrality, Cognitive Demand, Resource Exclusivity, Task Exclusivity, 

Knowledge Exclusivity. The measure values can then be viewed within the 
Entity Status Window. 

 

 

Hide Pendants 

Pendants share links with only one other node. Their linkage is tangential and 
therefore isolated from the core linkages you may be interested in examining. 

Pendant Nodes, like Isolated Nodes, can be hidden. 

From the drop down menu in the Visualizer select Tools > Hide Pendant Nodes.  

Below is a Before/After screen shot of the visualization before showing the 
removal of the pendant nodes. 
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Add Node 

IMPORTANT NOTE : Changes done using Add Node(s) and Add Link(s) are 
transient. Be sure to use either the File > Save Meta-Network As... (to save the 

entire Meta-Network with additions) or File > Add Meta-Network to Ora (to 
create a new Meta-Network using only the currently visible nodes). Changes can 
not be saved back to the currently open Meta-Network. 

The Add Node(s) function allows addition of nodes to the current Visualizer. These 

added Nodes are not added to the currently open Meta-Network. If there is a need 
to save the Meta-Network with the added nodes then use the menu item File > 

Save Meta-Network to File... and create a new Meta-Network. 

Below is the NodeSet for Stargate with the original 16 node NodeSet. 
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From the main menu select, Actions > Add Node(s) which brings up the Add 

Node(s) dialog box. 

 

1. Use an Existing nodeset :  

allows for for a NodeSet selectable in option 2 or Use a new nodeset 

creates a new empty NodeSet. 
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2. This dropdown gives the option for selecting a pre-existing NodeSet to place 
the new node. 

3. The Node ID: textbox is used for giving the new node an ID. 

4. The Number to Create: specifies the number of new nodes. 

NOTE : If the Number to Create is larger than 1 then the text placed in section 3 

for Node ID will be used as a prefix for all new nodes crated. 

After inputting the information to add node A17, the Visualizer will now display the 

new node as A17 with no connections. In order to display this node with a title will 
require saving the Meta-Network and changing the information within the ORA 
Editor. 

 

Adding Multiple Nodes 

The procedure for adding multiple nodes is similar to adding a single node. The 

exception is the text in the Node ID: textbox. When adding multiple nodes only 
use a prefix. ORA will attach numbers, starting at 1, for each node. 

Here's the addition of three new nodes and the prefix A will be used. Three nodes, 
A_1, A_2, and A_3 are created on screen. 

NOTE : You can only use a prefix ONCE. ORA will not accept any previously used 

prefixes a second time. 
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To add additional nodes use a different prefix. 

 

NOTE : Now either save the altered Meta-Network using the File > Save Meta-
Network As... to a new filename or continue with Add Link(s). 

 

Add Link 
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Allows you to create links between nodes in the Visualizer and place them in an 
existing NodeClass or create a new NodeClass. You can also set the weight for the 

new link. 

 

NOTE : Changes done using Add Node(s) and Add Link(s) are transient. Be sure to 
use either the File > Save Meta-Network As... (to save the entire Meta-Network 

with additions) or File > Add Meta-Network to Ora (to create a new Meta-
Network using only the currently visible nodes). Changes can not be saved back to 

the currently open Meta-Network. 

1. Start node : The start of a directed edge. 

2. End node : The end of a directed edge. 

3. Insert Nodes as they're clicked : Fills in the text boxes for Node. The first 
click adds the node in the Start node section. The second click adds the 

node to the End node section. Any further clicks will make the previous End 
node the start node and the newly clicked node becomes the new End node. 
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4. Use an Existing network : will place the links within the chosen network 
form the dropdown menu and Use a new network creates a new network 

from the name in option 5. 

5. New Network ID : is the name for the new network from option 4. 

6. Network : allows you to choice the Network to create the link in. 

7. Link Weight : The weight to assign the edge between the nodes. 

NOTE : Since this function creates directed links a second link would need created 

for reciprocal action. 

Example : If a connexion was made starting with A to B, a second connexion 
would need to be made starting with B to A. 

Adding a Missed Link 

If after the Meta-Network was constructed and it's noticed an link is missing (e.g. 
janet_frazier should have been connected to gen_hammond), the missing link can 
be added immediately without returning to the editor. 

 

From the Visualizer menu select Actions > Add Edge(s). 
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Be sure that the Insert Nodes as they're clicked has been check marked and 
that Use an existing network is selected with the correct network is visible in the 

dropdown. Then select the [Create Edge] button. 

 

The two nodes are now connected with a directed link. 

NOTE : this created a directional link from janet_frazier to gen_hammond but 
not the other way. To make it go both ways, a second link from gen_hammond to 

janet_frazier would need to be created. 
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Color Nodes By Attribute 

When the agent-by-agent network is opened all the nodes default to the color 
red. ORA has default colors for all the various NodeSets. But ORA can also color the 
nodes based on their individual attributes. Here's the default agent-by-agent 

NodeSet in red. 

 

From the Visualizer main menu select Actions > Color Nodes by Attribute or 
Measure. This brings up the Node Color Selector dialog box. 

 

Selecting the down arrow for Select an Attribute:. Highlight an attribute from 
the list. ORA gives default colors to the nodes. 
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In some instances the color distinction isn't highly visible. And for presentation 
purposes a good contrast is necessary. 

To bring up the Color Selector click on the color you want to change. 

 

Note: By hovering over the measure or attribute, you can bring up detailed tool 
tips. 

Select a new color from the swatches. Then select [OK] 
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Your new color choice is now reflected in the dialog box. 

 

And the nodes with the attribute you selected are now a new, and brighter, color. 
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Compute Standard Measures 

This functions runs four standard measures: 

Cognitive Demand: Cognitive Demand measures the total amount of effort 
expended by each agent to do its tasks. Individuals who are high in cognitive 
demand value are emergent leaders. Removal of these individuals tends to be quite 

disruptive to networks. 

Centrality, Betweenness: Betweenness tells us which node is the most connected 
to other parts of a network. For example, Betweenness can tell us which person in a 

network is the most central to the network as a whole. Betweenness measures the 
number of times that connections must pass through a single individual to be 

connected. 

Centrality, Eigenvector : Eigenvector Centrality reflects one's connections to 
other well-connected people. A person connected to many isolated people in an 
organization will have a much lower score in this measure then those that are 

connected to people that have many connections themselves. This would be true 
even if such a WHO might have a high amount of actual connections (i.e. high 

degree centrality). 

Centrality, Total Degree: Degree Centrality tells us the relative number of direct 
connections a WHO might have in a network; the higher the score the more likely a 

WHO might be likely to receive and potentially pass on critical information that 
flows through the organization. 

These values can be viewed either by hovering over a node and revealing the 
tooltip or double clicking a node and bringing up the Node status dialog and 

selecting the Measures tab. 

 

Isolates 

Periphery 

Places isolates that were moved into column back to their original positions. 

Hide Isolate Nodes 

To further simply a visualization, it may prove useful to remove isolated nodes from 
the visualization.  
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Isolated nodes are not directly linked or connected to other nodes, which share 
direct links with each other. In the screen shot below, the red ellipses highlights an 

isolated nodes which need removed. 

 

Select from the Main Menu: Actions > Hide Isolated Nodes. 

In the screen shot below, after removing isolated nodes, the visualization is further 

simplified.  

 

Combine into MetaNode 

This option will combine all the Isolates into one MetaNode. This can be expanded 
right-clicking to bring up the contextual menu. 

Move into Column 

This function is used to move isolate nodes from the main viewing area to move 
easily view the connected nodes. These will be lined up on the left side of the 
screen. 

NOTE : The original dataset was changed in order to create the isolates. 

NOTE : If the names are not viewable and off the screen, change the position of 
the labels 

The isolates can be returned to the original position using the Periphery options. 
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:  

 

Add Network From Scratch 

This function also allows the creation of Networks from Scratch. First, remove the 

check marks from all the NodeSets in the Legend to remove them from the screen. 

 

The DataSet 

Next prepare your data for inclusion. Here is a small, five node, NodeSet. 

A01 col_jack_o'neill 

A02 maj-samantha_carter 

A03 daniel_jackson 

A04 teal'c 

A05 gen_hammond 



 

388 
 

From the main menu select Actions > Add Node(s). 

In the dialog box activate the Use a new nodeset radio button. Underneath, in the 
Type: dropdown menu, select the type of NodeSet. Then in the New NodeSet ID: 

textbox give it a name. Then select the [Create Node(s)] button. 

 

The five nodes will appear in the Visualizer with the prefix and attached numbers. 
Now it's time to connect the nodes. 

 

From the Visualizer menu select Actions > Add Link(s). 
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After selecting [Create Link] a new link will be drawn in the Visualizer. 

 

Now switch the NodeSet to use to Use an existing network, select the newly 
created NodeSet in the dropdown, and create the rest of the links. 
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All of the links are now complete. 

 

Save the Meta-Network with either Save Meta-Network As… or Add Meta-
Network to Ora and use the ORA editor to add in titles and attributes. 

 

Resize Nodes By Attribute 

Resize by Attribute uses the numerical value of an attribute to size the nodes. 
Sizes will be scaled accordingly. Below is an attribute created for this example.  

The numbers range from 0 to 10 and denote approximate rank. 10 denoting 

general/leader down through the ranks to 5 for civilians and finally 0 for persons 
not involved. 
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From the main menu select Actions > Size Nodes by Attribute or Measure. 
Then select the attribute to use for the sizing. When finished, select [Close]. 

NOTE : Sizing nodes by attributes only works with attributes of numerical 

content. Alpha content will have no affect on the size of the nodes. 
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Each node will now be displayed according to the value in the chosen attribute. 

NOTE : The numerals are not displayed in ORA and are shown only for display 
purposes. 
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Resize Nodes By Measure 

ORA has the capability to visualize nodes by scaling them relative to each other in 
relation to common SNA Measures or Attributes as selected within the ORA 
Visualizer.  

The key benefit to sizing nodes by Measure or Attribute is the ability to conceptually 

capture which nodes in your network figure more prominently in terms of measures 
by simply gauging their size visually and intuitively. 

First, visualize one of your networks. Below is the Stargate agent x event 

network to find the agent with expertise regarding events in the scenario. 

 

From the main menu select Actions > Size Nodes by Attribute or Measure. 
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From the bottom textbox I selected Cognitive Expertise. Each of the nodes in 
turn grows to reflect it's value from that measure. 

 

The display now changes to reflect each node's value by size. 

 

We'll compare two nodes: daniel_jackson and teal'c.  
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daniel_jackson's cognitive expertise value is 0.2400 and is displayed with a large 
red circle while teal'c's value is 0.1556 is displayed by a much smaller red circle. 

The values can be read in the Node Status dialog box. 

Cognitive Measure for daniel_jackson 

 

Cognitive Measure for teal'c 

 

 

Visualizer Tools 

The ORA Visualizer provides a suite of tools to visually analyze your Meta-
Network. The Visualizer Tools can be located accessed from within Visualization 
mode on the main menu bar (image below):  

 

Legend : Allows for toggling visibility of nodes and links on the fly. 

 

Drill Down : With the ORA Drill-Down Wizard you can quickly visualize 
ego networks by overall node class knowledge, tasks, resources, 

agents) or by choosing individual nodes from a checklist. The ORA Drill-
Down Wizard is only accessible through the Visualizer: 

 

Node StatusThe Node Status Window is selected by default. It first pops-
up when you select any node in the Visualizer. This window provides you 
with a snapshot of the currently selected node by displaying that nodes 

unique Attributes, Measures, and Neighbors. 

 

Group Viewer : Allows viewing of current display to be viewed in various 

grouping: CONCOR, Newman, Johnson, FOG, and K-FOG 

 

Node Selector : You can use the Node Selector to simply complex 
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visualizations. 

 

Link Selector : In a complex network it may be difficult to locate one 
particular link. The Link Selector allows you can chose to work with One 

Node or Two Nodes, pick which is the Source/Target node, and the 
appearance of the link in the Visualizer. 

 

MetaNodes : A Meta-Node contains multiple nodes collapsed into one. 
You can create Meta-Nodes based on the NodeClasses in your 
organization, or you can create Meta-Nodes based on the attributes of the 

nodes. To create Meta-Nodes, you must access the Meta-Node Manager. 

 

Path Finder : The Path Finder allows you to focus or drill down on a 
particular node, or multiple nodes, that you may be interested in analyzing 

in greater detail. 

 

Sphere of Influence : Each node within a network has a unique Sphere 
of Influence or Ego Network, essentially it's direct relationship with it's 
neighbors as a function of specified path length. 

 

Backward Influence : Used to view how a node influences other nodes. 

 

Block Maps : Block Maps display varying intensities of data by displaying 
"blocks" correlating to the value of data. For instance, a block map 

displaying node centrality values would reserve the largest block for the 
node highest in that value. Color is used to as well to visualize different 
values with the the darkest color reserved for the highest value. Block 

Maps can also be referred to as heat maps.  

 

Node Locator : Brings up a window with the Meta-Network in a 

collapsible tree structure. Selecting any node within this tree will highlight 
the node, enlarge it, and bring it to the center of the display. 

 

Micro Simulation : Micro Simulation allows you to run some basic 
simulations on the curretly loaded visualization. LInk weights are 
important as once they are normalized, they correspond to the probablity 

of a transmission. 

 

 

Meta-Network Designer : Allows you to create, or add icon nodes, to a 
Meta-Network display. Select the type of nodeclass then Drag and drop 

icons onto the display. 
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Networks Over Time : Allows you to view a version of your network 
across multiple time periods.  

 

Vector Maps :  

 

 

Drill Down Wizard 

With the ORA Drill-Down Wizard you can quickly visualize ego networks by overall 
node class (knowledge, tasks, resources, agents) or by choosing individual 
nodes from a checklist. The ORA Drill-Down Wizard is only accessible through the 

Visualizer: 

From the ORA Visualizer Main Menu select Tools > Drill Down. 

The following window box will appear. 
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The top sections allows you to chose the nodes for use. The bottom tabs allow for 
choosing specific nodes within a set. 

Drill Down Wizard Example 

Using the Embassy Meta-Network, we will render the various node classes using the 

Drill-Down Wizard Tool. The screen shot below displays the Embassy Meta-Network 
as it should first appear in the Visualizer. 
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From the Main Menu select Tools > Drill Down. 

This will bring up the Drill Down dialog box as shown below). 
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Here, select the node class Knowledge by selecting the Knowledge check mark 
box. The screen shot below, displays the end result that you should now see in the 
Visualizer. 
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Next, with the Knowledge node box checked, add the node class Task. The screen 
shot below displays the end result. 
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Next use the search bar feature of the Drill-Down Wizard to narrow the search. 

Enter the word Bombing in the Visualizer search field below. Then select the check 

box on the bombing row. The screen should now reflect your new search 
parameters. Everything not associated with bombing has been turned off. 
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Drill Down Wizard Explained 

The ORA Drill Down Wizard can be broken down into three primary sections of 

input: 

1. Section 1: enables you choose individual node sets or combination of node 
sets to display in the Visualizer. 

2. Section 2: of the Drill Down Wizard enables you to search for a particular 
node within your Meta-Network. This can be handy when you dealing with 

large nodesets and the one you are interested in finding is not easily located. 

3. Section 3: enables you check mark an individual node within your Meta-

Network by node class if so desired. 
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Node Status 

The Node Status Window is used to reveal pertinent information about one 
selected node. The window can be brought up by either selecting it from the main 
menu, Tools > Node status or by double-clicking the node in the visualizer. The 
dialog box below will appear.  



 

405 
 

 

The top of the box will contain general information about the selected node. 
Underneath there are five tabs available which will display the node's information. 

You can switch nodes by selecting any other node in the visualizer. ORA will 
automatically change the display. 

The Node Title: box allows you to change the title of the selected node. 

Tabs 

Neighbors : displays the nodes which are linked to the selected node. It also 

displays the weight of each link. 

Sources :  

URIs : If there are any URIs attached to the node they are display under this tab. 

Attributes : Types and Values of all attributes are displayed under this tab. 

Measures : If Measures were run on the Meta-Network their values are displayed 

under this tab. 
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Attribute Button 

This dialog box allows you to add attributes to a node. Click the Add Attribute 
button. 

 

The drop down menu on the left contains all the current attributes for the node. You 

can select a pre-exising attribute, enter a value, the click the Add Attribute 
button. 

This also allows you to create New Attributes. Scroll down to the bottom of the 

drop down menu and select <Enter New Attribute ID:>, enter a Value, and click 
the Add Attribute button. Your new attribute will appear in the Meta-Network. 

Show This Window check box 

When a check mark is placed in this box it causes this dialog box to appear 

whenever you click a node in the Visualizer. 

 

Group Viewer 

The Group Viewer helps separate nodes into distinct groups.  

We'll use one of the networks for each of the groups to further examine the 

breakdown. 

There are six groupings which can be called up: 

Clique :  

CONCOR :  

Johnson :  

Newman : Used to find clusters in a network. 

FOG :  

Alpha-FOG :  
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ORA implements the newman algorithm presented in the following paper: 

Finding community structure in very large networks, Aaron Clauset, M. E. J. 

Newman, and Cristopher Moore, Phys. Rev. E 70, 066111 (2004). The algorithm 

uses link weights. It is not the Newman-Girvan algorithm based on betweenness 
centrality. 

Please note, Newman developed this algorithm as it scales better than the 
Newman-Girvan for large networks. 

 

Group Viewer-Newman 

Description 

Newman's Algorithm starts with each node as its own group, and then combines 

groups in a hierarchical manner until only one group remains (e.g. it is 
agglomerative hierarchical clustering). At each step, which two groups to merge is 
based on what will maximize the modularity value - or group community structure 

value. 

 

In the Group Viewer window set the Number of groups to view: to 4. 
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The Newman grouping is used to find clusters in a network. I began increasing the 

number of groups to view until the larger cluster began to break up. 

Newman with 4 groups 
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Newman with 10 groups 
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In this case the nodes remained clustered (with only one or two nodes breaking off) 

until I reached 4 as the number of groups. Then the network broke up into two 
large and two small clusters. The nodes in each of the two large clusters have a 

commonality as to the organizations they belong to and the tasks they were 
assigned. 

 

Group Viewer-Girvan Newman 

Description 

Girvan-Newman is divisive hierarchical clustering (all nodes start off in the same 
group and groups are split until each node is its own group). Groups are split by 

choosing from the edges that remain the one with the maximum edge betweenness 
score. 
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In the Group Viewer window set the Number of groups to view: to 4. 

 

Girvan Newman with 4 groups 
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Girvan Newman with 10 groups 
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Group Viewer - K-FOG 

FOG (or Fuzzy Overlapping Groups) works in either square-mode (NodeSet-1 x 
NodeSet-1) of multi-mode (NodeSet-1 x NodeSet-2). The multi-mode is the more 
natural procedure. it's prime function is to form nodes into groups (clusters or 

communities) and show which nodes share the secondary functions. 

REMEMBER : Groups produce tasks - people participate in tasks. 

Below are images of the Group Viewer K-Fog window for both SingleMode and 
MultiMode. 
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Parameters 

SingleMode and MultiMode 

Select a Network: The same in both. The dropdown menu lists all the available 
networks in the selected Meta-Network. 

Select a number of groups to see : Number of groups to divide the nodes into. 

Generally the analyst would have an idea of the number of groups that are 
necessary. 

SingleMode 

Select the number of trees per node : The number of sample events to 

generate. 

Select the tree size : The number of people involved in each group 

MultiMode 

Select Node Class to Cluster : Selects, via the radio buttons, the node class to 
display using the other node class as it's base. 

Links 
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The thickest link is usually the leader of the group. The question to ask is WHY is 
that particular person the strongest link. It is important to look at the composition 

of the group(s) involved. 

If the weights are Lopsided (many strong and/or weak links) the analyst needs to 
look at the association of the interstitial* actors whose information will assist in 

analyzing the groups. 

If a node is connected to only one group and that group has few actors then it is 
considered somewhat insular. 

SingleMode Example 

Run on the agent x agent network with a number of threes per node set to "2", 

the tree size set to "2", and the number of groups to see set to "2". The header 
designation is "S=the set (1-5)" and "G=first or second group". 
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maj_mansfield                 
0.05
26 

0.05
88 

MultiMode Example 

The agent x task network is used and the Task Node Class is selected to Cluster. 

THe number of groups to see was set to "4". The results of hitting [Compute] five 
times are shown below. Each of the results is different but there is an overall 

pattern. In four of them there is a distinctive single large cluster of nodes. 

 

 

Group Viewer-ALPHA FOG 

Alpha-FOG is similar to K-FOG in it clusters nodes into groups. The difference 
between the two is Alpha-FOG is used when the analyst is not quite sure of the 
number of groups. 

The trade-off between K-FOG and Alpha-FOG is accuracy vs. insight. 

The ALPHA-FOG dialog box 
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Parameters 

The dropdown menu contains all the networks in the Meta-Network. After selecting 
a network ORA will display the two nodesets in the network below in a set of radio 
buttons. Select one to display. The other will be used as the tasks set. 

Alpha Value (0-1): 

The slider bar controls the ALPHA-value. It defaults to 0.5. You can manually move 
the slider right or left then press [Compute]. 

Below the slider are three buttons, [Left], [Zoom Out], and [Right]. 

 Pressing the Left button will reset the three values. The left value will 

remain the same, the right values will be reduced by half, and the middle 
value will be the value somewhere between the two. Each press of the Left 
button will repeat the sequence. Pressing the Right button will do the same, 

but in the opposite direction. 

 The Zoom Out button reverse the above procedure in the exact order (i.e. if 

you pressed Left, Right Right, Left, and Left the Zoom Out button 
would undo then as Left, Left, Right, Right, Left). 
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The buttons at the bottom control the display. The [Compute] button uses the 

current Alpha value and re-display the network. The [Reset button removes all 

groups and resets all the nodes to default. The [Close] button closes the dialog 
box. 

Below is the initial display using the default of 0.5. It doesn't really tell us much 

about the grouping of the network. There are some groupings but there are also 
four groups with one node only and many small "almost" groupings. Also all the 

links are the same weight which does not indicate the leader of any group. 

 

Setting the slider bar to 0.0 groups all the nodes into a single group. This contains 
the opposite problem as there is only one group. 

 

Setting the slider bar to 1.0 divides the tasks into 18 groups, none of which are 

distinctive. There is definitely no groupings here. 
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It's necessary to find the optimum setting. 

Starting from the default setting I clicked Left. The range was from 0.0 - 0.5. got 

three groups which looked fairly good. But I decided to check out the other options. 
I clicked Left again and the range changed to 0.0 - 0.25. But it combined all the 
nodes into one group. Definitely was he correct grouping. I clicked Right and the 

range changed to 0.125 - 0.25. It split them into two groups. 
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Node Selector in Visualizer Tool 

Note : A slightly different version of this tool is available in the ORA Main Menu 
interface (i.e., non-Visualizer tool). 

You can use the Node Selector to simply complex visualizations. The Node Selector 
tool is accessible from the Visualizer menu: Tools > Node Selecter. 
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Node Selector 

Search : Displays only nodes which have matching content. To the right is the 
AND/OR dropdown box where you can select whether to make ORA search for 

entries with all terms in the box or terms in the box. 

NodeClass tabs : Contains a tab for each NodeClass in a Meta-Network. 

Node Display Area Displays all the nodes for the currently active tab. The 
checkbox to the left allows you to select/deselect nodes to work with. 

Select Visible/Un-Select Visible buttons : This works on all nodes currently 

displayed in the Node Display area. If places a checkmark [selects] or removes a 
checkmark [deselects] on al items visible. 

Visibility 
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Show Only Checked Items : Shows only nodes which have a checkmark next to 
their names. 

Show All But Checked Items : Shows only nodes without a checkmark next to 

their names. 

Add Checked Items : Adds to the visualizer display (if they are not already 
visible) any nodes which have a checkmark to the left of their names. 

Remove Checked Items : Hides in the visualizer display (if they are not already 

hiddne) any nodes which have a checkmark next to their names. 

Node Location 

Move to the Left : All selected nodes will be moved to a column to the left side of 
the screen. 

Move to the Right : All selected nodes will be moved to a column to the right side 

of the screen. 

Node Appearance 

Show Label(s) : Works in co-ordination with the [Set Labels] button and all 
selected nodes. Will make the lables visible [checkmarked] or hidden [no 

checkmark]. 

Set Labels button : Clicking this button activates your choices with the Show 
Label(s) option. 

Node Color : Brings up a color palette to chose a color. 

Change Color button : The color of any node(s) selected will be changed to the 

new Node Color. 

Other 

Create Meta-Node : Creates a Meta-Node from all selected nodes. 

Highlight Checked Items : Draws an outline around all nodes selected. This 
functions with nodes of all sizes. 

Node Selector Examples 

Following is a short example of the KeySet Selector. It covers the main aspects of 
the tool only. 
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In the Filter Commands textbox the word poison is typed which causes all nodes 
with poison in any attribute to be revealed. Pressing the [Select All] button 

places a check mark in all the nodes. Lastly in the Visualizer Commands pressing 
the [Show Only Checked Items] button hides all but the checked items. 

 

The [Clear All] button is pressed to clear all the check marks. poison is replaced 
in the Filter Commands with the word sg-1. Be aware that even though only 
nodes with sg-1 are to be added the two nodes with sg-17 also appear as sg-1 is a 

sub-string of sg-17. SO instead of using the [Select All] button check marks are 
manually placed in the check boxes desired. 

The [Add Checked Items] button is pressed and the four new nodes are added to 

the visualizer. 

 

With the four nodes of sg-1 still check marked press the [Highlight Checked 
Items]. The four nodes are now displayed in a larger format. 
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The last button, [Create Meta-Node] will cull nodes into a Meta-Node. 

Move Left/Right 

If a set of nodes needs "pulled out" of the display the Move Left/Move Right 

buttons can help. Below is a normal display. The nodes for SG-1 are quite difficult 
to see. 

 

From the Node Selector dialog select the nodes to be highlighted and place a check 

mark in the box. 

 

Press the [Move to the Right] button. This brings the selected items toward that 
side of the display. 
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Pressing the button again will move the selected nodes farther in that direction. 

 

 

Link Selector 

In a complex network you may find it difficult to locate one particular link. This is 
where the Link Selector will help.You can chose to work with One Node or Two 
Nodes, picking which is the Source/Target node, and the appearance of the link 

in the Visualizer. 
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1. One or Two Nodes : Chose to specify links using methods for One Node 

(shows all nodes linked to node picked) or Two Nodes (where you specify the 
exact two links to use) or  

2. Node Area : In One Node you pick the node and ORA shows you all the 
links. In Two Nodes you pick two nodes the chose one of three direction 
options : From First to Second, From Second to First, Goes Either Direction. 

This last one is handy in order to change the apprearance of bi-directional 
links. 

3. Link Area : Displays all links that meet the parameters in the Node Area. 
Beneath this are the [Select All] and [De-Select All] buttons. 
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4. Appearance/Visibility : This allows you to control the look of the links. 
Appearance allows you to change link color and make then dotted or 

continuous lines. Visibility allows you to Hide or Show links. 

5. Link Color : The drop down menu has three options : Color by Source node, 

Color by Target Node, or Choose a Custom Color. 

6. Dotted/Continuous Lines : Allows you to choose the style of line. 

The Original Network 

 

NOTE : For these examples I changed the color of the location nodes to light blue 
for better visibility during changes. See Node Color for procedure 

17 APR 11 

 

Link Selector-One Node 

In [Area 1] Select the [One Node] tab. In [Area 2] select a node from the drop 
down menu. To the right select from the other drop down menu whether you want 

this to be a source or a target node. All links associated with this node will be 
displayed in [Area 3]. Click on links you want highlighted. Click the [Appearance] 
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tab in [Area 4]. Select [Choose a Custon Color] from the drop down menu in 
[Area 5]. In the Color Select dialog box select a complementary color and click 

[OK] then click [Apply]. 

Example : I select the node Greedo and place checkmark in both boxes. Under the 
tab Appearance I select [Choose a Custom Color] from the drop down menu. A 

distinctive dark blue color is selected then I click [Apply]. 

 

 

You can further enhance this information by use 
of the [Make Link(s) Dotted-Lines] button. 
 
Notice that in this example the link Greebo to 

Mos Eisley is a clearly defined dotted-line. The 
link Greebo to Han Solo is a blue dotted line 

but the link Han Solo to Greebo is still the 
default red and could obscure it in a more 
densely packed network. 

 
Caution should be observed when working with 

a large network. 
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When finished you can, from the main menu, select Display > Link Appearance 
> Link Color and chose either Match Source Node or Match Target Node to 

reset your colors. Another choice is to select the particular links and change the 
colors via the method described above. You can also change any dotted-lines back 

using the [Make Link(s) Continuous LInes] button. 
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Link Selector-Two Nodes 

Two Nodes 

 

In [Area 1] Select the [Two Nodes] tab. In [Area 2] select a node from both of the 

drop down menus. Between these menus is another drop down menu about 
whether you want this to be a From First to Second, From Second to First, or a 

Goes Either Direction. Choosing either of the first two will result in a single link. 
Choosing Goes Either Direction will give you one link (if the link is bi-directional) 
or two links (if the link is bi-directional). The links will be displayed in [Area 3]. 

Click on links you want highlighted. Click the [Appearance] tab in [Area 4]. Select 
[Choose a Custon Color] from the drop down menu in [Area 5]. In the Color 

Select dialog box select a complementary color and click [OK] then click [Apply]. 
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Two nodes have been selected, Darth Vader and 
Luke Skywalker, with the option [Goes Either 
Direction. A check mark is placed next to both 

links. At present both links are their default color, 
red. 
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Under the appearance tab select from the drop 
doen menu [Choose a Custom Color]. Click the 

color block to the right and select a complementary 
color. For example, Fuchsia. CLick the [Apply] 

button and the links then take on that color. 
 
You can see how well they stand out now. 

 

 

Notice here that a check mark is placed only next 

to Luke Skywalker. When the [Make Link(s) 
Dotted Lines] is clicked the dotted line is 
obscured by the continuous line from Darth Vader 

to Luke Skywalker. 
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Making them both Dotted Lines helps clarify the 
connection. 

NOTE : You can also revert these changes by using the drop down menu to select 
Color by Source Node or Color by Target Node which will remove any custom 

color. Clicking [Make Link(s) Continuous Lines] will revert any selected links 
back to one solid link. 
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Legend 

The Legend dialog box allows you to quickly hide and reveal nodes and links in the 
visualizer.  

Use the check boxes to change a NodeSets visibility. When you first call up the 
Visualizer all the boxes will contain checkboxes... 
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...and in the Visualizer all nodes and links are revealed. A little hard to make heads 
or tails of something like that. 

 

By using the Legend check boxes you can selectively show/hide nodes and 

links. Deselect the checkbox to the left of Agent. Instantly all of the Agent nodes 
are hidden along with any connections they had with the rest of the nodes. The 
node structure is a little easier to see now. 
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Next think about a particular set of connexions you'd like to see, say a task x task 
network and how the agents relate to the tasks. 

 

From the Legend box menu select Control > Hide All nodes Then again from the 

menu Control > Refresh Legend. Now place check marks in the check boxes for 
agent, task, and task x task. All the tasks will be linked together as per your 
network and all the agents will have connexions to the tasks they are associated 

with. 
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Another example is how knowledge relates to specific tasks. From the Legend 

menu select Control > Hide All Nodes. Now place check marks next to 
knowledge, task, and the Knowledge x task network. 
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Now the Visualizer reveals which knowledge is required for which specific tasks. 

 

The legend also reflects the size, shape, and color of the nodes in the Visualizer. 
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Legend Edit Menu 

Below is an image of the Legend Edit Menu and a description of this tool: 

 

Copy Legend Image to Clipboard : Copies an image of the entire legend that 
can be pasted into an image-editing program. 

 

Legend Control Menu 

Below is an image of the Legend Control window: 

 

Show All Nodes : Will bring into view all entities in the Meta-Network. Good to use 
if you need to make a fresh start. 

Hide All Nodes: Hides every node. Good starting point when you only wish to 
display a small subset of nodes. 

Refresh Legend : After using the menu items above and/or using the check boxes 

this item will bring the visualizer up to date. 

 

Node Color 

The color of a NodeClass can be changed in the Visualizer. In the Legend window 
click on the colored node of a NodeClass. This will bring up a color selector box. 
Select a new color and click [OK]. All the nodes of that NodeClass will change 

colors. 

NOTE : This color change is in effect for as long as the Visualizer is open. If you 
close and re-open the Visualizer the colors will revert to their default colors. 

Here is a section with the default colors of red for agents and cyan for tasks. 
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Open the Legend window (if it's not open already) and click once on the NodeSet 
you want to change. This will bring up the Color Change dialog window. 

 

Select [OK] and the new color will be displayed for the chosen NodeSet. 



 

439 
 

 

The newly selected color appears in both the Visualizer and Legend windows. 

 

Legend Contextual Menu 

With the Legend displayed clicking on either a nodeclass or a network will bring up 
the color picker which allows you to change the color of the node or link. But right-
clicking on either of these will bring up other options. 

Node Formatter 

There are two ways to select nodes. 1] You can Control-Click on each node 

separately in the Visualizer. 2] You can use the Selector tool and lasso a group of 
nodes. When you have the nodes selected righ-click to bring up the Node 

Formatter dialog box. 

Appearance Tab : Controls the color, transparency, and labels of the Node(s) 
selected. 

Node Color : Control the color of individual nodes. 

Match Node Class Color : Resets the color of the node(s) back to the default color 

of the nodeset. 
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Choose a Custom Color : Click the color box. From the color the selector palette 
select a new color and click [ OK ]. In the Node Formatter box click [ Apply ]. 

Node Transparency : Set the Node Transparency from 0 [transparent] to 1 

[visible]. 

Node Size : Set the Node Size from 4 [small] to 25 [large] 

Visibility Tab : Controls visibility of nodes. 

Hide Node(s) button Removes nodes from the display. 

Show Node(s) button puts the nodes back into the display. To bring back Nodes 

of a NodeClass which have been hidden you can toggle the check box in the Legend 
off and on and all nodes of a NodeClass will reappear. 

Label Tab : Set the label size from 1 [small] to 25 [large]. You can also show or 
hide the labels of the selected NodeClass. 

Label Size : Change the size of the label from 1 [small] to 25 [large]. 

Hide Node Label(s) button Removes label from the display. 

Show Node Label(s) button Puts the label back into the display. 

NOTE : The Node Formatter works only with the node(s) originally selected. To 
change the parameters for another node(s) you must close the Node Formatter 

dialog box, select another node(s), then perform your changes. 

Link Formatter 

Right-Clicking on a Link in the Visualizer brings up the Link Formatter.  

Appearance Tab : You can color the selected links by Source node, Target node, 
or pick a custom color. You also have the option of using solid or dashed lines. 

Node Color : Control the color of individual nodes. 

Color by Source Node : Sets the color of the link(s) to the color of the Source 

Node. 

Color by Target Node : Sets the color of the link(s) to the color of the Target 
Node. 

Choose a Custom Color : Click the color box. From the color the selector palette 

select a new color and click [ OK ]. In the Link Formatter box click [ Apply ]. 
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Visibility Tab :  

Hide Link(s) button Removes link from the display. 

Show Link(s) button Puts the Link back into the display. 

NOTE : If after you hide a link and close the Link Formatter dialog box the only way 

to bring that link back a link you have hidden is to use the menu item Actions > 
Show All Nodes. But remember, this will also undo any other hidden nodes and 
links you have. 

 

Create a Meta-Node 

 A Meta-Node contains multiple nodes collapsed into one. You can create Meta-

nodes based on the nodesets in your organization, or you can create MetaNodes 

based on the attributes of the nodes. From the drop down menu select Tools > 
Meta-Nodes or select the Meta-Node Manager button on the toolbar. This brings 
up the Meta-Node dialog box. 
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Expand all meta-nodes : After any Meta-Nodes have been created this button 
will expand all Meta-Nodes out to individual nodes. 

Select how to create links between Meta-Nodes: 

Absolute count of the links : Counts any link from any node in the 

Meta-Nodes to any other node as 1.0. Uses this as the total 

Proportion of the maximum possible links : Takes the total number 

of links in the Meta-Nodes and divides this by the totasl possible number 
of links. 

Block model links and weights : Uses two terms. A) The Proportion of 
the maximum possible links (as calculated above); and B) The total 
number of links in a Meta-Network divided by the total number of possible 

links in a Meta-Network. If (A) is higher than (B) then the value used 
equals (A). If (A) is lower then the value is 0. 
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Meta-Node Creation is controlled by four buttons: 

By Node Class : Creates Meta-Nodes based on current NodeSets. All 
nodes from a nNodeClass will be collected into a single node. 

By Most Recent Grouping : Creates Meta-Nodes based on the most 
recent use of the Group Viewer. 

By Attribute... : Toggles the Select an attribute pane below. Using the 
Select an attribute dropdown below you can create a Meta-Node group 
based on one attribute. 

By Multiple Attributes... : Allows for a more precise creation of Meta-
Nodes based on drilling down through attributes. 

Funnel nodes without attribute into a new meta-node : Groups all nodes 
which do not match the parameters and places them into one common meta-

node. 

 

Meta-Node - Node Class 

Using the By Node Class button separate all nodes into Meta-Nodes based on 
their NodeClass. 

 

This button will create Meta-Nodes for each NodeSet. 
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Meta-Node Attribute 

This button creates Meta-Nodes using a single attribute. It's used in conjunction 
with the Funnel Nodes checkbox. Below is an image of the Select an attribute 
box:  

 

Choosing group without the Funnel Nodes checked creates a confusing 
display. 
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Next place a checkmark in the Funnel nodes box and select groups for a 

cleaner display. 

 

 

Leaving the Funnel nodes option unchecked works best with fewer NodeSets. 

Below only the agent and tasks NodeSets were used. Without funneling the 
individual tasks can be viewed as to which agent Meta-Node they connect to. It 

also reveals that groups in area 1 are not connected to any tasks and that 
groups in area 2 are all the agent nodes that had no groups affiliation. 
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Path Finder 

The Path Finder is used to find, not only, the shortest path between two nodes but 
also paths to other nodes when particular situations occur. Below is an image of the 

The Path Finder tool and a description of its various elements.  
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The interface contains four sections: 

Start node : Select the NodeSet/Node to begin the path. 

End node : Select the NodeSet/Node to end the path. 

Options : Options regarding link parameters and which NodeSets to use. 

Advanced Options : Options regarding whether, and how, to use one particular 

node within the set. 

Using only Agent nodes (tolerance = 0) 

Using only the Agent NodeSet the pathway requires three intervening nodes. 
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NOTE : For this example the values in the Network have been altered from the 
regular values. 

Tolerance of "1", nothing else checked. 

Shortest path: 1 

 

There is the direct link from gen_hammond to col_jack_o'neill and the 

secondary pathway with teal'c in the middle. 

Use link direction 

Shortest path: 2 

The path direction must lead from the source to the target. 

 

The link from gen_hammond to col-jack-o'neill is removed as it's a directional 
link in the wrong direction. The shortest link is "2". 

Use link weight (Remove links with negative values) 
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Shortest path: 6 

Use link weights finds the shortest path from A to B using minimal weights 
as opposed to minimal number of links. Also the shortest path is the total 

of the link weights — not the number of links total. 

 

The shortest path is from col_jack_o'neill to teal'c (5) then from teal'c to 

gen_hammond (1) for a total of "6". 

Use link weight (Convert negative links to positive values) 

Shortest path: 3 

Uses the absolute values of numbers. A negative number becomes a positive 
number. 

 

Use link direction and link weight with absolute values 

Shortest path: 3 
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Sphere of Influence/Ego Network 

The Sphere of Influence tools helps show how nodes are interconnected by 
displaying links to other nodes. You can also control the size of the Sphere of 
Influence. 

It is important to understand that Sphere of Influence is similar to Reverse 

Influence but not identical. Sphere of Influence ignores directionality and looks at 
both in and out degress for each node. Sphere of Influence answers the question 

What other nodes are connected to the ego network. By using both in and out 
degrees it finds the sphere surrounding a node. Cycles are an endemic part of a 
Sphere of Influence and are not highlighted. 

Reverse Influence only looks at the in-degree and answers the question what 
nodes influence the ego node. As such, cycles can be critical, leading to never 
ending chains, as when A influence B, B influences C and C influences A. The Cycle 

and self-loop options enable the user to stop backward chaining when a loop or 
cycle is encountered. 

 

Sphere of Influence 

Each node within a network has a unique Sphere of Influence or Ego Network. 
Essentially it's a direct relationship with it's neighbors as a function of specified path 

length. The ORA Visualizer allows you to focus on this relationship by creating an 
Ego Map centered on any particular node you choose. This mapping ignores 
directionalty and counts equally both in and out degrees it finds to the sphere 

surrounding the node. Cycles afre an andemic part of a Sphere of Influence and are 
not highlighted. 

From the Visualizer's Main Menu select Tools > Sphere of Influence. 

The following dialog box will then appear. From here you can select the Size of 

your sphere's influence, the NodeSets, and Key Sets to use. 
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Select a sphere of influence radius 

The drop down box allows you to choose the path length for a particular node(s). 
The value starts out at 0. Below is an example of a radius of 0, 1, 2, and 3. In 
many other cases the links will branch out as you increase the radius. 
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Auto-Zoom : Maximizes your ego network within the Visualizer. 

Auto-Center : Keeps the visualized Ego Network centered within the visualizer 
display. 

Hide connections between levels : Removes any connections between nodes 
that do not have a connection to any node in the filter. 

 

Expand only these nodes : Allows you to select the components you wish to have 
displayed in a node's Sphere of Influence. 

Filter Commands : Used for selecting the filters to use on the current 

visualization. 

Node selection table : Allows the selection of individual nodes for visualization. 
First selected is symbiote_poison in the bottom table. Then the NodeSets events 
and locations were added. Only the nodes that are linked to the original 

symbiote_poison are displayed in the visualizer. 

A Sphere of Influence Example 

This example will show how to take one node and expand upon it to show how it is 
related to nodes in other NodeSets. First, from the table at the bottom, select a 

node. Here we select the symbiote_poison. From the Expands only these 
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nodes: place a checkmark in location. It reveals that symbiote_poison is 
connected to two locations, revanna and hasaraSystem_spaceStation. 

 

Next we'll place a checkmark next to tasks:. This reveals that there are two tasks 

that relate directly to symbiote_poison, poison_jaffa_at_gate and 
poison_summit. 

 

Now that we've got a couple of nodes on the screen let's increase the radius of the 

sphere to 2. The tree will now display all nodes within 2 links of symbiote_poison. 
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Lastly you can eliminate any NodeSets by removing them from the list. Remove the 
checkmark from tasks: to reveal only the locations up to two links away. 

 

The Sphere of Influence allows you to hone your search and show only the nodes 

you need to see. 

 

Rings 



 

455 
 

What are node rings in the visualizer? 

Rings help you keep track of which nodes have been selected in a Sphere of 
Influence. Right-Clicking on a node allows you to toggle the ring on and off. 

 

They're not much more than rings around a node but rather they are used to help 
accentuate node(s) amongst other nodes. Currently, the only use they have is for 

Sphere of Influence, where the node(s) whose Sphere of Influence we're looking at 
get a ring around them. 

 

Node Locator 
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The Node Locator is a tool palette 
that allows you quickly zero in and 
find a node that may be obscured in 

a complex visualization. Essentially, 
when you click on a node in the Node 
Locator tool, the Visualizer will then 

pan over to the node centering on it. 
Below are procedures for using the 

node locater. 
 
From the ORA Visualizer: Tools > 

Node Locator. This brings up the 
Node Locator dialog box. It contains 

to folders in it's root, Alphabetical 
Order and Categorical Order.</td 

Alphabetical Order : Contains one folder for each set of nodes divided into 
letter groups. All nodes beginning with the same letter will contained in one 
folder. 

 
Categorical Order : Divides the nodes into node types. There were four 

NodeCLasses in this example and it created four folders under Categorical Order. 
 

Notice how the nodes for Accounts_Payable and also for Accounts_Receivable 
appear in both areas. 

Selecting a Node 

Whenever you select a node in the Node Locator dialog box that node will be 

highlighted. Since it's hard to see with a white background this example uses the 
black background. Notice the white circle around the accounts_payable node 

denoting it has been selected. If you select a new node the previously selected 
node will return to normal and the new node will be highlighted. 
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Micro Simulation 

Micro Simulation allows you to run some basic simulations on the curretly loaded 
visualization. LInk weights are important as once they are normalized, they 

correspond to the probablity of a transmission. 

ORA Micro-Simultation Overview 

  
I can give it to 

others 
I keep it after 

sharing 
I lose it after 

some time 
I can get it 

back 

Ideas Yes Yes No N/A 

Disease Yes Yes Yes No 

Money Yes No No Yes 

Technology Yes Yes Sometimes Yes 

General Thoughts on MicroSims 

The simulations themselves are not that complex. Typically Disease, Money, and 

Information can be described as types of flows. At any given timepoint, any entity 
that has one of those things are going to try to give it to another node, with each 
flow having their own rules. 

Ideas : Once an entity gets information, they cannot lose it. They also never stop 

giving out the information. 

Disease : An entity can not re-get the disease, and an entity can only give out the 
disease while it has the disease. The entity can also give out a disease to multiple 

other entities. After a user-specified number of time periods, the entity loses the 
disease. 

Money : Once an entity gives away the money, he cannot give the money to 

anyone else. There is no limit on re-getting the money. 

Technology Adoption : How quickly a new technology might spread through a 
network. 
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It's important to understand how these transmissions occur. During the 
transmission phase, it looks at every node that has a resource. Then it iterates 

through all outgoing links trying to give that resource through that link ( in the case 
of money, since it can only go through one link, we randomize the order links are 

tested ). When looking at a link, it first does a check to see if the transmission can 
occur based on the link weight. Then it does another CHECK to see if the 
transmission can beat the transmission resistance. 

These transmissions continue based on the rules outlined above for the user 
specified number of time periods. Then it generate a dynamic meta-network that 
shows for any given time period what entity was associated with a resource. 

Diffusion of Ideas 

NOTE : Negative weight links are ignored. 

 

In the drop down box you are prompted to 
selected a Square Network for the 

simulation. If the NodeClass you select is 
in multiple square networks, then all will 
be displayed below. Place a check mark 

next to the network to use. 
 

This will create a new meta-network 
consisting of a single node class with the 
same nodes as the input node class, and a 

single network with the same links present 
in the selected networks. In the event 

multiple networks are selected and 
multiple links from node A -> node B are 
present, the resulting link from A -> B has 

a weight equal to the sum of all A -> B 
links. 

 
Click [Next] 

NOTE : Once a new meta network is created, it takes all the links and normalizes 
them between zero and one. The link weight then corresponds to the probability 
that a transmission will occur down that link. This obviously means that both Link 

Direction and Link Weight play a pretty important role here. 



 

459 
 

 

In the Node Selector box you chose 
a node(s) where an idea begins. I 
typed romana into the search box 

which displayed two choices. I 
placed a check mark to chose the 
romana_I node. When you've 

made your select, click [Next] 

Two main controls 

Transmission Resistance : ranges from 0.0 to 1.0. The higher the resisitance 

the less likely a node will accept what is offered. Setting this to [0] allows for 
perfect transmission and the target node will accept whatever is offered. 

Increase nodes size as it is hit : helps in seeing which nodes have been 

activated. Nodes get progressively bigger with each hit. 
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We'll leave the Simulation to 
Diffusion of Ideas. Say we don't 

want ideas to spread automatically 
but want the nodes to have a little 
resistance. So the Transmission 

Resistance it increased to 0.3. I also 
placed a check mark in the 

Increase node size as it is hit 
box so it will show the amount of 
hits a node gets. 

 
When you are finished, click [Next]. 

Below is an animated example 
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Micro Simulation-Ideas 

Ideas 

 An agent can give away information it has access to. 

 An agent retains information even after giving it away. 

 An agent never looses information it gains. 

 An agent never stops giving away information. 

 

Micro Simulation-Disease 
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Diffusion of Disease 

This function has two additional parameters: 

Number of periods nodes remain contagious : After a node gets infected it 

will stay infected for a set number of periods before it then becomes immune. 
After that it can no longer spread the disease. 

Percent nodes immune at start : You can set a percentage of nodes to be 
immune from the start. These nodes will be colored yellow. 

Information for disease simulation. 

 An agent can not re-get the disease. 

 An agent can only give the disease while it is infectious. 

 An agent can give the disease to multiple other entities 

 An agent loses the disease after a user-specified number of time periods. 

 

Micro Simulation-Money 

Dispersion of Money 

This mode asks for the amount of money units to start with then makes them 
travel around the network. The amount of money stays constant. 

 An agent can give away money it posses (all or nothing). 

 Once given, an agent cannot give away the same money. 

 An agent can re-acquire money previously given away. 

 There is no limit to the amount of money an agent can receive/hold. 

 Agents pick randomly the order of neighbor(s) to give away money to in 

effort to reduce endless loops. 

 

Micro Simulation-Technology 

Adoption of Technology 

The Transmission Resistance determines how easily technology is adopted by the 
network. This is a unique simulation. A node is more likely to adopt a piece of tech 
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if it has many neighbors trying to convince it to adopt the tech. A node is more 
likely to un-adopt a piece of tech if the user has fewer neighbors also using the 

tech. 

 An agent may adopt technology if enough of its neighbors use the 
technology. 

 An isolated agent will flip a coin to adopt a technology. 

 An agent can stop using a technology, especially if its neighbors are not 

using the technology. 

 An agent can re-start using a technology. 

 An agent has a user-adjustable level of resistance to using new technology. 

 

 

View Networks Over Time 

The Networks Over Time loads multiple Meta-Networks into the Visualizer and 
displays them as Time Slices. 

NOTE : Data that is not dated will be loaded in the order it was selected, not the 
order it is in the tree and not the order it was loaded in. This only happens when 

the data has no dates associated with it. 

Procedure  

Highlight the Meta-Networks to load into the Visualizer. For this example I divided 
the whole Stargate Summit network into four distinct phases. 1) The meetings; 2) 

What was supposed to happen; 3) What did happen; 4) The attack on the Tok'ra 
homeworld. These are Summit 1-4. 

 

Start the Visualizer. Then select Tools > Networks Over Time 

The dialog box appears to verify you've chosen the correct Meta-Networks. Place a 
checkbox in the ones you want or Check All. Then select [View]. 
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To control the Over Time function from the main menu, select Tools > Networks 

Over Time. 

 

The Phase Duration has two controls. Transition Phase duration sets the 

amount of time in milliseconds for the fading out of the previous set and the fading 
in of the new set. The Display Phase duration sets the amount of time in 
milliseconds that a set will be displayed before moving to the next set. 

Constant maintains a node's position throughout all Timeslices. Determined by 

Timeslice allows you to move a node independently in each Timeslice. 

Record Node Locations upon Exiting a Meta-Network maintains a node's 
position when changing Timeslices. NOTE: It does not maintain the node's positions 

after you exit the Visualizer. Upon returning to the Visualizer all nodes will be in 
default positions. 
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The Slider bar controls which Timeslice is displayed. The buttons at the bottom, 
[Play] and [Stop] control the motion display. 

Summit-1 

The initial meetings between the SGC and the Tok'ra 

 

Note: You can select multiple nodes by simply clicking on them. You do not need to 
depress any other keys (i.e., ctrl+shift, etc.).  

Summit-2 

The plan as it was supposed to go 
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Summit-3 

What really happened when Osiris showed up unexpectedly. Instead of poisoning 

the Summit daniel_jackson decides to forgo that action after hearing the 
information from Osiris. He's almost found out but still escapes. 

 

Summit-3 

What was happening back on Revanna while daniel_jackson was at the Summit. 



 

467 
 

 

NOTE : Measures and reports run on these multi-Meta-Neworks are for all 
connexions, not the individual Meta-Networks. 

Time Clustering 

Time clustering is available via the Over Time dialog in the visualizer. It's a fairly 
simple panel - there's a ComboBox to select which period you want to cluster by 
(by Day, by Week, by Month, by Year), and two radio buttons to select what a week 

begins with (only used when clustering by week). Finally, there's a simple button to 
cluster. 
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Clusters are fairly straightforward. It looks at the start date (earliest date available 

in a set of timeslices) and the end, and grabs snapshots at the given interval, 
looking at the beginning of that interval. So, if you cluster by month, it'll move 

through each month, grabbing a snapshot of the 1st day. If no Timeslices exist for 
that day, it just uses the Timeslice with a date closest to that day without going 
over. 

 

Visualizer Layout Menu 

 

Run Active Layout : Turns on the motion and allows ORA to attempt to 
sort out the positioning of the nodes. 

 

Stop Active Layout : Turns off the motion and stops all nodes from 
moving. This allows you to move individual nodes around without 
disturbing the rest of the Meta-Network. 

 

Spring Embedded Layout : This layout operates fine in datasets of 
approximately under 500 nodes. Much higher than that and the layout gets 

sluggish. A single layout iteration could take two minutes or longer. Not 
really practical. 



 

469 
 

 

Spring Embedded (with enhancements for large data) : The 
enhanced layout with large datasets. It uses the same basic algorithm but 

has some optimizations built in. With 10k nodes or so, a single layout 
iteration takes 10 seconds or so. 

NOTE : Now you're probably asking "if this new algorithm is so good, why not 
keep it on all the time?" Reason: If you pick up and drag a node, and as such 
drag an entire meta-network, the display will look jittery and confusing. So, 

whenever you load in under 500-nodes, the normal version is enabled. More than 
that, it uses the enhanced version. 

 

Run MDS Layout : The purpose of Multidimensional Scaling [ MDS ] is to 
provide a visual representation of the pattern of proximities (i.e., 
similarities or distances) among a set of objects. Given a matrix of 

perceived similarities between objects, MDS plots these on a map such 
that those nodes that are perceived to be very similar to each other are 

placed near each other on the map, and those nodes that are perceived to 
be very different from each other are placed far away from each other on 
the map. 

 

Run Tree Layout :  

 

Run Circle Layout (Pendants to Outside): Takes all pendants and puts 
them in a circle. All Nodes connected to a pendant are on a circle inside 

the pendant circle. Repeat until all nodes are in some circle, with the inner 
most nodes being the farthest from any pendant. 

 

Run Circle Layout (Center is High Betweenness) : Calculate the 
Centrality-Betweenness for the graph. Take the node(s) with the highest 
value. Place them in the center. All nodes connected to those nodes get 

put on a circle surrounding the center. Repeat as necessary. 

 

Run Hierarchical Layout : Tries to layout the network in a pyramid 
formation so that all arrows either point up or point down. 

 

Run Box Layout : More of a Polygon Layout, really. You select 1-4 groups 

of nodes (either by node type or by node class). Each group is then laid 
out as one edge of a polygon. 1 Group = circle, 2 Groups = 2 parallel 
lines. 3 Groups = Triangle, 4 Groups = square 

 

Attribute/Measure Layout : Uses the input attribute and/or measure as 
the x,y coordinates of the nodes. 



 

470 
 

 

 

Hierarchical Layout 

  

 

 Run Hierarchical Layout : 
The Hierarchical layout option 
allows for two different layout 

styles. 
 

The Pyramid style looks at level 
0 as being the peak of the 
pyramid. Level 1 being the one 

beneath that, and so on. A level's 
width is equal to the level number 

(with the distance between levels 
being a constant). This gives it the 
appearance of a pyramid. This is 

the one that's been implemented 
for ages now. 

 
Variable style Variable Style is 
similar in that the distance 

between levels is still constant, but 
the width of a level is now 

variable. Instead of being based on 
the level number its based on the 
number of nodes in that level. If 

you look at top-heavy networks, 
you'll learn the appeal of this 

layout. 

You will be prompted for a square network (including the Visible meta-network, 
since technically it's square), and then for a node to use as the peak node. 

 
Finally, you must choose the desired build direction. This refers to Link direction, 

since a link could mean reports to just as easily as it could mean commands. 

NOTE : This layout typically works well with non-circular networks. i.e. networks 
were links have links going only one direction. Using circular layouts can create 

problematic displays. 
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Regular Layout : showing links between resources and the office staff. 

 

Automatic 

The Automatic buttons will take the most direct path in creating a hierarchy. 

Whichever node has no links out will most likely become the top node. You can 
chose [Auto Layout (Top to Bottom)] or [Auto Layout (Bottom to Top)]. 

Arrows always try to maintain their direction meaning, in the event of cycles, for 
example, we try to minimize the number of arrows that go "against the current", so 

to speak. It will also warn you should you try to input a symmetrical network, as 
those don't really have bosses or subordinates. 

Hierarchical Layout (Top to Bottom) : which places both staff and resources in 

a top to bottom pyramid. This view makes it much easier to detect which resources 
are used by which staff member. 
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Automatic - Ignore Link Direction 

Automatic - Ignore Link Direction Layout : Allows you to chose the node you 

want at the top. Notice in the image the direction of the arrows are not in the same 
direction. 
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Automatic - by Attribute 

This layout is based on the attributes of the ndoes. It requires all relevant nodes to 

have some number-based attribute. The lower the value of the attribute, the 
higher in the hierarchy it will be. Think of 0 as being the top...level 1 is one below, 

and so on. 

 

Box Layout 
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 Run Box Layout : This 
layout allows you to chose 
from one to four Node 

SubSets and will arrange they 
depending on how many are 
choosen. The default is to use 

individual Node Classes. i.e. 
This would allow you to choose 

different agent Node Classes 
for different sides of the 
shape. 

  

Use Node Types 

  

Using this option allows you to 
choose all Node Classesat the 

same time, i.e. if you have 
multiple Agent Node Classes 
then choosing Agent would 

select all of them for a single 
side of the shape. 

Regular Layout 

Here's a Meta-Network as originally display in ORA. 
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Box Layout (Two NodeSets) 

Running the Box Layout lines up the Node Classes opposite each other with their 
links displayed between them. 

 

Box Layout (Three NodeSets) 
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Adding a third Node Class would form a triangle with each Node Class on one of the 
three sides. 

 

 

Circle Layout (Pendant to Outside) 

 Run Circle Layout (Pendants to Outside) :  
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Regular Layout 

 

Circle Layout (Pendants to the Outside) 
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Here we see the spreadsheet and the desktop computer are at the center of the 
circle as they have multiple connections. You can also see the pendants (executive 

washroom, laptop, catered lunch, corner office, leather chair, and blackberry 
comprise the outer circle. Lesser connected nodes drift to the outer circle. 

 

Circle Layout (Center is  

High Betweenness) 

 Run Circle Layout (Center is High Betweenness) :  

Regular Layout 

 

Circle Layout (Center is High Betweenness) 
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This example shows how the Office Manager is the most connected node being 

responsible for two nodes under him and reporting to the CEO.  

 

Display 

Link Appearance 

 

Link Labels > Show Link Labels : Toggles on/off the display of the 
labels of the links. 

 

Link Labels > Show Weight Value Labels : Toggles on/off the display 
of the weight of the links 

 

Link Labels > Show Weight Sign Labels : Sets the label and shows 
whether their weight is positive or negative. 

 

 

Link Color > Default : Removes all custom link coloring and resets all 
links to default. 
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Link Color > By Link Weight : You can set a range of colors to represent 
the weight of links. A dialog box allows you to chose the colors for the 

minimum and maximum weights. 

 

Link Color > Match Source Node : Colors the link the same as the 
source. 

 

Link Color > Match Target Node : Colors the link to match the target. 

 

 

Retain Bidirectional Links : When two nodes have links to each other 
only one link will be displayed. 

 

Split Bidirectional Links : When two nodes have links to each other only 
both links will be displayed. These links will be rendered as curved links 

between the nodes. 

 

 

Show Links : Toggles on/off the display of links between nodes. 

 

Scale Link Width to Weight : Toggles on/off the display of links between 
nodes. 

 

Scale Link Width to Number of Links Between Nodes : Adjusts the 
width of the link to represent the weight of the link. 

 

Show Arrows : Toggles on/off the display of the arrows of the links. 

 

Show Self Links (Loops) : Shows whether there is a connection between 
a node and itself. It is designated with a circle pointing back to itself. 

 

Node Appearance 
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Label Style > Default : Sets the label to appear to the right of the node. 
This is the default position for labels. 

 

Label Style > On Right of Node : Sets the label to appear to the right of 
the node. 

 

Label Style > On Left of Node : Sets the label to appear to the left of 
the node. 

 

Label Style > On Top of Node : Sets the label to appear on top of the 
node. 

 

Label Style > On Bottom of Node : Sets the label to appear beneath the 
node. 

 

Label Style > Centered on Node : Sets the label to appear directly 
centered on the node. 

 

 

Node Style > Toggle Node Size : Rotates between the three sizes and 
styles for the display of the nodes. 

 

Node Style > Spot : Sets the size of all nodes to a small colored circle. 

 

Node Style > Small Shapes : Sets all nodes to a colored shape (circle, 

square, triangle, pentagon, diamond, hexagon). 

 

Node Style > Large Shapes : Sets shape of nodes to a colored shape 
only large enough to contain the label. 

 

 

Node Color > Save Node Color To Attributes : Creates an attributes to 
store the current color of all nodes. If the color for a nodeset is changed by 
coloring by attribute, coloring by measure, or changing the color in the 

Legend dialog then this function will save that information. 

NOTES : Meta-Network must be saved in the Editor in order for colors to 
be reloaded the next time the Meta-Network is loaded. 
 
The NodeClasses retain their default color in the Legend dialog. i.e. all 

agent NodeClasses will default to red. 
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Node Color > Load Node Color From Attributes : If a Meta-Network 
contains color information for the nodesets then this function will load the 
color into the Meta-Network and reset the display. 

 

 

Node Color > Show Node Occurrance Transparencies :  

 

 

Node Color > Color Nodes by Attribute or Measures : ALlows you to 

chose an attribute or measure to run on a Meta-Network and will color the 
nodes in specific groups. 

 

Node Color > Color Nodes by Componant :  

 

Node Color > Color Nodes by Concor Grouping : Divides and colors 
nodes according to the Concur Grouping 

 

Node Color > Color Nodes by Newman Grouping : Divides and colors 
nodes according to the Newman Grouping 

 

 

Reset Node Color and Size : Sets the color and size of all node to the 
default values. 

NOTE : Primarily used to resetting size after using Size Nodes by 
Attribute or Measure. The size set on the toolbar is the default size. 

 

Size Nodes by Attribute or Measure : Allows you to chose an attribute 
or measure to run on a Meta-Network and will size all nodes accordingly. 

 

Apply Log Scale to Current Sizing :  

 

Show Labels : Toggles the names of the nodes on and off. 

 

Load Node Images : If nodes have image files attached to an attribute 

this will display the picture instead of the node icon. 



 

483 
 

 

Remove Node Images : Removes all images from the visualizer and 
returns all nodes to their icon status.  

 

 

Node Shaper : Allows you to chose the size and/or shape of any set of 
nodes. The set is not just one particualr NodeClass but can be created 

from individually choosen nodes from any NodeClass. 

 

Attribute Measure related Options :  

Comments 

 

Show Comments : Toggles on/off the display of comments 

 

Set Comments Font : Sets the font used in Visualizer comments. 

 

Set Comments Color : Sets the color used in Visualizer comments. 

Title 

 

Title Location > Top : Sets the Title to the top of the Visualizer window. 

 

Title Location > Bottom : Sets the Title to the Bottom of the Visualizer 
window. 

 

Title Location > Left : Sets the Title to the left of the Visualizer window. 

 

Title Location > Right : Sets the Title to the right of the Visualizer 
window. 

 

Title Location > Center : Sets the Title to the center of the Visualizer 
window. 

 

Set Title : Create a title for a screen shot. The title will remain a static 
size and retain its position regardless of the zoom of movement of the 

display. 
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Set Title Font : Set the font used in the title of the screen shot 

 

Show Title : Toggle visibility of the title. 

 

Allow Click to Edit Node Title :  

 

Show Mouse Overs : Toggles the information 
boxes on and off whenever you hover the 

mouse over a node or link in the visualizer. 

 

Autozoom : Zooms the display either In or 
Out to bring all nodes into view. 

Background Color 

 

Background Color > Black : Sets the Visualizer background to black. 

 

Background Color > White : Sets the Visualizer background to white. 

 

Background Color > Custom : Brings up the color picker which allows 
you to chose any color for the background. 

NOTE : Some of the possible background colors can make it difficult to view the 
visualizer. Your best choice is black (although white is used in the examples for 
easier printing). 

Background Image 

 

Background Image > Load : Allows you to chose a .jpg, .gif, or .png 
to use as a background. 

 

Background Image > Clear Image : Removes the image and returns 
the background to the last background color used. 

NOTE : Some pictures may make viewing the network somewhat difficult. 
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Black and White Only : Removes all colors form the visualizer. 

 

Grayscale : Removes the hue from all nodes and links displaying them as 
shades of gray. If any of the nodes are difficult to read try changing the 
background color to a darker or lighter color. A black background works 

very well for grayscale images. 

 

Reset Node/Link Options : Resets all node and link colors back to 
default. 

 

 

Link Color 

In ORA you can color links according to several preferences. Below are the 
procedures for doing so.  

 

NOTE : For this example all the nodes are colored black so as to decrease the color 
confusion. 

NOTE : For this example the link weights have been drastically altered from the 

original values to assist in display purposes. 

NOTE : Below is a warning for the placement of the Min and Max sliders. When the 
sliders are set to the absolute left and right positions this causes all the colors to be 

set to red. Move the sliders in to prevent this. 
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Even Distribution - The Full spectrum 
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The colors used are evenly distributed across the chosen spectrum. Using a 
NodeSet with weights of 2, 4, 6, 8, & 10 would have three colors chosen at evenly 

spaced intervals across the spectrum. 

Even Distribution - The Limited spectrum 
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Limiting the spectrum to smaller set will cause some of the numbers to contain very 
similar colors. This might make it difficult to tell the various shades of blue apart. 
Use this only when there are a very limited number of values. 

Scale to Weight 
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When scaling to weight the 100 values cause a spread to occur that makes all 

other values in the same general color area. 

Link Values 

 

When a link is bi-directional and the weights of the links are not the same the 
Visualizer will color the link that was drawn last. 
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Change link Color 

After setting the type Even Distribution/Scale by Weight the color of the links 
can be set manually through the color changer. Click on the color box of any of the 
links to bring up the color change dialog box. Select a new color and select [OK]. 

 

Comments 

While in the Visualizer Comments can be added to the display. Right-click a node 
and from the contextual menu select Add Comment. The comment is placed in a 

colored box with a dashed arrow connecting them to the original node. 

NOTE : These comments are not saved when exiting the Visualizer. 

NOTE : The main use of these comments would be in creating screen shots for 
display in order to add commentary for a report. 

Below is a section of the Stargate scenario with the unexpected appearance of 

Osiris. 

 

Adding a Comment 

A comment is added stating Osiris's arrival changes the plan. 
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From the main menu, under the Tools item, the font size and color, as well as the 
color of the box, can be changed. 

 

Adding Multiple Comments 

It is also possible to add multiple comments to the same node. 
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NOTE: These comments are not saved when exiting the Visualizer. 

Deleting a Comment 

A comment can be deleted by first selecting that comment. A right-click brings up 

the contextual menu. From this menu select Delete Selected Node(s). 

 

Mouseovers 

NOTE : To access the contextual menu the option must be checked. 

Go to Display >  Show Mouse Overs and make sure the option is check 
marked. 

When the pointer is passed over any Node in the visualizer a yellow tooltip box 

will appear showing information on links to other nodes as well as values for 
measures than have been run. Below is a screen shot comparing two mouseovers. 
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If an Attribute is eompty ORA will leave a blank line for that attribute. Only if the 

attribute has a value will it be displayed. Neighbors are all the links to other 
nodes. 

Mouseover Display Limit 

With the mouseover display active ORA will attempt to display which node or link 

you have the pointer hovering over. But there is a limit of 5,000 links when ORA no 
longer attempts to dusplay the link. It will, however, still attempt to dusplay which 

node the pointer is hovering over. 

 

Node Images 

Nodes can be replaced with various symbols or pictures to make it easy to identify 
individual nodes. There are a few items to note. 

All images should be reduced to approximately 50 x 50 pixels before using in 
ORA. Bigger images will be reduced in size on the display and the image quality 

may possibly be degraded. 

If a picture is placed on a background with the color R=255, B=0, G-192 the 
background will be changed to the color of the node. 

Setting a Image Folder 
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The Set Picture option is designed with modularity in mind, with adding new images 
as easy as putting a folder with images in the 

include\OraFiles\images\visualizer\node folder. The dialog will automatically 
read that folder for subfolders, use the subfolder names as categories, and the 

images inside the subfolders as the images for each category. 

Set Picture 

Right-click any node and select from the contextual menu Appearance Submenu 
> Set Picture. The Node Selector dialog box will appear. The drop down menu 

contains various types of node images. With a node selected a custom image can 
be applied. Nodes with Images will scale.  

 

Custom 

The Custom option allows for the inclusion of a user's own icons. 

The custom category is used for images that have been previously loaded in the 
current meta-network. Clicking OK applies the currently selected node's image to all 
nodes selected in the visualizer.  

Additional information can be found in the Node Shaper section. 

The [New Image] button brings up a navigation box from which to navigate any 
directory and select an image file. The picture types can be jpg/jpeg, gif, or png. 
These will all be collected into the Custom section. 

NOTE : Remember to reduce the picture size BEFORE importing it into ORA. 
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To set a new image right-click the node and select Set Picture. This brings up the 
picture dialog box. Locate the appropriate picture and select it. A black border will 

appear around the image. Select [OK] will set the picture to the node. 

 

 

Node Shaper 

The Node Shaper allows you to change the size of individual node(s) or assigning 
pictures. Below is an image of the Node Shaper widow and a description of how to 
change the shape of the nodes in your model.  



 

496 
 

 

1. Select a Style : Select from three Node Style Sizes or use an image in it 
place of the node. 

2. Select a Shape : An optional shape can be used instead of the NodeSet's 

default shape. The node will retain it's default NodeSet color. 

3. Select Node to Re-Shape : The bottom section contains the controls for 

selecting which nodes to work with. Typing anything in the Find textbox will 
automatically filter out non-matching nodes. 
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4. NodeSet tabs : Select which NodeSets to view. ALL shows every node or 
the tabs will show only their individual NodeSets. 

5. Check boxes : Place a checkmark in the box next to the nodes you want to 
change. 

6. Filters : Use for filtering based on individual attributes. You can filter on 
more than one attribute at at time. An example can be found in Create a 

new Meta-Network 

7. Select/Clear All buttons : Will either Select or Clear all VISIBLE 

nodes. If a check marked node has been filtered out and is currently NOT 
visible when the Clear All button is pressed, then that node will retain it's 

checkmark and be affected by future changes. 

8. Apply/Load Changes : After any changes have been made to the top 

portions selecting the [Apply Changes] buttons will cause them to be 
displayed int he Visualizer. 

9. Close :  

 

How The Node Shaper Changes  
The NodeSet 

What follows are examples of how the Node Shaper changes the NodeSet. 

Whenever the Node Shaper is called and a node is assigned something other than 

it's default shape new attributes will be added to Every NodeSet, not just the 
NodeSet you're working with. 

 Drawing Type : This will define what type of node is to be drawn, shape of 

image. There are three options for size (small, medium, and large) and one 
option for image. 

 Nodes Shape : There are four large shapes (circle, rectangle, ellipse, and 
hexagon), eight medium shapes (circle, hexagon, down triangle, pentagon, 

diamond, square, up triangle, and octagon), and one small shape. 

 Image : Contains the name of the file associated with that node. 

Changing one node will create these three attributes and place the default value 

in every node in every NodeSet. Any of these attributes can be manually changed 
from within the Main Interface Editor. 

This is useful if you have changed many nodes and want to restore them all to their 
defaults quickly and easily. The quickest way is using the Copy and Paste method. 
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Column "1" contains the modified values. In column "2" three values of medium are 
highlighted and copied using Ctrl-C. In column "3" the cursor is moved to the top 

cell and Ctrl-V is used to paste those three values in. In column "4" this is repeated 
until all values are back to their defaults. 

If the Image attribute contained a filename then changing Drawing Type to 

image will relink that file to the picture. Any of the four Drawing Type values can 
be placed in this column. 

 

Node Shaper Examples 

Original agent x agent Network 

Below is the agent x agent network in the normal medium sized nodes.  

We start out with the stargate agent x agent nodeclass set to medium size nodes. 
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Changing a few nodes 

From the Visualizer menu select Display > Node Appearance > Node Shaper. 
Click the tab marked [agents]. Place a check mark next to col_jack_o_neill, 

maj_samanatha_carter, daniel_jackson, and teal_c. Select the Large Node 
Style. 
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When you are finished click the [Apply Changes] button. 
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Now the four members of SG-1 stand out represented by larger nodes. 

Select Nodes to Re-Shape 

You can also use the Search box, in conjunction with the tabs, to bring up specific 

nodes in the grid. It's predictive so as you begin typing the grid will change. 
Continue typing until you see the node(s) you need. I wanted the two characters 

with the rank of major and knew their rank was a prefix. I typed maj into the 
search box and the two nodes were singled out. 

 

 

Visualizer Contextual Menus 

The Contextual Menu is displayed by right-clicking an a Node or Link. It contains 
many standard uses in manipulating nodes and links. 
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Node Menu 

Pin SubMenu : 

Pin All Nodes : Globally pins all nodes. Nodes are unaffected by the [Play] button 

or the movement of other nodes. 

Unpin all Nodes : Frees all nodes from being pinned. 

Pin Selected Node(s) : All selected nodes will become pinned 

Unpin Selected Node(s) : All selected nodes will become unpinned. 

URL SubMenu :  

Attach URI : You can attach a URI to the selected node. 

Go To URI : Activates your browser and goes to the URI associated with this node. 

Appearance Submenu :  

Set Picture : You can replace the node shape with a picture. 

Set Node Size : You can numerically set the Node Size of an individual node. 

Set Node Color :  

Set Font Size : You can numerically set the Font Size for an individual node. 

Enlarge : Increases the size of the selected node in the Visualizer 

Shrink : Decreases the size of the selected node in the Visualizer 

Brighten : Lightens the shade of the color of the selected node 

Darken : Darkens the shade of the color of the selected node. 

Hide Labels : Hides the label of the selected node. 

Show Labels : Reveals the label of the selected node. 

Show Ring(s) : Places a highly visible ring around the selected node(s). 

Hide Rings(s) : Removes ring from selected node(s) 

Visibility Submenu :  
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Hide Node(s) : Removes the selected node (along with all links) from view in the 
Visualizer. 

NOTE : This does not delete the node from the Meta-Network. 

Hide Adjacent Node(s) : Hides all nodes that are linked to the selected node. The 
selected node remains visible. 

Other :  

Color Adjacent Edges : Allows you to chose the color for all links associated with 

the selected node. Only works on one node at a time. 

Select Node : Registers the node as selected when Ora affects multiple nodes. 

Center Node : Brings the selected node to the center of the visualizer. 

Pin Node : Pins node to background so it is unaffected by the movement of other 
nodes. 

Expand Node : Shows all nodes and links connected to the selected node. 

Combine into MetaNode : Multiple nodes can be selected and combined into a 

Meta-Node which will contain links to all the nodes that the individual nodes had. 
The four large circles of SG-1 are selected. The and green circles show which tasks 

are associated with these agents. Press, and hold, the Control key while selecting 
each node for the Meta-Node. Then without releasing the Control key, right-
click one of the nodes to bring up the contextual menu. Select Combine into 

Meta-Node. 

 

After combining the task nodes that were linked to the individual nodes are now 
linked to the sg-1 Meta-Node. 
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NOTE : If additions or deletions of NodeSets needs done expand the Meta-Node 
before proceeding. 

Add Comment : Attaches a comment to the currently selected node. Good for 

making notes for display purposes. Comments can be toggled to be shown or 
hidden form the Display menu. The color and font of the comments are also 

controlled from the Display menu. 

Spread Out : Finds the center for the currently selected nodes. Then calculates a 
ray from that center through the nodes current location, and pushes the node along 
that ray by (currently) 40 units. 

Delete Selected Node(s) : Allows for the deletion of nodes form a Meta-Network 
from within the Visualizer. 

NOTE : This deletion is permanent once the Meta-Network is saved. If there is any 
question regarding the deletion then remove the Meta-Network from ORA before 

saving and reload the Meta-Network. 

Link Menu 

Link Status : Brings up the Link Status box with information on its weight, the 
network, source and target nodes, source and target nodeset. 

Hide Link : Hides the link. This does not delete the link. 

Set Value : Set a new value for a link. 

Reverse Direction : Reverses the Source and Target aspects of the link. 

Delete Link : Removed the link from the Network. 

Empty Space 
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Pin All Nodes : Globally pins all nodes. Nodes are unaffected by the [Play] button 
or the movement of other nodes. 

Unpin all Nodes : Frees all nodes from being pinned. 

Pin Selected Node(s) : All selected nodes will become pinned 

Unpin Selected Node(s) : All selected nodes will become unpinned. 

Add Comment : Attaches a comment to the currently selected node. Good for 
making notes for display purposes. Comments can be toggled to be shown or 

hidden form the Display menu. The color and font of the comments are also 
controlled from the Display menu. 

Spread Out : Finds the center for the currently selected nodes. Then calculates a 
ray from that center through the nodes current location, and pushes the node along 

that ray by (currently) 40 units. 

Format Nodes : Brings up the Node Formatter dialog box. 

 

Comments 

Add Comment : Attaches a comment to the currently selected node. Good for 
making notes for display purposes. 

 

 

Node Contextual Menu 
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Right clicking any node in the Visualizer brings up a menu of the most useful 
tasks concerning nodes.  

The Pin Node Submenu : Allows you access various function involving pinning 

and unpinning nodes in the visualizer 

The URI Submenu : Allows you to attach a URI to a node or go to a URI already 
attached to a node. 

The Appearance submenu : You can enlarge or shink the size of a node, brighten 

or darken it's color, set its color or size, attach a picture to a node, or give it a 
display ring for easier visibility 

Label submenu : Individual labels can be hidden or displayed and the font size can 

be altered 

Visibility submenu : You can either hide the selected node or hide the adjacent 
nodes. 

Color Adjacent Edges : Sets the color of adjacent links of the selected node. 

Select Node : Makes the node selected. 

Center Node : Center the selected node to the center of the window 

Combine into MetaNodes : After selecting two or more nodes you can combine 

them into a single MetaNode and give that MetaNode a name. If necessary you can 
also Expand that MetaNode into its individual nodes. 

Add Comment : You can add or delete comments for any node in the Meta-

Network. 
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Spread Out : Puts mode space between node around the selected node. 

Delete Selected Node(s) : Removes selected node(s) from display 

Format Nodes : Calls up the Node Formatter 

 

Removing Nodes In The Visualizer 

You can remove nodes directly from the ORA Visualizer by right clicking on a node 
and selecting Hide Node. Below is an example of removing an node using the Hide 

Node tool.  

Find the node you want to hide. Here we will hide ren'al.  

 

Place the cursor over the node and right-click on the node to bring up the 

contextual menu. Highlight Hide node. gen_hammond and the four task nodes 
are now separated from the rest of the network. 
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Set Node Picture 

In addition to changing the size of nodes in the visualizer you can also assign nodes 
individual pictures. This example is my Raiders of the Lost Ark set from Peru. 

NOTE : This example uses only standard icons found in ORA. 
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I Right-Clicked on The Bullship node and selected Appearance Menu > Set 
Picture. This brings up the Set Picture dialog. I clicked the downward triangle and 

selected the Resource - Generic folder. I then selected the colored cubes icon. 
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Clicking [ OK ] assigns that picture to the selected node. 
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You can replace any number of nodes with icons. 
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Your Own Icon Set 

You can create your own set of icons. Place all your personnal icons in a folder and 
place that folder in the following directory. The next time you use ORA you will be 
able to select icons from your own folder. 

 

NOTE : Be aware that very large icons will make viewing the display difficult. Small 
distinct icons work better. If using pictures of individuals it's advised to resize them 

to 50 x 50 pixels. 

 

Node and Link Formatter 

Node Formatter 
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There are two ways to select nodes. 1] You can Control-Click on each node 
separately in the Visualizer. 2] You can use the Selector tool and lasso a group of 

nodes. When you have the nodes selected righ-click to bring up the Node 
Formatter dialog box. 

Appearance Tab : Controls the color, transparency, and labels of the Node(s) 

selected. 

Node Color : Control the color of individual nodes. 

Match Node Class Color : Resets the color of the node(s) back to the default color 
of the nodeset. 

Choose a Custom Color : Click the color box. From the color the selector palette 

select a new color and click [ OK ]. In the Node Formatter box click [ Apply ]. 

Node Transparency : Set the Node Transparency from 0 [transparent] to 1 
[visible]. 

Node Size : Set the Node Size from 4 [small] to 25 [large] 

Visibility Tab : Controls visibility of nodes. 

Hide Node(s) button Removes nodes from the display. 

Show Node(s) button puts the nodes back into the display. To bring back Nodes 

of a NodeClass which have been hidden you can toggle the check box in the Legend 
off and on and all nodes of a NodeClass will reappear. 

Label Tab : Set the label size from 1 [small] to 25 [large]. You can also show or 

hide the labels of the selected NodeClass. 

Label Size : Change the size of the label from 1 [small] to 25 [large]. 

Hide Node Label(s) button Removes label from the display. 

Show Node Label(s) button Puts the label back into the display. 

NOTE : The Node Formatter works only with the node(s) originally selected. To 
change the parameters for another node(s) you must close the Node Formatter 

dialog box, select another node(s), then perform your changes. 

Link Formatter 

Right-Clicking on a Link in the Visualizer brings up the Link Formatter.  
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Appearance Tab : You can color the selected links by Source node, Target node, 
or pick a custom color. You also have the option of using solid or dashed lines. 

Node Color : Control the color of individual nodes. 

Color by Source Node : Sets the color of the link(s) to the color of the Source 
Node. 

Color by Target Node : Sets the color of the link(s) to the color of the Target 
Node. 

Choose a Custom Color : Click the color box. From the color the selector palette 
select a new color and click [ OK ]. In the Link Formatter box click [ Apply ]. 

Visibility Tab :  

Hide Link(s) button Removes link from the display. 

Show Link(s) button Puts the Link back into the display. 

NOTE : If after you hide a link and close the Link Formatter dialog box the only way 

to bring that link back a link you have hidden is to use the menu item Actions > 
Show All Nodes. But remember, this will also undo any other hidden nodes and 
links you have. 

 

Motifs 

This is a list of common motifs that can make it easier to find various clusters as 
the underlying structure of your network.  

No Links 

 

2-Group 
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Bowtie 

 

Chain 

 

Circle 

 

Star 

 

Cognitive 
Demand 

 

Degree 
Centrality 

 

Eigenvecto
r Centrality 

 

High 
Betweennes

s and No 

Degree 
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Exclusivity 

 

  

 

 

 

GeoSpatial Network 

ORA provides tools to visualize Geospatial Information Systems: GIS Visualizer and 
GIS Visualizer 3D. When working with the GIS Visualizer your Meta-Network must 

include location information. 

 GeoSpatial is concerned with plotting who or what was where on a global 
basis. It plots nodes on a map and then connects those nodes. 
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 Loom also deals with nodes in locations but is keyed on the timeframes in 
which nodes appear. There are locations in which two agents appear in but which 

were there at different times and never met. 

 

 

GIS 

The GeoSpatial Visualizer differs from the 2D Visualizer as it places nodes on a 
representative map whereas the regular visualizer allows the nodes to float freely in 
a non-space. 

Many Geospatial information system (GIS) products apply the term geospatial 

analysis in a very narrow context. In the case of vector-based GIS this typically 
means operations such as map overlay (combining two or more maps or layers 
according to predefined rules), simple buffering (identifying regions of a map within 

a specified distance of one or more features, such as towns, roads or rivers) and 
similar basic operations. The Geospatial Network tool in ORA allows for the plotting 

of a Meta-Network on a map of the globe using longitude and latitude for placing 
the nodes. 



 

518 
 

This longitude and latitude is associated with a location nodeclass. Then other 
nodeclasses are associated with the location nodeclass. This information is used to 

place people and items on the map. 

Below is the default map included with ORA's GIS tool. 

 

NOTE : Other maps, or layers, can be added and loaded into the GIS Visualizer. 
The GIS Visualizer generally can load geospatial maps based on the Shapefile 
format. 

The ORA Geospatial Visualizer can be accessed from either the main menu bar: 
Main Menu Bar > Visualization > Geospatial Networks or by clicking the 
triangle on the Visualizer button in the Editor. 

Geospatial Networks attributes 

The Meta-Network MUST contain a location Node Class and that Node Set MUST 
contain longitude and latitude data. Below is an example of a Location node 

class information that contains Longitude and Latitude as attributes. 

 

Location COUNTRY POP CAP LONGITUDE LATITUDE 

Murmansk Russia 468000 N 33.0860405 68.96355 

Arkhangelsk Russia 416000 N 40.6461601 64.52067 
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Saint Petersburg Russia 5825000 N 30.4533272 59.95189 

Magadan Russia 152000 N 150.780014 59.571 

Perm' Russia 1160000 N 56.2324638 58.00024 

Yekaterinburg Russia 1620000 N 60.6101303 56.84654 

Nizhniy Novgorod Russia 2025000 N 43.94067 56.28968 

Glasgow UK 1800000 N -4.26994753 55.86281 

Kazan' Russia 1140000 N 49.1454659 55.73301 

NOTE : The columns which are necessary to build a Location Node Class are 
highlighted in Blue. In this example below, COUNTRY, POP, and CAP are not 
necessary, though they can be added, as additional attributes. Further below this 

chart, we will display how a location node set will appear in ORA's editor. 

Longitude and Latitude Format : The longitude and latitude use the 
degree.minute format. Longitude begins at the prime meridian which runs 

through Greenwich Village and run eastward 360 degrees. You can also denote the 
longitude values with positive or negative (-) numbers between 0 and 180. 
Latitude uses a 0-point which begins at the equator and runs to 90 to the north 

and -90 to the south. 

Location data example 
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GeoSpatial Network Toolbar 

 The GUI contains tools to work with the GIS maps. You can also customize the 

toolbar with functions from the menu. 

Standard Toolbar 

 

Copy Image to Clipboard : Places a copy of the current map in the 
clipboard which can be pasted into another program. 

 

Pan Map : Place the cursor on the map and click the button. The map will 
re-center on those co-ordinates. 

NOTE : Right-Click on the map to center view on that area. 

 

Select Place : Click and drag to capture nodes for information to display 
in an information window. This information will be displayed in an 

expanding tree format. Click and drag the cursor to include the nodes to 
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display. 

 

A pop-up window will display information for all the nodes captured by the cursor. 
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Zoom In : Zoom In works in two ways. 1) Click and drag to select the 
area you want to zoom in on. The selected area will fill the GIS window. 2) 

Click the map once and the view will zoom in centering on the clicked 
area. This can be repeated until you zoom in as close as needed. 

 

Zoom Out : Place the cursor on the map and click the button. the map 
will zoom out and re-center on those co-ordinates. 

 

Show Labels : Toggle the labels on & off. 

 

Show Links : Toggle the links on & off. 

 

Show Arrows : Toggle the arrows on & off. 

 

Font Size : Increase or decrease font size using the up & down arrows. 

 

Node Size : Increase or decrease node size using the up & down arrows. 
The size of the node is proportional to the number of entities in a location. 
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Link Width : Increase or decrease link width using the up & down arrows. 

 

 

GeoSpatial File Menu 

 The GeoSpatial file menu allows you to open, add, and save map data. 

 

Open Meta-Network… : Opens a NEW Meta-Network file into the 
Geospatial map. REMEMBER: The new file needs to have both longitude 
and latitude data. 

 

Open Trailset… :  

 

Save Screenshot : Saves the currently map to the .PNG format. 

Add GIS Data… :  

 

Add CSV : You can load a .csv file and specify which columns contains the 
longitude/latitude data. 

 

 

Add KML (Google Earth) : KML is a file format used to display 
geographic data in an earth browser (e.g. Google Earth). A KML file is 
processed in much the same way that HTML (and XML) files are processed 

by web browsers. Like HTML, KML has a tag-based structure with names 
and attributes used for specific display purposes. 

 

Add e00 : Contains Geographic Information Systems (GIS) mapping data 
exported by ArcGIS software. ORA can import this style of vector data and 
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convert it for use in the GeoSpatial tool. 

 

Add ERSI Shapefile : An ERSI shapefile is a digital vector storage format 
for storing geometric location and associated attribute information. 

Shapefiles spatially describe geometries: points, polylines, and polygons. 

  NOTE : This format lacks the capacity to store topological information. 

 

Add Shapefile (using Openmap) :  

 

Add Shapefile (using Geotools) :  

Save Map… :  

 

Save Map To PNG : Saves the currently map to the .PNG format. 

 

Save Map To SHP : Saves the currently map to the .SHP format. 

 

Save Map To KML : Saves the currently map to the .KML format. 

 

Save Map To DyNetML : Saves the current map to the DyNetML format 
with the added NodeClass ClusterLocation--ClusterLocation. This 
records changes affected by the Network Aggregator in grouping locations 
into regions. 
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Save Map To Loom Trailset : Saves the currently map to the Loom 
format. 

Current GIS Layers 

 

 

Open From Defaults : Opens what is currently saved as the default 
Dynamic Network and GIS layers. 

 

 

Open from a File : Uses the information saved in the choose file to set 
the Dynamic Network and GIS layers. 

 

 

Save As Default : Saves the currently selected Dynamic Network and 
GIS layers as the default. 

 

 

Save to a File : Saves the currently selected Dynamic Network and GIS 
layers to a file. 

Current Meta-Network Locations Configurations 
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Open From a File :  

 

 
Save to a File :  

 

 
Create Meta-Network From Visible Network... 

 

 

Copy Image To Clipboard : Saves a picture of the current map to the 
clipboard which can be pasted into another program for use in 

demonstration purposes. 

 

 
Close 

 

 

GeoSpatial Modify Menu 

 GeoSpatial Actions Menu. 

 

Replace Current Meta-Network : Allows you to open a new geospatial 
file without closing the GIS visualizer. 

 

Create New Spatial Relation :  

 

Create New Spatial Nodeset :  

 

 

GeoSpatial Analyze Menu 

 GeoSpatial Actions Menu controls color and size of location nodes. 

 

Reset Map Zoom : Reset the display of the map to it's default size. 

 

Reset Nodes Colors and Size : Returns on nodes to their default colors 
and sizes. 
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NOTE : If the colors do not reset, click on the map with Pan tool to force 

the reset. 

 

Size Nodes by Attribute or Measure : Sizes nodes using numerical 
data. 

  NOTE : You can not size by an attribute using non-numerical data. 

 

Size Links by Value : Adjusts the weights of links in proportion to all 
links. 

 

Color Nodes by Attribute or Measure : Colors the nodes using 

 

Color Nodes by Component :  

 

Color Nodes by Concor Grouping : Colors nodes using Concor 
Grouping*. 

 

Color Nodes by Newman Grouping : Colors nodes using Newman 
Grouping* 

 

 

GeoSpatial Tools Menu 

 Tools is a set of controls for adjusting how nodes and links are displayed. 

 

Layer Manager : Controls the visibility of the NodeClass(es), Network(s), 
and Shape layers on the map by checking or unchecking the boxes. 

 

Network Aggregator : Controls the groupings of nodes which are 
displayed together as separate regions. 

 

Get/Set View :  

 

Configure Meta-Network Locations :  
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Layer Manager 

The GIS Layer Manager controls what is displayed in the GeoSpatial Visualizer. 
This includes all NodeClasses and Shape layers. It is similar to the Legend in the 

regular Visualizer. 

 

Selecting or Unselecting a NodeClass or GIS Layer will remove it from the display. 

It does not remove it from the dataset. 

The Move Up and Move Down buttons adjust the display position of the SHAPE 
files. These buttons have no affect on the Network Layers. 

Layer Manager Menus 

Layers 

Add New Layer : You can add additional map files to the display. 

Remove Selected Layer : You can remove any selected map layer that has a 

checkmark next to it from the display. 

Show All Network Layers : Displays all node information on the map 
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Hide All Network Layers : Removes all Network information form the map. 
The Information is still available through the Layer Manager. 

NOTE : If you have more than one map layer loaded you can arrange how they are 

stacked. 

Change Layer Position > Move Layer Forward :  

Change Layer Position > Move Layer Backward :  

Change Layer Position > Move Layer To Front :  

Change Layer Position > Move Layer To Back :  

Add Layer As Nodeset :  

Options 

Set Current Map Data As Default :  

Reset Map With Default Data :  

 

Network Aggregator 

The Network Aggregator looks at regions instead of individual locations. Using 
the slider you can control how dense each region will be. Increasing the density 
groups more locations into a region. 
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Using a sliding scale, which in turn represents network information retention (or 

loss) depending on the level of the adjusted slider. A value can also be entered 
manually in the numeric field box. 

When the network bar is fully red it indicates full network resolution and therefore 

network information is preserved and displayed in the GIS Visualizer. Conversely, 
when lower network resolution figures are entered network detail can be sacrificed. 

This bar graph is intended to show the level of such loss. 

It is best to experiment with the slider at varying values and observing GIS 
visualization for optimum balance of data resolution and visual relevancy.  

This is a useful tool when you have many noisy or cluttered locations. The grouping 
assists you in seeing the connections easier. 

GeoSpatial with no aggregation 
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GeoSpatial using Network Aggregation 

 

 

GeoSpatial Network Toolbar 

Add... :  

Add ESRI ShapeFile : Load a shapefile into the GIS Visualizer. 

Add ShapeFile (using Openmap) :  
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Add ShapeFile (using Geotools) :  

Color Shapes by Links... :  

Color Shapes by Internal Links : Value determined by number of links within 

a single shape. 

Color Shapes by External Links : Color Value determined by links extending 
to other shapes. 

Color Shapes by Internal/External Link Ratio : Color Value determined 

using both the above calculations. 

Color Shapes by Node Count : Color Value determined by number of nodes 
contained in a shape 

Color Shapes by Attribute/Measure : Color Value deteremined by selected 
attribute or by results from measure. 

 

General Content About ShapeFiles 

`  

ShapeFiles are used in the GeoSpatial Visualizer and allow you to color code map 
details from data in your Meta-Networks. 

Finding ShapeFiles 

The GeoSpatial tool can use various ShapeFile formats. This shapefiles can be 

obtained from the following locations : 

World Shape files : 
http://thematicmapping.org/downloads/world_borders.php 

number of different USA based shapefiles : 

http://www.census.gov/geo/www/tiger/shp.html 

Other shapefiles : http://maplibrary.org/ 

Download, and if necessary, unzip these files. Place these files in a folder on your 
computer. 

General Suggestions 

Default Map Colors : Before using the coloring functions on shapefiles I have 

found it advantageous to set the default color of the shapes to a neutral grey. Go to 
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the Layer Manager. If it is not visible call it up by selecting Tools > Layer 
Manager. Click on the colored box next to the checkbox. When the color picker 

appears pick one of the middle grey tones. In the Layer Manager's menu select 
Options > Set Current Map Data as Default. This change will follow through the 

next time ORA is started. 

 

If you do not set a default color to your shapefile the color will be taken from the 

color spectrum range. This could possible be different each time you run and select 
your colors. Also the grey, being neutral, helps define shapes which are not 
included in the data. Below is the same map which was not given a default grey 

color. Makes some of the colors harder to distinguish. 
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ShapeFiles 

`  

Default 

The default GIS renderer is 
known as OpenMap. Through 

OpenMap you can aggregate 
locations, add shapefiles, and 

perform basic visualization.  

 

 

NASA WorldWind 
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Once the data has been loaded 
into GIS, under options you can 

select the 3D visualization, 
which uses Nasa Worldwind. 

Any feature available in the 2D 
version is available in the 3D 
version, albeit it may operate a 

tad differently 3D Version 
operates primarily as a sphere, 

but a flat map version can be 
toggled on.  

 

 

Google Earth 

Google Earth is not integrated 
with ORA, but the GIS is 
capable of producing a .kml file 

for use with Google Earth. The 
command to do so is located 
under File -> Save Map. The 

output will have the same 
nodes and links.  

 

 

Customizing 
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Shapefiles allow you to 
customize the map with custom 

political boundaries, highways, 
whatever you can find 

Shapefiles are imported via the 
File -> Add GIS Data. menu. 
Both the fill color and border 

color can be changed via the 
GIS Legend. All shapefiles must 

be in WGS84 Projection 
Screenshot shows a shapefile of 
the political boundaries of the 

states of Sudan, as downloaded 
from MapLibrary.org  

 

 

 

 

Load ShapeFile 

`  

Load Meta-Network Into GeoSpatial 

You can load a Meta-Network into the GeoSpatial Visualizer in three ways. 

In the Main Interface hightlight the Meta-Network. Select from the main menu 
Visualizations > GeoSpatial Networks... 

In the Main Interface hightlight the Meta-Network. Click the downward triangle 

on the Visualize button and select GeoSpatial Networks... 

From the GeoSpatial Visualizer select from the Main Menu File > Open Meta-
Network... 

Load ShapeFile Into GeoSpatial 
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When started the GeoSpatial tool will display a world map with, if selected, your 
Meta-Network locations shown. From the GIS Menu select Shapefiles > Add... > 

Add ESRI Shapefile. Navigate to the location to which you saved this file. 
Highlight the file and click [ Open ]. 

You will notice the outlines appear to have gotten bolder. This is due to the second 

set of country outlines. In the Layers Manager deselect the default shapefile leaving 
only your newly loaded shapefile. 

 

Color A ShapeFile 

`  

A ShapeFile can be colored by various methods. By Node Count, Link Count, and 
Attibute/Measure. 

Color Shapes by Links... 

There are three options for links, Color Shapes by Internal Link Count, Color Shapes 
by External Link Count, and Color Shapes by Internal/External Link Ratio. 

Color Shapes by Node Count 

You can color the shapes accounting for the number of nodes in any location. The 

color bar allows you to set the color for the minimum and maximum. In this case I 
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selected ultramarine for the minimum [which essentially means any country with 
zero nodes] up to the maximum which is colored orange. 

 

Color by Attribute/Measure 

For this example I took the population numbers of the U.S. States and territories. I 
set the high number to be yellow, going through the dark to light blues to green 

and ending up at white for the least populated. 
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Next I added an attribute to the U.S. population file and called it timezone which 

includes the lower 48 states plus the Atlantic territories. I assigned a number for 
each timezone and added entries when a state used multiple timezones. 

NOTE : When adding attributes to use in this manner you need to make sure they 
are created as numeric. Text attributes will not work. 
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GeoSpatial Options Menu 

 These options control various display options of the Visualizer. 

 

Show Links : Toggles the visibility of the Links. 

 

Show Labels : Toggles the visibility of the Node Labels. 

 

Show Arrows : Toggles the visibility of the link Arrows. 

 

Toggle Map Grid : Show/Hide the grid on the map 

 

Cluster by Attribute :  

 

Cluster by Area of Influence :  
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Toggle Cluster Appearance :  

 

Use 2D Visualization (OpenMap) :  

 

 

Use 3D Visualization (NASA Worldwind) : Switches no the 3D map 
view. 

 
NASA World Wind is mapping software developed by NASA. The globe can 

be rotated, tilted, and zoomed in and out. Nodes and links are plotted on 
the globe with word balloons holding descriptions of the nodes. 
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Loom/View Trails 

Description 

Loom is primarily concerned with how specific entities move or evolve through 
other entities. In the most basic case, this involves Agents as they move through 

Locations. More abstract examples include Agents moving through Beliefs or Beliefs 
moving through Locations. 

When you first start Loom, you are prompted for a Network. The target nodes in 

the Network dictate what they're moving through. The source nodes are who/what 
is doing the moving. 

Once started, Loom goes through all timeslices, and looks at the connections in that 

network only. It sets up a series of waypoints based on what connections are made 
at that timeslice, upon which it constructs a trailset. 
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Classically, we restrained Loom such that for any timeslice, any source node could 
appear in at most one target, but now we allow for a source node to occupy 

multiple targets at a time (Agents having multiple beliefs, for example). 

NOTE : Loom can also display things like persons through beliefs showing how a 
person make change their mindset over time. 

Before you Start 

Before starting you need a dataset that can be used within the Loom. One such 

dataset is the TAVI dataset. Use File > Open Meta Network to open TAVI.xml 

The clock icon in the Meta-Network Panel means that it is a dynamic meta network 
and that there are continuous-time updates (deltas, which are listed below the 

top-level network) indicating how the network changes over time. 
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To analyze the data you must have a relation that A) changes over time and B) 
stays many:one (e.g., a person must have only one location at any given time). 

Usually this is Agent x Location, but in theory you can select other relations. 

In the main ORA screen, open the Visualizer > View Trails. Select the Person x 
Location input network. 

At the top left is a list of Agents; the bottom left is a list of locations. Activating the 

check-box next to an agent will cause its trail to appear in the right hand panel. The 
large vertical strips correspond to locations, and the path moving between them is 

the trail indicating the agent's location at each point in time. 

 

Open Loom : Highlight the TAVI dataset in the Meta-Network pane. From the drop 

down menu select Visualizations > View Trailsets. In the dialog box select 
Persons x Locations. The Loom window will appear with the chosen Network. 

 

1. Person Pane : Lists all persons in the meta-networks. This pane contains a 

check box to the left of next to each person to control which persons are 
visible. To the right is a color designation 

2. Location Pane : Lists the locations in the meta-networks. To the right is a 

color designation. 

3. Loom Pane : Displays the persons as they travel through the locations. 
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Selecting one person you can easily see where they've been (Left window). But 

when you select multiple people, it can quickly get impossible to view the trails 

right window). 

 

Making the Display more Readable : can be done in several ways. Clicking the 
color circle representing the individual node brings up the color changer. You can 
then select a color which stands out better for viewing. 
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Loom File 

 Loom File Menu 

 

Open … : Opens up DyNetML file which contains location and time data. 

 

Save as… : Saves currently open DyNetML file under a new filename. 

 

Export > DyNetML : Saves the Loom data as a DyNetML file. 

 

Save Image as… : Saves an image of the current Loom state. Can be 
saved as a png, jpeg, pdf, svg, or tiff file. 

 

 

Loom Options 

 Loom Options Menu 

 

Anti-Aliasing : Used to smooth out rough edged lines. 

 

Grayscale : Removes all colors from image and is good when printing 
black and white images. 
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Show Timeline : Displays the timeline markers on the left of the Loom. 

 

Stretch Vertical : You can select a percentage to enlarge the height of 
the Loom. Good when many nodes are situated in a small area. 
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Bar Width : Widens the individual locations. Good when many nodes are 

situated in a small area. 

 

 

Allow Multiple Waypoints per Period : If unchecked a node will appear 
only in the most weighted position. If checked then the node will be 
placed in all locations. 

Example : A main location also contains three separate rooms. An agent 
can be listed to be in the main location but can also be listed as moving 

between the individual rooms. If this option is checked, the agent will be 
shown to be in all locations which can lead to it appearing an agent is in 
two places at once. 

NOTE : The dotted line denotes a node which disappeared from all locations then 
reappeared later on. 
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Trail Clustering 

What Trail Clustering can do: 

Classification : Given a set of trails, the algorithm can classify trails based on the 
underlying patterns of observed location visits. 

Level of Similarity : The degree of similarity in the classified trails can be 
increased or decreased according to user need by varying the specified depth of the 
PFSA. 

Approximate similarity : Further, trails that have a subset of similar patterns of 

location visits, while also displaying differences by visiting other non common 
locations can also be identified by specifying a threshold for the similarity. 

Noise Insensitivity : Approximate clustering also provides an inbuilt 

imperviousness to measurement noise in the trails. Occasional incorrectly identified 
location in a trail will not prevent it from being classified correctly according to the 

other correctly identified locations. 

Pre-specification of number of clusters : The use of agglomerative clustering 
eliminates the need of pre-specifying the required number of clusters. Thus, this 
removes the risk of assigning trails to clusters they do not necessarily belong to 

(such as in cases where the number of final clusters is less than that necessitated 
by the dataset) 

 

Trail Cluster Creation 

After loading a Loom ready DyNetML set (e.g. The Star Wars dataset) You can show 

how the characters are clustered. Below is the Loom with entire Star WArs 
characters set displayed. With this example we are interested in the Aunt 
Beru/Uncle Owen and Han Solo/Chewbacca pairings. Both pairs followed, for the 

most part, the similar path. 

NOTE : The Loom lists characters in alphabetical order which may, or may not, 
correspond to the order of the characters in a dataset. 
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From the menu call up Trail Clustering by selecting Clustering > Show Similar 

Trails. Leaving most at their defaults I increase the Trail pattern length to four. 
Clicking [Compute] will display the four characters selecting in the Loom. 

NOTE : In this example Uncle_Owen = character_5, Aunt_Beru = character_6, 

Han_Solo = character_9, and Chewbacca = character_10. 
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Increasing the Trail pattern length to five removes Uncle Owen (character_5) and 
Aunt Beru (character_6). If you look at the Loom image below both these nodes 

appear in only four time slices. When the length is increased to five they are 
removed form the display. 
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Trail Cluster Analysis 

Trail Clustering using Symbolic Time Series Analysis 
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The objective of the Trails Cluster Analysis is to find similar behaviors in large 
networks. This can be described as a network trail generated by an agent over a 

period of time. This tracking can be used to predict that agent's behavior. 

This methodology is fast and flexible and can be applied to several different node 
classes. It views each trail as a sequence of discrete symbols where each symbol is 

a visited location. Clustering is performed using a model based approach where a 
representative Probabilistic Finite State Automata model [PFSA] is derived for 

each trail. Each trail is treated as temporal sequence generated by an underlying 
Markovian process. The process is assumed to be Markovian of length D; the 
current location of each agent is influenced only by the past D locations visited by 

the agent 

The trail clustering is a two-step approach. The first step is a coarse clustering 
stage where each trail's representative PFSA model is derived using the D-Markov 

algorithm [Ray, 2004]. The value of D significantly affects the granularity of the 
analysis. A value of 1 for the depth D implies that agents visit the same locations 
with similar frequencies, though not necessarily in the same order. A higher value 

of depth implies that agents are clustered based on visiting locations in the same 
order with similar frequencies. After the models are derived, the trails are grouped 

into coarse clusters where the cluster membership is determined based only on the 
locations that the agents visit and not on the frequencies with which these locations 
are visited. The second step of the trail clustering algorithm is cluster refinement 

where hierarchical clustering is performed on each of the coarse clusters to form 
groups of trails where each of the trails visit locations with similar visit probabilities. 

 

Figure 1 : Trail Clustering Menu in LOOM 

Sometimes it's necessary to look beyond trails which do not visit all the same 
locations but do visit many of them. For this a cluster quality index is used. It 
finds which percentage of locations are common amongst the coarse trails. 

A cluster quality of [ 1 ] implies that trails which visit the exact same locations are 

only grouped together into coarse clusters. A cluster quality of [ 0.5 ] implies that 
all the trails in a coarse cluster have at least 50% of locations in common. The 
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cluster refining step then groups the trails in the coarse cluster based on probability 
of visiting these common locations with similar frequencies. 

The Clustering Tool is integrated into the LOOM Visualization tool. It requires two 

inputs: 

1 : The trail pattern depth for the generation of PFSA. 

2 : The cluster quality. 

Trail clustering allows for the extraction of groups of trails that demonstrate similar 

behavior. [ i.e. visiting the location in the same order though not necessarily at the 
same time ]. LOOM allows several different options for these visualizations. 

 

Figure 2 : Cluster Visualization Options 

In addition to showing all the trails in each cluster and only the longest trail, LOOM 
also allows the visualization of the longest common subsequence amongst all the 

trails in a cluster. Trails belonging to the same cluster will have more sequences of 
locations visited in the same order (not necessarily consecutively) than trails 
belonging to different clusters. The longest common subsequence in a cluster 

depicts the most common behavior pattern amongst the agents that led to their 
being grouped together. The five different approaches to visualization of clusters 

provided by LOOM allows the end user different viewpoints of the clustered trails 
based on the analysis requirement. 
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Loom Events 

 Loom Events Menu 

 

Load Events from File : Load csv file containing two columns 
(date,events) 

 

Group Events By… :  

 

Don't Group : Makes each line correspond to one event. 

 

Day : Each line will correspond to a summation of all events for a day 

 

Month : Each line will correspond to a summation of all events for a 
month 

 

Year : Each line will correspond to a summation of all events for a year 

 

Show Events : A toggle to show/hide event lines. 

 

 

Make Loom Dataset 

Multiple Meta-Networks can be combined into a single Meta-Network usable in 
Loom. 

Pre-Requisites 

To create a dataset usable in Loom it requires multiple Meta-Networks containing 
the exact same Nodes/NodeClasses/Networks. What changes between the multiple 

Meta-Networks is which Nodes and Links are present in each timeslice. 

NOTE : Every NodeClass needs to contain identical nodes in every NodeClass. No 
exceptions. 
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What differs is the Networks created from these agent and location NodeClasses. 

Below shows the difference between the first three time slices of the Star Wars set. 
Identical characters and locations but each network changes as to which characters 
are listed in individual locations. 

Star Wars - Time Slice 1 

 

Star Wars - Time Slice 2 
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Star Wars - Time Slice 3 

 

Creating a DataSet 

Load all Meta-Networks into ORA. Highlight all these Meta-Networks. Right-Click 
to bring up the contextual menu. 
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Select Create Dynamic Meta-Network. This brings up the Create dialog box. 



 

559 
 

 

Clear check marks under Import as keyframe from all instance except the first. 

Then click the Create button. 

Creates Meta-Network with Clock 
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Now you have a Dynamic Meta-Network that can be viewed in Loom. 

 

MGRS Coordinates 

MGRS coordinates consist of an even number of characters. It starts off identifying 
a Grid Zone, and then as more characters are added the location becomes more 
precise. 

To implement, create an Attribute called the Military Grid Reference System 

[MGRS] in your location node class. Unlike Lat/Lon, it only requires a single 
attribute. Populate each location with it's corresponding MGRS, and so on. Apart 

from it's separate conventions, it operates much the same as the Lat/Lon, in terms 
of adding it to your data. 

NOTE : In terms of Priorities, GIS looks for Lat/Lon data first, then attempts to find 

MGRS. 

Example 
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An example of an MGRS coordinate, or grid reference, would be 4QFJ12345678, 
which consists of three parts: 

 4Q (grid zone designator, GZD), 

 FJ (the 100,000-meter square identifier), and 

 12345678 (numerical location; easting is1234 and northing is 5678, in this 
case specifying a location with 10m resolution). These map coordinates are 
read from west to east first (easting), then from south to north (northing). 

4QFJ15 is the square occupied by Honolulu. The 1 and 5 are the first digits of 

each of the four-digit combinations. The rest of the digits are used as refinement to 
the location. 

 

NOTE : Common mnemonics include in the house, up the stairs, left-to-right, 
bottom-to-top and Read Right Up. 

Image Licensing : Image map of Hawaii licensed under the Creative Commons 
Attribution-Share Alike 3.0 Unported license. 

 

ORA Measures 
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ORA contains over 100 measures.  

What is a Measure 

A measure is a function that takes as input a Meta-Network and outputs a single 

value or a vector of values. Consider the measure Density. The output for this 
measure is a single number used to analyze an organization. By default, all 
measures are run on a Meta-Network. To view which measures are available, go to 

the Tools menu and select the Measures Manager. 

ORA Measures Manager 

The Measures Manager categorizes measures in the following ways: Entity 
Level, Graph Level, and Risk Category. 

Entity Level Measure is one that is defined for, and gives a value for, each 

entity in a network. If there are x nodes in a network, then the metric is 
calculated x once each for each node. 

Examples are Degree Centrality, Betweenness, and Cognitive Demand. 

Graph Level Measure is one that is defined for, and gives a value for, the 

network as a whole. The metric is calculated once for the network. 

Examples are Centralization, Graph Hierarchy, and the maximum or average 
Betweenness 

Some reports use a predefined set of measures, and these are not affected by 

the Measure Manager selections (for example, the Intel, Context, Located 
SubGroups, Sphere of Influence, and Immediate Impact reports). The 

Risk Report, however, uses only the measures selected in the Measure 
Manager. 

The following sets of entities (with their abbreviated symbol) are used 
throughout the document: Agent (A), Knowledge (K), Resource (R), and 

Task (T). The following networks defined on these entity sets are used 
throughout the documentation. 

 

Symbol Entity Sets Name 

 
U V   

AA Agent Agent Communication Network 

AK Agent Knowledge Knowledge Network 

AR Agent Resource Capabilities Network 
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AT Agent Task Assignment Network 

KK Knowledge Knowledge Information Network 

KR Knowledge Resource Training Network 

KT Knowledge Task Knowledge Requirement Network 

RR Resource Resource Resource Substitute Network 

RT Resource Task Resource Requirement Network 

TT Task Task Precedence Network 

Input: 

This lists each of the Networks that are required as input to the measure. If a 

measure takes as input a specific network from the Meta-Network, such as the 
Agent x Knowledge (AK) matrix, then it is listed. If the measure runs on any 

square (unimodal) network then N is given. A measure can require more 
than one input matrix. 

1. Each input matrix can have one or more of the following requirements:  

a. square: the matrix must have the same number of rows as 
columns 

b. binary: it must be binary data (i.e. any links in the network are 
assumed to have a weight of one) 

c. symmetric: the network must be undirected 

2. ORA does the following when a network does not meet one or more of the 

above requirements: 

a. square: measure is not computed 

b. binary: measure is computed, and edge weights are ignored (all 
edges are given value one) 

c. symmetric: measure is computed, and the matrix is first 
symmetrized using the union method 

A complete list of all measures available in ORA, along with references, input 

and output specifications, can be found in the following ORA Measures sections. 

 

Computational Speeds 

Measure Speeds 



 

564 
 

Slow : These measures do geodesic computations or multiple matric 
multiplcations. 

e,g, Betweenness measures, Closeness measures, and Relative 
Cognitive measures. 

Medium : These multiply matrices 

e.g. Cognitive Demand, Congruence measures, and Workload measures. 

Fast : Are usually measures that basically count very fast  
e.g. In-Degree Centrality, Row and Columns Count, and Capability . 

 

Fast Measures 

Measure 
Network 

Level 
Node 
Level 

Uses Link 
Weights 

Access Redundancy True False False 

Agent Socio Economic Power False True False 

Assignment Redundancy True False False 

Burt Effective Network Size False True True 

Capability False True True 

Classic SNA Density True False False 

Clustering Coefficient Density True True False 

Column Breadth True False False 

Column Count True False False 

Column Degree Centrality False True True 

Column Redundancy True False False 

Complexity True False False 

Density True False False 

Diagonal False True True 

Exclusivity False True False 

Exclusivity Complete False True False 

Gini Means Difference Column False True True 

In-Degree Centrality False True True 

In-Degree Network True False True 
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Centralization 

Interdependence True False False 

Interlockers False True False 

Isolate Count True False False 

Knowledge Based Access INdex False True False 

Knowledge DIversity True False False 

Knowledge, Exclusivity False True False 

Knowledge Load True False False 

Knowledge Redundancy True False False 

Lateral Link COunt True False False 

Link Count True False False 

Node Count True False False 

Out-Degree Centrality False True True 

Out-Degree Network 

Centralization 
True False True 

Personnel Cost False True False 

Pooled Link Count True False False 

Radials False True False 

Reciprocal Link Count True False False 

Resource Based Access Index False True False 

Resource Diversity True False False 

Resource Exclusivity False True False 

Resource Load True False False 

Resource Redundancy True False False 

Row Breadth True False False 

Row Count True False False 

Row Degree Centrality False True True 

Row Redundancy True False False 

Sequential Link Count True False False 

Span of Control True False False 
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Task Exclusivity False True False 

Total Degree Centrality False True True 

Total Degree Network 
Centralization 

True False False 

 

 

Medium Measures 

Measure 
Network 

Level 
Node 
Level 

Uses Link 
Weights 

Actual Workload False True False 

Actual Workload False True False 

Agent Knowledge Needs Congruence False True False 

Agent Knowledge Waste Congruence False True False 

Agent Resource Needs Congruence False True False 

Agent Resource Waste Congruence False True False 

Authority Centrality False True True 

Average Distance True False True 

Average Speed True False True 

Bonacich Power Centrality False True True 

Boundary Spanner False True False 

Burt Constraint False True True 

Clique Count False True False 

Cognitive Demand False True False 

Communication False True False 

Communication Congruence True False False 

Connectedness True False False 

Diameter True False True 

Efficiency True False False 

Eigenvector Centrality False True True 

Eigenvector Per Component 

Centrality 
False True True 
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Fragmentation True False False 

Geodesic Distance False False False 

Hub Centrality False True True 

Knowledge Negogiation True True True 

Knowledge Potential Workload False True False 

Knowledge Based Task Completion True False False 

Knowledge Under Supply True False False 

Minimum Speed True False True 

Network Levels True False True 

Organization Agent Knowledge 
Needs Congruence 

True False False 

Organization Agent Knowledge 
Waste Congruence 

True False False 

Organization Agent Resource Needs 
Congruence 

True False False 

Organization Agent Resource Waste 
Congruence 

True False False 

Organization Task Knowledge Need 
Congruence 

True False False 

Organization Task Knowledge Waste 
Congruence 

True False False 

Organization Task Knowledge Need 
Congruence 

True False False 

Organization Task Knowledge Waste 
Congruence 

True False False 

Overall Task Completion True False False 

Performance As Accuracy True False False 

Potential Workload False True False 

Relative Expertise False True False 

Relative Similarity False True False 

Resource Actual Workload False True False 

Resource Negiogiation True False False 
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Resource Potential Workload False True False 

Resource Based Task Completion True False False 

Resource Under Supply True False False 

Shared Situation Awareness False True False 

Simmelian Ties False True False 

Skip Link Count True False False 

Social Technical Congruence True False False 

Strict Knowledge Congruence True False False 

Strict Resource Congruence True False False 

Strong Component COunt True False False 

Task Knowledge Needs Congruence False True False 

Task Knowledge Waste Congruence False True False 

Task Resource Needs Congruence False True False 

Task Resource Waste Congruence False True False 

Transitivity True False False 

Triad Count False True False 

Weak Component Count True False False 

Weak Component Members False True False 
 

 

 

Slow Measures 

Measure 
Network 

Level 
Node 

Level 
Uses Link 

Weights 

Betweenness Centrality False True True 

Betweenness Centrality Spatial False True True 

Betweenness Network 
Centralization 

True False True 

Closeness Centrality False True True 

Closeness Network 

Centralization 
True False True 
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Closeness Centrality Spatial False True True 

Cognitive Distrinctiveness False True False 

Cognitive Expertise False True False 

Cognitive Resemblance False True False 

Cognitive Similarity False True False 

Degree Centrality Spatial False True True 

Diffusion True False False 

Distinctiveness Correlation False True False 

Eigenvector Centrality Spatial False True True 

Expertise Correlation False True False 

Edge Betweenness Centrality False False True 

Eigenvector Network 

Centralization 
True False True 

Global Efficiency True False False 

Hierarchy True False False 

In-Closeness Centrality False True True 

In-Closess Network 
Centralization 

True False True 

Information Centrality False True True 

Inverse Closeness Centrality False True True 

Knowledge Omega True False False 

Local Efficiency True False False 

Location Relevance False True True 

Organizanal Availability False True False 

Overall Role Based Availability False True False 

Potential Boundary Spanner False True False 

Relative Cognitive 

Distinctiveness 
False False False 

Relative Cognitive Expertise False False False 

Relative Cognitive Resemblance False False False 
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Relative Cognitive Similarity False False False 

Resemblance Correlation False True False 

Role Based Knowledge 
Availabity 

False True False 

Role Based Resource Availability False True False 

Role Based Knowledge 
Availability 

False True False 

Role Resource Availability False True False 

Resource Omega True False False 

Role Based Knowledge 
Availability 

False True False 

Role Resource Availability False True False 

Similarity Correlation False True False 

Upper Boundedness True False False 

 

 

Access Redundancy 

 

Description 

Average number of redundant agents per resource. An agent is redundant if there 
is already an agent that has access to the resource. 

NOTE : This measure works on the Agent x Resource matrix and needs to be in 

the binary format [ 0 or 1 ]. 

Informal Name 

None 

Citation 

Carley, Kathleen M. 2002. "Summary of Key Network Measures for Characterizing 
Organizational Architectures." Unpublished Document: CMU 2002 

Minimum and Maximum Values 

file:///C:/myStuff/User's Guides/reports2/measureByReport.html
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Minimum Possible : 0 

Maximum Possible : ℜ ∈[0,(|A|-1*|R|]. 

Computational Time 

Fast 

Input and Output 

Input :  

Agent by Resource : DataType=binary. 

Output :  

Graph Level : DataType=real. 

 

This is the Column Redundancy of matrix AR. 

 

Actual Workload 

 

Description 

The knowledge and resources an agent uses to perform the tasks to which it is 
assigned. Individuals or organizations that are high in workload are those that are 

doing more complex tasks and have the resources and knowledge or expertise to 
do those tasks. Tasks are more complex if they require more expertise and/or more 
resources. 

NOTE : This measure works on the Agent x Knowledge, Agent x Resource, 
Agent x Task, Knowledge x Task, Resource x Task and needs to be in the 
binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 

file:///C:/myStuff/User's Guides/reports2/measureByReport.html
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In a given organization, employees have access to certain knowledge (e.g., fix 
computers) and resources (e.g., computer parts). This measure would compute a 

value to reflect the overall level of organizational access within the network.  

Informal Name 

None 

Citation 

Carley, Kathleen M. 2002. "Summary of Key Network Measures for Characterizing 

Organizational Architectures." Unpublished Document: CMU 2002 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Input :  

Agent by Knowledge : DataType=binary 

Agent by Resource : DataType=binary 

Agent by Task : DataType=binary 

Knowledge by Task : DataType=binary 

Resource by Task : DataType=binary 

Output :  

Node Level : Type=agent and DataType=real. 

 

Actual Workload for agent i is defined as follows: 
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Agent Knowledge Needs Congruence 

 

Description 

The number of knowledge that an agent lacks to complete its assigned tasks 
expressed as a percentage of the total knowledge required for the assigned tasks. 

Works primarily on the Agent x Knowledge matrix and also uses those two 
nodesclasses working with the task nodeclass. 

NOTE : This measure works on the Agent x Knowledge, Agent x Task, and 
Knowledge x Task matrices and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Lee, Ju-Sung, & Carley, Kathleen M. (2004). OrgAhead: A Computational Model of 
Organizational Learning and Decision Making. Pittsburgh, PA: Carnegie Mellon 
University, School of Computer Science, Institute for Software Research 

International, Technical Report, CMU-ISRI-04-117.  

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Input :  

Agent by Knowledge : DataType=binary. 
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Agent by Task : DataType=binary. 

Knowledge by Task : DataType=binary. 

Output :  

Node Level : Type=agent and DataType=real. 

 

Agent Knowledge Needs compares the knowledge needs of the agent to do its 
assigned tasks, with the actual knowledge of the agent. 

Let N = AT*KT' = knowledge needed by agents to do assigned tasks. 

for Resource replace KT with RT 

We need to sum the knowledge needed but not available. 

Then, Agent Knowledge Needs for 

 

Agent Resource Needs is analogous, replacing AK with AR, and KT with RT. 

 

Agent Knowledge Waste Congruence 

 

Description 

The number of knowledges that an agent has that are not needed by any of its 

tasks expressed as a percentage of the total knowledge of the agent. 

NOTE : This measure works on the Agent x Knowledge, Agent x Task, and 
Knowledge x Task matrices and needs to be in the binary format [ 0 or 1 ]. 

file:///C:/myStuff/User's Guides/reports2/measureByReport.html
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The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Lee, Ju-Sung, & Carley, Kathleen M. (2004). OrgAhead: A Computational Model of 
Organizational Learning and Decision Making. Pittsburgh, PA: Carnegie Mellon 

University, School of Computer Science, Institute for Software Research 
International, Technical Report, CMU-ISRI-04-117.  

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Input :  

Agent by Knowledge : DataType=binary. 

Agent by Task : DataType=binary. 

Knowledge by Task : DataType=binary. 

Output :  

Node Level : Type=agent and DataType=real. 

 

Agent Knowledge Waste compares the knowledge of the agent with the 
knowledge it actually needs to do its tasks. Any unused knowledge is considered 
wasted. 

Let N = AT*KT' = knowledge needed by an agent to do its assigned tasks. 

for Resource replace KT with RT 
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We need to sum the knowledge the agent has but which is not needed. 

Then, Agent Knowledge Waste for 

 

The equation for Agent Resource Waste replaces AK with AR, and KT with RT. 

 

Agent Resource Needs Congruence 

 

Description 

The number of resources that an agent lacks to complete its assigned tasks 

expressed as a percentage of the total resources required for the assigned tasks. 

NOTE : This measure works on the Agent x Resource, Agent x Task, and 
Resource x Task matrices and needs to be in the binary format [ 0 or 1 ]. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Lee, Ju-Sung, & Carley, Kathleen M. (2004). OrgAhead: A Computational Model of 

Organizational Learning and Decision Making. Pittsburgh, PA: Carnegie Mellon 
University, School of Computer Science, Institute for Software Research 
International, Technical Report, CMU-ISRI-04-117. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 
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Computational Time 

Medium 

Input and Output 

Input :  

Agent by Resource : DataType=binary. 

Agent by Task : DataType=binary. 

Resource by Task : DataType=binary. 

Output :  

Node Level : Type=agent and DataType=real. 

 

Agent Knowledge Needs compares the knowledge needs of the agent to do 

its assigned tasks, with the actual knowledge of the agent. 

Let N = AT*KT' = knowledge needed by agents to do assigned tasks. 

for Resource replace KT with RT 

We need to sum the knowledge needed but not available. 

Then, Agent Knowledge Needs for 

 

Agent Resource Needs is analogous, replacing AK with AR, and KT with 

RT. 

 

Agent Resource Waste Congruence 
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Description 

The number of resources that an agent has that are not needed by any of its tasks 

expressed as a percentage of the total resources of the agent. 

NOTE : This measure works on the Agent x Resource, Agent x Task, and 
Resource x Task matrices and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Lee, Ju-Sung, & Carley, Kathleen M. (2004). OrgAhead: A Computational Model of 

Organizational Learning and Decision Making. Pittsburgh, PA: Carnegie Mellon 
University, School of Computer Science, Institute for Software Research 
International, Technical Report, CMU-ISRI-04-117. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Input :  

Agent by Resource : DataType=binary. 

Agent by Task : DataType=binary. 

Resource by Task : DataType=binary. 

Output :  

Node Level : Type=agent and DataType=real. 
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Agent Knowledge Waste compares the knowledge of the agent with the 
knowledge it actually needs to do its tasks. Any unused knowledge is 
considered wasted. 

Let N = AT*KT' = knowledge needed by an agent to do its assigned tasks. 

for Resource replace KT with RT 

We need to sum the knowledge the agent has but which is not needed. 

Then, Agent Knowledge Waste for 

 

The equation for Agent Resource Waste replaces AK with AR, and KT with RT. 

 

Agent Socio Economic Power 

 

Description 

A measure of actor power based on access to knowledge, resources, and tasks in 
the organization. 

NOTE : This measure works on the Agent x Knowledge, Agent x Resource, and 

Agent x Task matrices and needs to be in the binary format [ 0 or 1 ]. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Example 

An individual within an organization that has the most connections, hence access, 
to knowledge (special skills), resources (unlimited funding) and tasks (has the most 

file:///C:/myStuff/User's Guides/reports2/measureByReport.html
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important tasks). Such an agent would rank high in the SocioEconomic Power 
measure. 

Informal Name 

None 

Citation 

Kathleen M. Carley, 2004 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Fast 

Input :  

Agent by Knowledge : DataType=binary. 

Agent by Resource : DataType=binary. 

Agent by Task : DataType=binary. 

Output :  

Node Level : Type=agent and DataType=real. 

 

Let N = [AK AR AT], that is, the concatenation of the input matrices. 

Then, Agent Socio Economic Power is the row degree centrality of N. 

 

Assignment Redundancy 

 

Description 

file:///C:/myStuff/User's Guides/reports2/measureByReport.html
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Average number of redundant agents assigned to tasks. An agent is redundant if 
there is already an agent assigned to the task. 

NOTE : This measure works on the Agent x Task matrix. 

Informal Name 

None 

Citation 

Carley, Kathleen M. 2002. Summary of Key Network Measures for Characterizing 
Organizational Architectures. Unpublished Document: CMU 2002 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : ℜ ∈[0,(|A|-1*T] 

Computational Time 

Fast 

Input and Output 

Input :  

Agent by Task : DataType=binary 

Output :  

Graph Level : DataType=real 

 

This is the Column Redundancy of matrix AT. 

 

Authority Centrality 

 

Description 

file:///C:/myStuff/User's Guides/reports2/measureByReport.html
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A node is authority-central to the extent that its in-links are from nodes that have 
many out-links. Individuals or organizations that act as authorities are receiving 

information from a wide range of others each of whom sends information to a large 
number of others. Technically, an agent is authority-central if its in-links are from 

agents that have are sending links to many others. The scientific name of this 
measure is authority centrality and it is calculated on agent by agent matrices. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 

Location, etc]. 

Informal Name 

None 

Citation 

Kleinberg, Jon M. (1998). Authoritative sources in a hyperlinked environment. 
Paper presented at the SODA '98 Ninth Annual ACM-SIAM Symposium on Discrete 

Algorithms, San Francisco, CA. Latria and Marchiori, 2001 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Input :  

Square matrix : DataType=real. 

Output :  

Node Level : DataType=real. 

 

Average CommunicationSpeed 
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Description 

The average speed with which any two nodes can interact. This is based on the 
inverse of the shortest path lengths between node pairs. 

NOTE : This measure works Square Matrices [i.e. Agent x Agent, Location x 
Location, etc.] and needs to be in the binary format [ 0 or 1 ]. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Example 

In an organization that any two individuals have an average of 3.4 connections 
between them would approximate the average speed at which an a communication 

might spread throughout the organization. Naturally, the lower the average links, 
the higher the organizational speed. 

Informal Name 

None 

Citation 

Carley, Kathleen M. 2002. Summary of Key Network Measures for Characterizing 

Organizational Architectures. Unpublished Document: CMU 2002 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Input :  

Square matrix : DataType=binary. 

Output :  

Graph Level : DataType=real. 
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Average Speed is the average of the Inverse Closeness Centrality for the 
network entities. 

 

Betweenness Centrality 

 

Description 

The Betweenness Centrality of node v in a network is defined as: across all node 
pairs that have a shortest path containing v, the percentage that pass through v. 
Individuals or organizations that are potentially influential are positioned to broker 

connections between groups and to bring to bear the influence of one group on 
another or serve as a gatekeeper between groups. This agent occurs on many of 

the shortest paths between other agents. The scientific name of this measure is 
betweenness centrality and it is calculated on agent by agent matrices. 

NOTE : This measure works Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 

This measure indicates the extent that an individual is a broker of indirect 

connections among all others in a network. Someone with high Betweenness could 
be thought of as a gatekeeper of information flow. People that occur on many 

shortest paths among other People have highest Betweenness value. Betweenness 
is one of the key measures used by those interested in networks. 

Informal Name 

None 

Citation 

Freeman, Linton C. (1979). Centrality in social networks I: Conceptual clarification. 

Social Networks, 1(3), 215-239. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 
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Computational Time 

Slow 

Input and Output 

Input :  

Square Matrix : DataType=binary 

Output :  

Node Level : DataType=real 

 

Let G=(V,E) be the graph representation for the network. Let n=|V|, and fix 

an entity . 

For , let be the number of geodesics in G from u to 

w. 

If , then set . 

Define the following: 

let 

 

let  

Then Betweenness Centrality of the entity 

.  

NOTE : If G is not symmetric, then between is normalized by (n-1)(n-2). 

 

Betweenness Centrality Spatial 
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Description 

The extent to which a node lies between other nodes that are far from each other. 

The spatial network metrics assume that for each node in the network you have 

specified a latitude and longitude as two attributes of the node. Based on these 
values a distance is calculated (as the crow flies). 

Then the metrics are calculated taking this spatial proximity into account. 
Specifically, Spatial Betweenness emphasizes the nodes that lie on shortest paths 

between distant others (e.g. an expert who collaborates with people in different 
cities) over paths paths that connect nearby others(e.g. a manager who connects 

the workers in a single office). Spatial Closeness emphasizes nodes that are closest 
to the other nodes both in the network and in space by calculating standard 
closeness centrality on a distance-weighted copy of the network. Nodes connected 

mostly to spatially nearby neighbors would have higher spatial closeness than 
nodes connected to the same number of spatially distant neighbors. 

NOTE : This measure works on the Agent x Agent and Agent x Resource 

matrices with weighted links. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Malloy, Eric, Olson, Jamie, & Carley, Kathleen M. (2009). Geographic and Network 
Analysis of Drug Interdiction Information. Paper presented at the Twenty Ninth 

International Sunbelt Social Network Conference, San Diego, CA. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Slow 

Input and Output 

Input :  
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Agent by Agent : DataType=real. 

Agent by Location : DataType=real. 

Output :  

Node Level : Type=agent and DataType=real 

 

Betweenness Network Centralization 

 

Description 

Network centralization based on the betweenness score for each node in a square 

network. This measure is defined for directed and undirected networks. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Freeman, Linton C. (1979). Centrality in social networks I: Conceptual clarification. 

Social Networks, 1(3), 215-239. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Slow 

Input and Output 

Input :  
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Square Matrix : DataType=binary 

Output :  

Node Level : DataType=real 

 

Let G=(V,E) represent the square network, and let n = |V| 

let di = Betweenness Centrality of node i 

let d = max{di | 1 < i < n } 

Then Network Betweenness Cent. = . 

 

Biological Diversity Index 

 

Description 

The mathematical knowledge that helps is that the log of a product is the sum of 
the logs, e.g. ln(4!) = ln(1)+ln(2)+ln(3)+ln(4). Otherwise it is impossible to 

calculate the index for larger data. So, the implementation is just simple loops:  

Informal Name 

None 

Citation 

Anne E. Magurran, Measuring Biological Diversity. Wiley-Blackwell, 2003. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
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Fast 

float brillouin=0; 

for (int i=1; i<=N; i++) 

brillouin = brillouin + log(i); 

  

for (int s=1; s<=number_of_groups; s++) 

for (int i=1; i<=n[s]; i++) 

brillouin = brillouin - log(i); 

brillouin = brillouin / N 

[ln(N!) - ∑ ln(ni!)] / N where ni is the number of elements in a specific group and 
N is the sum of all ni. 

An issue of the Brillouin index is the lack of normalization, so there is no defined 

value range. The idea is that larger environments are more diverse even if the 
distribution of the elements is the same. Nevertheless the results look always 
similar because of the /N. 

Input and Output 

Input :  

Node Level : DataType=Binary 

Output :  

A single value showing distribution. 

 

Bonacich Power Centrality 

 

Description 
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The Bonacich Power Centrality computes the centrality of each entity based on the 
centrality of its neighbors. Beta should be chosen such that its absolute value is less 

than the reciprocal of the larges eigenvalue of N. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and can be any number. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 

In a given organization, this meausre can tell us who is connected to the most 

powerful (e.g., other highly connected agents) people. 

Informal Name 

None 

Citation 

Bonacich P., 1987 "Factoring and weighing approaches to clique identification" 
Journal of Mathematical Sociology, 2 (January, 1972), 113-120. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Input :  

Square Matrix : DataType=real and Directed=No. 

 

Output :  

Node Level : DataType=real. 
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Let A = adjacency representation of the network N. Then Bonacich Power 
Centrality for the network is the solution c to the following system of linear 

equations: 

, where I is the identity matrix, and e a vector of ones. 

NOTE : If beta is 0, then c is simply equal to the row degree of each entity. 

The values of c are not normalized. 

 

Burt Constraint 

 

Description 

The degree to which each node in a square network is constrained from acting 
because of its existing links to other nodes. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 

Location, etc] and can be any number. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Example 

Bob is given a certain task, but that task requires certain links, which Bob does not 
have. Bob is constrained in the sense he does not have the links to complete the 

task. This measure computes a value for such relationships as they distributed 
across the whole network. 

Informal Name 

None 

Citation 

Burt, Ronald. Structural Holes: The Social Structures of Competition. Cambridge, 

MA: Harvard University Press, 1992. 

Minimum and Maximum Values 

Minimum Possible : 0 
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Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Input :  

Square matrix : DataType=real. 

Output :  

Node Level : DataType=real. 

 

This is the Constraint measure described by Equ. 2.4 on pg. 55 of Burt, 

1992. 

NOTE : The matrix Z is the adjacency matrix representation of the network N. 

 

Burt Effective Network Size 

 

Description 

The effective size of a node's ego network based on redundancy of links. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and can be any number. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 

In a given organizaton, let us say Bob has ties to many others in the organization, 

who in turn have redundant ties to other people. The point at which this no longer 
applies tends to define effective network size. 

Informal Name 
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None 

Citation 

Burt, Ronald. Structural Holes: The Social Structures of Competition. Cambridge, 

MA: Harvard University Press, 1992. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Fast 

Input :  

Square matrix : DataType=real. 

Output :  

Node Level : DataType=real. 

 

This is the Effective Size of Network measure described by Equ. 2.2 on pg. 
52 of Burt, 1992. Note that the Communciation Network is used for the 

matrix Z. 

 

Capability 

 

Description 

Detects entities with high or low degree relative to other entities. The formula 
discounts for the fact that most agents have some connections and assumes that 

there is a general discount to having large numbers of connections. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and can be any number. 
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The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Kathleen M. Carley, Dave Columbus, Matthew DeReno, Jeff Reminga and Il-Chul 
Moon, 2007, "ORA User's Guide 2007," Carnegie Mellon University, School of 

Computer Science, Institute for Software Research, Technical Report, CMU-ISRI-07-
115. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Fast 

Input and Output 

Input :  

Square matrix : DataType=real. 

Output :  

Node Level : Type=row and DataType=real. 

 

Let RD = the vector of row degrees for each entity in the network. Scale RD 

by dividing each element by the largest value in RD. 

Then the Capability of node i is:  

NOTE : For the most connected entity, this value tends to 1.0, for the least 
connected node it tends to 0, and for the average connected entity it tends to 0.5. 
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Characteristic Path Length 

 

Description 

The average shortest path length between nodes, excluding infinite distances. 

Example 

In a given organization, this measure computes the average amount of connections 

between any two members in the organization. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and N ], inclusive. 

Informal Name 

None 

Citation 

NetStat 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Input :  

Square matrix : DataType=binary 

Output :  

file:///C:/myStuff/User's Guides/reports2/measureByReport.html


 

596 
 

Graph Level : DataType=real. 

 

Let G=(V,E) represent a square network. Define a set S of all pairs (i,j) of 
entities such that i can reach j. Then average the shortest paths. 

let S = {(i,j) | j is reachable in G from j } 

Then, 

 

 

Clique Count 

 

Description 

The number of distinct cliques to which each node belongs. Individuals or 
organizations who are high in number of cliques are those that belong to a large 
number of distinct cliques. A clique is defined as a group of three or more actors 

that have many connections to each other and relatively fewer connections to those 
in other groups. The scientific name of this measure is clique count and it is 

calculated on the agent by agent matrices. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be the number of cliques [ Result not scaled to 0 and 1 ]. 

Informal Name 

None 

Citation 

Wasserman, Stanley and Katherine Faust. "Social Network Analysis: Methods and 

Applications." Cambridge: Cambridge University Press, 1994. 
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Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Slow 

Input and Output 

Input :  

Square matrix : DataType=binary. 

Output :  

Node Level : DataType=integer. 

 

A clique of an undirected, square network is defined in Wasserman and Faust 

as a maximal complete subgraph of three or more nodes. The clique 
detection algorithm employed is the Bron-Kerbosch maximal clique 
algorithm, which is Algorithm 457 of the Collected Algorithms from CACM. 

 

Closeness Centrality 

 

Description 

The average closeness of a node to the other nodes in a network. Closeness is the 

inverse of the average distance in the network between the node and all other 
nodes. 

Closeness reveals how long it takes information to spread from one individual to 

others in the network. High scoring individuals in Closeness have the shortest paths 
to all others in the network. It would follow such individuals could monitor the 

information flow in an organization better than most others that have a lesser 
Closeness value. The ones with the highest value in this measure will often times 
have the best picture of what is happening in the network as a whole. 
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In short, Closeness is the inverse of the average distance in the network between 
any given node and all other nodes. 

NOTE : This measure uses both link weights and link direction in its calculations. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and can be any number. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Example 

Closeness reveals so-called people in the know. Closeness measures the path 
length from one person to another in a network. It tells us which person is central 

to an organization. 

Informal Name 

None 

Citation 

Freeman, L.C. (1979). "Centrality in Social Networks I: Conceptual Clarification." 
Social Networks, 1, 215-239. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Slow 

Input :  

Square matrix : DataType=real. 

Output :  

Node Level : DataType=real. 

Let G=(V,E) be the graph representation of the square network. 

Fix 
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let 

 

if i is unreachable from v. 

Then Closeness Centrality of node . 

 

Closeness Centrality Spatial 

 

Description 

The extent to which a node is close to the other nodes both in the network and in 

space 

NOTE : This measure works on the Agent x Agent and Agent x Location 
matrices and is any number. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Malloy, Eric, Olson, Jamie, & Carley, Kathleen M. (2009). Geographic and Network 

Analysis of Drug Interdiction Information. Paper presented at the Twenty Ninth 
International Sunbelt Social Network Conference, San Diego, CA. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
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Slow 

Input and Output 

Input :  

Agent by Agent : DataType=real. 

Agent by Location : DataType=real. 

Output :  

Node Level : Type=agent and DataType=real 

 

Closeness Network Centralization 

 

Description 

Network centralization based on the closeness centrality of each node in a square 
network. This is defined only for connected, undirected networks. 

Example 

An organization has employees, computers, benchmarks, and products. How central 

these entities exist within the connections of the network, which is defined by the 
connections they have throughout the network, is loosely what is network 
centralization. This measure computes a value for the centrality of these entities. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 

Location, etc] and can be any number. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Freeman, L.C. (1979). Centrality in Social Networks I: Conceptual Clarification. 
Social Networks, 1, 215-239. 
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Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Slow 

Input and Output 

Input :  

Square matrix : DataType=real. 

Output :  

Graph Level : DataType=real. 

 

(if N connected) 

Let G=(V,E) represent the square network, and let n = |V| 

let 

 

let 

 

Then 

 

 

Clustering Coefficient 
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Description 

Measures the degree of clustering in a network by averaging the clustering 

coefficient of each node, which is defined as the density of the node's ego network. 

The clustering coefficient gives a sense of the local characteristics of the network--
how information spreads by means of employee groups. A higher clustering 

coefficient supports local information diffusion as well as a decentralized 
infrastructure because employees are likely to share information and know what is 
happening in their work group. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 

Location, etc] and needs to be in the binary format [ 0 or 1 ]. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Example 

The average of the proportion of links between each employee and his or her direct 
neighbors divided by the number of links that could possibly exist between them. 

Informal Name 

None 

Citation 

Watts DJ, Strogatz SH "Collective dynamics of 'small-world' networks" NATURE 393 

(6684): 440-442 JUN 4 1998.  

Minimum and Maximum Values 

Values for both Graph Level and Node Level 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Slow 

Input and Output 

Input :  
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Square matrix : DataType=binary. 

Output :  

Graph Level : DataType=real. 

Node Level : DataType=real. 

Graph Level:  

Entity Level:  

let G=(V,E) be the graph representation of a square network. 

Define for each node its Clustering Coefficient :  

let Gv = ego network of entity v 

Then Clustering Coefficient for entity: 

 

Then Clustering Coefficient for graph: 

 

 

Cognitive Demand 

 

Description 

Measures the total amount of cognitive effort expended by each agent to do its 
tasks, need to move, connecting others, and so on. Such individuals may never 

become the formal leader of a group. Emergent leaders are identified in terms of 
the amount of cognitive effort that is inferred to be expended based on the 
individual's position in the meta-network. Individuals who are strong emergent 

leaders are likely to be not just connected to many people, organizations, tasks, 
events, areas of expertise, and resources; but also, are engaged in complex tasks 
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where they may not have all the needed resources or knowledge and so have to 
coordinate with others, or have other reasons why they need to coordinate or share 

data or resources. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

Emergent Leader 

Citation 

Carley, Kathleen M. & Yuqing Ren, 2001, "Tradeoffs Between Performance and 

Adaptability for C3I Architectures." In Proceedings of the 2001 Command and 
Control Research and Technology Symposium, Annapolis, Maryland, June, 2001. 

Carley, 2002. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Input :  

Agent by Agent : DataType=binary. 

Output :  

Node Level : Type=agent and DataType=real. 

 

The Cognitive Demand for an agent i is an average of terms, each of which 
measures an aspect of its cognitive demand. Each term is normalized to be in 

[0,1]. The number of terms depends on the input networks. The computation 
of each term for agent i is detailed below: 
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x1 = normailzed count of all agents with which agent i interacts. 

 

x2 = normalized count of tasks to which i is assigned 

 

x3 = normalized sum of agents assigned to the same tasks as i  

 

x4 = normalized count of resources managed by i 

 

x5 = normalized count of total knowledge known by i 

 

x6 = normalized sum resources needed by i for all of its tasks 

 

x7 = normalized sum of knowledge i needs for all its tasks 

 

x8 = normalized sum of resource negotiation needs i has for its tasks 
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x9 = normalized sum of knowledge negotiation needs 

 

x10 = normalized sum of agents that i depends on or that depend on i 

w = colsum([AT]) 

s = (T+T')•w 

v = [AT]•s 

 

Then Cognitive Demand for agent i is the average of the above terms. 

 

Cognitive Distinctiveness 

 

Description 

Measures the degree to which each pair of agents has complementary knowledge, 
expressed as the percent of total knowledge. 

NOTE : This measure works on the Agent x Knowledge matrix and needs to be in 
the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 
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Carley, Kathleen M. 2002. "Summary of Key Network Measures for Characterizing 
Organizational Architectures." Unpublished Document: CMU 2002. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Slow 

Input and Output 

Input :  

Agent by Knowledge : DataType=binary. 

Output :  

Node Level : Type=agent and DataType=real. 

Dyad Level : Agent by Agent and DataType=real. 

 

For each pair of agents (i,j) compute the number of knowledge bits they 
have exactly opposite. Then normalize this sum by the total number of 

knowledge bits. In effect, this is the exclusive-OR of their knowledge vectors. 

 

NOTE : The CD output matrix is symmetric. 

 

Cognitive Expertise 
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Description 

Measures the degree to which each pair of agents has complementary knowledge, 

expressed as a percentage of the knowledge of the first agent. 

NOTE : This measure works on the Agent x Knowledge matrix and needs to be in 
the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 

If one person in an organization knows how do perform X but can't do Y. Whereas 
another individual can do Y but not X, such individuals would rank highly in this 

measure. 

Informal Name 

None 

Citation 

Carley, Kathleen M. 2002. "Summary of Key Network Measures for Characterizing 

Organizational Architectures." Unpublished Document: CMU 2002 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Slow 

Input and Output 

Input :  

Agent by Knowledge : DataType=binary. 

Output :  

Node Level : Type=agent and DataType=real. 
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Dyad Level : agent by agent with DataType=real. 

 

For each pair of agents (i,j) compute the number of knowledge bits that j 
knows that i does not know. Then normalize this sum by the total number of 

knowledge bits that agent i does not know. 

 

NOTE : The CD output matrix is NOT-symmetric. 

 

Cognitive Resemblance 

 

Description 

Measures the degree to which each pair of agents has the exact same knowledge. 
Each value is normalized by the row sum. 

NOTE : This measure works on the Agent x Knowledge matrix and needs to be in 

the binary format [ 0 or 1 ]. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Example 

In an given organizational network, let us say that Bob has the knowledge to 
perform X, Y, and Z. Whereas Sally also has the knowledge to perform X, Y and Z. 

This measure would rank this pair (i.e., dyad) high in Cognitive Resemblance. 

Informal Name 

None 
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Citation 

Carley, Kathleen M. 2002. "Summary of Key Network Measures for Characterizing 
Organizational Architectures." Unpublished Document: CMU 2002. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Slow 

Input :  

Agent by Knowledge : DataType=binary. 

Output :  

Dyad Level : Agent by Knowledge and DataType=real. 

 

For each pair of agents (i,j) compute the number of knowledge bits they 
have in common - whether known or unknown. Then normalize this sum by 

the total number of knowledge bits. 

 

NOTE : The CR output matrix is symmetric. 

 

Cognitive Similarity 
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Description 

Measures the degree to which each pair of agents have overlapping knowledge. 

NOTE : This measure works on the Agent x Knowledge matrix and needs to be in 

the binary format [ 0 or 1 ]. 

Example 

With an organization where Bob has the knowledge of X, Y and Z and Sally has the 
knowledge of Q, R and Z. The Cognitive Similarity mesure would compute a value 

for Bob and Sally's overlapping knowledge of Z. 

The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Carley, Kathleen M. 2002. "Summary of Key Network Measures for Characterizing 
Organizational Architectures." Unpublished Document: CMU 2002. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Slow 

Input and Output 

Input :  

Agent by Knowledge : DataType=binary. 

Output :  

Node Level : Type=agent and DataType=real. 

Dyad Level : Agent by Agent and DataType=real. 
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For each pair of agents (i,j) compute the number of knowledge bits they 
have in common. Then normalize this sum by the total knowledge between 

them. 

 

NOTE : The CS output matrix is symmetric. 

 

Column Breadth 

 

Description 

The fraction of entities with column nodes with degree greater than one. 

NOTE : This measure works on all Networks and can be any number. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 

In a given organization, we have the following entities: employees (agents), 

computers (resources), benchmarks (tasks). This measure tells us on how many 
links greater than one exist within these entity types. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002 

Minimum and Maximum Values 
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Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Fast 

Input and Output 

Input :  

DataType=binary. 

Output :  

Graph Level : DataType=real. 

 

Let d = the Column degree vector of the network N 

Then, the Column Breadth of N is: 

 

NOTE : Row breadth is identical, except that d is defined using the row degree, 
rather than the column degree. 

 

Column Count 

 

Description 

The number of column nodes in a network. 

NOTE : This measure works on a Network and needs to be in the binary format 

[ 0 or 1 ]. 
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The result will be a integer between [ 0 and the total number of columns ], 
inclusive. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : Number of Columns 

Computational Time 

Fast 

Input and Output 

Input :  

DataType=binary. 

Output :  

Graph Level : DataType=integer. 

Result: Z > 0 

 

Column Degree Centrality 

 

Informal Name 

See In Degree Centrality 
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Column Degree Network Centralization 

 

Description 

A centralization based on the degree of the column nodes of a network. 

NOTE : This measure works on Any Matrix and can be any number. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

Also called InDegree Network Centralization 

Citation 

NetStat 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Fast 

Input and Output 

Input :  

DataType=real 

Output :  

Node Level : Type=columns and DataType=real. 

 

Let N be a network with n column entities. 
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let 

 

let 

 

Then 

 

 

Column Rendundancy 

 

Description 

The mean number of column node links in excess of one. 

NOTE : This measure works on Any Matrix and needs to be in the binary format 
[ 0 or 1 ]. 

 
The result will be a number between [ 0 and the number of redundant 
columns ], inclusive. 

Informal Name 

None 

Citation 

Carley, Kathleen M. 2002. Summary of Key Network Measures for Characterizing 
Organizational Architectures. Unpublished Document: CMU 2002. 

Minimum and Maximum Values 

Minimum Possible : 0 

file:///C:/myStuff/User's Guides/reports2/measureByReport.html


 

617 
 

Maximum Possible : ℜ ∈[0,(m-1)*n] 

Computational Time 

Fast 

Input and Output 

Input :  

DataType=binary. 

Output :  

Graph Level : DataType=real. 

 

Let M be the matrix representation for a network N of dimension m x n. 

let 

 

for 

 

this is the number of column entries in excess of one for column j. 

Then 

 

 

Communication 

 

Description 
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Measures the communication need of agents to complete their assigned tasks. 

NOTE : This measure works on the Agent x Agent, Agent x Task, Agent x 
Resource, Resource x Task, and Task x Task matrices and needs to be in the 

binary format [ 0 or 1 ]. 

Example :  

In a given organization Bob is assigned a task which is dependant upon his social 
links to other individuals in the network. The measure would compute a value for 

how dependent Bob is on the links to the other individuals to complete the task. A 
higher value would indicate Bob must possess a greater number of connections to 

complete any given task he is assigned. Conversely, a low value would indicate 
relatively few linkages are necessary to complete certain tasks. 

The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Manju K. Ahuja, Dennis F. Galletta and Kathleen M. Carley, 2003, "Individual 

Centrality and Performance in Virtual R&D Groups: An Empirical Study," 
Management Science, 49.1:21-38. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Input and Output 

Input :  

Agent by Agent : DataType=binary. 

Agent by Task : DataType=binary. 

Agent by Resource : DataType=binary. 
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Resource by Task : DataType=binary. 

Task by Task : DataType=binary. 

Output :  

Node Level : Type=agent and DataType=real. 

 

Communication uses the concepts from Communication Congruence: 
Handoff, Co-Assignment, and Negotiation. 

let H, C, and N be defined as in Communication Congruence. 

let M(i,j) = [AA + (H+H') + C + (N+N')](i,j) > 0, and M(i,i) = 0 

NOTE : The transpose of H and N is used to make the communication reciprocal. 

let d = sum(M(i,:)) 

let d = d / (|A|-1), normalizing d to be in [0,1] 

Then Communication for agent i is d. 

 

Communication Congruence 

 

Description 

Measures to what extent the agents communicate when and only when it is needful 
to complete tasks. Perfect congruence requires a symmetric Agent x Agent 

network. 

One of the following pairs of matrices must exist: Agent x Knowlage/Knowledge 
x Task -OR- Agent x Resource/Resource x Task. If both exist, then the 

measure first concatenates them into [Agent x Knowledge/Agent x Resource], 
[Knowledge x Task/Resource x Task] and uses them. 

Communication Congruence = 1 if agents communicate when and only when it is 

needful to complete their tasks. There are three task related reasons when agents i 
and j need to communicate: 
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(a) Handoff: if i is assigned to a task s and j is assigned to a task t and s 
directly precedes task t. 

(b) Co-Assignment: if i is assigned to a task s and j is also assigned to s. 

(c) Negotiation: if i is assigned to a task s and j is not, and there is a resource 
r to which agents assigned to s have no access but j does. 

The three cases are computed as follows: 

(a) let Handoff = Agent x Task * Task x Task * Agent x Task' 

(b) let Co-Assignment = Agent x Task * Agent x Task' 

(c) let Negogiation = Agent x Task * Z * Agent x Resource', where Z(t,r) = 

[Agent x Task * Agent x Resource - Resource x Task](t,r)<0 

NOTE : Co-Assignment is always symmetric, but Handoff and Negogiation are not 
necessarily symmetric. 

NOTE : This measure works on the Agent x Agent, Agent x Task, Agent x 

Resource, Resource x Task, and Task x Task matrices and needs to be in the 
binary format [ 0 or 1 ]. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. "Summary of Key Network Measures for Characterizing 

Organizational Architectures." Unpublished Document: CMU 2002 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

let Q(i,j) = [ (H+H') + C + (N+N')](i,j) > 0. 
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Communication Congruence requires reciprocal communication, explaining 
the transposes of H and N to make them symmetric. 

let d = hamming distance between Q and AA, which measures the degree to 

which communication differs from that which is needed to do tasks. 

The maximum value for d is d_max = |A|*(|A|-1) 

Then Communication Congruence = 1 - (d /d_max), which is in [0,1]. 

Input and Output 

Input :  

Agent by Agent : DataType=binary. 

Agent by Task : DataType=binary. 

Agent by Resource : DataType=binary. 

Resource by Task : DataType=binary. 

Task by Task : DataType=binary. 

Output :  

Graph Level : DataType=real. 

 

 

Communicative Need 

 

Description 

Measures the percentage of reciprocal links in a network. This is also called 

Reciprocity. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 
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Informal Name 

See Reciprocal Link Count for full description 

Citation 

Carley Kathleen M., 2002 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Input :  

Square matrix : DataType=binary 

Output :  

Graph Level : DataType=real. 

 

Complexity 

 

Description 

The density of the meta-network as a whole. 

NOTE : This measure works on Any Matrix and needs to be in the binary format 

[ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 
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Citation 

Wasserman, Stanley, & Faust, Katherine. (1994). Social Network Analysis: Methods 
and Applications: Cambridge University Press. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Fast 

Input and Output 

Input :  

DataType=binary. 

Output :  

Graph Level : DataType=real. 

 

Connectedness 

 

Description 

Measures the degree to which a square network's underlying (symmetrized) 

network is connected. Individuals or organizations that connect groups are those 
that are connecting disconnected groups. The individual or organization may be 

connected to only one or a few members of each groups. This is a composite 
measure that is high when the agent is potentially influential but is not in the know. 
This is calculated as the ration of betweenness centrality to total degree centrality 

and is calculated on agent by agent matrices. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 
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Informal Name 

None 

Citation 

Krackhardt, D. 1994. Graph Theoretical Dimensions of Informal Organizations. In 

Computational Organization Theory, edited by Carley, Kathleen M. and M.J. 
Prietula. Hillsdale, NJ: Lawrence Erlbaum Associates, 1994. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Input :  

Square matrix : DataType=binary. 

Output :  

Graph Level : DataType=real. 

 

Degree Centrality Spatial 

 

Description 

The total distance from a node to its neighbors 

NOTE : This measure works on the Agent x Agent and Agent x Location 
matrices and needs to be [ any number ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 
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None 

Citation 

Malloy, Eric, Olson, Jamie, & Carley, Kathleen M. (2009). Geographic and Network 

Analysis of Drug Interdiction Information. Paper presented at the Twenty Ninth 
International Sunbelt Social Network Conference, San Diego, CA. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Slow 

Input and Output 

Input :  

Agent by Agent : DataType=real. 

Agent by Location : DataType=real. 

Output :  

Node Level with Type=agent and DataType=real 

 

Density 

 

Description 

The ratio of the number of links versus the maximum possible links for a network. 

Density compares existing links to all possible links in the employee communication 
network. It reflects the social level of organizational cohesion. This measure must 

be interpreted in relation to the size of the group and the type of work performed. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and needs to be in the binary format [ 0 or 1 ]. 
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The result will be a number between [ 0 and 1 ], inclusive. 

NOTE : There can not be any self-loops in any of the matrices 

Informal Name 

None 

Citation 

Wasserman, Stanley and Katherine Faust. Social Network Analysis: Methods and 
Applications. Cambridge: Cambridge University Press, 1994. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Fast 

Input and Output 

Input :  

Unimodel matrix : DataType=binary. 

Output :  

Graph Level : DataType=real. 

 

Let M be the adjacency matrix for the network of dimension m x n. 

If the network is unimodal, then m=n and M has a zero diagonal, and 
therefore 

Density = sum(M)/(m*(m-1)). 

For rectangular networks 

Density = sum(M)/(m*n). 
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Density Classic SNA 

 

Description 

The ratio of the number of links versus the maximum possible links for a square 
network. Self-loops are ignored. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and needs to be in the binary format [ 0 or 1 ]. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Fast 

Input and Output 

Input :  

Square matrix : dataType=binary. 

Output :  

Graph Level : DataType=real. 

 

Let M be the adjacency matrix for the network of dimension m x n. 
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If the network is unimodal, then m=n and M has a zero diagonal, and 
therefore 

Density = sum(M)/(m*(m-1)). 

For rectangular networks, Density = sum(M)/(m*n). 

 

Diameter 

 

Description 

The maximum shortest path length between any two nodes in a unimodal network 
G=(V,E). If there exist i,j in V such that j is not reachable from i, then |V| is 

returned. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and needs to be in the binary format [ 0 or 1 ]. 
 

The result will be a number between [ 0 and Total Number of Nodes ], inclusive. 

Informal Name 

None 

Citation 

Wasserman, Stanley and Katherine Faust. Social Network Analysis: Methods and 
Applications. Cambridge: Cambridge University Press, 1994. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Input :  
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Square matrix : DataType=binary. 

Output :  

Graph Level : DataType=integer. 

 

The diameter of G=(V,E) is defined as: 

 

That is, the maximum shortest directed path between any two vertices in G. If 

there exists i and j such that j is not reachable from i, then |V| is returned. 

 

Diffusion 

 

Description 

Computes the degree to which something could be easily diffused (spread) 
throughout the network. This is based on the distance between nodes. A large 
diffusion value means that nodes are close to each other, and a smaller diffusion 

value means that nodes are farther apart. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Carley, Kathleen M. (2002). Smart agents and organizations of the future. In Leah 

Lievrouw, and Sonia Livingstone (Ed.), The Handbook of New Media (pp. Chapter 
12, 205-220). Thousand Oaks, CA: Sage. 

Minimum and Maximum Values 
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Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Slow 

Input and Output 

Input :  

Square matrix : DataType=binary. 

Output :  

Graph Level : DataType=real. 

Let N = number of nodes. 

Let K = number of pairs of nodes that are unreachable (note that G is not 
required to be symmetric. 

For each pair of unreachable nodes we record a distance of N, which is 

beyond the maximum distance for a binary network. 

Let TotalDistance =  

Let AverageDistance = TotalDistance / (N*(N-1)), which is the average 

distance between nodes 

Then Diffusion = N/(N-1) * [1 - AverageDistance/N], which is the average 
distance from 1 and normalized so that cliques get a score of 1 

 

Distinctive Correlation 

 

Description 

Measures the degree to which each pair of rows has complementary data, 

expressed as the percent of total data. 
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NOTE : This measure works on Any Matrix and needs to be in the binary format 
[ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Input and Output 

Input :  

DataType=binary. 

Output :  

Node Level : Type=row and DataType=real. 

Dyad Level : Row by Row and DataType=real. 

 

Edge Betweenness Centrality 

 

Description 

The Edge Betweenness Centrality of an edge e in a network is defined as: across all 

node pairs that have a shortest path containing e, the percentage that pass through 
e. 

NOTE : This measure works on the Agent x Resource matrices and needs to be in 

the binary format [ 0 or 1 ]. 
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The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Freeman, Linton C. (1979). Centrality in social networks I: Conceptual clarification. 
Social Networks, 1(3), 215-239. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Slow 

Input and Output 

Input :  

Agent by Resource : DataType=binary. 

Output :  

Graph Level : DataType=real. 

 

This is the Column Redundancy of matrix AR. 

 

Efficiency 

 

Description 
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The degree to which each component in a network contains the minimum links 
possible to keep it connected. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 

Location, etc] and needs to be in the binary format [ 0 or 1 ]. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Example 

In an organization, let us say Bob has a connection to the computer, Sales, Event, 
and Goal. This measure computes a value for the minimum number of links entities 

such as Bob must have for the network to maintain its network status. Therefore, 
this is a network level measure. In other words, if Bob had one less link, then then 
the entities would cease to constitute the original network. 

Informal Name 

None 

Citation 

Krackhardt, D. 1994. Graph Theoretical Dimensions of Informal Organizations. In 
Computational Organization Theory, edited by Carley, Kathleen M. and M.J. 

Prietula. Hillsdale, NJ: Lawrence Erlbaum Associates, 1994. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Fast 

Input :  

Square : DataType=binary and Directed=No. 

Output :  

Graph Level : DataType=real. 

 

Let G=(V,E) be the graph representation of a square, undirected network. 
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let 

 

let 

 

let 

 

let 

 

Then Efficiency = 1 - penalty/maxPenalty 

 

Eigenvector Centrality 

 

Description 

Calculates the principal eigenvector of the network. A node is central to the extent 

that its neighbors are central. Leaders of strong cliques are individuals or 
organizations who are connected to others that are themselves highly connected to 
each other. In other words, if you have a clique then the individual most connected 

to others in the clique and other cliques, is the leader of the clique. Individuals or 
organizations who are connected to many otherwise isolated individuals or 

organizations will have a much lower score in this measure then those that are 
connected to groups that have many connections themselves. This would be true 
even if such a WHO might have a high amount of actual connections (i.e. high 

degree centrality). 

It calculates the eigenvector of the largest positive eigenvalue of the adjacency 
matrix representation of a square network. A Jacobi method is used to compute the 

eigenvalues and vectors. 

Hub-Centrality and Authority-Centrality measures are generalizations of the 
Eigenvector Centrality measure and take into account directed links. 

file:///C:/myStuff/User's Guides/reports2/measureByReport.html


 

635 
 

NOTE : This measure works on the Agent x Agent matrix and can be in [ any 
number ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 

It follows that a person well-connected to well-connected people can spread 

information much more quickly than one who only has connections to lesser 
important people in a network. People with higher scores of Eigenvector Centrality 

could be critical when rapid communication is needed. 

Furthermore, individuals or organizations that are connected to man other 
otherwise isolated groups will have a much lower score in this measure than those 
that are connected to groups that have many connections themselves.  

Informal Name 

None 

Citation 

Bonacich, Phillip. (1972). Factoring and weighting approaches to status scores and 
clique detection. Journal of Mathematical Sociology, 2, 113-120. 

Bonacich, Phillip. (1972). Technique for Analyzing Overlapping Memberships. In H. 

Costner (Ed.), Sociological Methodology (pp. 176-185). San Francisco: Jossey-Bass. 

Minimum and Maximum Values 

Minimum : 0 

Maximum : 1 

Computational Time 

Medium 

Input :  

Agent by Agent Node Level : DataType=real and Directed=No. 

Output :  

Node Level and DataType=real. 
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Calculates the eigenvector of the largest positive eigenvalue of the adjacency 
matrix representation of a square network. A Jacobi method is used to 

compute the eigenvalues and vectors. 

  

 

Eigenvector Centrality Spatial 

 

Description 

The sum of the eigenvector centralities of all nodes located at a place. Intuitively, 
the likelihood of arriving at a node at a particular location in a random walk. 

NOTE : This measure works on the Agent x Resource, Agent x Agent and 

Agent x Location matrices and can be [ Any Number ]. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Malloy, Eric, Olson, Jamie, & Carley, Kathleen M. (2009). Geographic and Network 
Analysis of Drug Interdiction Information. Paper presented at the Twenty Ninth 

International Sunbelt Social Network Conference, San Diego, CA.  

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Slow 

Input and Output 

Input :  

Agent by Agent matrix : DataType=real. 
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Agent by Location matrix : DataType=real. 

Output :  

Node Level : Type=location and DataType=real 

  

 

Exclusivity 

 

Description 

Detects entities that have ties that comparatively few other entities have. 

Individuals or organizations that are high in complete exclusivity for knowledge are 
those that have expertise or are connected to types of knowledge that no one else 
has. The scientific name of this measure is complete exclusivity and it is calculated 

on agent by knowledge matrices. 

 Individuals or organizations that are high in complete exclusivity for location 
are those that have frequented locations that no one else has. 

 Individuals or organizations that are high in complete exclusivity for 
resources are those that have resources or are connected to types of 

resources that few others have. 

 Individuals or organizations that are high in complete exclusivity for tasks 

are those that are engaged in or assigned to tasks or activities for which no 
one else is engaged in or assigned to. 

NOTE : This measure works on Any Matrix and needs to be in the binary format 

[ 0 or 1 ]. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Ashworth, Michael J., & Louie, Marcus A. (2002). Alignment of the Garbage Can and 
NK Fitness Models: A Virtual Experiment in the Simulation of Organizations. 

Minimum and Maximum Values 
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Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Fast 

Input and Output 

Input :  

DataType=binary. 

Output :  

Node Level : Type=row and DataType=real. 

 

Exclusivity Complete 

 

Description 

Detects entities that have ties that no other entity has. Individuals or organizations 

that are high in complete exclusivity for events are those that attend or are 
supposed to attend an event that no one else does. The scientific name of this 
measure is complete exclusivity and it is calculated on agent by event matrices. 

NOTE : This measure works on Any Matrix and needs to be in the binary format 
[ 0 or 1 ]. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Example 

Individuals or organizations that are high in complete exclusivity for events are 
those that attend or are supposed to attend an event that no one else does.  

Informal Name 

None 

Citation 
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Ashworth, M. and Carley, K. (2006). Who you know vs. what you know: The impact 
of social position and knowledge on team performance. Journal of Mathematical 

Sociology, 30(1):43{75. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Fast 

Input and Output 

Input :  

DataType=binary. 

Output :  

Node Level : Type=row and DataType=real. 

 

This is a variation of the Exclusivity measure that weights the edges of an 

entity as follows: if no other entity has a connection to the entity, then its 
weight is one, otherwise it is zero. 

Thus, the Complete Exclusivity value for node i is: 

 

The value is then normalized by dividing by |K|. 

 

Expertise Correlation 

 

Description 
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Measures the degree to which each pair of rows has complementary data, 
expressed as a percentage of the data of the first row. 

NOTE : This measure works on Any Matrix and needs to be in the binary format 

[ 0 or 1 ]. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Carley, Kathleen, M., 2002 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Slow 

Input and Output 

Input :  

DataType=binary. 

Output :  

Node Level : Type=row and DataType=real. 

Dyad Level : Row by Row and DataType=real. 

 

Fragmentation 
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Description 

The proportion of nodes in a network that are disconnected. 

Example 

In a given organization 25 out of 400 sales agents are disconnected from the 

resources and knowledge that exists at the company headquarters because they 
travel more frequently and are thus disconnected from the rest of the network. The 
attribute of this disconnection expressed as a property of the entire organization is 

its computed disconnected measure.  

NOTE : This measure works on Any Matrix and needs to be in the binary format 
[ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Borgatti, S.P. 2003. The Key Player Problem. Dynamic Social Network Modeling and 

Analysis: Workshop Summary and Papers, R. 

Breiger, K. Carley, & P. Pattison (Eds.) Committee on Human Factors, National 
Research Council, 241-252. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Input :  

Square : DataType=binary and Directed=No. 

Output :  
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Graph Level : DataType=real. 

 

Consider a square, symmetric network G=(V,E). 

let 

 

let 

 

Then, 

 

 

Geodesic Distance 

 

Description 

Computes the length of the shortest path between all node pairs, where length is 

the number of links, ignoring link weights. If no path exists between two nodes, 
then a distance of zero is given. The distance from a node to itself is also zero. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 

Location, etc] and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number a between [ 0 and the number of columns - 1 ]. 

Informal Name 

None 

Citation 
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Wasserman, Stanley, & Faust, Katherine. (1994). Social Network Analysis: Methods 
and Applications: Cambridge University Press. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : Number of columns - 1 

Computational Time 

Medium 

Input and Output 

Input :  

Square matrix : DataType=binary. 

Output :  

Dyad Level : DataType=integer. 

 

Global Efficiency 

 

Description 

Global Efficiency is the normalized sum of the inverse geodesic distances between 
all entity pairs. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 

Location, etc] and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 

In an organization certain resources are closer to each other in terms of links. If 
both resources are located closer to each other than it would follow an organization 
where such resources tend to be more closely distributed across a network would 

be a more efficient network. 
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Informal Name 

None 

Citation 

Latria and Marchiori (2001), Efficient behavior of small-world networks. Physical 

Review Letters, volume 87, issue 19, The American Physical Society. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Slow 

Input and Output 

Input :  

Square matrix : DataType=binary. 

Output :  

Graph Level : DataType=real. 

 

Global Efficiency is the normalized sum of the inverse geodesic distances 
between all entity pairs. Let G be a square network on n entities. 

Then, 

 

 

Hierarchy 
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Description 

The degree to which a unimodal network exhibits a pure hierarchical structure. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 

Location, etc] and can be any number. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 

Let us say in an organization Sue is the president. Under Sue, we have 4 vice 
presidents, whom all in turn have 5 or 10 direct reports, who all have 2 or 3 
managers working for them. To such a degree that this architecture is present in 

the organzation is its computed Krackhardt Hierarchy value. 

Informal Name 

None 

Citation 

Krackhardt, D. 1994. Graph Theoretical Dimensions of Informal Organizations. In 
Computational Organization Theory, edited by Carley, Kathleen M. and M.J. 

Prietula. Hillsdale, NJ: Lawrence Erlbaum Associates, 1994. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Slow 

Input and Output 

Input :  

Square matrix : DataType=binary. 

Output :  

Graph Level : DataType=real. 
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Let N be a square network. The Hierarchy of N is the Reciprocity of the 
Reachability Network for N. 

 

Hub Centrality 

 

Description 

A node is hub-central to the extent that its out-links are to nodes that have many 
in-links. Individuals or organizations that act as hubs are sending information to a 

wide range of others each of whom has many others reporting to them. Technically, 
an agent is hub-central if its out-links are to agents that have many other agents 

sending links to them. The scientific name of this measure is hub centrality and it is 
calculated on agent by agent matrices. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 

Location, etc] and can be any number. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Kleinberg, Jon M. (1998). Decision algorithms for unsplittable flow and the half-
disjoint paths problem. Paper presented at the Thirtieth Annual ACM symposium on 
Theory of Computing, Dallas, TX. 

Kleinberg, Jon M. (1998). Authoritative sources in a hyperlinked environment. 
Paper presented at the SODA '98 Ninth Annual ACM-SIAM Symposium on Discrete 
Algorithms, San Francisco, CA. Latria and Marchiori, 2001 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 
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Input and Output 

Input :  

Square matrix : DataType=real. 

Output :  

Node Level : DataType=real. 

Let G be the adjacency matrix. 

Hub Centrality = eigenvectorCentrality(G*G') 

Authority Centrality = eigenvectorCentrality(G'*G) 

 

In Degree Centrality 

 

Description 

The In Degree Centrality of a node is its normalized in-degree. For any node, e.g. 

an individual or a resource, the in-links are the connections that the node of 
interest receives from other nodes. For example, imagine an agent by knowledge 
matrix then the number of in-links a piece of knowledge has is the number of 

agents that are connected to. The scientific name of this measure is in-degree and 
it is calculated on the agent by agent matrices. 

For any node, e.g. an individual or a resource, the in-links are the connections that 

the node of interest receives from other nodes. 

NOTE : This measure works on the Agent x Agent matrix and can be [ Any 
Number ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 

An agent by knowledge matrix with a number of in-links. A piece of knowledge has 
is the number of agents that are connected to. 

Informal Name 
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None 

Citation 

Wasserman, Stanley and Katherine Faust. "Social Network Analysis: Methods and 

Applications." Cambridge: Cambridge University Press, 1994. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Fast 

Input and Output 

Input :  

Agent by Agent : DataType=real. 

Output :  

Node Level : Type=column and DataType=real. 

 

Consider the matrix representation X of a network with m rows and n 
columns. Each column j is assigned an in-degree centrality based on the sum 

of entries in its column. 

The In-Degree Centrality for column j 

 

NOTE : This measure is also called Column Degree Centrality. 

 

In Degree Network Centralization 
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Description 

A centralization of a square network based on the In-Degree Centrality of each 

node. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and can be any number. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 

In a given organization, all employees have many incoming links to other 
employees. This is their In degree connections. This measure computes a value for 

the entire organization as a whole as to how central these connections are within 
the organization.  

Informal Name 

None 

Citation 

NetStat 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Fast 

Input and Output 

Input :  

Square matrix : DataType=real. 

Output :  

Graph Level : DataType=real. 
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Let N be a unimodal network with n entities. 

let 

 

let 

 

Then 

 

where D = (n-2) if N is undirected, and (n-1) otherwise. 

 

Information Centrality 

 

Description 

Information centrality is a network metric that accounts for indirect as well as 
shortest (geodesic) paths among entities. Information centrality is similar to 

betweenness, except that betweenness considers only shortest paths geodesics, 
whereas information centrality also considers more circuitous paths weighted by the 
inverse of the path length (the number of links along the path). 

Calculates the Stephenson and Zelen information centrality measure for each 
entity. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and can be any number. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
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Entities high in information centrality are more likely to get more information and to 
get information faster. 

Informal Name 

None 

Citation 

Wasserman, Stanley and Katherine Faust. "Social Network Analysis: Methods and 
Applications." Cambridge: Cambridge University Press, 1994. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Slow, with High Space requirements 

Input and Output 

Input :  

Square matrix : DataType=real and Directed=No. 

Output :  

Node Level : DataType=real. 

 

Calculates the measure described on pg 195-6 of Wasserman and Faust. 
Isolates (entities with no edges) are first removed from the network, and the 
measure computed on the resulting sub-graph. The isolates are given centrality 

value 0. 

 

Interdependence 

 

Description 
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The percentage of links in a unimodal network that are Pooled or Reciprocal. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 

A reciprocal link is one that is bidirectional. Let us say Bob has a link to Sue and 

Sue has a link back to Bob This is a reciprocal link. However, if Bob had a lot of 
links to Sue and others, which were not reciprocated, that is bidirectional, than Bob 

would be said to rank higher in radial links, which linked in one direction. The 
extent that a network exhibits these relationships is computed as the 
Interdependence and Radial value for the network.  

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for Characterizing 
Organizational Architectures. Unpublished Document: CMU 2002 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Fast 

Input and Output 

Input :  

Square matrix : DataType=binary. 

Output :  

Graph Level : DataType=real. 
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Let G=(V,E) be the graph representation of a square network. 

Let a = Pooled Edge Count and b = Reciprocal Link Count of the 
network. 

Then Interdependence = (a+b)/|E| 

 

Interlockers 

 

Description 

Interlocker are nodes that have a triad count (the number of triads each node is in) 

that is greater than the mean plus one standard deviation. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and needs to be in the binary format [ 0 or 1 ]. 
 

The result will be in the binary format [ 0 or 1 ]. 

Example 

A typical corporate board of directors is a good example of an interlocking 
architecture. Whereas a predominant amount of board members - perhaps close to 

70-percent - might serve on one board only, it is often common that the remaining 
30-percent may serve on 3 or more other boards. These directors that serve on the 

other boards constitute the interlocking agents that connect all these typical boards 
together. The Interlockers and radial measures compute a value for such 
relationships as they exist in the network at the entity, that is agent (e.g., "board 

member"), level. 

Informal Name 

None 

Citation 

Laumann, 1973 Edward O. Laumann, Bonds of Pluralism: The Form and Substance 

of Urban Social Networks, Wiley-Interscience, New York (1973). 

Minimum and Maximum Values 

Minimum Possible : 0 
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Maximum Possible : 1 

Computational Time 

Fast 

Input and Output 

Input :  

Square matrix : DataType=binary. 

Output :  

Node Level : DataType=binary. 

Let N=(V,E) be a square network. 

Let 

= Triad Count for node i,  

Let 

= the mean of  

Let 

= the variance of  

Then, 

if , then agent k is an interlocker. 

If , then agent k is a radial. 

 

Inverse Closeness Centrality 
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Description 

The average closeness of a node to the other nodes in a network. Inverse 
Closeness is the sum of the inverse distances between a node and all other nodes. 

Nodes high in closeness centrality are more likely to communicate faster and 
operate more efficiently. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 

Location, etc] and can be any number. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Wasserman, Stanley and Katherine Faust. Social Network Analysis: Methods and 
Applications. Cambridge: Cambridge University Press, 1994. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Slow 

input and Output 

Input :  

Square matrix : DataType=real. 

Output :  

Node Level : DataType=real. 

 

Let G=(V,E) be the graph representation of the square network. 

For  
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let 

 

if i is not reachable from v. 

Then, Inverse Closeness Centrality of entity v = dist/(|V|-1). 

 

Isolate Count 

 

Description 

The number of isolate nodes in a unimodel network. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and needs to be in the binary format [ 0 or 1 ]. 
 

The result will be [ the total number of isolates ]. 

Informal Name 

None 

Citation 

Carley, Kathleen, M., 2002 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : Number of nodes in the network 

Computational Time 

Fast 

Input and Output 
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Input :  

Square matrix : DataType=binary. 

Output :  

Graph Level : DataType=integer. 

 

Let N=(V,E) be a square network. 

An isolate is a node v in V such that no edges are incident upon it. The 
number of such nodes is returned. 

  

 

Knowledge Actual Workload 

 

Description 

The knowledge an agent uses to perform the tasks to which it is assigned. 

NOTE : This measure works on the Agent x Knowledge, Knowledge x Task, 
and Agent x Task matrices and needs to be in the binary format [ 0 or 1 ]. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. "Summary of Key Network Measures for Characterizing 
Organizational Architectures." Unpublished Document: CMU 2002 

Minimum and Maximum Values 

Minimum Possible : 0 
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Maximum Possible : 1 

Computational Time 

Medium 

input and Output 

Input :  

Agent by Knowledge : DataType=binary 

Knowledge by Task : DataType=binary 

Agent by Task : DataType=binary 

Output :  

Node Level : Type=agent and DataType=real. 

 

Knowledge Based Access Index 

 

Description 

Boolean value which is true if an agent is the only agent who knows a piece of 

knowledge and who is known by exactly one other agent. The one agent known 
also has its KAI set to one. 

An node level measure that computes the average shortest path length between 

entities, excluding infinite distances. This is known as the Knowledge Access Index 
(KAI) value. 

NOTE : This measure works on the Agent x Agent and Agent x Knowledge 
matrices and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a binary number [ 0 or 1 ]. 

Example 

Let us imagine a social network where 50 employees have many connections to 

each other. The average number of connections per employee is the Access Index.  
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Informal Name 

None 

Citation 

Ashworth, M. and Carley, Kathleen M., 2003, "Critical Human Capital", Working 

Paper, CASOS, Carnegie Mellon, Pittsburgh PA. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Fast 

\ 

input and Output 

Input :  

Agent by Agent : DataType=binary 

Agent by Knowledge : DataType=binary 

Output :  

NodeLevel : Type=agent and DataType=binary. 

The Knowledge Access Index (KAI) for agent i is defined as follows: 

let 

 

Then 
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Knowledge Task Completion 

 

Description 

The percentage of tasks that can be completed by the agents assigned to them, 
based solely on whether the agents have the requisite knowledge to do the tasks. 

NOTE : This measure works on the Agent x Knowledge, Agent x Task, and 
Knowledge x Task matrices and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 

Bob is assigned 10 Tasks to complete which require a certain amount of knowledge 

to finish. However, on average only 10-percent of this knowledge will be available 
to Bob for him to complete the tasks given. This measure would compute a value 

for the likelyhood that Bob would be able to complete any given task. 

NOTE : Task Completion Overall is a combination of the Task Completion 
Knowledge and the Task Completion Resource. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for Characterizing 

Organizational Architectures. Unpublished Document: CMU 2002 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

input and Output 
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Input :  

Agent by Knowledge : DataType=binary. 

Agent by Task : DataType=binary. 

Knowledge by Task : DataType=binary. 

Output :  

Graph Level : DataType=real 

 

Find the tasks that cannot be completed because the agents assigned to the 

tasks lack necessary knowledge. 

let 

 

let 

 

Knowledge Based Task Completion is the percentage of tasks that could be 
completed = (|T|-|S|) / |T| 

Resource Based Task Completion is analogous, replacing AK with AR and 
KT with RT. 

 

Knowledge Diversity 

 

Description 

The distribution of difference in idea sharing. This is the Herfindahl-Hirshman index 
applied to column sums of AK. 

NOTE : This measure works on the Agent x Knowledge matrix and needs to be in 
the binary format [ 0 or 1 ]. 
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The result will be a number between [ 0 and 1 ], inclusive. 

Example 

Characterizes the network in terms of how the items in a knowledge network (who 
knows what) are non-uniformly distributed across employees 

Informal Name 

None 

Citation 

Hirschman A. O., 1945. National Power and the Structure of Foreign Trade. 

Berkeley: University of California Press. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Fast 

Input :  

input and Output 

Agent by Knowledge : DataType=binary. 

Output :  

Graph Level : DataType=real 

 

This is the Herfindahl-Hirshman index (economics: sum of the squares of 

each firm's market share) applied to the normalized column sums of AK. This 
measures the degree to which knowledge is equally known. 

let 
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let 

 

Then 

 

 

Knowledge Exclusivity 

 

Description 

Detects agents who have singular knowledge. 

Example 

A key piece of knowledge that supports an entire organization is only accessible 
through one person. 

NOTE : This measure works on the Agent x Knowledge matrix and needs to be in 

the binary format [ 0 or 1 ]. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 
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Ashworth, M. and Carley, K. (2006). Who you know vs. what you know: The impact 
of social position and knowledge on team performance. Journal of Mathematical 

Sociology, 30(1):43{75. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Fast 

input and Output 

Input :  

Agent by Knowledge : DataType=binary. 

Output :  

Node Level : DataType=real and Type=agent. 

 

The Knowledge Exclusivity Index (KEI) for agent i is defined as follows: 

 

The Knowledge Exclusivity Index (KEI) for agent i is defined exactly as 
for Knowledge Based Exclusivity. 

 

Knowledge Load 

 

Description 

Average number of knowledge per agent. 
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NOTE : This measure works on the Agent x Knowledge matrices and needs to be 
in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. "Summary of Key Network Measures for Characterizing 
Organizational Architectures." Unpublished Document: CMU 2002. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Fast 

input and Output 

Input :  

Agent by Knowledge : DataType=binary 

Output :  

Graph Level : DataType=real. 

 

Knowledge Load = sum(AK)/ (|A|) 

Resource Load is defined analogously, replacing AK with AR. 

 

Knowledge Negotiation 
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Description 

The extent to which agents need to negotiate with each other because they lack the 
knowledge to complete their assigned tasks. 

NOTE : This measure works on the Agent x Task, Agent x Knowledge, and 
Knowledge x Task matrices and needs to be in the binary format [ 0 or 1 ]. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Example 

In a given organization, Bob does not have knowledge needed to complete a certain 
task but Sue does have it. Bob must negotiate with Sue to gain that knowledge to 

complete the task. The extent to which others in the organization must negotiate 
for knowledge that others have is the organization's knowledge negotiation value. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. "Summary of Key Network Measures for Characterizing 

Organizational Architectures." Unpublished Document: CMU 2002 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

input and Output 

Input :  

Agent by Task : DataType=binary. 

Agent by Knowledge : DataType=binary. 

Knowledge by Task : DataType=binary. 

Output :  
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Graph Level : DataType=real. 

 

Compute the percentage of tasks that lack at least one knowledge (or 
Resource): 

let 

 

for Resource replace AK with AR and KT with RT 

let 

 

Then Knowledge (or Resource) Negotiation = |S| / |T| 

 

Knowledge Omega 

 

Description 

The degree to which agents reuse knowledge while doing their tasks. 

NOTE : This measure works on the Agent x Task, Knowledge x Task, and Task 

x Task matrices and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 

Sue has X amount of tasks within her company. How many of those tasks that 
require a knowledge that can be used for one or more of her other tasks is omega 
knowledge. This measure computes a value for such relations to knowledge sets at 

the network level.  

Informal Name 

None 
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Citation 

Carley, K, Dekker, D., Krackhardt, D (2000). How Do Social Networks Affect 
Organizational Knowledge Utilitization.  

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Input :  

Agent by Task : DataType=binary. 

Knowledge by Task : DataType=binary. 

Task by Task : DataType=binary. 

Output :  

Graph Level : DataType=real. 

 

Let TAT = TA*TA' 

Let N = ((T'@TAT)*KT')@KT' 

for resource replace KT with RT 

Then Knowledge Based Omega = sum(N)/sum(KT) 

for resource replace KT with RT 

 

Knowledge Potential Workload 
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Description 

Maximum knowledge an agent could use to do tasks if it were assigned to all tasks. 

NOTE : This measure works on the Agent x Knowledge and Knowledge x Task 

matrices and needs to be in the binary format [ 0 or 1 ]. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Example 

In a given organization, let us say Bob is assigned all task that exist in the 
organization. This measure would compute a value expressing Bob's potential to 
carry out all the tasks based on his connections to the resources and knowledge 

needed for the tasks.  

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for Characterizing 

Organizational Architectures. Unpublished Document: CMU 2002. 

Minimum and Maximum Values 

Minimum Possible: 0 

Maximum Possible : 1 

Computational Time 

Medium 

input and Output 

Input :  

Agent by Knowledge : DataType=binary. 

Knowledge by Task : DataType=binary. 

Output :  
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Node Level : Type=agent and DataType=real. 

 

Potential Knowledge Workload for agent i = sum((AK*KT)(i,:))/sum(KT) 

for Resource replace AK with AR and KT with RT 

  

 

Knowledge Rendundancy 

 

Description 

Average number of redundant agents per knowledge. An agent is redundant if there 
is already an agent that has the knowledge. 

NOTE : This measure works on the Agent x Knowledge matrix and needs to be in 

the binary format [ 0 or 1 ]. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. "Summary of Key Network Measures for Characterizing 
Organizational Architectures." Unpublished Document: CMU 2002. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : ℜ ∈ [0,(|A|-1)*|K|] 

Computational Time 

Fast 

input and Output 
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Input :  

Agent by Knowledge : DataType=binary. 

Output :  

Graph Level : DataType=real. 

 

This is the Column Redundancy of matrix AK. 

 

Knowledge Under Supply 

 

Description 

The extent to which the knowledge needed to do tasks are unavailable in the entire 
organization. 

NOTE : This measure works on the Agent x Task, Agent x Knowledge, and 

Knowledge x Task matrices and needs to be in the binary format [ 0 or 1 ]. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for Characterizing 
Organizational Architectures. Unpublished Document: CMU 2002 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
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Medium 

input and Output 

Input :  

Agent by Task : DataType=binary. 

Agent by Knowledge : DataType=binary. 

Knowledge by Task : DataType=binary. 

Output :  

Graph Level : DataType=real 

 

This is the number of required knowledge not available to tasks based on the 

current agent task assignments normalized by the number of tasks. 

Knowledge Under Supply = sum(dich( KT - AK'*KT)) / |T| 

Under Resource Supply is analogous, replacing AK with AR, and KT with 
RT. 

  

 

Lateral Link Count 

 

Description 

The percentage of lateral links in a unimodal network. Fixing a root node x, a lateral 

link (i,j) is one in which the distance from x to i is the same as the distance from x 
to j. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 

Location, etc] and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
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Fixing a root entity x, a lateral edge (i,j) is one in which the distance from x to i is 
the same as the distance from x to j. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for Characterizing 
Organizational Architectures. Unpublished Document: CMU 2002. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible: 1 

Computational Time 

Fast 

input and Output 

Input :  

Square matrix : DataType=binary. 

Output :  

Graph Level : DataType=real 

 

Let G=(V,E) be the graph representation of a network. And fix an node x∈V to 
be the root node. 

Let 

 

Then Lateral Edge Count = |S| / |E| 
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Link Count 

 

Description 

The number of links in the network. 

NOTE : This measure works on Any Matrix and needs to be in the binary format 
[ 0 or 1 ]. 
 

The result will be a number between [ 0 and the total number of links in the 
network ]. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : Number of links in the network 

Computational Time 

Fast 

Input and Output 

Input :  

DataType=binary. 

Output :  

Graph Level : DataType=integer. 
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Local Efficiency 

 

Description 

Normalized sum of the Global Efficiency of each node's ego network (here, the ego 
network for entity i does not include entity i). 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 

In an organization, Bob has a connection to the computers, Sales Data, Events, 

Goals. This measure computes a value for the minimum number of links to entities 
such as Bob must have for the network to maintain its network status. Therefore, 

this is a network level measure. If Bob had one less link, then then the entities 
would cease to constitute the original network. 

Informal Name 

None 

Citation 

Latria and Marchiori (2001), Efficient behavior of small-world networks. Physical 

Review Letters, volume 87, issue 19, The American Physical Society. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Slow 

Input and Output 

Input :  
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Square matrix : DataType=binary. 

Output :  

Graph Type : DataType=real. 

 

Local Efficiency is the normalized sum of the inverse closeness of the ego 
networks (here, the ego network for entity i does not include entity i). 

Let G = (V,E) be any square, symmetric network with |V| = N entities. 

let 

 

let 

 

to 

 

define 

 

Then, 

 

 

Location Relevance 

 

Description 
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The extent to which location influences a particular persons connections. 

NOTE : This measure works on the Agent x Agent, and Agent x Location 
matrices and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Malloy, Eric, Olson, Jamie, & Carley, Kathleen M. (2009). Geographic and Network 
Analysis of Drug Interdiction Information. Paper presented at the Twenty Ninth 
International Sunbelt Social Network Conference, San Diego, CA. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Slow 

Input and Output 

Input :  

Agent by Agent : DataType=real. 

Agent by Location : DataType=real. 

Output :  

Node Level : Type=location and DataType=real. 

 

Minimum Speed 

 

Description 
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The maximum shortest path length between node pairs (i,j) where there is a path 
in the network from i to j. If there are no such pairs, then Minimum Speed is zero. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 

Location, etc] and can be any number. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Example 

In an organization, we have Bob and Sue with numerous paths between them. The 
shortest path between this entity pair would be Bob and Sues (Bob/Sue) minimum 

speed. One might also say that if there were numerous links between Bob and Sue 
and that the average linkage was in the neighborhood of 5 paths (e.g., links) when 
every person in the organization is taken as a whole, the shortest linkage between 

them would be the minimum speed at which Bob and Sue might communicative. If 
Bob and Sue had direct links, minimum speed would be 0.  

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for Characterizing 
Organizational Architectures. Unpublished Document: CMU 2002. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

NOTE : Minimum Speed = 1 / (Levels for the Network) 

Computational Time 

Medium 

Input and Output 

Input :  

Square matrix : DataType=real. 

Output :  
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Graph Level : DataType=real. 

 

Minimum Speed = 1 / (Levels for the Network) 

 

Network Levels 

 

Description 

The Network Level of a square network is the maximum Node Level of its nodes. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 

Location, etc] and can be any number. 
 

The result will be a number between [ 0 and the number of node levels - 1 ]. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : Z∈[0,|V|-1] 

Computational Time 

Medium 

Input and Output 

Input :  

Square matrix : DataType=real. 
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Output :  

Graph Level : DataType=integer. 

 

Let G=(V,E) be the graph representation of a square network and fix an 
entity v. 

Then 

 

 

Node Count 

 

Description 

The number of nodes in a unimodal network. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and the number of nodes in the 

Network ]. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : Number of nodes in the network 

Computational Time 
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Fast 

Input and Output 

Input :  

Square matrix : DataType=binary. 

Output :  

Graph Level : DataType=integer. 

 

Node Levels 

 

Description 

The Node Level for a node v in a square network is the longest shortest path from v 
to every node v can reach. If v cannot reach any node, then its level is 0. 

The Network Level of a square network is the maximum Node Level of its nodes. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and can be any number. 
 

The result will be a number between [ 0 and the number of nodes - 1 ]. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : Number of nodes in the network - 1 

Computational Time 
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Medium 

Input and Output 

Input :  

Square matrix : DataType=real. 

Output :  

Graph Level : DataType=integer. 

 

Let G=(V,E) be the graph representation of a square network and fix a 

node v. 

Node Level : DataType=integer 

 

If v cannot reach any nodes, then its level is 0. 

 

Organization Agent Knowledge Needs 
Congruence 

 

Description 

Across all agents, the knowledge that agents lack to do their assigned tasks 

expressed as a percentage of the total knowledge needed by all agents. 

NOTE : This measure works on the Agent x Knowledge, Agent x Task, and 
Knowledge x Task matrices and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 
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Lee, Ju-Sung, & Carley, Kathleen M. (2004). OrgAhead: A Computational Model of 
Organizational Learning and Decision Making. Pittsburgh, PA: Carnegie Mellon 

University, School of Computer Science, Institute for Software Research 
International, Technical Report, CMU-ISRI-04-117. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Input :  

Agent by Knowledge matrix : DataType=binary. 

Agent by Task matrix : DataType=binary. 

Knowledge by Task matrix : DataType=binary. 

Output :  

Graph Level : DataType=real. 

 

As in Agent Needs, let N = AT*KT' 

Then 

 

 

Organization Agent Knowledge Waste 
Congruence 



 

684 
 

 

Description 

Across all agents, the knowledge that agents have that are not required to do their 

assigned tasks. 

NOTE : This measure works on the Agent x Knowledge, Agent x Task, and 
Knowledge x Task matrices and needs to be in the binary format [ 0 or 1 ]. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Lee, Ju-Sung, & Carley, Kathleen M. (2004). OrgAhead: A Computational Model of 

Organizational Learning and Decision Making. Pittsburgh, PA: Carnegie Mellon 
University, School of Computer Science, Institute for Software Research 
International, Technical Report, CMU-ISRI-04-117.  

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium  

Input :  

Input and Output 

Agent by Knowledge matrix with DataType=binary. 

Agent by Task matrix with DataType=binary. 

Knowledge by Task matrix with DataType=binary. 

Output : Graph Level with DataType=real. 
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As in Agent Waste, let N = AT*KT' 

Then 

 

 

Organization Agent Resource Needs 
Congruence 

 

Description 

Across all agents, the resource that agents lack to do their assigned tasks 
expressed as a percentage of the total resources needed by all agents. 

NOTE : This measure works on the Agent x Resource, Agent x Task, and 
Resource x Task matrices and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Lee, Ju-Sung, & Carley, Kathleen M. (2004). OrgAhead: A Computational Model of 
Organizational Learning and Decision Making. Pittsburgh, PA: Carnegie Mellon 
University, School of Computer Science, Institute for Software Research 

International, Technical Report, CMU-ISRI-04-117.  

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
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Medium 

Input and Output 

Input :  

Agent by Resource : DataType=binary. 

Agent by Task : DataType=binary. 

Resource by Task : DataType=binary. 

Output :  

Graph Level : DataType=real. 

 

As in Agent Needs, let N = AT*RT' 

Then 

 

 

Organization Agent Resource Waste 
Congruence 

 

Description 

Across all agents, the resources that agents have that are not required to do their 

assigned tasks. 

NOTE : This measure works on the Agent x Resource, Agent x Task, and 
Resource x Task matrices and needs to be in the binary format [ 0 or 1 ]. 
 

The result will be a number between [ 0 and 1 ], inclusive. 
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Informal Name 

None 

Citation 

Lee, Ju-Sung, & Carley, Kathleen M. (2004). OrgAhead: A Computational Model of 

Organizational Learning and Decision Making. Pittsburgh, PA: Carnegie Mellon 
University, School of Computer Science, Institute for Software Research 
International, Technical Report, CMU-ISRI-04-117.  

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Input :  

Agent by Resource : DataType=binary. 

Agent by Task : DataType=binary. 

Resource by Task : DataType=binary. 

Output :  

Graph Level : DataType=real. 

 

As in Agent Waste, let N = AT*RT' 

Then 
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Organization Task Knowledge Needs 

Congruence 

 

Description 

Across all tasks, the knowledge that tasks lack expressed as a percentage of the 
total knowledge needed by all tasks. 

NOTE : This measure works on the Agent x Knowledge, Agent x Task, and 
Knowledge x Task matrices and needs to be in the binary format [ 0 or 1 ]. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Lee, Ju-Sung, & Carley, Kathleen M. (2004). OrgAhead: A Computational Model of 
Organizational Learning and Decision Making. Pittsburgh, PA: Carnegie Mellon 

University, School of Computer Science, Institute for Software Research 
International, Technical Report, CMU-ISRI-04-117.  

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Example : An organization needs many skills to meet it's organizational 
objectives. However, not all of the skills are present within the organizational 

network. This measure computes a value for this lack of skills as it is distributed 
across the organization as a whole.  

Input :  
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Agent by Knowledge : DataType=binary. 

Agent by Task : DataType=binary. 

Knowledge by Task : DataType=binary. 

Output :  

Graph Level : dataType=real 

 

As in Task Needs, let S = AT'*AK 

Then 

 

 

Organization Task Knowledge Waste 
Congruence 

 

Description 

Across all agents, the knowledge that agents have that are not required to do their 
assigned tasks. 

NOTE : This measure works on the Agent x Knowledge, Agent x Task, and 

Knowledge x Task matrices and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 
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Lee, Ju-Sung, & Carley, Kathleen M. (2004). OrgAhead: A Computational Model of 
Organizational Learning and Decision Making. Pittsburgh, PA: Carnegie Mellon 

University, School of Computer Science, Institute for Software Research 
International, Technical Report, CMU-ISRI-04-117.  

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Input :  

Agent by Knowledge : DataType=binary. 

Agent by Task : DataType=binary. 

Knowledge by Task : DataType=binary. 

Output :  

Graph Level : dataType=real 

 

As in Task Waste, let S = AT'*AK 

Then 

 

 

Organization Task Resource Needs 
Congruence 
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Description 

Across all tasks, the resources that tasks lack expressed as a percentage of the 

total resource needed by all tasks. 

NOTE : This measure works on the Agent x Resource, Agent x Task, and 
Resource x Task matrices and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 

An organization needs many resources to meet it's organizational objectives. 
However, not all of the resources are present within the organizational network. 

This measure computes a value for this lack of resources as it is distributed across 
the organization as a whole.  

Informal Name 

None 

Citation 

Lee, Ju-Sung, & Carley, Kathleen M. (2004). OrgAhead: A Computational Model of 
Organizational Learning and Decision Making. Pittsburgh, PA: Carnegie Mellon 
University, School of Computer Science, Institute for Software Research 

International, Technical Report, CMU-ISRI-04-117.  

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

MediumFast 

Input and Output 

Input :  

Agent by Resource : DataType=binary. 

Agent by Task : DataType=binary. 
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Resource by Task : DataType=binary. 

Output :  

Graph Level : dataType=real 

 

As in Task Needs, let S = AT'*AR 

Then 

 

 

Organization Task Resource Waste 
Congruence 

 

Description 

Across all agents, the resources that agents have that are not required to do their 

assigned tasks. 

NOTE : This measure works on the Agent x Resource, Agent x Task, and 
Resource x Task matrices and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Lee, Ju-Sung, & Carley, Kathleen M. (2004). OrgAhead: A Computational Model of 

Organizational Learning and Decision Making. Pittsburgh, PA: Carnegie Mellon 
University, School of Computer Science, Institute for Software Research 

International, Technical Report, CMU-ISRI-04-117.  
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Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Input :  

Agent by Resource : DataType=binary. 

Agent by Task : DataType=binary. 

Resource by Task : DataType=binary. 

Output :  

Graph Level : dataType=real 

 

As in Task Waste, let S = AT'*AR 

Then 

 

 

Organizational Availability 

 

Description 
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An organization is available to do a task if it has the required agents and the 
required resources.Computes the degree to which organizations are available to do 

tasks based on their access to resources and roles that are needed to do the tasks. 

NOTE : This measure works on the Agent x Organization, Agent x Task, 
Organization x Resource, and Resource x Task matrices and needs to be in the 

binary format [ 0 or 1 ]. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

  

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Slow 

Input and Output 

Input :  

Agent by Organization : DataType=binary. 

Agent by Task : DataType=binary. 

Organization by Resource : DataType=binary. 

Resource by Task : DataType=binary. 

Output :  

Node Level : DataType=real. 
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Out Degree Centrality 

 

Description 

For any node, (e.g. an individual or a resource), the out-links are the connections 
that the node of interest sends to other nodes. For example, imagine an agent by 
knowledge matrix then the number of out-links an agent would have is the number 

of pieces of knowledge it is connected to. 

The scientific name of this measure is out-degree and it is calculated on the agent 
by agent matrices. Individuals or organizations who are high in most knowledge 

have more expertise or are associated with more types of knowledge than are 
others. If no sub-network connecting agents to knowledge exists, then this 
measure will not be calculated. The scientific name of this measure is out degree 

centrality and it is calculated on agent by knowledge matrices. Individuals or 
organizations who are high in "most resources" have more resources or are 

associated with more types of resources than are others. If no sub-network 
connecting agents to resources exists, then this measure will not be calculated. The 

scientific name of this measure is out degree centrality and it is calculated on agent 
by resource matrices. 

NOTE : This measure works on the Agent x Agent matrix and needs to be in the 
binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Wasserman, Stanley and Katherine Faust. "Social Network Analysis: Methods and 

Applications." Cambridge: Cambridge University Press, 1994. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
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Fast 

Input and Output 

Input :  

Agent by Agent : DataType=real. 

Output :  

Node Level : DataType=real and Type=row. 

  (If N is binary) 

Consider the matrix representation X of a network with m rows and n 

columns. Each row i is assigned an out-degree centrality based on the sum of 
entries in its row. 

The Out-Degree Centrality 

 

NOTE : This measure is also called Row Degree Centrality. 

 

Out Degree Network Centralization 

 

Description 

A centralization of a square network based on the Out-Degree Centrality of each 
node. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 

Location, etc] and can be any number. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 
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In a given organization, all employees have so many links to other employees. This 
is their out degree connections. This measure computes a value for the entire 

organization as a whole as to how central these connections are within the 
organization.  

Informal Name 

None 

Citation 

NetStat 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Fast 

Input and Output 

Input :  

Square matrix : DataType=real. 

Output :  

Graph Level : DataType=real. 

 

Let N be a unimodal network with n nodes. 

let 

 

let 
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Then 

, 

where D = (n-2) if N is undirected, and (n-1) otherwise. 

 

Overall Role Based Availability 

 

Description 

Computes the degree to which agents are available to do tasks based on their 
access to knowledge and resources and roles that are needed to do the tasks. 

NOTE : This measure works on the Agent x Knowledge, Agent x Resource, 

Knowledge x Role, Resource x Role, and Task x Role matrices and needs to be 
in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

  

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Slow 

Input and Output 
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Input :  

Agent by Knowledge; DataType=binary. 

Agent by Resource; DataType=binary. 

Knowledge by Role; DataType=binary. 

Resource by Role; DataType=binary. 

Task by Role; DataType=binary. 

Output :  

Agent Node Level with DataType=real. 

 

Overall Task Completion 

 

Description 

The percentage of tasks that can be completed by the agents assigned to them, 

based solely on whether the agents have the requisite knowledge and resources to 
do the tasks. 

NOTE : Task Completion Overall is a combination of the Task Completion 

Knowledge and the Task Completion Resource. 

NOTE : This measure works on the Agent x Knowledge, Agent x Resource, 
Agent x Task, Knowledge x Task, and Resource x Task matrices and needs to 

be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for Characterizing 
Organizational Architectures. Unpublished Document: CMU 2002 
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Minimum and Maximum Values 

Minimum Possible: 0 

Maximum Possible: 1 

Computational Time 

Medium 

Input and Output 

Input :  

Agent by Knowledge : DataType=binary. 

Agent by Resource : DataType=binary. 

Agent by Task : DataType=binary. 

Knowledge by Task : DataType=binary. 

Resource by Task : DataType=binary. 

Output :  

Graph Level : DataType=real 

  

 

Performance as Accuracy 

 

Description 

Measures how accurately agents can perform their assigned tasks based on their 

access to knowledge and resources. 

NOTE : This measure works on the Agent x Knowledge, Agent x Task, Agent x 
Resource, Knowledge x Task, and Resource x Task matrices and needs to be 

in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 
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Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for Characterizing 

Organizational Architectures. Unpublished Document: CMU 2002 

Minimum and Maximum Values 

Minimum Possible: 0 

Maximum Possible: 1 

Computational Time 

Medium 

Input and Output 

Input :  

Agent by Knowledge DataType=binary. 

Agent by Task DataType=binary. 

Agent by Resource DataType=binary. 

Knowledge by Task DataType=binary. 

Resource by Task DataType=binary. 

Output :  

Graph Level : DataType=real 

 

One of the following pairs of matrices must exist: AK/KT, AR/RT. If both 

exist, then the measure first concatenates them into [AK AR], [KT RT] and 
uses them. 

Accuracy is computed based on the binary classification problem. It is 

computed in one of two ways: 



 

702 
 

(1) Knowledge based: Let b be a binary string of length |K|, let N=KT', 
and let S=AK. Fix a task t. 

let 

 

which is the correct classification of b with respect to task t. 

Now, let I={ i | AT(i,t)=1}. 

let 

 

This is agent i's classification of b with respect to t. 

The group of agents classify b using majority voting. 

That is, 

 

Then, if group_answer = answer, then the group was accurate, otherwise 
not. 

This is repeated multiple times for each task, and across all tasks. The 

percentage correct is Performance as Accuracy. 

(2) Resource based: let N=RT' and S=AR in the analysis of case (1). 

 

Personnel Cost 

 

Description 
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Total number of people reporting to an agent, plus its total knowledge, resources, 
and tasks. 

Personnel Cost is the sum of the in-degree centrality of all AA matrices in the graph 

(this computes the number of agents reporting to each agent), plus the out-degree 
centrality of any AK, AR, and AT graphs. 

NOTE : This measure works on the Agent x Agent, Agent Knowledge, Agent x 

Resource, and Agent x Task matrices and needs to be in the binary format [ 0 or 
1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 

In a given organization, five employees report to Sue. All of the knowledge, 

resource and tasks connections attributed all the employees and Sue constitute 
Personnel Cost. This measure then computes a value for Sue based on all these 
connections of her employees. 

Informal Name 

None 

Citation 

Ashworth, M. and Carley, Kathleen, M., 2003, "Critical Human Capital, Working 
Paper, CASOS" Carnegie Mellon, Pittsburgh PA. 

Minimum and Maximum Values 

Minimum Possible: 0 

Maximum Possible: 1 

Computational Time 

Fast 

Input and Output 

Input :  

Agent by Agent : DataType=binary. 

Agent by Knowledge : DataType=binary. 
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Agent by Resource : DataType=binary. 

Agent by Task : DataType=binary. 

Output :  

Node Level : Type=agent and DataType=real. 

 

Personnel Cost is the sum of the in-degree centrality of all AA matrices in the 
graph (this computes the number of agents reporting to each agent), plus 

the out-degree centrality of any AK, AR, and AT graphs. 

This sum is scaled so that each entity gets a score in [0,1]. 

 

Pooled Link Count 

 

Description 

The percentage of pooled links in a unimodal network. A pooled is an link (i,j) such 
that there exists at least one other link (i,k) in the network, and k <> j. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 

Location, etc] and needs to be in the binary format [ 0 or 1 ]. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Example 

A pooled link in a network N=(V,E) is an link (i,j)∈ E such that there exists at least 

one other link (i,k) ∈ E, and k ≠ j. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for Characterizing 
Organizational Architectures. Unpublished Document: CMU 2002 
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Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Fast 

Input and Output 

Input :  

Square matrix : DataType=binary. 

Output :  

Graph Level : DataType=real. 

 

Let M be the adjacency matrix representation of a unimodal network. 

Let S = { (i,j) | M(i,j)=1 ∧ sum(M(:,j))>1 } 

In other words: edge (i,j) is a pooled link iff the in-degree of 
entity j > 1. 

Then Pooled Link Count = |S| / |E| 

 

Potential Boundary Spanner 

 

Description 

Individuals or organizations that connect groups are those that are connecting 

disconnected groups. The individual or organization may be connected to only one 
or a few members of each group. This is a composite measure that is high when the 
agent is potentially influential but is not in the know. This is calculated as the ration 

of betweenness centrality to total degree centrality and is calculated on agent by 
agent networks. 
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Locates nodes that are high in betweenness centrality, but low in total 
degree centrality, and therefore potentially act as links between groups of 

entities. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 

This measures finds an individual who could likely have great potential to interact 

with other parts of an organization based on their exisiting connections. 

Informal Name 

None 

Citation 

Cormen, Leiserson, Rivest, Stein 2001. "Introduction to Algorithms" Second Edition. 
Cambridge, MA: MIT Press, 2001. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Slow 

Input and Output 

Input :  

Square matrix : DataType=binary and Directed=No. 

Output :  

Node Level : DataType=real 

 

For each node in the network, its Potential Boundary Spanner is its 
Betweenness Centrality divided by its Total Degree Centrality. 
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Potential Workload 

 

Description 

Maximum knowledge and resources an agent could use to do tasks if it were 
assigned to all tasks. 

NOTE : This measure works on the Agent x Knowledge, Agent x Resource, 

Knowledge x Task, and Resource x Task matrices and needs to be in the binary 
format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for Characterizing 

Organizational Architectures. Unpublished Document: CMU 2002. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Input :  

Example : In a given organization, Bob is assigned all task that exist in the 

organization. This measure would compute a value expressing Bob's potential to 
carry out all the tasks based on his connections to the resources and knowledge 
needed for the tasks.  

Input :  
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Agent by Knowledge : DataType=binary. 

Agent by Resource : DataType=binary. 

Knowledge by Task : DataType=binary. 

Resource by Task : DataType=binary. 

Output :  

Node Level : DataType=real 

 

Radials 

 

Description 

Radial are nodes that have a triad count (the number of triads each node is in) that 

is less than the mean minus one standard deviation. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be in the binary format [ 0 or 1 ]. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Fast 
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Input and Output 

Input :  

Square matrix : DataType=binary. 

Output :  

Node Level : DataType=binary. 

 

Reciprocal Link Count 

 

Description 

The percentage of links in a unimodal network that are reciprocated. A link (i,j) in 

the network is reciprocated if link (j,i) is also in the network. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for Characterizing 

Organizational Architectures. Unpublished Document: CMU 2002 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Fast 

Input and Output 
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Input :  

Square matrix : DataType=binary. 

Output :  

Graph Level : DataType=real 

 

Let G=(V,E) be the graph representation of a network. 

Let S=card{(i,j)∈E|i<,(j,i)∈E} 

Then Reciprocral Link Count = |S| / |E| 

 

Relative Cognitive Distinctiveness 

 

Description 

Measures the degree to which each pair of agents has complementary knowledge, 

expressed as the percent of total knowledge. Each value is normalized by the row 
sum. 

NOTE : This measure works on the Agent x Knowledge matrix and needs to be in 
the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 
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Computational Time 

Slow 

Input and Output 

Input :  

Agent by Knowledge : DataType=binary. 

Output :  

Dyad Level : Agent by Agent and DataType=real. 

For each pair of agents (i,j) compute the number of knowledge bits they have 
exactly opposite. Then normalize this sum by the total number of knowledge 
bits. In effect, this is the exclusive-OR of their knowledge vectors. 

 

NOTE : Note that the CD output matrix is symmetric. 

Relative Cognitive Distinctiveness normalizes each element of CD as follows: 

 

Thus, the elements of the ith row are normalized by the ith row sum. 

 

Relative Cognitive Expertise 
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Description 

Measures the degree to which each pair of agents has complementary knowledge, 
expressed as a percentage of the knowledge of the first agent. Each value is 

normalized by the row sum. Individuals or organizations that are high in specialized 
knowledge are those that have expertise or are connected to types of knowledge 

that few others have. 

NOTE : This measure works on the Agent x Knowledge matrix and needs to be in 
the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Slow 

Input and Output 

Input :  

Agent by Knowledge : DataType=binary. 

Output :  

Node Level : Type=agent and DataType=real. 

Dyad Level : Agent by Agent and DataType=real. 

For each pair of agents (i,j) compute the number of knowledge bits that j 

knows that i does not know. Then normalize this sum by the total number of 
knowledge bits that agent i does not know. 
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NOTE : Note that the CD output matrix is NOT-symmetric. 

Relative Cognitive Expertise normalizes each element of CE as follows: 

 

Thus, the elements of the ith row are normalized by the ith row sum. 

 

Relative Cognitive Resemblance 

 

Description 

Measures the degree to which each pair of agents has the exact same knowledge. 
Each value is normalized by the row sum. 

NOTE : This measure works on the Agent x Knowledge matrix and needs to be in 

the binary format [ 0 or 1 ]. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002 
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Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Slow 

Input and Output 

Input :  

Agent by Knowledge : DataType=binary. 

Output :  

Dyad Level : Agent by Agent and DataType=real. 

 

For each pair of agents (i,j) compute the number of knowledge bits they have in 

common - whether known or unknown. Then normalize this sum by the total 
number of knowledge bits. 

 

NOTE : The CR output matrix is symmetric. 

Relative Cognitive Resemblance normalizes each element of CR as follows: 

 

Thus, the elements of the ith row are normalized by the ith row sum. 
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Relative Cognitive Similarity 

 

Description 

Measures the degree to which each pair of agents have overlapping knowledge. 
Each value is normalized by the row sum. 

NOTE : This measure works on the Agent x Knowledge matrix and needs to be in 

the binary format [ 0 or 1 ]. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Slow 

Input and Output 

Input :  

Agent by Knowledge and DataType=binary. 

Output :  

 

Node Level : Type=agent and DataType=real. 
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Dyad Level : Agent by Agent and DataType=real. 

For each pair of agents (i,j) compute the number of knowledge bits they 
have in common. Then normalize this sum by the total knowledge between 

them. 

 

NOTE : The CS output matrix is symmetric. 

Relative Cognitive Similarity normalizes each element of CS as follows: 

 

Thus, the elements of the ith row are normalized by the ith row sum. 

 

Relative Expertise 

 

Description 

The degree of dissimilarity between agents based on shared knowledge. Each agent 

computes to what degree the other agents know what they do not know. 
Individuals or organizations that are high in specialized knowledge are those that 

have expertise or are connected to types of knowledge that few others have. The 
scientific name of this measure is relatively unique and it is calculated on agent by 
knowledge matrices. 

NOTE : This measure works on the Agent x Knowledge matrix and needs to be in 
the binary format [ 0 or 1 ]. 
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The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Carley, Kathleen. (2003). Dynamic Network Analysis. 133-145. Committee on 
Human Factors, National Research Council. 

http://www.casos.cs.cmu.edu/publications/temp/hope110922160731/carley_2003_
dynamicnetwork.pdf. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Input :  

Agent by Knowledge : DataType=binary. 

Output :  

Node Level : Type=agent and DataTpe=real. 

  

 

Relative Similarity 

 

Description 

The degree of similarity between two agents based on shared knowledge. Each 
agent computes to what degree the other agents know what they know. 
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NOTE : This measure works on the Agent x Knowledge matrix and needs to be in 
the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Carley, Kathleen. (2003). Dynamic Network Analysis. 133-145. Committee on 
Human Factors, National Research Council. 
http://www.casos.cs.cmu.edu/publications/temp/hope110922160731/carley_2003_

dynamicnetwork.pdf. 

Minimum and Maximum Values 

Minimum : Possible 0 

Maximum : Possible 1 

Computational Time 

Input and Output 

Medium 

Input :  

Agent by Knowledge : DataType=binary. 

Output :  

Node Level : Type=agent and DataType=real. 

 

Resemblance Correlation 

 

Description 

Measures the degree to which each pair of rows has the exact same data. 
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NOTE : This measure works on Any Matrix and needs to be in the binary format 
[ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Carley, Kathleen, M., 2002 

Minimum and Maximum Values 

Minimum : Possible : 0 

Maximum : Possible : 1 

Computational Time 

Slow 

Input and Output 

Input :  

DataType=binary. 

Output :  

Node Level : Type=row and DataType=real. 

Dyad Level : Row by Row and DataType=real. 

 

Resource Actual Workload 

 

Description 

The resources an agent uses to perform the tasks to which it is assigned. 
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NOTE : This measure works on the Agent x Resource, Resource x Task, and 
Agent x Task matrices and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. "Summary of Key Network Measures for Characterizing 
Organizational Architectures." Unpublished Document: CMU 2002 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Input and Output 

Medium 

Input :  

Agent by Resource : DataType=binary 

Resource by Task : DataType=binary 

Agent by Task : with DataType=binary 

Output :  

Node Level : Type=agent and DataType=real. 

 

Resource Based Access Index 

 

Description 
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Boolean value which is true if an agent has exclusive access to a resource and who 
is known by exactly one other agent. The one agent known also has its KAI set to 

one. 

An node level measure that computes the average shortest path length between 
entities, excluding infinite distances. This is known as the Resource Access Index 

(RAI) value. 

NOTE : This measure works on the Agent x Agent and Agent x Resource 
matrices and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be in the binary format [ 0 or 1 ]. 

Example 

Let us imagine a social network where 50 employees have many connections to 

each other. The average number of connections per employee is the Access Index.  

Informal Name 

None 

Citation 

Ashworth, M. and Carley, Kathleen M., 2003, "Critical Human Capital", Working 
Paper, CASOS, Carnegie Mellon, Pittsburgh PA. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Fast 

Input and Output 

Input :  

Agent by Agent : DataType=binary 

Agent by Resource : DataType=binary. 

Output :  
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Node Level : Type=agent and DataType=binary. 

The Resource Access Index (RAI) for agent i is defined as follows: 

 

let 

Then 

 

 

Resource Based Task Completion 

 

Description 

The percentage of tasks that can be completed by the agents assigned to them, 
based solely on whether the agents have the requisite resources to do the tasks. 

NOTE : This measure works on the Agent x Resource, Agent x Task, and 
Resource x Task matrices and needs to be in the binary format [ 0 or 1 ]. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Example 

Bob is assigned 10 Tasks to complete which require a certain amount of resources 
to finish. However, on average only 10-percent of those resources will be available 

to Bob for him to complete the tasks given. This measure would compute a value 
for the likelyhood that Bob would be able to complete any given task. 

NOTE : Task Completion Overall is a combination of the Task Completion 

Knowledge and the Task Completion Resource. 

Informal Name 

None 

Citation 
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Carley, Kathleen M., 2002. Summary of Key Network Measures for Characterizing 
Organizational Architectures. Unpublished Document: CMU 2002 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Input :  

Agent by Resource : dataType=binary. 

Agent by Task : dataType=binary. 

Resource by Task : dataType=binary. 

Output :  

Graph Level : DataType=real 

Find the tasks that cannot be completed because the agents assigned to the 

tasks lack necessary knowledge. 

let Need = [(AT'*AR) - KT'] 

let S = { i | , j : Need(i,j) < 0 } 

Knowledge Based Task Completion is the percentage of tasks that could be 
completed = (|T|-|S|) / |T| 

 

Resource Diversity 

 

Description 

file:///C:/myStuff/User's Guides/reports2/measureByReport.html


 

724 
 

The distribution of difference in resource sharing. This is the Herfindahl-Hirshman 
index applied to column sums of AR. 

NOTE : This measure works on the Agent x Resource matrix and needs to be in 

the binary format [ 0 or 1 ]. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Example 

Characterizes the network in terms of how the items in a resource network (who 
has what) are non-uniformly distributed across employees 

Informal Name 

Who Has What 

Citation 

Hirschman A. O., 1945. National Power and the Structure of Foreign Trade. 
Berkeley: University of California Press. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Fast 

Input and Output 

Input :  

Agent by Resource : DataType=binary. 

Output :  

Graph Level : DataType=real 

 

This is the Herfindahl-Hirshman index (economics: sum of the squares of 

each firm's market share) applied to the normalized column sums of AK. This 
measures the degree to which knowledge is equally known. 
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let 

 

let 

 

Then 

 

 

Resource Exclusivity 

 

Description 

Detects agents who have singular resource access. 

NOTE : This measure works on the Agent x Resource matrix and needs to be in 

the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 

A key resource that supports an entire organization is only accessible through one 
person. 

Informal Name 

None 

Citation 
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Ashworth, M. and Carley, K. (2006). Who you know vs. what you know: The impact 
of social position and knowledge on team performance. Journal of Mathematical 

Sociology, 30(1):43{75. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Fast 

Input and Output 

Input :  

Agent by Resource : DataType=binary. 

Output :  

Node Level : DataType=real and Type=agent. 

 

The Resource Exclusivity Index (REI) for agent i is defined as follows: 

 

The Resource Exclusivity Index (REI) for agent i is defined exactly as for 
Resource Based Exclusivity. 

 

Resource Load 

 

Description 

Average number of resources per agent. 
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NOTE : This measure works on the Agent x Resource matrix and needs to be in 
the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. "Summary of Key Network Measures for Characterizing 
Organizational Architectures." Unpublished Document: CMU 2002. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Fast 

Input and Output 

Input :  

Agent by Resource : DataType=binary 

Output :  

Graph Level : DataType=real. 

 

Resource Negotiation 

 

Description 

The extent to which agents need to negotiate with each other because they lack the 
resources to complete their assigned tasks. 
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NOTE : This measure works on the Agent x Task, Agent x Resource, and 
Resource x Task matrices and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 

In a given organization, Bob does not have access to the resources needed to 

complete a certain task but Sue does have it. Bob must negotiate with Sue to gain 
those resources. The extent to which others in the organization must negotiate for 

resources that others have is the organization's resource negotiation value. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. "Summary of Key Network Measures for Characterizing 
Organizational Architectures." Unpublished Document: CMU 2002 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Input :  

Agent by Tasks : DataType=binary. 

Agent by Resource : DataType=binary. 

Resource by Tasks : DataType=binary. 

Output :  

Graph Level : DataType=real. 
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Resource Omega 

 

Description 

The degree to which agents reuse resources while doing their tasks. 

NOTE : This measure works on the Agent x Task, Resource x Task, and Task x 
Task matrices and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 

Sue has X amount of tasks within her company. How many of those tasks that 

require a resource that can be used for one or more of her other tasks is omega 
knowledge. This measure computes a value for such relations to the resources at 

the network level.  

Informal Name 

None 

Citation 

Carley, Kathleen M., Dekker, D., Krackhardt, D (2000). How Do Social Networks 
Affect Organizational Knowledge Utilitization.  

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Input :  

Agent by Task : DataType=binary. 
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Resource by Task : DataType=binary. 

Task by Task : DataType=binary. 

Output :  

Graph Level : DataType=real. 

Let TAT = TA*TA' 

Let N = ((TT'@TAT)*KT')@KT' 

 

Resource Potential Workload 

 

Description 

Maximum resources an agent could use to do tasks if it were assigned to all tasks. 

NOTE : This measure works on the Agent x Resource and Resource x Task 

matrices and needs to be in the binary format [ 0 or 1 ]. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Example 

In a given organization, let us say Bob is assigned all task that exist in the 
organization. This measure would compute a value expressing Bob's potential to 

carry out all the tasks based on his connections to the resources and knowledge 
needed for the tasks.  

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for Characterizing 

Organizational Architectures. Unpublished Document: CMU 2002. 

Minimum and Maximum Values 

Minimum Possible : 0 
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Maximum Possible: 1 

Computational Time 

Medium 

Input and Output 

Input :  

Agent by Resource : DataType=binary. 

Resource by Task : DataType=binary. 

Output :  

Node Level : Type=agent and DataType=real. 

Potential Knowledge Workload for agent i = sum((AK*KT)(i,:))/sum(KT) 

 

Resource Rendundancy 

 

Description 

Average number of redundant agents per resource. An agent is redundant if there 
is already an agent that has the resource. 

NOTE : This measure works on the Agent x Resource matrix and needs to be in 

the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. "Summary of Key Network Measures for Characterizing 
Organizational Architectures." Unpublished Document: CMU 2002. 

Minimum and Maximum Values 
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Minimum Possible : 0 

Maximum Possible : [(|R|-1)*|T|] 

Computational Time 

Fast 

Input and Output 

Input :  

Agent by Resource : DataType=binary. 

Output :  

Graph Level : DataType=real. 

 

This is the Column Redundancy of matrix RT. 

 

Resource Under Supply 

 

Description 

The extent to which the resources needed to do tasks are unavailable in the entire 

organization. 

NOTE : This measure works on the Agent x Task, Agent x Resource, and 
Resource x Task matrices and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 

In an organization where Bob needs to complete Task A, he needs access to 

Resource B, which in this case might be a computer. However, what would happen 
if Resource B were simply unavailable? Say the computer was offline 50-percent of 
the time. This computer would likely under supply the task of completing Task A. 
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This measure would compute a value to the effect that this under supply factor 
affected the ability to perform the task at hand.  

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for Characterizing 
Organizational Architectures. Unpublished Document: CMU 2002 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Input :  

Agent by Task : dataType=binary. 

Agent by Resource : dataType=binary. 

Resource by Task : dataType=binary. 

Output :  

Graph Level : DataType=real 

This is the number of required knowledge not available to tasks based on the 
current agent task assignments normalized by the number of tasks. 

Resource Under Supply = sum(dich( RT - AR'*RT)) / |T| 

  

 

Role Based Knowledge Availability 
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Description 

Computes the number of roles that an agent is qualified to have based on 

knowledge requirements. 

Agent by Knowledge x Knowledge by Role = Agent by Roleresource subject to 
the additional constraint: 

If Max(Knowledge by Rolej)=0 (i.e. role j requires no knowledge) then 

Agent by Rolej=1 

A link Agent by Roleij indicates that agent i has no access to the knowledge 
needed for role j. 

NOTE : This measure works on the Agent x Knowledge and Knowledge x Role 

matrices and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Behrman, Robert; forthcoming; "Network Analysis of the Structure and Capacity of 
Brigade Level Military Organizations"; Chapter 3; PhD Thesis 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Slow 

Input and Output 

Input :  

Agent by Knowledge : DataType=binary. 

Knowledge by Role : DataType=binary. 
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Output :  

Agent by Role : DataType=binary. 

 

Role Based Resource Availability 

 

Description 

Computes the number of roles that an agent is qualified to have based on Resource 
requirements. 

Agent by Resource x Resource by Role = Agent by Roleresource 

A Link Agent by Roleij indicates that agent i has the skills to use the resource 
required by role j. 

NOTE : This measure works on the Agent x Resource and Resource x Role 
matrices and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Behrman, Robert; forthcoming; "Network Analysis of the Structure and Capacity of 
Brigade Level Military Organizations"; Chapter 3; PhD Thesis 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Slow 

Input and Output 
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Input :  

Agent by Resource : DataType=binary. 

Resource by Role : DataType=binary. 

Output :  

Agent by Role : DataType=binary. 

 

Role Based Knowledge 

 

Description 

Computes the degree to which agents are available to do tasks based on their 

access to knowledge and roles that are needed to do the tasks. 

NOTE : This measure works on the Agent x Knowledge, Knowledge x Role, and 
Task x Role matrices and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Behrman, Robert; forthcoming; "Network Analysis of the Structure and Capacity of 

Brigade Level Military Organizations"; Chapter 3; PhD Thesis 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Slow 

Input and Output 
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Input :  

Agent by Knowledge : DataType=binary. 

Knowledge by Role : with DataType=binary. 

Task by Role matrix : DataType=binary. 

Output :  

Node Level : Type=agent and DataType=real. 

 

Role Resource Availability 

 

Description 

Computes the number of roles that an agent is qualified to have based on resource 

requirements. 

NOTE : This measure works on the Agent x Resource and Resource x Role 
matrices and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Behrman, Robert; forthcoming; "Network Analysis of the Structure and Capacity of 

Brigade Level Military Organizations"; Chapter 3; PhD Thesis 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Slow 
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Input and Output 

Input :  

Agent by Resource matrix with DataType=binary. 

Resource by Role matrix with DataType=binary. 

Output :  

Agent Node Level with DataType=real. 

 

Row Breadth 

 

Description 

The fraction of entities with row nodes with degree greater than one. 

Example : In a given organization, we have the following entities: employees 
(agents), computers (resources), benchmarks (tasks). This measure tells us on 

how many links greater than one exist within these entity types. 

NOTE : This measure works on Any Matrix and needs to be in the binary format 
[ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
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Fast 

Input and Output 

Input :  

DataType=binary. 

Output :  

Graph Level : DataType=real. 

 

Let d = the Row degree vector of the network N 

Then, the Row Breadth of N is: 

 

NOTE : Column breadth is identical, except that d is defined using the column 
degree, rather than the row degree. 

 

Row Count 

 

Description 

The number of row nodes in a network. 

NOTE : This measure works on Any Matrix and needs to be in the binary format 
[ 0 or 1 ]. 

 
The result will be [ The number of rows in a matrix ]. 

Informal Name 

None 
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Citation 

Carley, Kathleen M., 2002 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : Number of rows in the network 

Computational Time 

Fast 

Input and Output 

Input :  

DataType=binary. 

Output :  

Graph Level : DataType=integer. 

Result: Z > 0 

 

Row Degree Centrality 

 

Informal Name 

see Out Degree Centrality 

 

Row Degree Network Centralization 

 

Description 
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A centralization based on the degree of the row nodes of a network. 

NOTE : This measure works on Any Matrix and needs to be in the binary format 
[ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

Also called OutDegree Network Centralization 

Citation 

NetStat 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Fast 

Input and Output 

Input :  

DataType=real 

Output :  

Graph Level : Type=row and DataType=real. 

 

Let N be a network with n row nodes. 

let 

 

let 
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Then 

 

 

Row Redundancy 

 

Description 

The mean number of row node links in excess of one. 

NOTE : This measure works on Any Matrix and needs to be in the binary format 
[ 0 or 1 ]. 
 

The result will be [ the average of links ]. 

Example 

Let us say in our organizational matrix, we have Bob who multiple links to Sue. Let 
us say this is multiple linkages has an average of 2.5 per employee to the same 

manager Sue or another. The measure computes a value for this average which is 
considering row redundancy.  

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for Characterizing 

Organizational Architectures. Unpublished Document: CMU 2002 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : [(N-1)*M] 
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Computational Time 

Fast 

Input and Output 

Input :  

DataType=binary. 

Output :  

Graph Level : DataType=real. 

for N dimension m x n 

Let M be the matrix representation for a network N of dimension m x n. 

let 

 

for 

 

this is the number of column entries in excess of one for row i. 

Then 

 

 

Sequential Link Count 

 

Description 
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The percentage of links in a network that are neither Reciprocal Links nor Pooled 
Links. Note that an link can be both a Pooled and a Reciprocal link. 

NOTE : This measure works on Any Matrix and needs to be in the binary format 

[ 0 or 1 ]. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Example 

The percentage of edges in a network that are neither Reciprocal Edges nor Pooled 
Edges. Note that an edge can be both a Pooled and a Reciprocal edge. Self-loops 

are ignored. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for Characterizing 
Organizational Architectures. Unpublished Document: CMU 2002. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Fast 

Input and Output 

Input :  

Square matrix : DataType=binary. 

Output :  

Graph Level : DataType=real. 

 

Let G=(V,E) be the graph representation of a network, and let X = set of 
Pooled edges of G, and let Y = set of Reciprocal edges of G. 
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Then Sequential Edge Count = | E-X-Y| / |E| 

 

Shared Situation Awareness 

 

Description 

Individuals or organizations that are high in group awareness are those that by 
virtue of their connections to others, what resources they use, what knowledge 

there is, what tasks there are - have a better understanding of what others are 
doing. 

NOTE : This measure works on the Agent x Resource, Agent x Task, and 

Resource x Task matrices and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number of [ shared assets with other nodes ]. 

Example 

If we take any given pair of actors in an organization, this measure computes a 
value for how similar they are to each other based on their relationships (i.e., links) 

to others in the same organization. 

Informal Name 

None 

Citation 

Graham, J. M., Schneider, M., & Gonzalez, C. (2004). Report Social Network 

Analysis of Unit of Action Battle Laboratory Simulations: Ft Leavenworth 2003 & Ft 
Lee 2004 (No. DDML Technical Report CMU-SDS-DDML-04-01): Carnegie Mellon 
University, Social & Decision Sciences, Dynamic Decision Making Laboratory. 

John Graham, 2005, "Dynamic Network Analysis of the Network-Centric 

Organization: Towards an Understanding of Cognition & Performance," Carnegie 
Mellon University, School of Computer Science, Institute for Software Research, 

Computation, Organizations and Society, June 20, 2005. Doctor of Philosophy. 

Minimum and Maximum Values 

Minimum Possible : 0 
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Maximum Possible : Unscaled real number 

Computational Time 

Medium 

Input and Output 

Input :  

Agent by Agent : DataType=binary. 

Output :  

Node Level : Type=agent and DataType=real. 

 

Dyad Level : agent by agent and DataType=real. 

 

Formula :  

Let 

 

Let A = Agent x Agent interaction/communication network. 

Let P = Agent x Agent physical proximity network. 

Let S = Agent x Agent social demographic similarity network. 

Let e = eigenvector centrality measure computed on A. 

Let G = geodesics between agents computed on A. 

Then the SSA measure between agents i and j is: 
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Similarity Correlation 

 

Description 

Measures the degree to which each pair of rows have overlapping data. 

NOTE : This measure works on Any Matrix and needs to be in the binary format 
[ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Carley, Kathleen, M., 2002 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Slow 

Input and Output 

Input :  

Matrix : DataType=binary. 

Output :  

Node Level : Type=row and DataType=real. 

Dyad Level : Row by Row, and DataType=real. 
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Simmelian Ties 

 

Description 

The normalized number of Simmelian ties of each node. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Example 

Described informally as ties embedded in cliques and are often associated with 

brokers inside such cliques such that if Bob and Susan only know of each other 
becuase of Chan and now all of them, Bob, Susan and Chan, now know each other. 

Chan, Bob, Susan now have simmelian ties to each other. 

Informal Name 

None 

Citation 

Krackhardt, David. 1998. "Simmelian Tie: Super Strong and Sticky." In Power and 
Influence in Organizations., edited by Roderick M. Kramer and Margaret Neale, pp. 

21/38. Thousand Oaks, CA: Sage. 

Simmel, Georg. 1950. "The Sociology of Georg Simmel." New York: Free Press, 1st 
free press paperback edition. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 
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Input :  

Square matrix : DataType=binary. 

Output :  

Node Level : dataType=real. 

 

let N be a square network with n entities. The Simmelian Tie value for entity i 
is computed as follows: 

let NS = network N symmetrized using the Intersect (Minimum) method. 

All cliques of size >= 3 are computed on NS and clique membership is 

recorded. Let be the number of entities that are in a clique with entity i. 

Then the Simmelian Ties value for emtity i is . 

 

Skip Link Count 

 

Description 

The fraction of links in a unimodal network that skip levels. An link (i,j) is a skip link 

if there is a path from node i to node j even after the link (i,j) is removed. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and needs to be in the binary format [ 0 or 1 ]. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Example 

The fraction of edges in a unimodal network that skip levels. An edge (i,j) is a skip 
edge if there is a path from entity i to entity j even after the edge (i,j) is removed. 

Informal Name 

None 
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Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for Characterizing 
Organizational Architectures. Unpublished Document: CMU 2002. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible: 1 

Computational Time 

Medium 

Input and Output 

Input :  

Square matrix : DataType=binary. 

Output :  

Graph Level : DataType=real. 

 

A skip link in a network G=(V,E) is an link (i,j)∈E such that j is reachable from i 
in the graph G'=(V,E\(i,j)), that is, the graph G with link (i,j) removed. Skip 

Count is simply the number of such links in G normalized to be in [0,1] by 
dividing by |E|.  

 

Social Technical Congruence 

 

Description 

Social technical congruence represents the proportion of coordination requirements 

that were satisfied through some type of actual coordination activity carried out 
through some means of communication. 

NOTE : This measure works on the Agent x Agent, Agent x Task, and Task x 

Task matrices and needs to be in the binary format [ 0 or 1 ]. 
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The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Cataldo, Marcelo, Wagstrom, Patrick, Herbsleb, James, & Carley, Kathleen M. 
(2006). Identification of Coordination Requirements: implications for the design of 

collaboration and awareness tools. Paper presented at the 2006 Conference on 
Computer Supported Cooperative Work, Banff, Alberta. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

A representation of the coordination requirements among the different workers is 

obtained by multiplying AT, TT and transpose of AT matrices. This product results in 
a people by people matrix where a cell ij indicates the extent to which person i 

works on tasks that share dependencies with the tasks worked on by person j. In 
other words, the resulting matrix represents the Coordination Requirements or the 
extent to which each pair of people needs to coordinate their work. 

Formally, the Coordination Requirements (CR) matrix is determined by the 
following product: 

Let, CR = AT * TT * transpose(AT) 

Given a particular CR matrix constructed from relating product dependencies to 
work dependencies, we can compare it to an Actual Coordination (CA) matrix that 

represents the interactions workers engaged in through different means of 
coordination. 

Diff (CR, CA) = card { diffij | crij > 0 & caij > 0 } 

|CR| = card { crij > 0 } 
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We have, 

Congruence(CR, CA) = Diff (CR, CA) / |CR| 

Input :  

Agent by Agent : DataType=binary 

Agent by Task : DataType=binary 

Task by Task : DataType=binary 

Output :  

Graph Level : DataType=real. 

Dyad Level with Agent (source) by Agent (target) with DataType=real. 

 

The Coordination Requirements (CR) matrix is determined by the following 

product: 

Let, CR = AT * TT * transpose(AT) 

Given a particular CR matrix constructed from relating product dependencies 
to work dependencies, we can compare it to an Actual Coordination (CA) 

matrix that represents the interactions workers engaged in through different 
means of coordination. 

Diff (CR, CA) = card { diffij | crij > 0 & caij > 0 } 

|CR| = card { crij > 0 } 

We have, 

Congruence(CR, CA) = Diff (CR, CA) / |CR| 

 

Span of Control 

 

Description 
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The average number of out links per node with non-zero out degrees. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be the [ average number of out links for all non isolate 

nodes ]. 

Example 

Bob has 5 out degree links to 5 other personnel in his company and of those 5 
personnel, the average non-zero (i.e., people that make up that personnel that 

have out-degree links of there own) is 4. Whereas Sue might have 5 personnel out 
degree links, but those personnel have 3 out-degree links themselves on average. 
It would figure that Sue might have a greater span of control, since the people she 

connects do, don't have as many connections as those that Bob connects to does. 
This measure would compute a value for such relationships called Span of Control. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for Characterizing 
Organizational Architectures. Unpublished Document: CMU 2002 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : ∈ ℜ [0,|V|-1] 

Computational Time 

Fast 

Input and Output 

Input :  

Square matrix : DataType=binary. 

Output :  

Graph Level : dataType=real. 
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let S = set of entities in V that have positive out-degree 

let 

 

Then 

 

 

Strict Knowledge Congruence 

 

Description 

Measures the similarity between what knowledge are assigned to tasks via agents, 
and what knowledge are required to do tasks. Perfect congruence occurs when 
agents have access to knowledge when and only when it is needful to complete 

tasks. 

NOTE : This measure works on the Agent x Knowledge, Agent x Task, and 
Knowledge x Task matrices and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for Characterizing 

Organizational Architectures. Unpublished Document: CMU 2002. 

Minimum and Maximum Values 

Minimum Possible : 0 
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Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Knowledge Congruence = 1 if agents have knowledge when and only when it is 

needful to complete their tasks. Thus, we compute the knowledge assigned to tasks 
via agents, and compare it with the knowledge needed for tasks. 

Input :  

Agent by Knowledge : DataType=binary. 

Agent by Task : DataType=binary. 

Knowledge by Task : DataType=binary. 

Output :  

Graph Level : DataType=real. 

Knowledge Congruence = 1 iff agents have knowledge when and only when it 
is needful to complete their tasks. Thus, we compute the knowledge assigned 
to tasks via agents, and compare it with the knowledge needed for tasks.  

let KAT = dich(AK'*AT) 

let 

 

let <d = d / (|K|*|T|), which normalizes d to be in [0,1] 

Then Knowledge Congruence = 1 - d 

 

Strict Resource Congruence 
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Description 

Measures the similarity between resources assigned to tasks via agents, and what 
resources are required to do tasks. Perfect congruence occurs when agents have 

resources when and only when it is needful to complete tasks. 

NOTE : This measure works on the Agent x Resource, Agent x Task, and 
Resource x Task matrices and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Carley, Kathleen M., 2002. Summary of Key Network Measures for Characterizing 

Organizational Architectures. Unpublished Document: CMU 2002. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Knowledge Congruence = 1 if agents have knowledge when and only when it is 

needful to complete their tasks. Thus, we compute the knowledge assigned to tasks 
via agents, and compare it with the knowledge needed for tasks. 

Input :  

Agent by Resource : DataType=binary. 

Agent by Task : DataType=binary. 

Resource by Task : DataType=binary. 

Output :  

Graph Level : DataType=real. 
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Resource Congruence = 1 iff agents have knowledge when and only when it 
is needful to complete their tasks. Thus, we compute the resource assigned 

to tasks via agents, and compare it with the resource needed for tasks.  

let RAT = dich(AK'*AT) 

let 

 

let <d = d / (|K|*|T|), which normalizes d to be in [0,1] 

Then Resource Congruence = 1 - d 

 

Strong Component Count 

 

Description 

The number of strongly connected components in a network. The network can be 

directed or undirected. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ]. 

Informal Name 

None 

Citation 

Wasserman, Stanley and Katherine Faust. "Social Network Analysis: Methods and 

Applications." Cambridge: Cambridge University Press, 1994. 

Minimum and Maximum Values 

Minimum Possible : 0 
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Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Given a square network G=(V,E), the Strong Component Count is the number of 

strongly connected components in G. This is computed directly on G, whether or 
not G is directed.  

Input :  

Square matrix : DataType=binary. 

Output :  

Graph Level : dataType=integer. 

 

Given a square, symmetric network G=(V,E), the Strong Component Count 

is the number of strongly connected components in G. This is computed 
directly on G, whether or not G is directed.  

 

Task Exclusivity 

 

Description 

Detects agents who exclusively perform tasks. Individuals or organizations that are 

high in complete exclusivity for tasks are those that are engaged in or assigned to 
tasks or activities for which no one else is engaged in or assigned to. The scientific 

name of this measure is complete exclusivity and it is calculated on agent by task 
matrices. 

NOTE : This measure works on the Agent x Task matrix and needs to be in the 

binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 
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Example 

A key task that supports an entire organization is only accessible through one 
person. 

Informal Name 

None 

Citation 

Ashworth, M. and Carley, K. (2006). Who you know vs. what you know: The impact 
of social position and knowledge on team performance. Journal of Mathematical 

Sociology, 30(1):43{75. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Fast 

Input and Output 

Input :  

Agent by Task : DataType=binary. 

Output :  

Node Level : Type=agent and DataType=real 

 

The Task Exclusivity Index (KEI) for agent i is defined as follows: 

 

The Task Exclusivity Index (TEI) for agent i is defined exactly as for Task 
Based Exclusivity. 
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Task Knowledge Needs Congruence 

 

Description 

The number of knowledge not supplied to a task, but required to do the task, 

expressed as a percentage of the total knowledge required for the task. 

Task Knowledge Needs compares the knowledge requirements of each task with the 
knowledge available to the task via agents assigned to it. It is similar to Knowledge 

Congruence, but quantifies only the under supply of knowledge to tasks. 

NOTE : This measure works on the Agent x Knowledge, Agent x Task, and 
Knowledge x Task matrices and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Lee, Ju-Sung, & Carley, Kathleen M. (2004). OrgAhead: A Computational Model of 

Organizational Learning and Decision Making. Pittsburgh, PA: Carnegie Mellon 
University, School of Computer Science, Institute for Software Research 
International, Technical Report, CMU-ISRI-04-117.  

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Input :  

Agent by Knowledge : DataType=binary. 
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Agent by Task : DataType=binary. 

Knowledge by Task : DataType=binary. 

Output :  

Node Level : Type=Task and DataType=real 

 

Task Knowledge Needs compares the knowledge requirements of each task 
with the knowledge available to the task via agents assigned to it. It is 

similar to Knowledge Congruence, but quantifies only the under supply of 
knowledge to tasks. 

Let S = AT'*AK = knowledge supplied to tasks via assigned agents 

We need to sum the knowledge required but not supplied. 

Thus, 

 

The equation for Agent Resource Needs replaces AK with AR, and KT with RT. 

 

Task Knowledge Waste Congruence 

 

Description 

The number of knowledge supplied to a task via agents that are not required by it 
expressed as a percentage of the total knowledge required for the task. 

Task Knowledge Waste compares the knowledge requirements of each task with the 
knowledge available to the task via agents assigned to it. It is similar to Knowledge 

Congruence, but quantifies only the over supply of knowledge to tasks. 
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NOTE : This measure works on the Agent x Knowledge, Agent x Task, and 
Knowledge x Task matrices and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Lee, Ju-Sung, & Carley, Kathleen M. (2004). OrgAhead: A Computational Model of 
Organizational Learning and Decision Making. Pittsburgh, PA: Carnegie Mellon 
University, School of Computer Science, Institute for Software Research 

International, Technical Report, CMU-ISRI-04-117.  

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Input :  

Agent by Knowledge : DataType=binary. 

Agent by Task : DataType=binary. 

Knowledge by Task : DataType=binary. 

Output :  

Node Level : Type=task and DataType=real. 

 

Task Knowledge Waste compares the knowledge requirements of each task 

with the knowledge available to the task via agents assigned to it. It is 
similar to Knowledge Congruence, but quantifies only the over supply of 

knowledge to tasks. 
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Let S = AT'*AK = knowledge supplied to tasks via assigned agents 

We need to sum the knowledge supplied but not required. 

Thus, 

 

The equation for Agent Resource Waste replaces AK with AR, and KT with RT. 

 

Task Resource Needs Congruence 

 

Description 

The number of resources not supplied to a task, but required to do the task, 
expressed as a percentage of the total resources required for the task. 

Task Knowledge Needs compares the knowledge requirements of each task with the 

knowledge available to the task via agents assigned to it. It is similar to Knowledge 
Congruence, but quantifies only the under supply of knowledge to tasks. 

NOTE : This measure works on the Agent x Resource, Agent x Task, and 

Resource x Task matrices and needs to be in the binary format [ 0 or 1 ]. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Lee, Ju-Sung, & Carley, Kathleen M. (2004). OrgAhead: A Computational Model of 
Organizational Learning and Decision Making. Pittsburgh, PA: Carnegie Mellon 

file:///C:/myStuff/User's Guides/reports2/measureByReport.html


 

764 
 

University, School of Computer Science, Institute for Software Research 
International, Technical Report, CMU-ISRI-04-117.  

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Input :  

Agent by Resource : DataType=binary. 

Agent by Task : DataType=binary. 

Resource by Task : DataType=binary. 

Output :  

Node Level : Type=task DataType=real. 

 

Task Knowledge Needs compares the knowledge requirements of each task 
with the knowledge available to the task via agents assigned to it. It is 

similar to Knowledge Congruence, but quantifies only the under supply of 
knowledge to tasks. 

Let S = AT'*AR = resource supplied to tasks via assigned agents 

We need to sum the resources required but not supplied. 

Thus, 
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The equation for Agent Resource Needs replaces AR with AK, and RT with KT. 

 

Task Resource Waste Congruence 

 

Description 

The number of resources supplied to a task via agents that are not required by it 
expressed as a percentage of the total resources required for the task. 

Task Knowledge Waste compares the knowledge requirements of each task with the 

knowledge available to the task via agents assigned to it. It is similar to Knowledge 
Congruence, but quantifies only the over supply of knowledge to tasks. 

NOTE : This measure works on the Agent x Resource, Agent x Task, and 
Resource x Task matrices and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

None 

Citation 

Lee, Ju-Sung, & Carley, Kathleen M. (2004). OrgAhead: A Computational Model of 
Organizational Learning and Decision Making. Pittsburgh, PA: Carnegie Mellon 
University, School of Computer Science, Institute for Software Research 

International, Technical Report, CMU-ISRI-04-117.  

Minimum and Maximum Values 

Minimum Possible : 0 
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Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Input :  

Agent by Resource : DataType=binary. 

Agent by Task ; DataType=binary. 

Resource by Task : DataType=binary. 

Output :  

Node Level : Type=task and DataType=real. 

 

Task Knowledge Needs compares the knowledge requirements of each task 

with the knowledge available to the task via agents assigned to it. It is 
similar to Knowledge Congruence, but quantifies only the under supply of 

knowledge to tasks. 

Let S = AT'*AK = knowledge supplied to tasks via assigned agents 

We need to sum the knowledge required but not supplied. 

Thus, 

 

The equation for Agent Resource Needs replaces AK with AR, and KT with RT. 
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Total Degree Centrality 

 

Description 

The Total Degree Centrality of a node is the normalized sum of its row and column 

degrees. Individuals or organizations who are "in the know" are those who are 
linked to many others and so, by virtue of their position have access to the ideas, 

thoughts, beliefs of many others. Individuals who are In the know are identified 
by degree centrality in the relevant social network. Those who are ranked high on 
this metrics have more connections to others in the same network. The scientific 

name of this measure is total degree centrality and it is calculated on the agent by 
agent matrices. 

Individuals or organizations who are In the know are those who are linked to 

many others and so, by virtue of their position have access to the ideas, thoughts, 
beliefs of many others. Individuals who are "in the know" are identified by degree 

centrality in the relevant social network. 

Square Matrices [binary] - between 0,1  

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and can be any number. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Informal Name 

In The Know 

Citation 

Wasserman, Stanley and Katherine Faust. "Social Network Analysis: Methods and 

Applications." Cambridge: Cambridge University Press, 1994. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 
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Fast 

Input and Output 

Input :  

Square matrix : DataType=real. 

Output :  

Node Level : DataType=real. 

 

Consider the matrix representation X of a square network with n entities. 

Each entity is assigned a value based on the sum of its row and columns. 

The Total Degree Centrality for 

 

NOTE : The diagonal values are ignored. 

 

Total Degree Network Centralization 

 

Description 

A centralization of a square network based on the Total-Degree Centrality of each 
node. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 

Location, etc] and can be any number. 
 
The result will be a number between [ 0 and 1 ], inclusive. 

Example :  
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An organization has a sales team, computers, sales data and a marketing team. 
How central all of these entities are within the organization is its total degree 

network centralization value. 

Informal Name 

None 

Citation 

Freeman, L.C. (1979). Centrality in Social Networks I: Conceptual Clarification. 

Social Networks, 1, 215-239.  

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Fast 

Input and Output 

Input :  

Square matrix : DataType=real. 

Output :  

Graph Level : DataType=real. 

 

Let N be a unimodal network with n entities. 

let 

 

let 
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Then 

 

 

Triad Count 

 

Description 

The number of triads centered at each node in a square network. A triad is a 

relationship amongst three nodes such that they constitute a distinct and important 
relationship which is deemed relevant to network architecture. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and the number of triads ]. 

Informal Name 

None 

Citation 

NetStat 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : Integer (N-1) (N-2) 

Computational Time 

Medium 

Input and Output 

Input :  
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Square matrix : DataType=binary. 

Output :  

Node Level : DataType=integer. 

  for N dimension n. 

Let G=(V,E) represent a square network with n entities. 

And let Triad be a matrix of dimension n x n. 

 

Then 

 

 

Transitivity 

 

Description 

The percentage of link pairs {(i,j), (j,k)} in the network such that (i,k) is also an 
link in the network. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and needs to be in the binary format [ 0 or 1 ]. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Example 

The percentage of pairs in the employee communication network where employee A 
is linked to B and B is linked to C and C is also linked to A 

Informal Name 
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None 

Citation 

NetStat 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Input :  

Square matrix : DataType=binary. 

Output :  

Graph Level : DataType=real 

 

Let G = (V,E) be the graph representation of the square network. 

let 

 

let 

 

let 

 

Then 
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Upper Boundedness 

 

Description 

The degree to which pairs of agents have a common ancestor. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 

Location, etc] and needs to be in the binary format [ 0 or 1 ]. 
 

The result will be a number between [ 0 and 1 ], inclusive. 

Example 

In a given organization, if Bob and Ahmed were both hired by Pedro this measure 
would compute a value correlating to this shared ancestry or linkage that both have 

to Pedro. 

Informal Name 

None 

Citation 

Krackhardt, D. 1994. Graph Theoretical Dimensions of Informal Organizations. In 
Computational Organization Theory, edited by Carley, Kathleen M. and M.J. 

Prietula. Hillsdale, NJ: Lawrence Erlbaum Associates, 1994. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Slow 

Input and Output 

Input :  

Square matrix : DataType=binary. 
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Output :  

Graph Level : DataType=real. 

 

 

Weak Boundary Spanner 

 

Description 

A node which if removed from a network creates a new component. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 

Location, etc] and needs to be in the binary format [ 0 or 1 ]. 
 

The result will be in the binary format [ 0 or 1 ]. 

Informal Name 

None 

Citation 

Corman, Thomas H., Leiserson, Charles E., Rivest, Ronald L., & Stein, Clifford. 
(2001). Introduction to Algorithms (2 ed.). Cambridge, MA: The MIT Press.  

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : 1 

Computational Time 

Medium 

Input and Output 

Input :  

Square matrix : DataType=binary and Directed=No. 
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Output :  

Node Level : DataType=binary. 

 

Weak Component Count 

 

Description 

The number of weakly connected components in an undirected (symmetric) 
network. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and needs to be in the binary format [ 0 or 1 ]. 

 
The result will be a number between [ 0 and the number weakly connected 

nodes ]. 

Informal Name 

None 

Citation 

Wasserman, Stanley and Katherine Faust. "Social Network Analysis: Methods and 
Applications." Cambridge: Cambridge University Press, 1994. 

Minimum and Maximum Values 

Minimum Possible : 0 

Maximum Possible : Integer Value 

Computational Time 

Medium 

Input and Output 

Input :  

Square matrix : DataType=binary and Directed=No. 
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Output :  

Graph Level : DataType=integer. 

 

Given a square, symmetric network G=(V,E), the Weak Component Count is 
the number of connected components in G. Such components are called 

weak because the graph G is undirected. 

 

Weak Component Members 

 

Description 

Computes the component to which each node belongs in the underlying, undirected 

network. 

NOTE : This measure works on Square Matrices [i.e. Agent x Agent, Location x 
Location, etc] and needs to be in the binary format [ 0 or 1 ]. 
 

The result will be a number between [ 0 and the number of weak 
components ]. 

Example 

Given a square, symmetric network G=(V,E), the Weak Component Member for 

a entity is the weak component to which the entity belongs. The components are 
numbered from 1 to the number of weak components (Weak Component Count). 

Informal Name 

None 

Citation 

Wasserman, Stanley and Katherine Faust. "Social Network Analysis: Methods and 

Applications." Cambridge: Cambridge University Press, 1994. 

Minimum and Maximum Values 

Minimum Possible : 0 
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Maximum Possible : Any Integer Value 

Computational Time 

Medium 

Input and Output 

Input :  

Square matrix : DataType=binary. 

Output :  

Node Level : DataType=integer. 

 

Given a square, symmetric network G=(V,E), the Weak Component 

Member for a entity is the weak component to which the entity belongs. The 
components are numbered from 1 to the number of weak components (Weak 
Component Count). 

 

 

Reports and Measures Tables 

Go to Reports by Measure Table  

Measures by Report 

To use this table look up the Report in the left hand column and the Measures 
used in that report are listed in the right hand column. Some of the Reports list 

no measures as they are calculated using other means. 

Report Measures 

All Measures 
Computes a collection of measures 

and generates output in categories. 
Each category analyzes a particular 

aspect of the meta-network 
structure. 

Does not used predefined measures. 

This report allows you to choose 
which measures to run. 
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Assessing Change In Plan 

Analyzes the similarity between a 
given network and a collection of 
other networks. 

Communication Congruence 

Belief Propagation 

Estimates belief propagation 
through social networks 

Betweenness Centrality, Closeness 
Centrality, Total Degree Centrality 

Capabilities 
Analyzes the knowledge, resource, 
and task capabilities of agents and 

organizations in the network. 

Communication Congruence, 
Organization Agent Knowledge Needs 

Congruence, Organization Agent 
Knowledge Waste Congruence, 

Organization Agent Resource Needs 
Congruence, Organization Agent 

Resource Waste Congruence, 
Organization Task Knowledge Needs 
Congruence, Organization Task 

Knowledge Waste Congruence, 
Organization Task Resource Needs 

Congruence, Organization Task 
Resource Waste Congruence, Socio 
Technical Congruence, Strict 

Knowledge Congruence, Strict 
Resource Congruence 

Change in Key Entities 
Analyzes the changes over time of 
the agents that score highest in 

measure values 

Agent Level : Actual Workload, 
Betweenness Centrality, Clique 

Count, Cognitive Demand, 
Eigenvector Centrality, Eigenvector 

Centrality Per Component, 
Exclusivity, Exclusivity Complete, 

Potential Boundry Spanner, Row 
Degree Centrality, Total Degree 
Centrality 

Communication Network 

Assessment 
This report assesses a 
Communications network. As 

information on speed of 
information transmittal becomes 

available it will be updated. This 
report takes a resource by resource 
network (preferably one where the 

nodes are Communications devices 
and the links are the speed or 

Failure : Boundry Spanner, Potential 

Boundry Spanner, Exclusivity 
Reliability Injected : Eigenvector 
Centrality, Total Degree Centrality 

Reliability Relaying : Betweenness 
Centrality 
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reliability of the link). 

Communicative Power 

Analyzes one or more semantic 
networks to classify concepts by 
measure values. 

Betweenness Centrality, Density, Link 

Count, Node Count, Total Degree 
Centrality 

Communicators 
Analyzes the Communication 

network (agent by agent) and 
gives high level statistics on its 

structure. 

Node Level : Betweenness 

Centrality, In Degree Centrality, Out-
Degree Centrality 
Graph Level : Clique Count, 

Clustering Coefficient, Density, Node 
Count 

Context 

Compares measured values against 
various stylized forms of networks 

in an effort to characterize network 
topology. 

Average Distance, Betweenness 

Centrality, Burt Constraint, Closeness 
Centrality, Clustering Coefficient, 
Cognitive Demand, Connectedness, 

Efficiency, Fragmentation, Hierarchy, 
Information Centrality, Inverse 

Closeness Centrality, Total Degree 
Centrality, Upper Boundedness 

Core Network 
Computes the core network and 

reports general statistics. 

Betweenness Centrality, Density, 
Node Count, Total Degree Centrality 

CPOF 
Analyzes the creation and 
modification of events and tasks 

and agent collaboration over time. 

Complexity, Density, In-Degree 
Centrality 

Critical Sets 
Finds critical sets of nodes in a 

network that best reach all other 
nodes, or whose removal 
maximally disrupts a network. 

Fragmentation 

Custom 

Computes a custom report with 
user selected measures and output 

tables, pictures, and figures. 

Whatever measures are selected by 
the user. 

Detect Spatial Patterns 

Find out whether a node attribute 
is clustered spatially, such that 

nodes are similar to nearby others. 
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Drill Down 

Computes the drill down from a 
selected organization and then to a 
selected agent. 

  

GeoSpatial Assessment 

Finds nodes that are co-located 
based, and counts the number of 

nodes that appear at location pairs. 

Degree Centrality, Location 

Relevance, Spatial Betweenness 
Centrality, Spatial Closeness 

Centrality, Spatial Degree Centrality 

Group Talk 

Analyzes the relationship between 
agents and knowledge. 

Row Degree Centrality 

Hot Topics (Content Analysis) 

Analyzes semantic network output 
from AutoMap. 

  

Immediate Impact 

Computes the key actors of the 
network, and then isolates them 
individually to determine the effect 

on measure values. 

Node Level : Betweenness 
Centrality, Cognitive Demand, Total 

Degree Centrality 
Impact : Average Distance, Average 

Speed, Clustering Coefficient, 
Communicaton Congruence, 
Complexity, Density, Diffusion, 

Fragmentation, Isolate Count, 
Knowledge Congruence, Overall 

Fragmentation, Overall Node Count, 
Performance as Accuracy 

Influence Net 
Displays the influence network and 

gives high level statistics on its 
structure. 

Betweenness Centrality, In Degree 
Centrality 

K-Centrality 
Calculates the geodesic centrality 

measures for various rdius values 
k, which approximates the 

geodesic computation by only 
considering neighbors within the 
radius distance. 

  

Key Entity 

Identifies key entities and groups 
who by virtue of their position in 

the network are critical to its 
operation.  

Agent Level : Actual Workload, 

Authority Centrality, Betweenness 
Centrality, Clique Count, Cognitivie 

Demand, Edge Betweenness 
Centrality, Eigenvector Centrality, 
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Eigenvector Centrality Per 

Component, Exclusivity, Exclusivity 
Complete, Hub Centrality, Potential 
Boundry Spanner, Row Degree 

Centrality, Shared Situation 
Awareness, Total Degree Centrality 

Organizational Level : Authority 
Centrality, Betweenness Centrality, 
Column Degree Centrality, 

Eigenvector Centrality, Exclusivity, 
Exclusivity Complete, Hub Centrality, 

Potential Boundry Spanner, Row 
Degree Centrality, Total Degree 

Centrality 
Knowledge Level : Betweenness 
Centrality, In-Degree Centrality, Row 

Degree Centrality, Total Degree 
Centrality 

Resource Level : Row Degree 
Centrality, Total Degree Centrality 
Location Level : Authority 

Centrality, Column Degree Centrality, 
Exclusivity Complete, Hub Centrality, 

Location Relevance, Row Degree 
Centrality, Spatial Eigenvector 
Centrality, Total Degree Centrality 

Event Level : Authority Centrality, 
Column Degree Centrality, Exclusivity 

Complete, Hub Centrality, Row 
Degree Centrality, Total degree 
Centrality 

Task Level : Authority Centrality, 
Column Degree Centrality, Exclusivity 

Complete, Hub Centrality, Row 
Degree Centrality, Total degree 
Centrality 

Performance Level : Average 
Speed, Communication Congruence, 

Complexity, Density, Fragmentation, 
Knowledge Congruence, Performance 
as Accuracy 

Large Scale 

Computes all network analysis 
measures. 

  

Local Patterns Special, Clique Count 
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Find link patterns in a network, 

such as Star, Checkerboard, and 
Clique. 

Locate Subgroup 
Identifies the subgroups present in 

the network using various grouping 
algorithms. 

Betweenness Centrality, Clique 
Count, Clustering Coefficient, 
Density, Total Degree Centrality 

Management 
Identifies over- and under-

performing individuals and 
assesses the state of the network 

as a functioning organization. 

Agent Level : Actual Workload, 
Authority Centrality, Cognitive 

Demand, Exclusivity, Exclusivity 
Complete, Hub Centrality, Shared 

Situation Awareness 
Knowledge Level : In-Degree 

Centrality 
Resource Level : In-Degree 
Centrality 

Location Level : In-Degree 
Centrality 

Performance Level : Column 
Breadth, Complexity, Knowledge 
Congruence, Resource Congruence, 

Shared Situation Awareness 
Potential Problems : Actual 

Workload, Cognitive Demand, In-
Degree Centrality, Shared Situation 
Awareness, Simmelian Ties  

MedHealth 
Analyzes health department data to 
find potential problems. 

Interaction : Density, Clustering 

Coefficient, Clique Count, Diffusion, 
Eigenvector Centrality, Hierarchy, In-

Degree Centrality, Node Count, Out 
Degree Centrality, Simmelian Ties, 
Total Degree Centralization, Triad 

Count 
Node Level : Boundry Spanner, 

Total Degree Centrality 

Merchant Marine Vessel 

Analyzes the relationships between 
crew members, owners, vessels 

and locations of the Merchant 
Marine Vessel data. 

Betweenness Centrality, Column 

Degree Centrality, Eigenvector 
Centrality, Row Degree Centrality, 
Total Degree Centrality 

Missing Links 
Compute possible missing links in a 

Node Level : Betweenness 
Centrality, Total Degree Centrality 
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network. Impact : Average Distance, Average 

Speed, Clustering Coefficient, 
Communication Congruence, Density, 
Diffusion, Fragmentation, Isolate 

Count, Overall Complexity, Overall 
Fragmentation, Performance as 

Accuracy 

Network Distribution 
Analyzes a collection o Meta-
Networks and calculates their 

common nodes and links 

 

Optimizer 
Adapt the link structure of a meta-

network to maximize or minimize 
selected measure values. 

User selects the Measures to run 

Part Of Speech 
Describe the distribution of 

concepts by part of speech in one 
or more networks. 

Betweenness Centrality, Total Degree 
Centrality  

Potential Errors 
Detects potential errors in agent to 

agent interactions based on the 
expected interactions from 

Cognitive Similarity and expertise. 

Cognitive Expertise, Cognitive 
Similarity 

Public Health 

Anayzes health department data to 
find potential problems. 

Access Redundacy, Assignment 

Redundacy, Average Distance, 
Clustering Coefficient, Density, Total 

Degree Centralization 

QAP/MRQAP Analysis 
Computes QAP and MRQAP 
Correlation and Regression (Dekker 

and Y-Permutation methods) on 
input networks. 

  

Role View 

For each individual, finds some 
important measures and facts 
about the actor in relation to their 

network 

Betweenness Centrality, Closeness 

Centrality, Complete Exclusivity, 
Eigenvector Centrality, Exclusivity, 
In-Degree Centrality, Out-Degree 

Centrality, Row Redundancy  

Rules of Engagement 
This report analyzes the trails that 

Special 
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are found in the Trails Viewer. 

Semantic Network 

Analyzes one or more semantic 
networks, computing the central 
networks and key concepts and 

links. 

Betweenness Centrality, Clustering 

Coefficient, Density, Diameter, Link 
Count, Node Count 

Shortest Path 
Computes the shortest path 
between two entities and general 

statistics on the paths. The sphere 
of influence of each entity is also 

computed. 

In Degree Centrality, Out Degree 
Centrality, Total degree Centrality 

Simmelian Ties 
Calculates the number of 
Asymmetric, Sole-Symmetric, and 

Simmelian Ties in unimodal 
networks computes standard 

measures on them. 

Node Level : Betweenness 
Centrality, Potential Boundry 
Spanner, Total Degree Centrality 

Graph Level : Density, 
Connectedness, Efficiency, Hierarchy, 

Link Count, Upper Boundedness 

Sphere of Influence 
For each individual, identifies the 

set of actors, groups, knowledge, 
resources, etc. that influence and 

are influenced by that actor. 

Actual Workload, Betweenness 
Centrality, Clique Count, Cognitive 
Demand, Eigenvector Centrality, 

Exclusivity, Exclusivity Complete, 
Potential Boundry Spanner, Shared 

Situation Awareness, Total Degree 
Centrality 

Standard Network Analysis 

Calculates the standard network 
analysis measures (Degree 

Centrality, Betweenness Centrality, 
etc). 

Node Level : Authority Centrality, 
Betweenness Centrality, Closeness 

Centrality, Eigenvector Centrality, 
Clique Count, Clustering Coefficient, 

Hub Centrality, In Closeness 
Centrality, Information Centrality, In-
Degree Centrality, Out Degree 

Centrality, Simmelian Ties, Total 
Degree Centrality 

Graph Level : Average Distance, 
Betweenness Centrality, Clique 
Count, Closeness Centrality, 

Clustering Coefficient, Column Count, 
Communicative Need, 

Connectedness, Density, Efficiency, 
Eigenvector Centrality, 
Fragmentation, Hierarchy, Isolate 
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Count, Link Count, Network Levels, 

Row Count, Total Degree 
Centralition, Upper Boundedness, 
Weak Component Count 

Table : Betweenness Centrality, 
Closeness Centrality, Eigenvector 

Centrality, In-Degree Centrality, Out 
Degree Centrality, Total Degree 
Centrality 

Statistical Change Detection 

Analyzes the changes in network-
level measures over time using a 

Statistical Process Monitoring 
(SPM) control chart. Control limits 
are determined based on a user 

defined level of risk. 

Betweenness Centrality, Closeness 

Centrality, Density  

Statistical Distribution 
User selects the measure to run for 
the analysis 

Tactical Insight 
 

Fits statistical distributions to a 
network based on measure values. 

Analyzes the top agent nodes 
across time periods, tracking 
locations and measure values. 

Betweenness Centrality, Total Degree 
Centrality 

Topic Analysis 

Finds topic clusters in a collection 
of text meta-networks using the 

LDA and LSA algorithms. 

 

Trails 
Analyzes the trails that an entity 
class makes through another entity 

class, for example, how vessels 
pass through ports. 

 

Trails Analysis 

This report analyzes the trails that 
are found in the Trails Viewer. 

Agent Level : Betweenness 
Centrality, Clique Count, Eigenvector 

Centrality, Exclusivity, Potential 
Boundry Spanner, Row Degree 

Centrality, Total Degree Centrality 

Go to Measures by Report Table  



 

786 
 

Reports by Measure 

To use this table look up the Measure in the left hand column and the Reports 
it is used in are in the right hand column. Some of the measures list This 

measure can be optionally added to many reports meaning they are not 
standard in any report but can be be optionally selected. 

Measure Used by Report 

Access Redundancy Public Health 

Actual Workload 
Changes in Key Entities, Key Entity, Management, 
Sphere of Influence 

Agent Knowledge 
Needs Congruence 

This measure can be optionally added to many 
reports 

Agent Knowledge 

Waste Congruence 
This measure can be optionally added to many 

reports 

Agent Resource 
Needs Congruence 

This measure can be optionally added to many 
reports 

Agent Resource 
Waste Congruence 

This measure can be optionally added to many 
reports 

Agent Socio 

Economic Power 
This measure can be optionally added to many 

reports 

Assignment 
Redundancy 

Public Health 

Authority Centrality Key Entity, Management, Standard Network Analysis 

Average Distance 
Context, Immediate Impact, Missing Links, Public 
Health, Standard Network Analysis 

Average Speed Immediate Impact, Key Entity, Missing Links 

Betweenness 

Centrality 

Changes in Key Entities, Communications Network 
Assessment, Communicative Power, Communicators, 

Context, Core Networks, Immediate Impact, 
Influence Net, Key Entity, Locate SubGroups, 

Merchant Marine Vessel, Missing Links, Part of 
Speech, Semantic Network, Simmelian Ties, Sphere 
of Influence, Standard Network Analysis, Statistical 

Change Detection, Tactical Insight, Trails Analysis 
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Bonacich Power 

Centrality 
This measure can be optionally added to many 

reports 

Boundary Spanner Communications Network Assessment, MedHealth 

Burt Constraint Context 

Capability 
This measure can be optionally added to many 

reports 

Classic SNA Density 
This measure can be optionally added to many 
reports 

Clique Count 

Changes in Key Entities, Communicators, Influence 
Centrality, Local Patterns, Locate SubGroups, 

MedHealth, Sphere of Influence, Standard Network 
Analysis, Trails Analysis 

Closeness Centrality 
Context, Standard Network Analysis, Standard 

Network Analysis, Statistical Change Detection 

Closeness Network 

Centralization 
This measure can be optionally added to many 

reports 

Clustering Coefficient 
Communicators, Context, Immediate Impact, Locate 
SubGroups, MedHealth, Missing Links, Public Health, 

Semantic Network, Standard Network Analysis 

Cognitive Demand 
Changes in Key Entities, Context, Immediate Impact, 

Influence Centrality, Management, Sphere of 
Influence 

Cognitive 

Distinctiveness 
This measure can be optionally added to many 

reports 

Cognitive Expertise Potential Errors 

Cognitive 

Resemblance 
This measure can be optionally added to many 

reports 

Cognitive Similarity Potential Errors 

Column Breadth Management 

Columns Count Standard Network Analysis 

Column Degree 

Centrality 
Merchant Marine Vessel, Key Entity 
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Column Degree 

Network 
Centralization 

This measure can be optionally added to many 
reports 

Column Redundancy 
This measure can be optionally added to many 
reports 

Communication 
This measure can be optionally added to many 

reports 

Communication 
Congruence 

Capabilities, Immediate Impact, Key Entity, Missing 
Links 

Communicative Need Standard Network Analysis 

Complexity Immediate Impact, Key Entity, Management 

Connectedness 
Context, Simmelian Ties Analysis, Standard Network 
Analysis, Simmelian Ties, Standard Network Analysis 

Correlation 
Distinctiveness 

This measure can be optionally added to many 
reports 

Correlation Expertise 
This measure can be optionally added to many 

reports 

Correlation 
Resemblance 

This measure can be optionally added to many 
reports 

Correlation Similarity 
This measure can be optionally added to many 
reports 

Density 

Communicative Power, Communicators, Core 

Networks, Immediate Impact, Key Entity, Locate 
SubGroups, MedHealth, Missing Links, Public Health, 
Semantic Network, Simmelian Ties, Standard 

Network Analysis, Statistical Change Detection 

Diameter Semantic Network 

Diffusion 
Immediate Impact, Missing Links, Immediate 
Impact, MedHealth, Missing Links 

Edge Betweenness 
Centrality 

Key Entity 

Effective Network 

Size 
This measure can be optionally added to many 

reports 
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Efficiency 
Context, Simmelian Ties Analysis, Standard Network 

Analysis 

Eigenvector 

Centrality 

Changes in Key Entities, Key Entity, MedHealth, 
Merchant Marine Vessel, Sphere of Influence, 
Standard Network Analysis, Trails Analysis 

Eigenvector 

Centrality Per 
Component 

Changes in Key Entities, Communications Network 
Assessment, Key Entity 

Exclusivity 
Changes in Key Entities, Communications Network 
Assessment, Key Entity, Management, Sphere of 

Influence, Trails Analysis 

Exclusivity Complete 
Changes in Key Entities, Key Entity, Management, 
Sphere of Influencev 

Fragmentation 
Context, Critical Sets, Immediate Impact, Key Entity, 
Missing Links, Standard Network Analysis 

Geodesic Distance 
This measure can be optionally added to many 

reports 

Global Efficiency 
This measure can be optionally added to many 
reports 

Hierarchy 
Context, MedHealth, Simmelian Ties, Standard 
Network Analysis 

Hub Centrality Key Entity, Management, Standard Network Analysis 

In Degree Centrality 
Communicators, Influence Centrality, Key Entity, 

Management, MedHealth, Shortest Path, Standard 
Network Analysis 

In Degree Network 
Centralization 

This measure can be optionally added to many 
reports 

Information 

Centrality 
Context, Standard Network Analysis 

Interdependence 
This measure can be optionally added to many 
reports 

Interlockers 
This measure can be optionally added to many 
reports 

Inverse Closeness Context 
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Centrality 

Isolate Count 
Immediate Impact, Missing Links, Standard Network 

Analysis 

Knowledge Acess 

Index 
This measure can be optionally added to many 

reports 

Knowledge Actual 
Workload 

This measure can be optionally added to many 
reports 

Knowledge 

Congruence 
Immediate Impact, Key Entity, Management 

Knowledge Diversity 
This measure can be optionally added to many 

reports 

Knowledge 
Exclusivity 

This measure can be optionally added to many 
reports 

Knowledge Load 
This measure can be optionally added to many 
reports 

Knowledge 

Negotiation 
This measure can be optionally added to many 

reports 

Knowledge Omega 
This measure can be optionally added to many 
reports 

Knowledge Potential 
Workload 

This measure can be optionally added to many 
reports 

Knowledge 

Redundancy 
This measure can be optionally added to many 

reports 

Knowledge Task 
Completion 

This measure can be optionally added to many 
reports 

Knowledge Under 
Supply 

This measure can be optionally added to many 
reports 

Lateral Link Count 
This measure can be optionally added to many 

reports 

Link Count 
Communicative Power, Semantic Network, 
Simmelian Ties, Standard Network Analysis 

Local Efficiency 
This measure can be optionally added to many 
reports 
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Location Relevance GeoSpatial Assessment, Key Entity 

Minimum Speed 
This measure can be optionally added to many 

reports 

Network Levels Standard Network Analysis 

Node Count 
Communicative Power, Communicators, Core 

Networks, MedHealth, Semantic Network 

Node Levels 
This measure can be optionally added to many 
reports 

Organization Agent 
Knowledge Needs 

Congruence 
Capabilities 

Organization Agent 
Knowledge Waste 

Congruence 
Capabilities 

Organization Agent 

Resource Needs 
Congruence 

Capabilities 

Organization Agent 

Resource Waste 
Congruence 

Capabilities 

Organization Task 
Knowledge Needs 

Congruence 
Capabilities 

Organization Task 
Knowledge Waste 
Congruence 

Capabilities 

Organization Task 

Resource Needs 
Congruence 

Capabilities 

Organization Task 
Resource Waste 

Congruence 
Capabilities 

Out Degree Centrality 
Communicators, MedHealth, Shortest Path, Standard 
Network Analysis 

Out Degree Network This measure can be optionally added to many 
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Centralization reports 

Overall Complexity Missing Links 

Overall 
Fragmentation 

Immediate Impact, Missing Links 

Overall Node Count Immediate Impact 

Overall Task 

Completion 
This measure can be optionally added to many 

reports 

Performance as 
Accuracy 

Immediate Impact, Key Entity, Missing Links 

Personnel Cost 
This measure can be optionally added to many 
reports 

Pooled Link Count 
This measure can be optionally added to many 

reports 

Potential Boundary 

Spanner 

Changes in Key Entities, Communications Network 
Assessment, Key Entity, Simmelian Ties, Sphere of 
Influence, Trails Analysis 

Potential Workload 
This measure can be optionally added to many 

reports 

Radials 
This measure can be optionally added to many 
reports 

Reciprocal Link Count 
This measure can be optionally added to many 
reports 

Relative Cognitive 

Distinctiveness 
This measure can be optionally added to many 

reports 

Relative Cognitive 
Expertise 

This measure can be optionally added to many 
reports 

Relative Cognitive 
Resemblance 

This measure can be optionally added to many 
reports 

Relative Cognitive 

Similarity 
This measure can be optionally added to many 

reports 

Relative Expertise 
This measure can be optionally added to many 

reports 
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Relative Similarity 
This measure can be optionally added to many 

reports 

Resource Access 
Index 

This measure can be optionally added to many 
reports 

Resource Actual 
Workload 

This measure can be optionally added to many 
reports 

Resource Congruence Management 

Resource Diversity 
This measure can be optionally added to many 

reports 

Resource Exclusivity 
This measure can be optionally added to many 

reports 

Resource Load 
This measure can be optionally added to many 
reports 

Resource Negotiation 
This measure can be optionally added to many 
reports 

Resource Omega 
This measure can be optionally added to many 

reports 

Resource Potential 
Workload 

This measure can be optionally added to many 
reports 

Resource 
Redundancy 

This measure can be optionally added to many 
reports 

Resource Task 

Completion 
This measure can be optionally added to many 

reports 

Resource Under 
Supply 

This measure can be optionally added to many 
reports 

Row Breadth 
This measure can be optionally added to many 
reports 

Row Count Standard Network Analysis 

Row Degree 

Centrality 
Changes in Key Entities, Group Talk, Key Entity, 

Merchant Marine Vessel, Trails Analysis 

Row Degree Network 

Centraliztion 
This measure can be optionally added to many 

reports 
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Row Redundancy 
This measure can be optionally added to many 

reports 

Sequential Link 
Count 

This measure can be optionally added to many 
reports 

Shared Situation 
Awareness 

Key Entity, Management, Sphere of Influence 

Simmelian Ties Management, MedHealth, Standard Network Analysis 

Skip Link Count 
This measure can be optionally added to many 

reports 

Social Technical 

Congruence 
Capabilities 

Span of Control 
This measure can be optionally added to many 
reports 

Spatial Betweenness 
Centrality 

GeoSpatial Assessment 

Spatial Closeness 

Centrality 
GeoSpatial Assessment 

Spatial Degree 
Centrality 

GeoSpatial Assessment 

Spatial Eigenvector 
Centrality 

Key Entity 

Strict Knowledge 

Congruence 
Capabilities 

Strict Resource 
Congruence 

Capabilities 

Strong Component 
Count 

This measure can be optionally added to many 
reports 

Task Exclusivity 
This measure can be optionally added to many 

reports 

Task Knowledge 
Needs Congruence 

This measure can be optionally added to many 
reports 

Task Knowledge 
Waste Congruence 

This measure can be optionally added to many 
reports 
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Task Resource Needs 

Congruence 
This measure can be optionally added to many 

reports 

Task Resource Waste 
Congruence 

This measure can be optionally added to many 
reports 

Total Degree 

Centrality 

Changes in Key Entities, Communications Network 
Assessment, Communicative Power, Context, Core 

Networks, Immediate Impact, Key Entity, Locate 
SubGroups, MedHealth, Merchant Marine Vessel, 
Missing Links, Part of Speech, Public Health, Shortest 

Path, Simmelian Ties, Sphere of Influence, Standard 
Network Analysis, Tactical Insight, Trails Analysis 

Total Degree 

Network 
Centralization 

Key Entity, Public Health, Standard Network Analysis 

Transitivity 
This measure can be optionally added to many 
reports 

Triad Count MedHealth 

Upper Boundedness 
Context, Simmelian Ties Analysis, Standard Network 

Analysis 

Weak Boundary 

Spanner 
This measure can be optionally added to many 

reports 

Weak Component 
Count 

Communicators, Standard Network Analysis 

Weak Component 
Members 

This measure can be optionally added to many 
reports 

 

 

Report General Content 

This section contains content relevant to the reports but not specific to any one 
report. New information will be added as it received. 

 

Statistical Comparison 
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Some reports support Statistical Comparison. For example, in the Key Entity report 
and the Standard Network Analytic reports bootstrapping techniques are used to 

assess statistical differences between statistics drawn from different networks. Two 
techniques are used: 

1. Random Reassignment : "Shuffle" the links in a network around - and 

thereby keep same size and density. 

2. Bootstrapping : Remove a small percentage of nodes and their attached 

links. 

To compare the metrics a t-statistic[ 1 ] is then calculated. Note that when the 
number of samples is large (> 100) the distribution for the t-statistic becomes the 
normal distribution. 

  

 

[ 1 ]t-statistic is a ratio of the departure of an estimated parameter from its 
notional value and its standard error.  

7 NOV 11 

  

 

Context In Reports 

Context attempts to address the question, "There's the measure values, but are 
they what I should expect? Are they low or high? I'm not sure what I 

should be seeing.". 

The Context the user needs from their measure values is comparing their measure 
values with the measure values that would result from a random network of the 

same size and density. This is somewhat helpful in addressing the questions, but by 
no means complete. It essentially answers how different the user's network is from 

a random network, and this may, or may not, be that useful to some users. 

Most reports that use tables, which is nearly all of them, would show Context. 

If you run a report on a single meta-network, then the some of the tables you see 
would show the Context. Not all measures have it, only some of them. 

Example 
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In-the-Know (total degree centrality) 

The Total Degree Centrality of a node is the normalized sum of its row and column 
degrees. Individuals or organizations who are "in the know" are those who are 
linked to many others and so, by virtue of their position have access to the ideas, 

thoughts, beliefs of many others. Individuals who are "in the know" are identified 
by degree centrality in the relevant social network. Those who are ranked high on 

this metrics have more connections to others in the same network. The scientific 
name of this measure is total degree centrality and it is calculated on the agent by 
agent matrices. 

Input network: characters x characters (size: 6, density: 0.466667) 

Rank Characters Value Unscaled Context* 

1 indiana_jones 1.00 5.00 2.62 

2 barranca 0.40 2.00 -0.33 

3 belloq 0.40 2.00 -0.33 

4 natives 0.40 2.00 -0.33 

5 satipo 0.40 2.00 -0.33 

6 jake 0.20 1.00 -1.31 

* Number of standard deviations from the mean of a random network of the same 
size and density 

Mean:  0.47 Mean in random network:  0.47 

Std.dev:  0.25 Std.dev in random network:  0.20 

 

 

All Measures 

Description :  

Computes a collection of measures and generates output in categories. Each 

category analyzes a particular aspect of the meta-network structure. 

Why Use This Report 
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This report calculates all the measures possible on a network. This report is 
often used for convenience of calculating the measures that may be reported 

separately from the report, such as when writing a journal paper. Unlike many 
of the other reports that put the measure into the context of the need, this 

report produces measures suitable only for people who understand the 
measures calculated by ORA. 

Input :  

Uses Node Classes and Networks from selected Meta-Networks. 

Parameters 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first Dialog 

Box also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new Meta-

Network. 

Dialog Box 3 : Choose to either Display all nodes or select the number of 
top ranked nodes. 

 

Output :  

Single Meta-Network, side-by-side comparison, multiple Meta-Network 
comparison. 

 

Assessing Change in Plan 

Description :  
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Analyzes a collection of Meta-Networks and show what has changed in terms of 
nodes and links when going from A to B. It is summerized in the following table. 

  

Uninvolved/Unattached nodes and links in A that are not in B A - B 

Common nodes and links in A and are also in B B intersect A 

New nodes and links not in A and in B B - A 

  

Actor Analysis 
agent x agent, agent x organization, organization x 
organization 

Expertise and 

Resource Analysis 
agent x knowledge, agent x resource, organization x 

knowledge, organization x resource 

Task and Event 
Analysis 

agent x event, agent x task, organization x event, 
organization x task 

Input 

Requires at least two networks. To obtain a complete report the following 
Networks need to be in the Meta-Network. 
  

Parameters 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first panel 
also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 

analyze. Placing a check mark in the box at the bottom will create a new Meta-
Network. 

Dialog Box 3 : Select the number of nodes to display. You can also select an 
attribute and value to further refine you analysis. Lastly select which Meta-

Network to use as an anchor. 



 

800 
 

 

Output :  

Single Meta-Network, multiple Meta-Network comparison. 

 

Belief Propagation 

Description :  

Estimates belief propagation through social networks. This report contains the 
most common beliefs shared by most people, the beliefs with the highest GINI 
coefficient, the most strongly held beliefs, the most likely to change beliefs, the 

most neutral individuals, and the most opinionated individuals. 
  

Betweenness Centrality 

Closeness Centrality 

Total Degree Centrality 

NOTE : This report requires the Meta-Network to analyze contains a Belief 

nodeclass. 

Why Use This Report 

This report runs a simulation of the belief (or attitude) propagation based on the 
Friedkin model from the social influence theory. 

Input 
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Requires a Belief NodeClass 

Parameters 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first Dialog 

Box also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new Meta-
Network. 

Dialog Box 3 : Select the number of nodes to display. You can also select an 
attribute and value to further refine you analysis. Lastly select which Meta-
Network to use as an anchor. 
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In addition you can set the Friedkin Algorithm Parameters and select the alpha 
measure. 

Finally you can set how contentious (likely to cause an argument) a belief is and 

choose the top ranked nodes. 

Output :  

Single Meta-Network, multiple Meta-Network comparison. 

 

Capabilities 

Description :  

Analyzes the knowledge, resource, and task capabilities of agents and 
organizations in the network. This is used to assess an individuals' or 

organizations' capability to perform tasks. 
  

Congruence 

Communication Congruence, Organization Agent 
Knowledge Needs Congruence, Organization 
Agent Knowledge Waste Congruence, 

Organization Agent Resource Needs Congruence, 
Organization Agent Resource Waste Congruence, 

Organization Task Knowledge Needs Congruence, 
Organization Task Knowledge Waste Congruence, 
Organization Task Resource Needs Congruence, 

Organization Task Resource Waste Congruence, 
Strict Knowledge Congruence, Strict Resource 

Congruence, Social Technical Congruence  

agent x knowledge, agent 
x resource, agent x task, 

agent x resource, 
knowledge x task, 

resource x task, task x 
task, 

Agent Capability Analysis 

Overall Capability Index 
agent x knowledge, agent 

x resource, agent x task 

Capability Index in Expertise agent x knowledge 

Capability Index in Resources agent x resource 

Capability Index in Tasks agent x task 

Organization Capability Analysis 
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Overall Capability Index organization x resource 

Capability Index in Resources organization x resource 

Task Requirement Analysis 

Overall Requirement Index 
task x knowledge, task x 
resource 

General Requirement Index in Expertise task x knowledge 

General Requirement Index in Resources task x resource 

Parameters 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first Dialog 
Box also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 

analyze. Placing a check mark in the box at the bottom will create a new Meta-
Network. 

Dialog Box 3 : Select the number of nodes to display. You can also select an 

attribute and value to further refine you analysis. 

 

Output :  

Single Meta-Network, side-by-side comparison, multiple Meta-Network 

comparison. 

 

Change In Key Entities 
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Description :  

Analyzes the changes over time of the agents that score highest in measure 
values. 

This report provides information on the overall structure of a complex network 
and identifies, for each type of node, which nodes stand out. A complex network 
typically is a meta-network with multiple types of entities such as people, 

expertise, resources and locations. Overall structure is defined using meta-
network metrics such as Overall Complexity, Social Density, Social 

Fragmentation, Communication Congruence, Knowledge Congruence, 
Performance as Accuracy, and Average Communication Speed. Key entities 
within each of the component networks are identified in terms of metrics such as 

Degree Centrality, Cognitive Demand, Specialization, and Redundancy. Separate 
key-entity pages are produced for each type of entity. For example, if there are 

people and resources - then key people and key resources are both identified. If 
the user selects two or more networks, this report will compare the results. 
  

Workload 
agent x knowledge, agent resource, agent x 
task, knowledge x task, resource x task 

Betweenness Centrality 

[Potentially Influential] 
agent x agent 

Clique Count agent x agent 

Cognitive Demand [Emergent 
Leader] 

agent x agent 

Eigenvector Centrality [Leader 
of Strong Clique] 

agent x agent 

Relatively Unique [Knowledge] agent x agent 

Complete Exclusivity 
[Knowledge] 

agent x knowledge 

High Betweenness/Low Degree agent x knowledge 

Row Degree Centrality agent x agent 

Total Degree Centrality agent x knowledge 

Input 

At least two Meta-Networks. 
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Parameters 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first Dialog 
Box also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new Meta-
Network. 

Dialog Box 3 : Select the number of nodes to display. You can also select an 

attribute and value to further refine you analysis. 

 

Output :  

Single Meta-Network. 

 

 

Communications Network Assessment 

Description :  

This report assesses a communications network. As information on speed of 
information transmittal becomes available it will be updated. This report takes a 

resource by resource network (preferably one where the nodes are 
communications devices and the links are the speed of reliability of the link). 
  

All reports resource x resource 

NOTE : This report uses the Context function as a comparison of the user's input 
network with that of a random network of the same number of nodes and density. 
This is an attempt to address a frequent user question, "Well, okay, I see the 
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measure values, but are they what I should expect? Are they low or high? I 
don't know what I should be seeing". 

Why Use This Report 

This report evaluates the effectiveness of a computer network, with the 
computer nodes being represented as resources. The computer network 
represents the physical layer of connections between machines. Effectiveness 

takes into account the placement of nodes in the network. 

Parameters 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first Dialog 
Box also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 

analyze. Placing a check mark in the box at the bottom will create a new Meta-
Network. 

Dialog Box 3 : Select the number of nodes to display. You can also select an 

attribute and value to further refine you analysis. Lastly select which Meta-
Network to use as an anchor. 

 

Output :  

Single Meta-Network 

 

Communicative Power 

Description :  
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Analyzes one or more semantic networks to classify concepts by measure 
values. 

  

Betweenness Centrality 

Density 

Link Count 

Node Count 

Total Degree Centrality 

Parameters 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first Dialog 
Box also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 

analyze. Placing a check mark in the box at the bottom will create a new Meta-
Network. 

Output :  

Single Meta-Network, side-by-side comparison, multiple Meta-Network 
comparison. 

 

Communicators 

Description :  

Analyzes the communication network (agent by agent) and gives high level 

statistics on its structure. 
  

In-Degree Centrality agent x agent 

Out-Degree Centrality agent x agent 

Betweenness Centrality agent x agent 

Node Count" agent x agent 
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Weak Component Count agent x agent 

Clique Count agent x agent 

Density agent x agent 

Clustering Coefficient agent x agent 

Parameters 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first Dialog 
Box also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 

analyze. Placing a check mark in the box at the bottom will create a new Meta-
Network. 

Output :  

Single Meta-Network, side-by-side comparison. 

When characterizing network topologies, it is important to consider the role of 

errors and incomplete data in the network. The Statistical Context and 
Communicators reports will provide additional analysis on network topologies 
and actors, respectively. For additional work on this subject, please refer to: 

References 

"Relating Network Topology to the Robustness of Centrality Measures", CASOS 

Technical Report, Terrill L. Frantz, Kathleen M. Carley May 2005. 

"On the robustness of centrality measures under conditions of imperfect data", 
Borgatti, Carley, Krackhardt. /Social Networks/ 28 (2006) 124-136. 

 

Context 

Description :  

Compares measured values against various stylized forms of networks in an 

effort to characterize network topology. 
  

Summary 
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Erdos-Remy, Core Perophery, Cellular All Square Networks 

Topology 

Betweenness Centrality, Closeness 
Centrality, Inverse Closeness Centrality 

random networks of various 
topologies with identical size and 

density 

Values Context 

Average Distance 

agent x agent 

Betweenness Centrality 

Closeness Centrality 

Clustering Coefficient Density 

Cognitive Demand 

Connectedness 

Burt Constrain 

Efficiency 

Fragmentation 

Hierarchy 

Information Centrality 

Inverse Closeness Centrality 

Total Degree Centrality 

Upper Boundedness 

NOTE : This report uses the Context function as a comparison of the user's input 
network with that of a random network of the same number of nodes and density. 

This is an attempt to address a frequent user question, "Well, okay, I see the 
measure values, but are they what I should expect? Are they low or high? I 

don't know what I should be seeing". 

Parameters 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first Dialog 
Box also gives you Transformation options for the final results. 
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Dialog Box 2 : Next select both the Node classes and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new Meta-

Network. 

Output :  

Single Meta-Network. 

 

Core Network 

Description :  

Computes the core network and reports general statistics. The Core Network is 
the largest component (sub-graph) in the graph. 

  

Centrality 
Set of selected networks 

Potentially Influential (Betweenness Centrality) 

NOTE : This report uses the Context function as a comparison of the user's input 
network with that of a random network of the same number of nodes and density. 
This is an attempt to address a frequent user question, "Well, okay, I see the 

measure values, but are they what I should expect? Are they low or high? I 
don't know what I should be seeing". 

Why Use This Report 

Good for extracting the big giant connected component in real life networks that 

have multiple disconnected small subcomponents and a big, giant connected 
component. 

Parameters 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first Dialog 

Box also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new Meta-

Network. 

Output :  
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Single Meta-Network, side-by-side comparison. 

 

CPOF 

Description :  

Analyzes the creation and modification of events and tasks and agent 
collaboration over time. 

  

Key Geo-Stickies 

In-Degree Centrality event x location 

Overall Complexity 
 

Collaboration Density agent x agent 

Parameters 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first Dialog 
Box also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new Meta-

Network. 

Output :  

Single Meta-Network, multiple Meta-Network comparison. 

This report finds out: 

Who are the top two busiest agents across time in terms of the total number 

of events and tasks modified or created? 

What is the busiest time period in terms of average agent activity? 

Which pairs of events are most likely to occur together? 

The co-occurence analysis requires that the networks be conformed so that 
entity sets are identical across networks. 
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Which pairs of tasks are most likely to occur together? The co-occurence 
analysis requires that the networks be conformed so that entity sets are 

identical across networks. 

 

Critical Sets 

Description :  

Finds critical sets of nodes in a network that best reach all other nodes, or 
whose removal maximally disrupts a network. 
  

Fragmentation Selected Networks 

Parameters 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first Dialog 
Box also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 

analyze. Placing a check mark in the box at the bottom will create a new Meta-
Network. 

Dialog Box 3 : The main items to choose here are the network to explore and 
the type of critical set you want to find. These are 1) A set whose removal will 

most fragment the network or 2) A set that most reaches other nodes in the 
network. 
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Secondly you need to set the size of your critical set and the number of 
iterations to perform. 

Lastly place a check mark in the box if you want to create a new Meta-Network 

based on this critical set. 

Output :  

Single Meta-Network. 

 

Custom 

Description :  

Computes a custom report with user selected measures and output tables, 
pictures, and figures. 

Why Use This Report 

The custom report allows a user to be able to design a report to meet a specific 
need by identifying the metrics that should be calculated on an input network. 
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The custom report would be used when a specific set of metrics or measures are 
needed routinely as opposed to simply producing the metrics directly each time. 

Parameters 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first Dialog 
Box also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new Meta-

Network. 

Output :  

A single Meta-Network. 

 

Detect Spatial Patterns 

Description :  

Find out whether a node attribute is clustered spatially, such that nodes are 
similar to nearby others. 

  

Network Properties Set of Selected Networks 

Input 

NOTE : Requires a Location Node Class with Latitude and Longitude attributes. 

Parameters 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first panel 
also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 

analyze. Placing a check mark in the box at the bottom will create a new Meta-
Network. 

Dialog Box 3 : Select a Location and an Agent Node Class and the Network 

where links are located at. 
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Place a check mark next to any of the attributes you want analyzed. 

Place a check mark in the Add a meta-network box to add this new meta-
network to ORA. 

Output :  

Single Meta-Network 

  

 

Drill Down 

Description :  
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Computes the drill down from a selected organization and then to a selected 
agent. 

Input 

Whatever node(s) you want to analyze. 

Parameters 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first Dialog 
Box also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 

analyze. Placing a check mark in the box at the bottom will create a new Meta-
Network. 

Dialog Box 3 : Select two nodes from any Node Class to expand. In the bottom 
section you can limit which Node Classes will be displayed in the display by 

removing any of the check marks. 

 

Output :  

A single Meta-Network. 
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Geospatial Assessment 

Description :  

Finds nodes that are co-located based, and counts the number of nodes that 
appear at location points. 

  

agent x location 

Parameters 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first Dialog 
Box also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 

analyze. Placing a check mark in the box at the bottom will create a new Meta-
Network. 

Dialog Box 3 : Select a Node Class. 
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You have two choices for determining the distance between locations. 1) 
distances from Latitude/Longitude and 2) Distance from attribute in Node Class. 

All Networks containing the Location Node Class will appear. Select the one(s) to 

analyze by placing a check mark next to their name. 

Select the number of links to list. 

Select whether or not to group the links. 

Finally place a check mark in the box if you want to create a new Meta-Network. 

Output :  

A single Meta-Network. 
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Group Talk 

Description :  

Analyzes the relationship between agents and knowledge. 
  

agent x agent, agent x knowledge, agent x role 

Parameters 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first panel 

also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new Meta-

Network. 

Output :  

A single Meta-Network. 

X[i] = X[i] / sum(X) 

Then the entropy is computed as: 

Entropy is (-1 * (sum of (X[i] * log(X[i]))/ log (2.0) 

Entropy: 

Entropy is measured using Shannon's Entropy measure (Shannon, 1948; Shannon, 

1951). It is a measure of uncertainty. ORA takes the data vector, converts in to a 
probability distribution and then applies Shannon's formula. 

Given a vector X (e.g. the vector of out-degrees for the AK graph) 

NOTE : It only applies to measures with non-negative values. 

The overall approach used is to: 

1. compute a measure with non-negative values: x1, x2, ..., xN  
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2. divide each xi by the sum(x1, x2, ..., xN) - to create a probability distribution 
- and so create: p1, p2, ..., pN 

3. Shannon Entropy is then calculated as the -sum_over_i(pi * log_base_2(pi)). 

The density of a network is defined as: The number of edges divided by the 
number of possible edges. 

References: 

Shannon, Claude E.. A Mathematical Theory of Communication. Bell System 

Technical Journal, July/October 1948. 

Shannon, Claude E.: Prediction and entropy of printed English, The Bell System 
Technical Journal, 30:50-64, January 1951. 

 

Group Talk 

Description :  

Analyzes the relationship between agents and knowledge. 
  

agent x agent, agent x knowledge, agent x role 

Parameters 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first panel 

also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new Meta-

Network. 

Output :  

A single Meta-Network. 

X[i] = X[i] / sum(X) 

Then the entropy is computed as: 

Entropy is (-1 * (sum of (X[i] * log(X[i]))/ log (2.0) 
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Entropy: 

Entropy is measured using Shannon's Entropy measure (Shannon, 1948; Shannon, 
1951). It is a measure of uncertainty. ORA takes the data vector, converts in to a 

probability distribution and then applies Shannon's formula. 

Given a vector X (e.g. the vector of out-degrees for the AK graph) 

NOTE : It only applies to measures with non-negative values. 

The overall approach used is to: 

1. compute a measure with non-negative values: x1, x2, ..., xN  

2. divide each xi by the sum(x1, x2, ..., xN) - to create a probability distribution 

- and so create: p1, p2, ..., pN 

3. Shannon Entropy is then calculated as the -sum_over_i(pi * log_base_2(pi)). 

The density of a network is defined as: The number of edges divided by the 
number of possible edges. 

References: 

Shannon, Claude E.. A Mathematical Theory of Communication. Bell System 

Technical Journal, July/October 1948. 

Shannon, Claude E.: Prediction and entropy of printed English, The Bell System 
Technical Journal, 30:50-64, January 1951. 

 

Immediate Impact 

Description :  

Computes the key actors of the network, and then isolates them individually to 
determine the effect on measure values. 

This report allows the user to engage in what if analysis about the immediate 
impact of removing one or more nodes. Comparative statistic techniques are 
used to assess the network with and without the nodes in question. 

The user identifies a network, identifies which node or nodes to remove, and 

then ORA computes the consequent changes in the network by removing those 
nodes in terms of overall network structure and key entities. A feature of this 
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report is that the user can save the meta-network with the removed nodes and 
then assess the modified network with any of the other reports. 

The Immediate Impact report is designed to help users understand how the 

removal of certain nodes, or a certain number of nodes, can effect a network. 
An Impact Analysis allows users to select specific nodes in the network to 

remove, and then compare various metrics between the original network and 
the network where these specific nodes are removed. In a Replication 

Analysis, users specify a specific number of random nodes to remove from a 
network. Users can then compare metrics of the original network with the 
average of a series of networks from which the set number of random nodes has 

been removed. 
  

Betweenness Centrality agent x agent 

Total Degree Centrality agent x agent 

Why Use This Report 

This report to allow you to perform one of two types of evaluation against the 

base network. The two types of analysis are : Impact analysis and 
Replication analysis. 

Impact analysis : One or more of the nodes identified in the Key Entities 

report are deleted as part of an assessment of the degradation in the 
network if those nodes were no longer in the network. This is a more precise 
version of impact analysis for node removal than random node removal. The 

report then shows the differences in values between the original and 
modified networks' at both the node and network measure levels. 

Replication analysis : Set a random number of nodes to delete, then the 

report will show the differences in values between the original and modified 
network's. Unlike impact analysis, the nodes are selected at random. The 
user also selects the number of iterations to execute, allowing a research to 

assess the vulnerability of a network to random node deletions. This is the 
more general impact analysis than the impact analysis discussed above. 

Parameters 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first panel 

also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new Meta-

Network. 
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Dialog Box 3 : Select the number of nodes to display. You can also select an 
attribute and value to further refine you analysis. Lastly select which Meta-

Network to use as an anchor. 

 

Impact Network [optional] : Specify one or more nodes to add or remove 
from a Meta-Network. 

Replication Analysis [Number of Replications] : Repeatedly remove a 
specified number of nodes uniformly at random from the meta-network. 

Output :  

Single Meta-Network. 

 

Influence Net 

Description :  

Displays the influence network and gives high level statistics on its structure. 

Input 

Betweenness agent x agent, task x task 
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Centrality 

In Degree 

Centrality 

agent x agent, agent x location, agent x profession, agent x 

task, agent x event, agent x knowledge, event x location, 
knowledge x task, task x event, agent x organization, atsk x 

task, knowledge x profession, task x profession, organization 
x resource, resource x task, resource x profession, agent x 
resource 

NOTE : This report uses the Context function as a comparison of the user's input 
network with that of a random network of the same number of nodes and density. 

This is an attempt to address a frequent user question, "Well, okay, I see the 
measure values, but are they what I should expect? Are they low or high? I 

don't know what I should be seeing". 

Parameters 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first panel 
also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 

analyze. Placing a check mark in the box at the bottom will create a new Meta-
Network. 

Dialog Box 3 : Select the number of nodes to display. You can also select an 

attribute and value to further refine you analysis. Lastly select which Meta-
Network to use as an anchor. 
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IMPORTANT : If your Network consists of more than one Node Class and one 
Network you must place a check mark in the Transform the input network 
into an inference network before proceeding. 

Lastly place a check mark in the Add inference network to create a new 
Metw-Network. 

Output :  

Single Meta-Network. 

 

Key Entity 

Description :  

Identifies key entities and groups who by virtue of their position in the network 
are critical to its operation. 

This report performs a network-level report to find Overall Complexity, Social 

Density, Social Fragmentation, Communication Congruence, Knowledge 
Congruence, Performance as Accuracy, and Avg Communication Speed. 

(Replaces the Event Analysis, Intelligence, and Location Analysis Reports). 

Why Use This Report 
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This is a go-to report to identify the important (or "key") who, what, where, 
when, and why. The input would be a social network in meta-network form 

using all of the ORA ontological categories (agents, organizations, etc.). If only a 
subset of the categories are represented, the key entity report will show a 

subset of the who, what, where, when, and why. 

Input 

Who Analysis 

Cognitive Demand [Emergent 

Leader] 
agent x agent 

Total Degree Centrality [In-The-

Know Leader] 
agent x agent 

Clique COunt [Number of Cliques} agent x agent 

Row Degree Centrality [Most 
Knowledgable} 

agent x knowledge 

Row Degree Centrality [Most 
Resources] 

agent x resource 

Eigenvector Centrality per 

Component [Leader of Strong 
Cliques] 

agent x agent 

Hub Centrality [Act as a Hub] agent x agent 

Authority Hub [Act as an authority] agent x agent 

Betweenness Centrality [Potenitally 
Influential Leader] 

agent x agent 

High Betweenness/Low Degree 

[Connects Groups] 
agent x agent 

Relatively Unique [Specialization - 

Knowledge] 
agent x knowledge 

Complete Exclusivity [Knowledge] agent x knowledge 

Relatively Unique [Resource] agent x resource 

Complete Exclusivity [Resource] agent x resource 

Relatively Unique [Task] agent x task 
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Complete Exclusivity [Task] agent x task 

Relatively Unique [Event] agent x event 

Complete Exclusivity [Event] agent x event 

Relatively Unique [Location] agent x location 

Complete Exclusivity [Location] agent x location 

Actual Workloads 
agent x knowledge, agent x resource, 
agent x task, knowledge x task, 

resource s task 

Shared Situation Awareness [Group 
Awareness] 

agent x agent 

  

How Analysis - Knowledge 

Total Degree Centrality [Dominant 
Knowledge] 

All networks based on 
knowledge 

Row Degree Centrality [Most Needed] knowledge x task 

Betweenness Centrality [Supply Chain 

Criticality] 
knowledge x knowledge 

  

How Analysis - Resource 

Total Degree Centrality [Dominant 
Knowledge] 

All networks based on 
resource 

Row Degree Centrality [Most Needed] resource x task 

  

What Analysis - Event 

High Concentration of Actors agent x event 

High Concentration of Tasks task x event 
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Actors at the Most events agent x event 

Tasks at the Most events task x event 

Events Where There Are Actors That Are Not At Other Events agent x event 

Events Where There Are Tasks That Are Not At Other Events tasks x event 

  

What Analysis - Task 

Central Tasks task x task 

Acts as a Hub task x task 

Acts as an Authority task x task 

High Concentration of Actors agent x task 

High Concentration of Knowledge 
knowledge x 
task 

High Concetration of Resources resource x task 

High Concentration of Tasks task x task 

High Knowledge Complexity 
knowledge x 
task 

High Resource Consumption resource x task 

Actors at the Most Tasks agent x task 

Knowledge at the Most Tasks 
knowledge x 
task 

Resource at the Most Tasks resource x task 

Tasks at the Most Tasks task x task 

Tasks Where There Are Actors That Are Not at Other Tasks agent x task 

Tasks Where There Are Knowledge That Are Not at Other 
Tasks 

knowledge x 
task 

Tasks Where There Are Resources That Are Not at Other 

Tasks 
resource x task 
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Tasks Where There Are Tasks That Are Not at Other Tasks tasks x task 

  

Where Analysis 

Most Active Locations For Events event x location 

Highest Concentration Of Actors agent x location 

Actors At The Most Locations agent x location 

Locations Where There are Groups Of Actors agent x agent, agent x location 

Parameters 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first panel 
also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 

analyze. Placing a check mark in the box at the bottom will create a new Meta-
Network. 

Dialog Box 3 : Select the number of nodes to display. You can also select an 
attribute and value to further refine you analysis. Lastly select which Meta-

Network to use as an anchor. 
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In addition you can select which entity to analyze: Who, How, What, or 
Where. 

Output :  

Single Meta-Network, side-by-side comparison, multiple Meta-Network 
comparison. 

 

K-Centrality 

Description :  

Calculates the geodesic centrality measures for various radius values k, which 
approximates the geodesic computation by only considering neighbors within the 

radius distance. 

Input 

Parameters 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first Dialog 
Box also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 

analyze. Placing a check mark in the box at the bottom will create a new Meta-
Network. 

Output :  

Single Meta-Network. 

 

Large Scale 

Description :  

Computes all network analysis measures. 

Input 

Computes all network analysis measures. 
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Parameters 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first panel 
also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new Meta-
Network. 

Output :  

Single Meta-Network. 

 

 

Local Patterns 

Description :  

Find link patterns in a network, such as Star, Checkerboard, and Clique. 

Input 

Clique Count agent x agent 

Parameters 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first panel 
also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 

analyze. Placing a check mark in the box at the bottom will create a new Meta-
Network. 

Dialog Box 3 : Select one Network to analyze. 
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In the Report mode you can choose to find selected patterns or only the 
patterns for a single selected node. 

In the bottom section define your pattern using the four parameters. 

Finally place a check mark in the box if you want to add the networks to Meta-

Networks to the Meta-Network Manager pane. 

Output :  

Single Meta-Network. 

 

Locate SubGroups 

Description :  
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Identifies the subgroups present in the network using various grouping 
algorithms. Most algorithms only work on a single network at a time 

Input 

Will analyze the networks selected by the user. 

Parameters 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first panel 
also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 

analyze. Placing a check mark in the box at the bottom will create a new Meta-
Network. 

Dialog Box 3 : In Step 1 select the types of transformation to apply. This deals 
with, among other paramters, isolates and pendants. Place a check mark next to 

all the transformations you want to apply. 
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In Step 2 you can choose any or all algorithms to run. Each will have it's own 
parameters such as the number of groups in Newman, the minimum number of 
cliques in Cliques, or the relationship types and link method in Johnson. 
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Dialog Box 4 : Finally you select the type of output you want. Again, place a 
check mark next to all the algorithms you want in the output. 

Output :  

Single Meta-Network 

 

Management 

Description :  

Identifies over- and under- performing individuals and assesses the state of the 
network as a functioning organization. 

Like some of the other key-entity reports, the Management Report uses a multi-
modal network to consider various aspects of an organization and report both 
organizational-level metrics as well as node-measures. This report includes 



 

836 
 

identification of both top-ranked actors and knowledge, but also least-ranked 
actors. Thus, this report provides answers to questions such as: 

Which actors are most central to the organization? 

What knowledge comprise the organization's core competencies? 

Which actors have access to the least knowledge? 

Which actors are not well-integrated socially? 

How much of the knowledge is unique to only one actor (across all actors)? 

Input 

Key Entities: Agent - Who 

Cognitive Demand agent x agent 

Hub Centrality agent x agent 

Authority Centrality agent x agent 

Workload 
agent x knowledge, agent x resource, agent x 
task, knowledge x task, resource x task 

Shared Situtation Awareness agent x agent 

Role Knowledge Availability agent x knowledge, knowledge x profession 

Role Resource Knowledge agent x resource, resource x profession 

Specialization - Knowledge 
(Relatively Unique) 

agent x knowledge 

Complete Exclusivity - 

Knowledge 
agent x knowledge 

Specialization - Resource 
(Relatively Unique) 

agent x resource 

Complete Exclusivity - 
Resource (Complete 

Exclusivity) 
agent x resource 

Specialization - Task 
(Relatively Unique) 

agent x task 

Complete Exclusivity - Task agent x task 
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(Complete Exclusivity 

Simmelian Ties   

Core Competency 

Knowledge agent x knowledge 

Resource agent x resource 

Tasks agent x task 

Performance Indicators 

  
agent x agent, agent x knowledge, agent x 
task, knowledge x task, agent x resource, 
resource x task 

Parameters : 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first panel 
also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new Meta-
Network. 

Dialog Box 3 : Select the number of nodes to display. You can also select an 

attribute and value to further refine you analysis. Lastly select which Meta-
Network to use as an anchor. 

 

Output :  

Single Meta-Network, multiple Meta-Network comparison. 
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MedHealth 

Description :  

Analyzes a collection of Meta-Network that represent nursing units. 

Input 

Interaction 

Betweenness Centrality 
 

Clique Count 
 

Clustering Co-effeicient 
 

Density 
 

Diffusion 
 

Eigenvector Centrality 
 

Hierarchy 
 

In-Degree Centrality 
 

Node Count 
 

Out-Degree Centrality 
 

Simmelian Ties 
 

Total Degree Centrality 
 

Triad Count 
 

Node Level 

Boundary Spanner 
 

Total Degree Centrality 
 

Parameters 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first panel 
also gives you Transformation options for the final results. 
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Dialog Box 2 : Next select both the Node classes and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new Meta-

Network. 

Output :  

Single Meta-Network, multiple Meta-Network comparison 

 

Merchant Marine 

Description :  

Analyzes the relationship between crew members, owners, vessels, and 
locations of the Merchant Marine Vessel data. It is used with a special data-set 

developed by CASOS.  

Parameters 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first panel 
also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 

analyze. Placing a check mark in the box at the bottom will create a new Meta-
Network. 

Dialog Box 3 : Select the number of nodes to display. You can also select an 
attribute and value to further refine you analysis. Lastly select which Meta-

Network to use as an anchor. 

The bottom box contains two tabs: [Crew] all of the agents in the Meta-
Networks and [Vessels] placed in the Resource NodeClass. 

Output :  

Single Meta-Network. 

 

Missing Links 

Description :  

Compute possible missing links in a network 
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Any one chosen square network in the Meta-Network. If multiple Meta-
Networks are chosen then your choice is only from the networks they have in 

common. 
  

Network Level 

Measures 
[square 
network] 

Average Communication Speed, Betweenness Centrality, 
Characteristic Path Length, Clustering Coefficient, 

Communication Congruence, Diffusion, Fragmentation, 
Isolated Agents, Social Density, Overall Complexity, Overall 
Fragmentation, Performance As Accuracy, Total Degree 

Centrality 

Parameters 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first panel 

also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new Meta-

Network. 

Dialog Box 3 : Select a network to analyze. 
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Next choose the algorithms to run on the network. 

Select the input networks. 

If you desire to run multiple replication analysis place a check mark in the 
bottom box. Then select the Number of replications and the Percent of links 

to remove. 

Output :  

Single Meta-Network. 
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Network Distribution 

Description :  

Analyzes a collection of Meta-Networks and calculates their common nodes and 
links 

Input : 

At least two networks. 

Parameters 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first panel 

also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new Meta-

Network. 

Dialog Box 3 : Select the number of nodes to display. You can also select an 
attribute and value to further refine you analysis. Lastly select which Meta-

Network to use as an anchor. 
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You can choose an anchor network which can be included or excluded in the 
comparison. 

The lossy percentage sets the threshold for ndoes and links to be included. 

Symmetric Differences allows you to add these to either the ORA Meta-

Network pane or write to disk. 

Next is whether to use Euclidean or Hamming distance. 
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Computing the distances between all pairs of input networks can be a time-
consuming process. 

Output : 

Single Meta-Network, side-by-side comparson, multiple Meta-Network 
comparison. 

 

Optimizer 

Description :  

Adapt the link structure of a Meta-Network to maximize or minimize selected 
measure values. 

Input :  

Any network in the selected Meta-Networks, with or without isolates. 

Parameters : 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first panel 

also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new Meta-

Network. 

Dialog Box 3 : Select the networks to optimize. 
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Next select the Network and Node measures to run. For each you can choose 
either minimum or maximum. 



 

846 
 

 

Output :  

Single Meta-Network. 

  

 

Part of Speech 

Description :  

Describe the distribution of concepts by part of speech in one or more networks. 
  

Semantic Network Betweenness Centrality and Total Degree Centrality 

Why Use This Report 

This report will identify the part of speech from the concepts in a text set. The 
networks are typically formed from AutoMap with a part of speech (pos) 
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attribute on each concept node. It can operate on any network (meta-network, 
semantic network, or concept network) as it makes use of only the nodes of the 

network. 

Input :  

Any network in the selected Meta-Networks. 

NOTE : NodeClass to analyze needs an attribute which contains the parts of 
speech. This is usually titles pos. 

Parameters : 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first panel 
also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new Meta-

Network. 

Output :  

Single Meta-Network, multiple Meta-Network comparison. 

 

Potential Errors 

Description :  

Detects potential errors in agent to agent interactions based on the expected 
interactions from cognitive similarity and expertise. 

  

Homophilly Cognitive Similarity, Cognitive Expertise 

Input :  

agent x agent  

Parameters : 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first panel 
also gives you Transformation options for the final results. 



 

848 
 

Dialog Box 2 : Next select both the Node classes and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new Meta-

Network. 

Output :  

Single Meta-Network. 

 

Public Health 

Description :  

Analyzes health department data to find potential problems. 

Input :  

Organizational Level Measures 

Communication Centralization, Communication Density, Clustering 

Coefficient, Characteristic Path Length,  
agent x 

agent 

Ranked Centrality Measures 

Betweenness Centrality, Degree Centrality, Potential Boundary 
Spanner 

agent x 
agent 

Task, Knowledge, Resource Networks 

 
  

Silo Analysis 

Internal Links (same group) and External (different groups) 
agent x 
agent 

Parameters : 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first panel 
also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 

analyze. Placing a check mark in the box at the bottom will create a new Meta-
Network. 
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Dialog Box 3 : Select an attribute to use for the analysis. 

 

Next select the tis for you input network. 

Output :  

Single Meta-Network. 

 

QAP/MRQAP Analysis 

Description :  

Computes QAP and MRQAP Correlation and Regression (Dekker and Y-
Permutation methods) on input networks. 

MRQAP : Used for multivariate cases if your dependent variable is continuous or 

count data (like in a negative binomial case), you should use MRQAP. If your 
dependent variable is binary, you should use ERGM (P*) which is forthcoming in 
ORA. One can perform MRQAP on data that have a dichotomous dependent 

variable (basically, this is equivalent to using a linear probability model). You do 
need to interpret your results accordingly. 

The MRQAP report is setup to compare the networks within a single 

MetaNetwork: e.g. communication vs department membership. However, you 
can also select multiple MetaNetworks for MRQAP, but you can not do regression 
of a network in one MetaNetwork vs a network in a different MetaNetwork. 
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You can do a regression using networks in the same and or different meta-
networks. Moreover, you can take a vector and create a repeated column or 

repeated row network and use that network in the regression as well. 

QAP Analysis : Computes QAP Correlation and Regression (Dekker and Y-
Permutation methods) on input matrices. QAP is designed as a bivariate test 

(only two variables). Generally, QAP is perfectly fine for almost any bivariate 
network problem. 

Why Use This Report 

Compares multiple networks to understand how two different networks relate 

using one network as dependent and the other as an independent network. Also 
useful for predicting the future of a network if there are multiple snapshots of 
the same network. 

Input :  

Define the independent matrices as well as the dependent network used in the 
QAP calculations. This is also given a random number seed and number of 
permutations to run.  

Lastly you can set to run any of the following: QAP Correlation, Dekker 

Regression, or Y-Permutation Regression analysis. 

Parameters : 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first panel 
also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new Meta-
Network. 
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Output :  

Single Meta-Network. 

See Also 

Regression 

 

 

Role View 

Description :  

For each individual, finds some important measures and facts about the actor in 

relation to thier network. 

Input 
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In-Degree Centrality agent x agent 

Out-Degree Centrality agent x agent 

Betweenness Centrality agent x agent 

Eigenvector Centrality agent x agent 

Exclusivity [knowledge] agent x knowledge 

Exclusivity [resource] agent x resource 

Exclusivity [task] agent x task 

Exclusivity [location] agent x location 

Closeness Centrality agent x agent 

Complete Exclusivity [knowledge] agent x knowledge 

Complete Exclusivity [resource] agent x resource 

Complete Exclusivity [task] agent x task 

Complete Exclusivity [location] agent x location 

Row Redundancy [agent] agent x agent 

Row Redundancy [task] agent x task 

Row Redundancy [resource] agent x resource 

Row Redundancy [knowledge] agent x knowledge 

Row Redundancy [organization] agent x organization 

Parameters 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first Dialog 
Box also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new Meta-

Network. 

Dialog Box 3 : Select the node(s) to analyze. You can use the Attribute Filter 
tab to select nodes with only certain attributes. When finished click [ Next > ]. 
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Output :  

Single Meta-Network, multiple meta-network comparison. 

 

Rules of Engagement 

Description :  

Analyzes the Rules of Engagement network and gives high level statistics on its 
structure. 

Why Use This Report 

This report is used to aid individuals in understanding rules of engagement. A 
rule of engagement (ROE) is a document describing how to behave in an 
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engagement situation. This ROE report can operate on a law document as well 
as an ROE. 

Parameters 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first panel 
also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new Meta-

Network. 

Dialog Box 3 : Select the number of nodes to display. You can also select an 
attribute and value to further refine you analysis. 

 

Select from one of the options for the type of analysis 
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Select a type of analysis :  

Search for a matching article by term :  

Compare all articles :  

Mission analysis : Analyze the difference between an historic body of law, mission 

rules of engagement, and current applicable laws of the sea. 

Output :  

Single Meta-Network, multiple Meta-Network comparison 

 

Semantic Network 

Description :  

This report analyzes one or more semantic networks, computing central 
networks and key concepts and links. It assesses the connection among 
concepts. Will derive networks from email content, texts, or documents of any 

sort. 

The semantics networks report analyzes one or more semantic networks, 
computes the central graphs, and key concepts and links. This is a comparison 

of two or more semantic networks. Each node in the network is considered a 
concept, and each link connects two concepts. Link weights are interpreted as 
the number of times it occurred in the underlying input text. 

The report includes tests whether the two semantic networks are statistically 
different using four different T-tests, based on the number of nodes, the number 
of links, betweenness centrality, and degree centrality. 

The symmetric distance of network A to network B is the number of concepts 

and links in A that are not in B. In set theoretic terms, this is the set difference 
(A - B). 

This report also provides communicative power analysis. Concepts are classified 

according to whether they have high and low values for the measures : 

Total Degree Centrality 

Betweenness Centrality 

Consensus 
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The semantic network report will perform analysis on a semantic network of 
concept colocations in a sentence generated by AutoMap. It will characterize the 

usage of words, such as a buzzword which is used but not described such as is 
often found in law documents. There are other word types based on how they 

exist within the semantic network. 

Ordinary (low degree, low betweenness, low consensus) 

Factoids (low degree, low betweenness, high consensus) 

Buzzwords (low degree, high betweenness, low consensus) 

Emblems (low degree, high betweenness, high consensus) 

Allusions (high degree, low betweenness, low consensus) 

Stereotypes (high degree, low betweenness, high consensus) 

Placeholders (high degree, high betweenness, low consensus) 

Symbols (high degree, high betweenness, high consensus) 

The report also creates new networks that represent different levels of 

agreement between the loaded networks. The set-theoretic intersection on the 
25, 50, 75% percent level is considered for this comparison. More precisely, the 
following outputs are computed: 

The union of compared links. 

The consensus between networks as it is represented by the intersection of links. 

The dissension between networks as it is represented as the difference. 

Why Use This Report 

The report outputs the nodes and edges in the intersection, offset, and union. 
Performing map comparison can help to answer questions such as: 

Do different people use the same words and themes in the same way? 

Do different people link concepts and themes in the same way? 

Do different people share the same knowledge? 

How similar or different are the analyzed texts? 

Input :  
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Set the percentage of maps a link must be in in order to be included in the 
central network. 

Output :  

Single Meta-Network, side-by-side comparison. 

Select whether to generate hamming distances between Meta-Networks. 

[1] Carley, K.M., Network text analysis: The network position of concepts, in Text 
Analysis for the Social Sciences: Methods for Drawing Statistical Inferences 

from Texts and Transcripts, C.W. Roberts, Editor. 1997, Lawrence Erlbaum 
Associates, Inc.: Mahwah, NJ, USA. p. 79-100. 

 

Shortest Path 

Description :  

Computes the shortest path between two entities and general statistics on the 
paths. The sphere of influence of each entity is also computed. 

Input :  

Organizational Level Measures agent x agent 

Ranked Centralizty Measures agent x agent 

Task, Knowledge, Resource Networks   

Silo Analysis agent x agent 

Parameters : 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first panel 

also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new Meta-
Network. 

Dialog Box 3 : Select a Start and End node. 
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In the bottom section place a check mark next to all Node Classes that can be 
used when computing the shortest path. 

Output :  

Single Meta-Network. 

 

Simmelian Ties Analysis 

Description :  

Calculates the number of Asymmetric, Sole-Symmetric, and Simmelian Ties in 
unimodal networks computes standard measures on them. 
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Input : 

Asymmetric, Simmelian, and Sole-Symmetric 
links 

Square matrices in Meta-
Network 

Parameters : 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first panel 
also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 

analyze. Placing a check mark in the box at the bottom will create a new Meta-
Network. 

Dialog Box 3 : Select a Start and End node. 

Place a check mark next to all Networks to analyze. 
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Select all, some, or none of the following options:  

Asymmetric :  

Simmelian :  

Sole Symmetric :  

Output :  

Meta-Network with Simmelian Ties. 

 

Sphere of Influence 

Description :  

For each individual, identifies the set of actors, groups, knowledge, resources, 

etc. that influence, and are influenced, by that actor. 

Any network. But it's most interpretable if you have an agent by agent and also 
have another network such as agent by knowledge or agent by resources or 
agent by location. 

Why Use This Report 

The Sphere of Influence report will provide information relative to one particular 
node in the network. This report is used when the impact of an individual 
(person, organization, location, etc.) and what the individual is directly 

connected to. 

Input : 

Cognitive Demand agent x agent 

Centrality, Total Degree agent x agent 

Clique Count agent x agent 

Centrality, Row Degree agent x knowledge 

Centrality, Row Degree agent x resource 

Centrality, Eigenvector agent x agent 
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Centrality, Hub agent x agent 

Centrality, Authority agent x agent 

Centrality, Betweenness agent x agent 

Boundary Spanner, Potential agent x agent 

Exclusivity agent x knowledge 

Exclusivity, Complete agent x knowledge 

Exclusivity agent x resource 

Exclusivity, Complete agent x resource 

Exclusivity agent x task 

Exclusivity, Complete agent x task 

Exclusivity agent x event 

Exclusivity, Complete agent x event 

Exclusivity agent x location 

Exclusivity, Complete agent x location 

Actual Workload agent x knowledge 

Shared Situation Awareness agent x agent 

Parameters : 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first panel 
also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new Meta-

Network. 

Dialog Box 3 : Select a Start and End node. 

Place a check mark next to all Networks to analyze. 
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Select all, some, or none of the following options:  

Output :  

Single Meta-Network. 

 

Standard Network Analysis 

Description :  

Calculates the standard network analysis measures (Degree Centrality, 

Betweenness, etc). 

This report calculates the standard network analysis measures such as Degree 
Centrality, Betweeness Centrality, etc. This report can be used on any "square 
network" where all the nodes are of one type; e.g., a people x people or 
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resource x resource network. The standard network analysis measures typically 
provide an analyst with a broad overall picture of the structure of the network. If 

the user selects two or more networks, this report will compare the results. 

Output :  

Single Meta-Network, side-by-side comparison. 

Why Use This Report 

This report calculates the standard network analysis subset of all the measures 

possible for a network. This report is often used for convenience of calculating 
the measures that may be reported separately from the report, such as when 
writing a journal paper. Unlike many of the other reports that put the measure 

into the context of the need, this report produces measures suitable only for 
people who understand social network analysis. 

 

Statistical Change Detection 

Description :  

Analyzes the changes in network-level measures over time using a Statistical 
Process Monitoring (SPM) control chart. Control limits are determined based on 

a user defined level of risk. 
  

Statistical 
Change 

Detection 

The entire Meta-Network 
OR 

agent x agent -or- task x task 

Input : 

At least three Networks. 

Parameters : 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first panel 

also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new Meta-

Network. 
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Dialog Box 3 : Select an algorithm: Shewhart X-Bar Chart or Cumulative 
Sum (CUSUM) Chart. 

 

Dialog Box 3 : Next set the Number of Networks and the Risk Probability of 

False Alarm. 

 

Choose whether to use the entire Meta-Network of one individual Network. 

Finally select all, some, or none of the following measures to run: 

Betweenness Centrality, Closeness Centrality, or Density. 

Output :  

Single Meta-Network, multiple Meta-Networks. 
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Statistical Distribution 

Description :  

Fits statistical distributions to a network based on measure values. 

When characterizing network topologies, it is important to consider the role of 
errors and incomplete data in the network. The Statistical Context and 

Communicators reports will provide additional analysis on network topologies 
and actors, respectively. For additional work on this subject, please refer to: 
  

Method of Least Square Error [LSE], Method of 
Maximum Likelihood Estimation [MLE], Method of 

Moments [MOM] 

Centrality 
Authority 

Parameters : 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first panel 

also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new Meta-

Network. 

Dialog Box 3 : Select a Input Network and an Input Measure. 
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Select all, some, or none of the following distributions: 

Normal (Gaussian) :  

Uniform :  

Exponential :  

Gamma :  

Beta :  

ChiSquare :  

Output :  

Single Meta-Network. 

References 

"Relating Network Topology to the Robustness of Centrality Measures", CASOS 

Technical Report, Terrill L. Frantz, Kathleen M. Carley May 2005. 

"On the robustness of centrality measures under conditions of imperfect data", 
Borgatti, Carley, Krackhardt. /Social Networks/ 28 (2006) 124-136. 
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Tactical Insight 

Description :  

Analyzes the top agent nodes across time periods, tracking locations and 
measure values. 

Top Agenet, Common Locations, Final 
Location 

Total egree Centrality, Betweenness 
Centrality 

Input :  

At least three networks. 

Parameters : 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first panel 
also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 

analyze. Placing a check mark in the box at the bottom will create a new Meta-
Network. 

Output :  

Single Meta-Network, Multiple Meta-Network comparison. 

 

Topic Analysis 

Description :  

Finds topic clusters in a collectin of text meta-networks using the LDA and LSA 

algorithms. 

Concept vs. Frequency, Topic 

Membership, Latent Semantic 
Analysis 

Concept(s) with Maximum Value, 

Concepts with Top-Ranked Membership 
Values 

Input 
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Every node is included and considered as a concept. The frequency of each 
concept is determined by the value of its frequency attribute. 

Parameters 

Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first Dialog 
Box also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 
analyze. Placing a check mark in the box at the bottom will create a new Meta-

Network. 

Dialog Box 3 : Select Latent Semantic Analysis [LSA] or Latent Dirichlet 
Allocation [LDA]. LSA request the number of topics. LDA adds to this he Number 

of Iteratins, Step Size, anbd Beta. 

 

Output :  

Single Meta-Network, side-by-side comparison, multiple Meta-Network 
comparison. 
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Trails 

Description :  

Analyzes the trails that an entity class makes through another entity class, for 
example, how vessels pass through ports. 

Input :  

At least two networks. Also requires data in trails format so the report can show 

who or what was where or when. Could also be who or what interacted 
with who or what when. 

Output :  

Single Meta-Network. 

  

 

Trails Analysis 

Description :  

Analyzes the trails that are found in the Trails Viewer. It does this by analyzing 

the trails of one nodeclass as it makes its way through another nodeclass (e.g. 
how vessels pass through ports). 

  

Betweenness Centrality, Clique Count, Co-Exit Analysis, Co-Location Analysis, 

Co-Movement Analysis, Co-Occurrance Analysis, Eigenvector Centrality, 
Presence, Total Degree Centrality, Transitions, Unique Links 

Why Use This Report 

Good for tracking and visualizing individual actors' geographic movements 
across a discrete space set over discrete time steps. Good for identifying trends 

like 1) is there any resemblence between different actors' moves? 2) are some 
locations more popular than others? 3) Is there a certain time range during 
which a big movement was triggered? 

Parameters : 
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Dialog Box 1 : Select the Meta-Networks to use in the analysis. The first panel 
also gives you Transformation options for the final results. 

Dialog Box 2 : Next select both the Node classes and the Networks to 

analyze. Placing a check mark in the box at the bottom will create a new Meta-
Network. 

Dialog Box 3 : Select the number of nodes to display. 

 

The bottom section allows you to refine your analysis. Place a check mark next 

to each option desired. 

Co-Entry : Nodes entering another node together. 

Co-Exit : Nodes leaving a node together. 

Co-Handoff : One node enters when another node exits. 

Co-Occurrance : Nodes at the same location. 

Presence : Nodes at the same location but not at the same time. 
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Transtitions : Nodes traveling along the same link route but not at the same time. 

From the drop down menu choose the Network to analyze. 

Finally, place a check mark in the bottom box to add this new pattern network 

to the Meta-Network. 

Output :  

Single Meta-Network with multiple Meta-Network comparison. 

 

Java Licenses 

Library Name / Website / License 

activation  

JavaBeans Activation Framework 

http://java.sun.com/products/archive/javabeans/jaf1
02.html 
Sun Microsystems, Inc. Binary Code License Agreement  

ant-launcher  
Ant Laucher 

http://ant.apache.org 
The Apache Software License, Version 2.0  

ant-optional-
1.5.1  

Ant Optional 
http://ant.apache.org 

The Apache Software License, Version 1.1  

batik-awt-util-

1.6  

Batik AWT Utilities 
http://xmlgraphics.apache.org/batik/ 

The Apache Software License, Version 2.0  

batik-bridge-

1.6  

Batik Bridge 

http://xmlgraphics.apache.org/batik/ 
The Apache Software License, Version 2.0  

batik-css-1.6  
Batik CSS 

http://xmlgraphics.apache.org/batik/ 
The Apache Software License, Version 2.0  

batik-dom-1.6  
Batik DOM Implementation 
http://xmlgraphics.apache.org/batik/ 

The Apache Software License, Version 2.0  

batik-ext-1.6  
Batik Extension 
http://xmlgraphics.apache.org/batik/ 
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The Apache Software License, Version 2.0  

batik-gvt-1.6  
Batik Graphics Vector Tree 

http://xmlgraphics.apache.org/batik/ 
The Apache Software License, Version 2.0  

batik-parser-
1.6  

Batik Parser 
http://xmlgraphics.apache.org/batik/ 

The Apache Software License, Version 2.0  

batik-script-1.6  
Batik Script 
http://xmlgraphics.apache.org/batik/ 
The Apache Software License, Version 2.0  

batik-svg-dom-
1.6  

Batik SVG DOM 

http://xmlgraphics.apache.org/batik/ 
The Apache Software License, Version 2.0  

batik-svggen-
1.6  

Batik SVG Generator 
http://xmlgraphics.apache.org/batik/ 

The Apache Software License, Version 2.0  

batik-

transcoder-1.6  

Batik Transcoder 
http://xmlgraphics.apache.org/batik/ 

The Apache Software License, Version 2.0  

batik-util-1.6  
Batik Utilities 

http://xmlgraphics.apache.org/batik/ 
The Apache Software License, Version 2.0  

>batik-xml-1.6  
Batik XML 

http://xmlgraphics.apache.org/batik/ 
The Apache Software License, Version 2.0  

casosparser  
CASOS Parser 
http://www.casos.cs.cmu.edu/projects/ora/ 

   

colt  
Colt 
http://acs.lbl.gov/software/colt/ 
CERN, 1999  

common-2.1.0  
Commons 

http://commons.apache.org/ 
The Apache Software License, Version 2.0  

commons-
beanutils-1.4  

Commons BeanUtils 
http://commons.apache.org/ 
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The Apache Software License, Version 2.0  

commons-cli-
1.2  

Commons CLI - Command Line Interface 

http://commons.apache.org/ 
The Apache Software License, Version 2.0  

commons-cli-
2.0-gt2-pre1  

Commons CLI - Command Line Interface 
http://commons.apache.org/ 

The Apache Software License, Version 2.0  

commons-

codec-1.4  

Commons Codec 
http://commons.apache.org/ 
The Apache Software License, Version 2.0"  

commons-
collections-3.1  

Commons Collections 

http://commons.apache.org/ 
The Apache Software License, Version 2.0"  

commons-
httpclient-3.1  

Commons HttpClient 
http://commons.apache.org/ 

The Apache Software License, Version 2.0"  

commons-io-

1.2  

Commons I/O Utilities 
http://commons.apache.org/ 

The Apache Software License, Version 2.0"  

commons-

jxpath-1.2  

Commons JXPath 

http://commons.apache.org/ 
The Apache Software License, Version 2.0"  

commons-lang-
2.1  

Commons Lang 

http://commons.apache.org/ 
The Apache Software License, Version 2.0"  

commons-
logging-1.1.1  

Commons Logging 
http://commons.apache.org/ 

The Apache Software License, Version 2.0"  

commons-
logging-api-
1.1.1  

Commons Logging API 
http://commons.apache.org/ 
The Apache Software License, Version 2.0"  

commons-
math-1.2  

Commons Math 

http://commons.apache.org/ 
The Apache Software License, Version 2.0"  

commons-pool-
1.3  

Commons Pool 
http://commons.apache.org/ 
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The Apache Software License, Version 2.0"  

concurrent-
1.3.4  

Java Concurrency 

http://download.oracle.com/javase/1.5.0/docs/ 
api/java/util/concurrent/package-summary.html 
Java 2 Platform SE 5.0  

db2jcc_dummy
-8.2.1  

DB2 Spatial Data 

http://geotools.org/ 
Lesser General Public License (LGPL)  

dnsjava-2.0.8  
DNS in Java 
http://www.xbill.org/dnsjava/ 

BSD license  

dom4j-1.6.1  
  
  

ecore-2.1.0  
Ecore 
http://java2ecore.blogspot.com/ 

Lesser General Public License (LGPL)  

facebook-java-

api-1.8-final  

Facebook Java API 
http://mrepo.happyfern.com/sites/facebook-java-api/ 

MIT License  

facebook-util-

1.8-final  

Facebook Companion Utility 

http://mrepo.happyfern.com/sites/facebook-java-api/ 
MIT License  

freehep-
graphics2d-2.0  

FreeHEP 2D Graphics 

http://java.freehep.org/ 
GNU LESSER GENERAL PUBLIC LICENSE, Version 2.1  

freehep-
graphicsio-2.0  

FreeHEP GraphicsIO 
http://java.freehep.org/ 

GNU LESSER GENERAL PUBLIC LICENSE, Version 2.1  

freehep-
graphicsio-pdf-
2.0  

FreeHEP GraphicsIO PDF 
http://java.freehep.org/ 
GNU LESSER GENERAL PUBLIC LICENSE, Version 2.1  

freehep-

graphicsio-svg-
2.0  

FreeHEP GraphicsIO SVG 

http://java.freehep.org/ 
GNU LESSER GENERAL PUBLIC LICENSE, Version 2.1  

freehep-io-
2.0.1  

FreeHEP IO 
http://java.freehep.org/ 
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GNU LESSER GENERAL PUBLIC LICENSE, Version 2.1  

freehep-util-
2.0.1  

FreeHEP Utilities 

http://java.freehep.org/ 
GNU LESSER GENERAL PUBLIC LICENSE, Version 2.1  

freehep-xml-
2.0.1  

FreeHEP XML 
http://java.freehep.org/ 

GNU LESSER GENERAL PUBLIC LICENSE, Version 2.1  

geoapi-
nogenerics-2.1-
M2  

GeoAPI 
http://www.geoapi.org/ 
GNU Lesser General Public License (LGPL)  

geowidgets-
1.0-M1  

GeoWidgets 

http://geowidgets.sourceforge.net/ 
GNU Lesser General Public License (LGPL)  

geronimo-stax-
api_1.0_spec-

1.0  

  
  

gluegen-rt  
GlueGen 
http://jogamp.org/gluegen/www/ 

BSD license  

gt2-api-2.3.3  
GeoTools API 

http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-arcgrid-
2.3.3  

GeoTools ArcGrid 

http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-arcsde-
2.3.3  

GeoTools ArcSDE 
http://geotools.org/ 

Lesser General Public License (LGPL)  

gt2-brewer-

2.3.3  

GeoTools Brewer 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-coverage-
2.3.3  

GeoTools Coverage 

http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-
coveragetools-

GeoTools Coverage Tools 
http://geotools.org/ 
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2.3.3  Lesser General Public License (LGPL)  

gt2-cql-2.3.3  
GeoTools CQL 

http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-db2-2.3.3  
GeoTools DB2 
http://geotools.org/ 

Lesser General Public License (LGPL)  

gt2-demo-data-

2.3.3  

GeoTools Data Demo 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-demo-
mappane-2.3.3  

GeoTools MapPane 

http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-demo-
property-2.3.3  

GeoTools Property Demo 
http://geotools.org/ 

Lesser General Public License (LGPL)  

gt2-directory-

2.3.3  

GeoTools Directory 
http://geotools.org/ 

Lesser General Public License (LGPL)  

gt2-epsg-

access-2.3.3  

GeoTools EPSG Access 

http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-epsg-hsql-
2.3.3  

GeoTools EPSG-HSQL 

http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-epsg-
postgresql-

2.3.3  

GeoTools ESPG PostreSQL 
http://geotools.org/ 

Lesser General Public License (LGPL)  

gt2-epsg-wkt-

2.3.3  

GeoTools ESPF-WKT 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-geomedia-
2.3.3  

GeoTools Geomedia 

http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-geotiff-
2.3.3  

GeoTools GeoTIFF 
http://geotools.org/ 
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Lesser General Public License (LGPL)  

gt2-gml-2.3.3  
GeoTools GML 

http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-go-2.3.3  
GeoTools Geospatial Object 
http://geotools.org/ 

Lesser General Public License (LGPL)  

gt2-graph-2.3.3  
GeoTools Graph 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-gtopo30-
2.3.3  

GeoTools GTopo30 

http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-hsql-2.3.3  
GeoTools HQSL 
http://geotools.org/ 

Lesser General Public License (LGPL)  

gt2-image-

2.3.3  

GeoTools Image 
http://geotools.org/ 

Lesser General Public License (LGPL)  

gt2-

imagemosaic-
2.3.3  

GeoTools ImageMosaic 

http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-

imagepyramid-
2.3.3  

GeoTools ImagePyramid 

http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-indexed-
shapefile-2.3.3  

GeoTools Indexed Shapefile 
http://geotools.org/ 

Lesser General Public License (LGPL)  

gt2-main-2.3.3  
GeoTools Main 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-mappane-
2.3.3  

GeoTools MapPane 

http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-mif-2.3.3  
GeoTools MIFFile 
http://geotools.org/ 
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Lesser General Public License (LGPL)  

gt2-mysql-
2.3.3  

GeoTools MySQL 

http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-openoffice-
2.3.3  

GeoTools OpenOffice 
http://geotools.org/ 

Lesser General Public License (LGPL)  

gt2-oracle-

spatial-2.3.3  

GeoTools Oracle Spatial 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-postgis-
2.3.3  

GeoTools PostGIS 

http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-
referencing-

2.3.3  

GeoTools Referencing 
http://geotools.org/ 

Lesser General Public License (LGPL)  

gt2-
referencing3D-

2.3.3  

GeoTools Referencing 3D 
http://geotools.org/ 

Lesser General Public License (LGPL)  

gt2-render-

2.3.3  

GeoTools Render 

http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-sde-
dummy-2.3.3  

GeoTools SDE Dummy 

http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-shapefile-
2.3.3  

GeoTools Shapefile 
http://geotools.org/ 

Lesser General Public License (LGPL)  

gt2-shapefile-

renderer-2.3.3  

GeoTools Shapefile Renderer 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-

svgsupport-
2.3.3  

GeoTools SVG Support 

http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-tiger-2.3.3  
GeoTools Tiger 
http://geotools.org/ 
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Lesser General Public License (LGPL)  

gt2-validation-
2.3.3  

GeoTools Validation 

http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-vpf-2.3.3  
GeoTools Vector Product Format 
http://geotools.org/ 

Lesser General Public License (LGPL)  

gt2-wfs-2.3.3  
GeoTools Website Feature Server 
http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-widgets-
swing-2.3.3  

GeoTools Swing Widgets 

http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-wms-2.3.3  
GeoTools Web Map Service 
http://geotools.org/ 

Lesser General Public License (LGPL)  

gt2-xml-2.3.3  
GeoTools XML 
http://geotools.org/> 

Lesser General Public License (LGPL)  

gt2-xml-filter-

2.3.3  

GeoTools XML Filter 

http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-xml-gml2-
2.3.3  

GeoTools XML GML 2 

http://geotools.org/ 
Lesser General Public License (LGPL)  

gt2-xml-gml3-
2.3.3  

GeoTools XML GML 3 
http://geotools.org/ 

Lesser General Public License (LGPL)  

hsqldb-1.8.0.1  
HyperSQL DataBase 
http://hsqldb.org/ 
BSD license  

htmlparser  
HTML Parser 

http://htmlparser.sourceforge.net/ 
Common Public License Version 1.0  

httpclient-4.0-
beta2  

HttpClient 
http://hc.apache.org/httpcomponents-client-ga/ 
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Apache License, Version 2.0  

httpcore-4.0-
beta3  

HttpCore 

http://hc.apache.org/httpcomponents-core-ga/ 
index.html 
Apache License, Version 2.0  

httpcore-nio-
4.0-beta3  

HttpCore Non-Blocking IO 

http://hc.apache.org/httpcomponents-core-ga/ 
httpcore-nio/index.html 
Apache License, Version 2.0"  

httpmime-4.0-
beta2  

HttpMime 

http://hc.apache.org/httpcomponents-client-ga/ 
httpmime/index.html 

Apache License, Version 2.0"  

idw  
IntelliDraw Vector Graphic 
  
Adobe License  

imageioext-

asciigrid-1.0-
rc1  

Image IO Extentions ASCII Grid 

http://java.net/projects/imageio-ext/ 
Lesser General Public License (LGPL)  

imageioext-
customstreams

-1.0-rc1  

Image IO Extensions Custom Streams 
http://java.net/projects/imageio-ext/ 

Lesser General Public License (LGPL)  

iText-2.1.0  
iText 
http://itextpdf.com/ 
Affero General Public License  

j3dcore  
Java3D Core 

http://www.j3d.org/ 
Java Distribution License  

j3dutils  
Java3D Utilities 

http://www.j3d.org/ 
Java Distribution License  

j3d-vrml97  
Java3D VRML 
http://www.j3d.org/ 

Java Distribution License  

jai_codec  
Java Advanced Imaging Codec 
http://java.net/projects/jai/ 
Sun Microsystems, Inc. Binary Code License Agreement  
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jai_core  
Java Advanced Imaging Core 

http://java.net/projects/jai/ 
Sun Microsystems, Inc. Binary Code License Agreement  

Jama-1.0.1  
Java Matrix Package 
http://math.nist.gov/javanumerics/jama/ 

GNU Lesser General Public License  

java-getopt-

1.0.13  

Java GetOpt 
http://javagetopt.sourceforge.net/ 
Lesser General Public License (LGPL)  

javaml-0.0.12  
Java Machine Learning Library 

http://java-ml.sourceforge.net/ 
GNU Lesser General Public License  

jaxb-api-1.3  
Java Architecture for XML Binding API 

http://jaxb.java.net/ 
GNU Lesser General Public License  

jaxb-impl-1.3  
Java Architecture for XML Binding Implementation 
http://jaxb.java.net/ 

GNU Lesser General Public License  

jaxb-libs-1.3  
Java Architecture for XML Binding Libraries 
http://jaxb.java.net/ 
GNU Lesser General Public License  

JAXWS2.1.3-
20071218  

Java API for XML Web Services 

http://jax-ws.java.net/ 
GNU Lesser General Public License  

jcalendar  
JCalendar 
http://www.toedter.com/en/jcalendar/index.html 

GNU Lesser General Public License  

jcommon-1.0.9  
JCommon 
http://www.jfree.org/jcommon/ 

GNU Lesser General Public License  

jdbc-stdext-2.0  

Java Database Connectivity 

http://www.oracle.com/technetwork/java/ 
javase/tech/index-jsp-136101.html 

Java 2 Platform SE 5.0  

jdom-1.1  
JDOM 
http://www.jdom.org/ 
JDOM License  
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jfreechart-
1.0.13  

JFreeChart 

http://www.jfree.org/jfreechart/ 
GNU Lesser General Public License  

jfreechart-
1.0.13-swt  

JFreeChart SWT 
http://www.jfree.org/jfreechart/ 

GNU Lesser General Public License  

jgraphlayout  
Java Graph Layout 
http://www.jgraph.com/jgraph.html 
BSD license  

jhall  
JavaHelp 

http://javahelp.java.net/ 
Sun Binary Code License Agreement  

jide-oss-3.0.2  
JIDE Common Layer 

http://www.jidesoft.com/products/oss.htm 
GNU Lesser General Public License  

jlfgr-1.0  

Java Look and Feel Graphics Repository 
http://java.sun.com/developer/techDocs/hi/repositor

y/ 
Java 2 Platform SE 5.0  

jogl  
Java OpenGL 
http://java.net/projects/jogl/ 

BSD license  

jsi-generics  
Java Spatial Index 
http://jsi.sourceforge.net/ 
GNU Lesser General Public License  

json-1.0  
JSON in Java 

http://www.json.org/java/ 
The JSON License  

jsr108-0.01  
Java Specification Request 

http://www.jcp.org/en/jsr/detail?id=108 
Apache License, Version 2.0  

jta-1.0.1B  
Java Transaction API 
http://java.sun.com/products/jta/ 

Java 2 Platform SE 5.0  

jts-1.7-generics  
Java Topology Suite Generics 
http://www.vividsolutions.com/jts/JTSHome.htm 
Lesser General Public License (LGPL)  
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jung  
Java Universal Network/Graph Framework 

http://jung.sourceforge.net 
The JUNG License  

junit  
JUnit Testing Framework 
http://junit.org 

JUnit Common Public License - v 1.0  

junit-3.8.1  
JUnit Testing Framework 
http://junit.org 
JUnit Common Public License - v 1.0  

kxml2-2.3.0 
kXML 2 

http://kxml.sourceforge.net/kxml2/ 
BSD license  

linkedin-j-
android  

LinkedIn for Android Java Wrapper 

http://m.linkedin.com/android 
The Apache Software License, Version 2.0  

log4j-1.2.6  
Log4j 
http://logging.apache.org/log4j/1.2/ 

The Apache Software License, Version 2.0  

mail  

JavaMail 
http://www.oracle.com/technetwork/java/ 
javamail/index.html 

JavaMail API  

MDateSelector1

4-00347  

MDate Selector 
http://web.ukonline.co.uk/mseries 
GNU Library or Lesser General Public License (LGPL)  

omcorba  
OpenMap CORBA Classes 

http://openmap.bbn.com/ 
OpenMap Software License  

omj3d  
Java 3D Classes 

http://www.j3d.org/ 
Java Distribution License  

omsvg  
  
http://openmap.bbn.com/ 

OpenMap Software License  

opencsv-1.7  
Open Source CSV Parser 
http://opencsv.sourceforge.net/ 
The Apache Software License, Version 2.0"  
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openmap-4.6.5  
OpenMap 

http://openmap.bbn.com/ 
OpenMap Software License  

picocontainer-
1.2  

PicoContainer 
http://picocontainer.org/ 

BSD License  

poi-3.7-

20101029  

Apache POI 
http://poi.apache.org/ 
The Apache Software License, Version 2.0  

poi-ooxml-3.7-

20101029  

Apache POI 

http://poi.apache.org/ 
The Apache Software License, Version 2.0  

poi-ooxml-

schemas-3.7-
20101029  

Apache POI 

http://poi.apache.org/ 
The Apache Software License, Version 2.0  

poi-scratchpad-
3.7.20101029  

Apache POI Scratchpad 
http://poi.apache.org/ 

The Apache Software License, Version 2.0"  

postgis-driver-

1.0  

PostGIS 
http://postgis.refractions.net/ 
GNU General Public License  

postgresql-8.1-
407.jdbc3  

PostgreSQL JDBC Driver 

http://jdbc.postgresql.org/ 
BSD License  

relaxngDatatyp

e-X  

Oracle Containers for Java 
http://www.oracle.com/technetwork/middleware/ias/ 

downloads/utilsoft-090603.html 
Java 2 Platform SE 5.0  

rome-1.0  
Rome 

http://java.net/projects/rome/ 
Apache Software License Version 1.1  

rssutils  

RSS Utilities 
http://java.sun.com/developer/technicalArticles/ 

javaserverpages/rss_utilities/ 
Java 2 Platform SE 5.0  

signpost-core-
1.2.1.1  

Signpost 
http://code.google.com/p/oauth-signpost/ 
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The Apache Software License, Version 2.0"  

spatialdb-0.1  
  

  
   

svgSalamander
-tiny  

SVG Salamander 
http://svgsalamander.java.net/ 

Lesser General Public License (LGPL)  

swingx-1.0  
SwingX 1.0 
http://www.swinglabs.org/ 
Lesser General Public License (LGPL)  

TableLayout  

TableLayout 

http://java.sun.com/products/jfc/tsc/articles/tablelay
out/ 

Java 2 Platform SE 5.0  

toolkits_1-2-0  
  

  
   

trove-2.0.4  
Trove 

http://trove.starlight-systems.com/ 
Lesser GNU Public License (LGPL)  

twitter4j-1.1.7  
Twitter4J 
http://twitter4j.org/en/index.html 

The Apache Software License, Version 2.0  

vecmath-1.3.1  
Java 3D Vecmath 
http://java.sun.com/products/java-media/3D/ 
Java 2 Platform SE 5.0  

velocity-1.4  
Velocity 

http://velocity.apache.org/,"Th 
Apache Software License, Version 2.0"  

worldwind-
0.6.430.13251  

NASA World Wind 
http://worldwind.arc.nasa.gov/java/ 

NASA OPEN SOURCE AGREEMENT VERSION 1.3  

velocity-dep-

1.4  

Velocity 
http://velocity.apache.org/ 

The Apache Software License, Version 2.0"  

xercesImpl- Xerces Implementation 
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2.7.1  http://xerces.apache.org/xerces2-j/ 

The Apache Software License, Version 2.0"  

xml-apis-1.0.b2  
XML APIs 
http://xml.apache.org/commons/ 
The Apache Software License, Version 2.0"  

xml-apis-
xerces-2.7.1  

Xerces XML APIs 

http://xerces.apache.org/xerces2-j/install.html 
The Apache Software License, Version 2.0"  

xml-beans-
2.3.0  

XML APIs 
http://xml.apache.org/commons/ 

The Apache Software License, Version 2.0"  

xml-writer  

XML Writer 
http://download.oracle.com/javase/1.5.0/docs/ 

api/javax/sql/rowset/spi/XmlWriter.html 
Java 2 Platform SE 5.0  

xsd-2.1.1  

XML Schema Definition 
http://vmgump.apache.org/gump/public/msv/ 

xsdlib/index.html 
JAVA WEB SERVICES DEVELOPER PACK, VERSION 1.5  

xsdlib-

20050614  

XML Schema Definition Library 
http://vmgump.apache.org/gump/public/ 

msv/xsdlib/index.html 
JAVA WEB SERVICES DEVELOPER PACK, VERSION 1.5"  
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